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About this publication

This publication helps you use InfoPrint® Manager for AIX®. This manual assumes
that you are up and running. It contains procedures to help you do various tasks
and troubleshoot problems. It also contains procedures for using orderable features
you can use with InfoPrint Manager.

Who should read this publication

This publication contains advanced configuration and operation tasks for the
administrators who configure the InfoPrint environment.

Consult the InfoPrint Manager: Reference for information about the various InfoPrint
commands, utilities, and attributes available to you while maintaining the system.

Most recent information

For the most recent information about InfoPrint Manager, go to the InfoPrint
Solutions Company Web site at http://www.infoprint.com and click Support and
downloads. Select your software product from the Software support list.

The InfoPrint publication library

For the most current information, see the InfoPrint Solutions Company Web site at
http://www.infoprint.com.

InfoPrint Manager common publication library

These publications are common to both InfoPrint Manager for AIX and InfoPrint
Manager for Windows®:
v InfoPrint Manager: SAP R/3 Planning and Configuration Guide, S550-1051. For print

administrators who need to create and configure both the SAP R/3 environment.
we recommend that users possess a detailed knowledge of a SAP R/3
environment, as well as administering and maintaining either AIX or Windows
operating systems. This publication describes how a business enterprise that
uses SAP R/3 can use either InfoPrint Manager for AIX or InfoPrint Manager for
Windows to manage its print environment.

v InfoPrint Manager: Reference, S550-1052. For print administrators, operators, and
application programmers with the need to do command-line functions. This
publication describes the commands, utilities, transforms, attributes, and
attribute values associated with InfoPrint.

v InfoPrint Manager: PSF and Server Messages, G550-1053. This publication lists the
PSF and Server messages and explanations from InfoPrint Manager.

v InfoPrint Manager Print-on-Demand Feature: Submit Express User’s Guide, S550-1054.
This publication is for the user who installs, configures, and uses Submit Express
on a Windows or Macintosh workstation. Although you can use this publication
for general guidance in using Submit Express, you should use the online Help to
find more detailed instructions.

v InfoPrint Job Ticketer: Job Ticketer User’s Guide, S550-1055. This publication is a
guide for using the InfoPrint Job Ticketer Web application. This guide provides
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descriptions of tasks and procedures that an end-user needs to know to set up
their workstation to use the application, and then to create, layout, store, retrieve
print jobs, and submit the jobs to a print server for printing.

v InfoPrint Job Ticketer: Administrator’s Guide, S550-1056. This publication is a guide
for system administrators who are responsible for the InfoPrint Job Ticketer Web
application. This guide provides information about the Job Ticketer system
requirements, installation and configuration, system maintenance, security, and
problem determination.

InfoPrint Manager for AIX publication library

InfoPrint Manager for AIX includes publications in PDF format on a CD-ROM
supplied with the product.

The publications for InfoPrint Manager for AIX are:
v InfoPrint Manager for AIX: Introduction and Planning Guide, G550-1060. This

publication gives an overview of InfoPrint Manager for AIX, introduces the
concepts, and helps you prepare to use it. It addresses migration from previous
versions of the product. And it explains the differences between the AIX and
Windows versions of InfoPrint Manager.

v InfoPrint Manager for AIX: Installation Instructions, G550-1059. This publication
describes how to install InfoPrint Manager for AIX 4.3. These instructions
explain the procedures for local and remote installations.

v InfoPrint Manager for AIX: Getting Started, G550-1061. This publication helps you
install and configure InfoPrint Manager for AIX. It focuses on the software
configuration of server and client system.

v InfoPrint Manager for AIX: Configuration and Tuning Guide, S550-1062. This
publication provides information about configuring and tuning the InfoPrint
Manager for AIX, Version 4.3. This book is designed for the InfoPrint Manager
administrator who needs to understand how to configure and tune an InfoPrint
Manager system. It helps administrators to evaluate, develop, and maintain both
a logical and hardware configuration for their environment.

v Guidelines for Installing InfoPrint Manager for AIX 4.2 in an HACMP Configuration,
G550-1063. This publication helps you install and configure HACMP™ with
InfoPrint Manager for AIX. It also describes how to use HACMP with InfoPrint
Manager for AIX.

v InfoPrint Manager for AIX: Using Generalized Fax, S550-1064. This publication
describes how to configure and use the Generalized Fax support that is included
with InfoPrint Manager for AIX. This publication includes information about
sending and receiving faxes from an InfoPrint Manager server.

v InfoPrint Manager for AIX: Procedures, G550-1066. This publication describes how
to set up an InfoPrint environment, to submit print jobs, to schedule jobs, and to
manage the print environment.

InfoPrint Manager for Windows publication library

InfoPrint Manager for Windows includes publications in PDF format on a
CD-ROM supplied with the product.

The publications for InfoPrint Manager for Windows are:
v InfoPrint Manager for Windows: Introduction and Planning Guide, G550-1071. This

publication gives an overview of InfoPrint Manager for Windows, introduces its
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concepts, and helps you prepare to use it. It describes features of this product.
Finally, this publication explains the differences between the AIX and Windows
versions of InfoPrint.

v InfoPrint Manager for Windows: Getting Started, G550-1072. This publication helps
you install and configure InfoPrint Manager for Windows. It focuses primarily
on server and client system software configuration.

v InfoPrint Manager for Windows: Procedures, G550-1073. This publication describes
the primary tasks necessary for setting up an InfoPrint environment, submitting
print jobs, scheduling jobs, and managing the print environment.

Related publications

Please see these publications for more information when they are referenced in this
manual:
v Color Management Object Content Architecture™ Reference, S550-0511
v Data Stream and Object Architectures: Mixed Object Document Content

Architecture™ Reference, SC31-6802
v Data Stream and Object Architectures: Graphics Object Content Architecture for

Advanced Function Presentation™ Reference, S544-5498
v EtherShare Version 2.6 User Manual,
v EtherShare OPI Version 2.1 User Manual,
v Font Summary for AFP™ Font Collection, S544-5633
v InfoPrint 4005 Hi-Lite Color Application Design Reference, S544-5794
v InfoPrint Hi-Lite Color Introduction and Planning Guide for 4005, G544-5741

Manual (man) pages for InfoPrint commands, utilities, and
transforms

Online information, in manual (man) page format, is available for all InfoPrint
commands and utilities. You can use the AIX man command to view man pages
for these InfoPrint commands:

v listconv

v lprafp

v lsippgw

v mkfntmap

v pdaccount

v pdclean

v pdcreate

v pddelete

v pddeviceop

v pddisable

v pdenable

v pdls

v pdmod

v pdpause

v pdpr

v pdpromote

v pdq

v pdreorder

v pdresubmit

v pdresume

v pdrm

v pdset

v pdshutdown

v pdspace

v psfstat

v uconv

For example, to view online information for the pdpr command, enter:
man pdpr
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You can use the AIX man command to view these man page for the -o flag, which
is used to pass information to InfoPrint on AIX print commands:

v oflag

You can use the AIX man command to view man pages for these InfoPrint utilities:

v admingui

v afpsplit

v ainupod1

v ainupod2

v ainupod3

v ainurpt1

v ainurpt2

v ainurpt3

v ainurpt4

v ainurpt5

v ainurpt6

v ainurpt7

v ainurpt8

v ainurpt9

v allocatefs

v cfu

v cmt

v ipguiadv

v ipguibasic

v ipguiadvadm

v ipguibasicadm

v jsmigr

v opergui

v pdadmin

v pdcrcds

v pdcrdflt

v pdcrmed

v pdinitports

v pdmigpp

v pdmincfg

v pdmsg

v pdnetifspri

v pdwsinitports

v rc.iprsap

v rc.pd

v setup

v startppo

v start_server

v startsrv

v stop_server

You can use the AIX man command to view man pages for these InfoPrint daemon
utilities:

v mvsprsd

v pcl2afpd

v ps2afpd

v startcbd

v startippgw

v startnotd

v startsapconnectd

v stopcbd

v stopippgw

v stopnotd

v stopsapconnectd

You can use the AIX man command to view man pages for these InfoPrint
transform commands:
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v db2afp

v d2afp

v gif2afp

v img2afp

v jpeg2afp

v line2afp

v pcl2afp

v pdf2afp

v ppml2afp

v ps2afp

v sap2afp

v tiff2afp

v xml2afp

v xml2pdf

For information about the flags that you can use with the man command, see the
man man page or to the AIX Commands Reference.
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Part 1. Administrative procedures: Configuring InfoPrint
Manager
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Chapter 1. Creating and managing servers

The InfoPrint server manages and controls all other InfoPrint objects in your
InfoPrint system. During InfoPrint installation, one server was created that
contains a logical destination, a queue, and an actual destination (a physical
printer). Use the information in this chapter to add additional servers and to
perform server configuration and maintenance tasks.

Preparing to create additional servers in a distributed environment
If you are configuring for a distributed environment and need to define many
instances of the InfoPrint server process on the same machine, use the fstshow
command to see what intercommunication ports are available on your server.

For example, entering fstshow —o on an AIX command line produces a display
similar to the contents of this table:

Table 1. Output from sample fstshow - o command
IN-USE? PORT# PID DIR-ID NAME
Y 2050 23266 2 server1
Y 2051 24272 0 notifyd
N 2052 99
N 2053 99
N 2054 99
N 2055 99
N 2056 99
N 2057 99
N 2058 99
N 2059 99

Once you have a list of the server intercommunication ports that are either in use
or available (2050 through 2059 in the display above), you can see if you have
enough ports to start more InfoPrint Manager server processes. If not, you can use
the pdinitports utility to initialize a larger range of port numbers for interprocess
communication. Note that InfoPrint Manager processes, such as notifyd and the
SAP callback daemons also use server intercommunication ports.

Because InfoPrint defaults to reserving only 10 ports, to define more than 10 server
processes, you must use the pdinitports utility to initialize more than 10 ports. For
example, to initialize InfoPrint to use the server interprocess communication ports
2050 through 2069 for twenty server processes, enter this at the AIX command line:
pdinitports 2050 2069

For a complete description of the pdinitports utility, see InfoPrint Manager:
Reference. Once you have completed this process, you can begin “Creating
additional servers or starting existing servers” on page 4.
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Creating additional servers or starting existing servers

You can create a new server or start an existing server through the InfoPrint SMIT
administrator’s interface. If you are not familiar with how to start the InfoPrint
SMIT administrator’s interface, see ″Using the InfoPrint Interfaces″ in InfoPrint
Manager for AIX: Getting Started.

To create a new server or start an existing server:
1. From the InfoPrint Printing System panel, click Start/Stop Servers. A new

menu displays.
2. Click Start a Server. The Start a Server dialog window opens.
3. Enter the name of the InfoPrint server in the * SERVER name field. By default,

InfoPrint fills in this field with the name of the AIX system on which you are
running the SMIT session.

4. To use a port number other than the default of 6874 as the communications
port for InfoPrint, enter the port number in the PORT number field.

Note: When selecting your own port number, always increment the choice by
two because the InfoPrint server uses two numbers: the one you specify and
the next one, for example, 6874 and 6875.

5. If you want the InfoPrint server to run in a locale other than your current
locale, enter the locale name in the LOCALE field.

6. Press Enter. The result of this step depends on whether the server exists:
v If the server does not exist, InfoPrint displays a confirmation message asking

if you want to create a new server. Respond to the prompt to continue.
v If the server exists but is not currently running, InfoPrint displays status

information and issues a message when it successfully starts the server.
v If the server exists and is running, InfoPrint issues a message to indicate that

the server is already operational.

Notes:

1. Normally you will only run one InfoPrint server on an AIX system.
2. You also use this procedure to start a server that you have shut down.

Important:

Following Daylight Savings Time changes, some customers have reported
discrepancies in their server accounting logs and others have reported job
submission failures. The problem was resolved by stopping and starting the
InfoPrint Manager server. If you are already experiencing these symptoms or want
to avoid them in the future, arrange to have your servers restarted immediately
following a Daylight Savings Time change.

Configuring servers with a mixed language environment
If your InfoPrint environment is a mixed language environment with separate
locales, you must use “Creating additional servers or starting existing servers” to
create separate servers running in each language of your environment. Each of
these servers can be named for the locale they support (such as english, french, or
german).
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These InfoPrint Manager servers do not need to contain any InfoPrint Manager
objects, such as queues or destinations. Instead, these servers handle the
locale-specific processing of the commands and forward those commands to the
InfoPrint Manager server that contains the objects.

For each InfoPrint client that is not running on the same AIX server as the
InfoPrint AIX servers, such as the InfoPrint Manager Operations GUI, InfoPrint
Submit Express, JobTicketer, or InfoPrint Select, you must make sure that it
connects to the correct InfoPrint server by setting the PD_SOCKET environment
variable to contain the port number of the InfoPrint AIX server supporting the
locale of your client. If your client is running in a locale not supported by the
InfoPrint server then connect it to an InfoPrint server running in English. To do
this task, see Chapter 12, “Setting InfoPrint Manager and AIX environment
variables,” on page 135.

Shutting down a server

You can shut down a server immediately or after it finishes processing some or all
of its current jobs.

InfoPrint prevents the server from accepting new jobs while the server is shutting
down and after it has shut down. Logical destinations and actual destinations in
the server that were enabled at shutdown time are enabled when the server is
restarted. Logical destinations and actual destinations in the server that were
disabled at shutdown time are disabled when the server is restarted.

Note: See “Creating additional servers or starting existing servers” on page 4 for
the restart procedure.

You can shut down an existing server through the InfoPrint SMIT administrator’s
interface. If you are not familiar with how to start the InfoPrint SMIT
administrator’s interface, see ″Using the InfoPrint Interfaces″ in InfoPrint Manager
for AIX: Installation Instructions.

To shut down an existing server:
1. From the InfoPrint Printing System panel, click Start/Stop Servers. A new

menu displays.
2. Click Stop a Server. The Stop a Server dialog window opens.
3. Enter the name of the InfoPrint server in the * SERVER name field. By default,

InfoPrint fills in this field with the name of the AIX system on which you are
running the SMIT session.

4. Press Enter. The result of this step depends on whether the server is running:
v If the server is currently running, InfoPrint issues a message when it

successfully stops the server.
v If the server is not running, InfoPrint issues a message to indicate that the

server is not operational.

Notes:

1. Normally you will only run one InfoPrint server on an AIX system.
2. You also use this procedure to start a server that you have shut down.
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Chapter 2. Installing and configuring printer devices and
related hardware

For information about printers not included in this chapter, please go to the
Printing Systems Web site. You can access this site from the InfoPrint Solutions
Company Web site at http://www.infoprint.com.

To create and configure the InfoPrint actual destinations that represent printer
devices, see “Creating and managing actual destinations” in InfoPrint Manager for
AIX: Getting Started.

Configuring and Using InfoPrint Manager with the InfoPrint Color 130
Plus

The InfoPrint Color 130 Plus is a high-speed, high quality, full-color digital printer
that you can submit jobs to through InfoPrint Manager. The InfoPrint Color 130
Plus system processes and prints high quality color AFP™ output at high speeds. It
also processes and prints PDF or PostScript® documents that include high
resolution color images.

The InfoPrint Color 130 Plus combines job management and page-level error
recovery capabilities with the ability to print full-color applications and documents.
This printer can support applications that use data formats, such as Encapsulated
PostScript (EPS), and Portable document format (PDF), as resources for variable
data AFP documents. The AFP architecture lets you use the Rasterized Image
Processor (RIP) to process these resources in the Advanced Function Common
Control Unit (AFCCU™) and save them in the printer. This capability improves
performance by eliminating the need to re-RIP these resources. It is not necessary
to convert single page PDF and EPS, objects to color images before sending them
to the printer. These objects can be RIPped directly in the AFCCU™, increasing
performance.

Significant processing demands are placed on the InfoPrint Manager system when
it is preparing and sending print jobs to an InfoPrint Color 130 Plus. Therefore,
you should dedicate one AIX server entirely to your InfoPrint Color 130 Plus; this
system should only contain one InfoPrint Manager server, and it should only send
print jobs to one InfoPrint Color 130 Plus.

System requirements

To submit jobs to an InfoPrint Color 130 Plus through InfoPrint Manager (without
using the color PostScript transform), your system must meet these requirements.
v Dedicated Gigabit Ethernet connection
v F80 AIX system with:

– Two CPUs (450 Mhz)
– Two GB RAM
– Four 18 GB Serial Storage Architecture (SSA)
– Two 18 GB SCSI hard drives

If you plan to use the PostScript color transform, your system must meet these
requirements.
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v Dedicated Gigabit Ethernet connection
v F80 AIX system with:

– Two 450 Mhz CPUs and four 500 Mhz CPUs
– Six GB RAM
– Six 18 GB Serial Storage Architecture (SSA)
– Two 18 GB SCSI hard drives

Defining the InfoPrint Color 130 Plus to InfoPrint Manager

Important: Because you are dedicating an InfoPrint Manager server to your
InfoPrint Color 130 Plus, this procedure assumes that you have just installed
InfoPrint Manager on this system. Your InfoPrint Manager server should not
contain any objects (logical destinations, queues, or actual destinations) yet. If you
are planning to use an existing InfoPrint Manager server to send jobs to your
InfoPrint Color 130 Plus, you should delete all of the objects that currently exist in
it before you start this procedure.

When you define your InfoPrint Color 130 Plus to InfoPrint Manager, you must
define it as a PSF TCP/IP-attached actual destination. The actual destination
represents the physical output device. The InfoPrint Color 130 Plus must be a PSF
TCP/IP printer. Use the Create Printer Wizard in the InfoPrint Manager
Administration GUI to create an actual destination.

Follow this procedure to define the printer using the InfoPrint Manager
Administration GUI.

Note: You create and configure the logical destination when you create the actual
destination with the Create Printer wizard.
1. Start the InfoPrint Manager Administration GUI.
2. Select Printer → Create → PSF → TCP/IP.
3. In the first panel of the Create Printer Wizard, do these steps.

a. Type a name for the actual destination in the Name field.
b. Verify that the server is correct in the Server field.
c. Select InfoPrintColor130Plus from the Model drop-down list.

Note: If that model is not shown, you must update InfoPrint Manager to
the current service level.

d. Type the TCP/IP address and port number for the printer in the correct
fields.

e. Click Next.
4. In the second panel, type a name for the logical destination that will send jobs

to this actual destination and click Next.
5. In the third panel, type a name for the queue that will submit jobs to this

actual destination and click Next.
6. On the rest of the panels, accept the default values that InfoPrint Manager sets

for AFP color printing by clicking Next and finally Finish.

Note: See the worksheets found in ″Creating and managing actual
destinations″ in InfoPrint Manager for AIX: Getting Started when providing the
information as prompted by the wizard.
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Configuring the PSF TCP/IP printer in InfoPrint Manager

Once you have created the actual destination in InfoPrint Manager, you must do
several other things before you can print. Complete the following procedures in
any order. Instructions appear below.
v “Verifying the size and location of the Input Manager workspace”
v “Identifying where to store AFP resources”
v “Specifying the color rasterized image processor (RIP) on this server” on page 11
v “Changing the color rendering value” on page 11

Once you have completed these steps, see Chapter 29, “Using InfoPrint Manager
with the InfoPrint Color 130 Plus,” on page 273 for additional information about
sending print jobs to the InfoPrint Color 130 Plus.

Verifying the size and location of the Input Manager workspace

The Input Manager is the part of InfoPrint Manager that breaks print jobs into
segments to allow greater flexibility during processing. The Input Manager stores
job segments in its workspace. Segments remain in the workspace either until they
are manually deleted or the workspace fills up, depending on how you choose to
manage the workspace. By default, the Input Manager workspace is located at
/var/psf/segments.

Because of the size and complexity of the color print jobs you send to your
InfoPrint Color 130 Plus, the Input Manager workspace must have at least 18 GB
of disk space available and it should be a separate filesystem. If the existing
/var/psf/segments does not have that much disk space available, the easiest thing
to do is to create a new filesystem and mount it over /var/psf/segments. None of
the InfoPrint Manager settings need to be changed.

Note: Make sure that the new filesystem is set to mount automatically at system
reboot so that it will still be available if you have to reboot your system.

If you do not want to overmount the filesystem, you can create a new filesystem
and mount it on a different mount point. In this case, you must change the Input
Manager settings to point to the correct location. To change the Input Manager
settings, do this.
1. At an AIX command prompt, type:

smitty pd_psf_com_adm_inp

2. Change the PATH used for work area & percent usage threshold to point to
the new filesystem you created.

3. Confirm the changes and exit SMIT.

Identifying where to store AFP resources

There are various kinds of AFP resources, such as form definitions, page
definitions, overlays, and fonts. The newest kind of AFP resource is the data object.
Like other resources, data object resources are files that you can include in AFP
documents. Data object resources can be EPS, PDF, and IOCA files. In addition, if
you use the transforms that come with InfoPrint Manager to convert TIF, GIF, and
JPEG images into AFP first, they can be used as data object resources as well. See
“Transforming color images” on page 273.
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In InfoPrint Manager, data object resources are grouped with BCOCA™ and GOCA
objects, and all of those types of files are called presentation object containers. As
with other kinds of AFP resources, you must tell InfoPrint Manager where your
presentation object containers are located.

In addition, you should tell InfoPrint Manager whether your presentation object
containers are private or public. Private resources cannot be reused by other print
jobs; public resources can be used by anyone in a variety of print jobs. For
example, you might make signature files private, so that no one could use them
inappropriately in correspondence or on checks. In addition, you might make your
company’s logo public, so you only need to store one copy of it for everyone to
use. By default, all presentation object containers are considered private.

You can define where your image resources are stored either from the AIX
command line using the pdset command with the resource-context-presentation-
object-container attribute or using the InfoPrint Manager Administration GUI.

Follow this procedure to set the attribute using the InfoPrint Manager
Administration GUI.
1. Start the InfoPrint Manager Administration GUI.
2. Select Options → Customize.
3. In the Customize dialog, click the Printer tab.
4. In the Action column, find Change AFP Resources and select the check box

in the Menu column next to it.
This step adds this task to the Printer menu. If you want to add other tasks to
the Printer menu or to any other menu, you can do it now or you can wait
until later.

5. Click OK to apply the settings and close the dialog.
6. Select the printer that you created in “Defining the InfoPrint Color 130 Plus to

InfoPrint Manager” on page 8.
7. Select Printer → AFP Resources to open the Change AFP Resources dialog.
8. In the Location of presentation object containers field, type the path where

your presentation object containers are stored. If they are stored in more than
one location, list all of the paths separated with colons (:), for example:
/resources/containers:/dept123/pres-obj-containers:/dept456/pres-obj-
containers

9. Fill in any other fields that are appropriate. For example, if you use form
definitions, fill in the Location of form definitions field.

10. Click OK to apply the settings and close the dialog.
11. If all of your presentation object containers are private, continue with step 13.

If some or all of your presentation object containers are public, select Printer →
Change Tuning to open the Change Tuning dialog.

12. In the Public presentation object containers field, type the path where your
public resources are stored. If your resources are stored in more than one
location, list them all here separated with colons (:), for example:
/resources/containers:/dept123/public-pres-obj-containers

13. Click OK to apply the settings and close the dialog.
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Specifying the color rasterized image processor (RIP) on this
server

Important: You only need to do this step if you will be submitting color PostScript
print jobs to your InfoPrint Color 130 Plus.

The RIP generates the data stream that InfoPrint Manager sends to the printer. By
default, InfoPrint Manager uses a RIP that produces monochrome (black and
white) documents. Therefore, you must specify the color RIP from the ps2afp data
stream transform before you send color documents to your InfoPrint Color 130
Plus.

To make the necessary configuration changes and start the color RIP, use this
procedure:
1. You first need to stop the ps2afpd daemon:

a. Find the process id number: ps | grep ps2afp

b. Stop the daemon: kill -9 <process id number>

2. Edit the ps2afpd.cfg daemon transform configuration file that is located in the
/usr/lpp/psf/ps2afp/ directory on the AIX server using your editor of choice.

3. Change the ps_output_type value to FS45, as shown in this example:
ps_output_type = FS45 # -a type of AFP image to generate

4. Save and close the file.
5. Start the daemon again: /usr/lpp/psf/bin/ps2afpd -C /usr/lpp/psf/ps2afp/

ps2afpd.cfg

If you ever want to send monochrome print jobs to your InfoPrint Color 130 Plus,
you can stop the color RIP and start the monochrome RIP by changing the
ps_output_type value back to the default value of IO1_G4, as shown in this
example:
ps_output_type = IO1_G4 # -a type of AFP image to generate

Changing the color rendering value

While the InfoPrint Color 130 Plus produces vibrant full-color images, including
images that contain gradients and shading, it is not able to reproduce every shade
of every color. The color rendering intent value (color-rendering-intent attribute)
determines what InfoPrint Manager does when it encounters a shade in a
PostScript image that the InfoPrint Color 130 Plus cannot reproduce exactly.

There are two possible values for color rendering intent:

Relative
When InfoPrint Manager encounters a color that InfoPrint Color 130 Plus
cannot reproduce, it substitutes the closest color value that it can
reproduce.

Perceptual
When InfoPrint Manager encounters a color that InfoPrint Color 130 Plus
cannot reproduce, it adjusts all of the colors in the image so that they
maintain their color relationships to each other. The result is an image that
is pleasing to the eye, but that might not look exactly like the original
image.

The default value is Relative.
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You can set the color rendering intent value on a print job, a default document, or on
an actual destination using either the command line or the InfoPrint Manager
Administration GUI. Follow this procedure to set the attribute using the InfoPrint
Manager Administration GUI.
1. Start the InfoPrint Manager Administration GUI.
2. If you have not already customized the InfoPrint Manager Administration GUI

to add the Change AFP Color task to the Printer, Printer → Job and Document
Defaults, Job, and Logical → Job and Document Defaults menus, complete
these steps:
a. Select Options → Customize.
b. In the Customize dialog, click the Printer tab.
c. In the Action column, find Change AFP Color and Job and Document

Defaults Change AFP Color and select the check box in the Menu column
next to it.

d. Repeat on the Job and Logical tabs.
e. Click OK to apply the settings and close the dialog.

3. Select the object that you want to set the color rendering intent value for by
clicking it once.

4. Use the menu items you added in 2 to open the appropriate Change AFP
Color dialog:
v For an actual destination, select Printer → Change AFP Color.
v For a default job on an actual destination, select Printer → Job and Document

Defaults → Change AFP Color.
v For a default job on a logical destination, select Logical → Job and Document

Defaults → Change AFP Color.
v for a job that has already been submitted, select Job → Change AFP Color.

5. In the Change AFP Color dialog, find the Color rendering intent field, select a
value from the drop-down list, and click OK.

Specifying the color rendering intent value on the other-transform-options
attribute: The attribute other-transform-options can now have a value which
includes an equals sign, so pragma statements are supported. For example, to
submit a color print job called PS.doc with the pragma colorRendering, to a
printer called color_printer using perceptual color rendering, you could type this
on the command line:

pdpr -d color_printer -x "other-transform-options = '-pragma
colorRendering=perceptual'" PS.doc

The single quotes are a syntax requirement.

This pragma can also be used on a command line invocation of a transform or it
can be specified in the transform configuration file.

Configuring the InfoPrint 2000 model MS1 (non-AFCCU)
The InfoPrint 2000 printer is a multi-purpose solution designed for a multiplicity
of users. Whether you require the speed and precision of an Advanced Function
Presentation (AFP) printer, or the print quality of a PostScript or PCL commercial
printer with finishing capabilities, the InfoPrint 2000 can meet your needs.
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Before you can use an InfoPrint 2000 printer, it is important to make sure that your
InfoPrint Solutions Company Customer Support Specialist has both created a local
account and added a local user. If these basic configuration tasks have not been
done on the InfoPrint 2000 printer, you will not be able to use it with InfoPrint
Manager.

In order to submit print jobs to the InfoPrint 2000, you must use the appropriate
destination support system (DSS). If you are using the InfoPrint 2000 AFP printer,
then you should use the PSF DSS. If you are using the standard InfoPrint 2000
printer, then you must use the IP2000 DSS, (specified as IP2000 on the command
line):
pdcreate -c destination \
-x destination-model=Infoprint2000 \
-x device-support-system=ip2000 \
-x attachment-type=tcpip \
-x destination-realization=actual \
-x destination-tcpip-internet-address=9.99.43.3 \
-x associated-queue=servername-default-queue \
servername:printername

Review the following three topics before trying to use the InfoPrint 2000 printer.

Matching media on the printer

Before you can send jobs to the InfoPrint 2000 printer, you must make sure that the
media supported by the printer corresponds to the media specified by InfoPrint
Manager. You must:
1. Make sure media objects are defined for each media you will be using on the

printer.
2. Tell InfoPrint Manager what media is ready at the printer.

The InfoPrint Manager Administration Interface window shows a highlighted
InfoPrint 2000 printer defined in the Queues pane under Printers. By selecting the
Printers drop-down menu and selecting the Properties... option, you can open the
Printer Properties window. Then click Media/Bins/Trays to see the media
attributes signified by letter.

If you are using a non-AFCCU InfoPrint 2000 printer, the medium-type,
medium-weight, medium-size, and medium-color values specified in the Printer
Properties window must exactly match the values for type, size, and color that are
specified on the InfoPrint 2000 printer: To do this task, you must check the
InfoPrint 2000 Paper Catalog and make sure it is mapped to the InfoPrint Manager
media. If you need to add a media object that is not yet defined, see Chapter 4,
“Configuring media,” on page 45.

Telling InfoPrint Manager what media is ready at the printer

To see the current values for PSF tray characteristics for each item displayed in the
Media ready field, specify this from the AIX command line:
pdls -cp -r psf-tray-characteristics ip2000

where ip2000 is the name of the actual destination used in this example.

For this example, InfoPrint Manager displays these values:

ip2000:
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psf-tray-characteristics =

1:letter:1:1:true
2:legal:2:2:true
3:ledger:3:3:true
4:A4:4:4:true
5:A3:5:5:true
6:B6:6:6:true

The first three values in each line, e.g. 1:letter:1, represent the tray name,
medium, and input bin number. Tray name can be anything, but each one has to
be unique. For simplicity, this example uses numbers 1 through 6. The medium
and bin number should match the actual setup on the printer. That is, if tabloid
paper is loaded in bin 2, one line should be "2:tabloid:2:2:true".

To set or change these values, you must use the pdset command at the AIX
command line. to set the psf-tray-characteristics attribute for all six bins on the
printer to define which of the supported paper sizes are loaded on the InfoPrint
2000 printer.

For example, if you map "letter" paper to bin "1" through the
psf-tray-characteristics attribute, the form definition provided with the print job
should call out bin "1". When you update the psf-tray-characteristics attribute to
change a paper size on the InfoPrint 2000, the InfoPrint AIX server will update the
printer profile to reflect the change.

To complete this task from the command line of your InfoPrint AIX server, use this
procedure:
1. To change the media ready, you must first disable the printer.
2. To initially define complete set of media ready invoke the pdset command. This

example sets the values shown above:
pdset -cp -x "psf-tray-characteristics=1:letter:1:1: 2:letter:2:2:
3:legal:3:z 4:tabloid:4:4: 5:A3:5:5: 6:A4:6:6:" ip2000

where ip2000 is the name of the actual destination used in this example.

You can change an individual media ready. If you have these values for psf-
tray-characteristics:

ip2000:

psf-tray-characteristics =

1:letter:1:1:true
2:legal:2:2:true
3:ledger:3:3:true
4:A4:4:4:true
5:A3:5:5:true
6:B6:6:6:true

To change the paper in bin 3 from ledger to tabloid, invoke the pdset command:
pdset -cp -x "psf-tray-characteristics+=3:tabloid" ip2000

where ip2000 is the name of the actual destination used in this example.

Note that in the above command, we used "+=" instead of just "=". This means
you are adding a value to the list rather than replacing the whole list.
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In this case, we specified tray name "3", so the previous setting for that tray is
replaced. If you specified a tray name that was not in the list, it would be added.

Submitting jobs to the InfoPrint 2000 printer

The InfoPrint 2000 DSS lets you submit jobs in two ways: Passthru Mode or
InfoPrint Mode.

If you will be submitting AFP jobs to the InfoPrint 2000, we recommend that you
set the dss-job-message-disposition actual device attribute to log so that all job
error messages are sent to the /var/psf/DestinationName/jobmessage.log file, instead
of printing out at the end of the job. When you use the jobmessage.log file,
remember to look in the file when a job fails to print.

You can modify this attribute from the AIX command line as follows:
pdset -cp -x "dss-job-message-disposition=log" ip2000

where ip2000 is the name of your actual destination for the InfoPrint 2000 printer.

InfoPrint mode
InfoPrint mode implies that the job is ripped by InfoPrint Manager. In this mode,
you can specify a range of different calibration screens by using the Halftone
Management System, which is described in the topic “Configuring the Halftone
Management System” on page 29.

Passthru mode
Passthru sends the job to the InfoPrint 2000 through a special socket connection
that passes the job to InfoPrint Manager spooler without ripping the job. To submit
a job as passthru, you must make sure that one of these attributes has been
specified:
job-ripped-by-server=false
doc-formats-ripped-at-dest=postscript
doc-formats-ripped-at-dest=pcl

The jobs-ripped-by-server attribute is a job attribute that takes precedence over the
doc-formats-ripped-at-dest printer attribute.

When sending a job to the printer in passthru mode, you must not specify any of
these attributes:
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v base-printer
v carriage-control-type
v chars
v color-mapping-table
v convert-to-ebcdic
v data-fidelity-problem-reported
v default-printer-resolution
v document-finishing
v explicit-page-placement
v font-fidelity-action
v font-processing-messages
v font-resolution
v form-definition
v halftone
v image-fit
v image-length
v image-out-format
v image-width
v input-exit
v input-tray-select
v job-terminate-message-count
v jog-between-job-copies
v maximum-messages-printed
v maximum-transform-pages-ahead
v mvs-segment-id
v new-line-option
v new-line-option-data-encoding
v number-up
v other-transform-options
v output-appearance

v output-bin
v output-format
v overlay
v overlay-back
v overlay-front
v page-definition
v page-media-select
v page-select
v resource-context
v resource-context-font
v resource-context-form-definition
v resource-context-overlay
v resource-context-page-definition
v resource-context-page-segment
v resource-context-user
v resource-exit
v reverse-page-order
v scanner-correction
v screen-frequency
v segment-file-size
v shared-formdef
v shift-out-shift-in
v start-on-new-sheet
v table-reference-characters
v transform-message-file-name
v transform-output-file-name
v x-image-shift
v x-image-shift-back
v y-image-shift
v y-image-shift-back

These job attribute conditions are not supported for Passthru Mode support:
1. Any use of the job-finishing attribute.
2. If the job is a variable data job or contains:
v More than one printable document
v An insert sheet
v A file-reference document
v A document with document-format=modca

v A document with job-rip-action=rip-and-hold or job-rip-action=rip-only

v A copy-count attribute set higher than 1

Limitations that apply to the InfoPrint 2000 printer
Because the InfoPrint 2000 printer lets you print AFP files on IPDS™ printers, there
are some limitations to the printer and job commands that you can use. The
InfoPrint 2000 DSS does not support these options:
1. Duplex printing of tab paper.

While the InfoPrint Manager Interfaces allow you to request this support,
printing duplex with tabbed paper causes output to be printed on the wrong
side of the page and can cause a printer jam.

2. Forward space the job printing.
3. Back space the job printing.
4. Pausing a currently printing job.
5. Resuming a job that had been paused while printing.

16 InfoPrint Manager for AIX: Procedures



6. Synchronous shut down of a printer.
This option is supported for jobs paused while ripping.

Configuring InfoPrint Manager to use the InfoPrint 2090ES, 2105ES,
2060ES, 2075ES, 2085, and 2105 printers

These printer models support a variety of data streams and provide a wide range
of finishing options. Depending upon how you plan to use these printers, you
configure them in two different ways:
1. To use Send and Save functions.
2. To use the Bookletmaker (see “Configuring as TCP/IP printers to use Booklet

Maker” on page 19).

Using Send and Save functions

If you define these printer models as either AIX or PSF Other actual destinations,
you can take advantage of the Send and Save options to enhance printer
throughput.

To pass data streams through InfoPrint Manager to the printer without
transforming them, complete these steps:
1. From the main window of the InfoPrint Manager Administration GUI, select

Printer → Create → AIX or PSF Other destinations.
2. Fill in the necessary fields in the Create Printer Wizard to create an actual

destination for these printers. See ″Creating and managing actual destinations″
in InfoPrint Manager for AIX: Getting Started for detailed instructions.

Note: You must install the pioibmdpm backend that comes with these printers
in order to ensure accurate job accounting. When the Create Printer Wizard
prompts you for a Printer Command, you can specify one similar to this for the
InfoPrint 2105ES Printer:

/usr/lib/lpd/pio/etc/pioibmdpm 9.99.99.51

where 9.99.99.51 is the printer’s IP address. The port for the pioibmdpm
backend defaults to 2501 and does not have to be specified.

3. If you have created a PSF Other destination, select Printer → Properties.
4. Select the Documents tab and make sure that the Formats to RIP at

destination field is set to pass PostScript or PCL data streams.

Using Send and Save in InfoPrint Manager
This section describes how you can specify Send and Save functions from the
command line and how account information is gathered when Send and Save is
active.

Note: If jobs that contain requests for function specific to these printers, such as
Send and Save function, are sent to printers other than these models, the function
will not be honored. In addition, jobs that are transformed by InfoPrint Manager
will not contain the function.

Invoking Send and Save from the command line:
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If you are sending a job to a printer that supports Send and Save functions (and it
is not already specified in the data stream), you can specify it from the command
line. Send and Save is invoked by using the -S flag and you can select from these
options:
v 0 Print now (Default)

v 1 Print one copy and hold job

v 2 Hold job until you enter PIN

Ensure that you set your Personal Identification Number (PIN) by specifying -S2
-ynnnn. The PIN is the number you need to enter on your printer’s Saved Jobs
menu to release the document for printing. If you do not fill in the nnnn with
your PIN, the printer forces this number to 0000.

v 3 Print later

v 4 Print now and save

v 5 Save

v 6 Print Now and Archive to Document Server

v 7 Archive to Document Server (without a PIN)
v 7 Archive to Document Server (with a PIN)

Ensure that you set your PIN by specifying -S7 -ynnnn. The PIN is the number
you need to enter on your printer’s Saved Jobs menu to release the document
for printing. If you do not fill in the nnnn with your PIN, the printer forces this
number to 0000.

Notes:

1. If the -S flag is not set to anything other than either option 2 or 7, the printer
ignores the PIN (-y ) number.

2. Options 6 and 7 are not available with InfoPrint 2085 and InfoPrint 2105.

For example, if you are submitting to an AIX actual destination and you want your
printer to print one copy of job1 and save it, enter this command:

pdpr -d ldname -x "destination-pass-through='-S4'" job1

where ldname is the name of the logical destination associated with your InfoPrint
2090ES, 2105ES, 2060ES, 2075ES, 2085, or 2105 actual destination in InfoPrint
Manager.

If you are submitting to a PSF-Other actual destination, you must put a "-BE"
value in the destination-pass-through attribute in front of the -S flag for the Send
and Save commands to work correctly. For example, if you want your PSF-Other
actual destination printer to print one copy of job1 and save it, enter this
command:

pdpr -d ldname -x "destination-pass-through='-BE -S4'" job1

where ldname is the name of the logical destination associated with your printer.

If you are submitting to an AIX actual destination and you want your InfoPrint
2090ES printer to hold your job until you enter a PIN, enter this command:

pdpr -d ldname -x "destination-pass-through='-S2 -ynnnn'" job1

where nnnn is your four-digit PIN.
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Logging accounting information:

The wait-for-job-completion attribute (Report job completed when printed label
on the InfoPrint Manager Administration GUI) indicates whether InfoPrint
Manager for AIX:
v Waits for the job to print completely before reporting the job as completed (Yes).
v Reports the job as completed as soon as all the data has been sent to the printer

(No).

If this attribute is set to No, InfoPrint Manager will log the number of pages
submitted, regardless of whether they printed or not.

If the wait-for-job-completion attribute is set to Yes and you are using Send and
Save options 1 through 5 or 7, 0 pages will be logged as having printed, regardless
of whether they print or not. If you are using the 0 Print now (Default) option or
the 6 Print Now and Archive to Document Server option, InfoPrint Manager will
log the actual number of pages printed.

To change this attribute from the InfoPrint Manager Administration GUI:
1. Select Printer → Properties.
2. Select the Job tab.
3. If the Report job completed when printed radio button does not appear at the

bottom of the window, click Show more.

Troubleshooting

If an AIX DSS printer is not waiting long enough to show a successfully-printed
job in the Job Management Information Base (MIB), you can configure settings on
the actual destination so it does not time out. First, make sure that the
wait-for-job-completion attribute (Report job completed when printed field on
the Job tab of the Printer Properties notebook) is set to Yes. Then, you can use the
following procedure to set wait-for-job-completion-snmp-timeout (Report job
completed when printed timeout (sec) field on SNMP tab of the Printer Properties
notebook) so that it will not time out as quickly.
1. From the main window of the InfoPrint Manager Administration GUI, select

the InfoPrint 2090ES, InfoPrint 2105ES, InfoPrint 2060ES, InfoPrint 2075ES,
InfoPrint 2085, or InfoPrint 2105 actual destination.

2. Click Printer → Properties.
3. Click the SNMP tab.
4. Enter a higher value in the Report job completed when printed timeout (sec)

field.
5. Click OK or Apply.

Note: Increasing this value will increase the amount of time it takes to report that
a job has failed. If you decrease this value, you might get false failures.

Configuring as TCP/IP printers to use Booklet Maker
If you are interested in using the Booklet Maker function, you must configure these
printers as PSF TCP/IP printers.

To pass data streams through InfoPrint Manager to the printer without
transforming them, complete these steps:
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1. From the main window of the InfoPrint Manager Administration GUI, select
Printer → Create → PSF → TCP/IP.

2. Fill in the necessary fields in the Create Printer Wizard to create an actual
destination for these printers. See ″Creating and managing actual destinations″
in InfoPrint Manager for AIX: Getting Started for detailed instructions.

Booklet Maker
If you have either an InfoPrint 2090ES, InfoPrint 2060ES, or InfoPrint 2075ES, you
can use the Booklet Maker feature to use the fold-in-and-staple finishing function.
Booklet Maker supports jobs that are a maximum of 15 pages in length.

When installed, the Booklet Maker feature is in output bin 3, which is called the
Shift Tray Lower. InfoPrint Manager selects Booklet Maker for a job only when the
job specifies:
1. center-stitch

2. Output bin 3

Note: If you specify output bin 3, but do not specify center-stitch, pages will be
routed to output bin 3 but booklets will not be created.

For more information about specifying the Booklet Maker bin for either PostScript,
PCL, or AFP jobs, see your printer documentation.

Configuring InfoPrint Manager to use the InfoPrint 2190, InfoPrint 2210,
and InfoPrint 2235

These printer models support a variety of data streams and provide a wide range
of finishing options. Depending upon how you plan to use these printers, you
configure them in two different ways:
1. To use Send and Save functions.
2. To use the Booklet Maker (see “Booklet Maker” on page 23).

Using Send and Save functions on the Infoprint 2190, Infoprint
2210, and Infoprint 2235

If you define these printer models as either AIX or PSF Other actual destinations,
you can take advantage of the Send and Save options to enhance printer
throughput.

To pass data streams through InfoPrint Manager to the printer without
transforming them, complete these steps:
1. From the main window of the InfoPrint Manager Administration GUI, select

Printer → Create → AIX or PSF Other destinations.
2. Fill in the necessary fields in the Create Printer Wizard to create an actual

destination for these printers. See ″Creating and managing actual destinations″
in InfoPrint Manager for AIX: Getting Started for detailed instructions.

Note: You must install the pioipdm backend that comes with these printers to
ensure accurate job accounting. When the Create Printer Wizard prompts you
for a Printer Command, you can specify one similar to this for the Infoprint®

2190 printer:

/usr/lib/lpd/pio/etc/pioipdm 9.99.99.51
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where 9.99.99.51 is the printer’s IP address. The port for the pioipdm backend
defaults to 9100 and does not have to be specified.

3. If you have created a PSF Other destination, select Printer → Properties.
4. Select the Documents tab and make sure that the Formats to RIP at

destination field is set to pass PostScript or PCL data streams.
5. Select the Auxiliary/Separator sheets tab and set the Start Sheet value to none

for the printer-start-sheet actual destination attribute.

Using Send and Save in InfoPrint Manager
This section describes how you can specify Send and Save functions from the
command line and how account information is gathered when Send and Save is
active.

Note: If jobs that contain requests for function specific to these printers, such as
Send and Save function, are sent to printers other than these models, the function
will not be honored. In addition, jobs that are transformed by InfoPrint Manager
will not contain the function.

Invoking Send and Save from the command line:

If you are sending a job to a printer that supports Send and Save functions (and it
is not already specified in the data stream), you can specify it from the command
line. Send and Save is invoked by using the -S flag and you can select from these
options:

Table 2. -S flag options

Option Job Type Description

0 Normal Print [default] Prints the job immediately.

1 Sample Print Prints one copy of job and saves the
job in the Sample Print Job list.

2 Locked Print Holds the job until you enter your
PIN.

Ensure that you set your Personal
Identification Number (PIN) by
specifying -S2 -ynnnn. The PIN is the
number you need to enter on your
printer’s Saved Jobs menu to release
the document for printing. If you do
not fill in the nnnn with your PIN, the
printer forces this number to 0000.

3 Hold Print Saves the job in the Hold Print Job list
for printing later.

4 Stored Print Saves the job in the Stored Print Job
list.

5 Store and Print Prints and saves the job in the Stored
Print Job list.

6 Documents Server Saves the job on the printer Document
Server

Note: If the -S flag is not set to anything other than option 2, the printer ignores
the PIN (-y ) number.
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For example, if you are submitting to an AIX actual destination and you want your
printer to print one copy of job1 then save it, enter this command:

pdpr -d ldname -x "destination-pass-through='-S5'" job1

where ldname is the name of the logical destination associated with your InfoPrint
2190, 2210, or 2235 actual destination in InfoPrint Manager.

If you are submitting to a PSF-Other actual destination, you must put a "-BE"
value in the destination-pass-through attribute in front of the -S flag for the Send
and Save commands to work correctly. For example, if you want your PSF-Other
actual destination printer to print one copy of job1 and save it, enter this
command:

pdpr -d ldname -x "destination-pass-through='-BE -S5'" job1

where ldname is the name of the logical destination associated with your printer.

If you are submitting to an AIX actual destination and you want your InfoPrint
2190, 2210, or 2235 printer to hold your job until you enter a PIN, enter this
command:

pdpr -d ldname -x "destination-pass-through='-S2 -ynnnn'" job1

where nnnn is your four-digit PIN.

Logging accounting information:

The wait-for-job-completion attribute (Report job completed when printed label
on the InfoPrint Manager Administration GUI) indicates whether InfoPrint
Manager for AIX:
v Waits for the job to print completely before reporting the job as completed (Yes).
v Reports the job as completed as soon as all the data has been sent to the printer

(No).

If this attribute is set to No, InfoPrint Manager will log the number of pages
submitted, regardless of whether they printed or not.

If the wait-for-job-completion attribute is set to Yes and you are using Send and
Save options 1 through 6, 0 pages will be logged as having printed, regardless of
whether they print or not. If you are using either the 0 Normal Print(Default)
option, InfoPrint Manager will log the actual number of pages printed.

To change this attribute from the InfoPrint Manager Administration GUI:
1. Select Printer → Properties.
2. Select the Job tab.
3. If the Report job completed when printed radio button does not appear at the

bottom of the window, click Show more.

Troubleshooting

If an AIX DSS printer is not waiting long enough to show a successfully-printed
job in the Job Management Information Base (MIB), you can configure settings on
the actual destination so it does not time out. First, make sure that the
wait-for-job-completion attribute (Report job completed when printed field on
the Job tab of the Printer Properties notebook) is set to Yes. Then, you can use this
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procedure to set wait-for-job-completion-snmp-timeout (Report job completed
when printed timeout (sec) field on SNMP tab of the Printer Properties notebook)
so that it will not time out as quickly.
1. From the main window of the InfoPrint Manager Administration GUI, select

the InfoPrint 2190, InfoPrint 2210, or InfoPrint 2235 actual destination.
2. Click Printer → Properties.
3. Click the SNMP tab.
4. Enter a higher value in the Report job completed when printed timeout (sec)

field.
5. Click OK or Apply.

Note: Increasing this value will increase the amount of time it takes to report that
a job has failed. If you decrease this value, you might get false failures.

Configuring as TCP/IP printers to use Booklet Maker
If you are interested in using the Booklet Maker function, you must configure these
printers as PSF TCP/IP printers:

Booklet Maker
If you have an Infoprint 2190, Infoprint 2210, or Infoprint 2235, you can use the
Booklet Maker feature to use the fold-in-and-staple finishing function. Booklet
Maker supports jobs that are a maximum of 15 pages in length.

When installed, the Booklet Maker feature is in output bin 3, which is called the
Shift Tray Lower. InfoPrint Manager selects Booklet Maker for a job only when the
job specifies:
1. center-stitch

2. Output bin 3

Note: If you specify output bin 3, but do not specify center-stitch, pages will be
routed to output bin 3 but booklets will not be created.

For more information about specifying the Booklet Maker bin for either PostScript,
PCL, or AFP jobs, see your printer documentation.

Configuring InfoPrint Manager to use the InfoPrint 4000 and 4100

Perform this procedure with the help of your InfoPrint service representative to
make sure that the actual destination, the InfoPrint 4000 or InfoPrint 4100 printer,
and the cutter-trimmer-stacker (CTS) (a post-processing device used for paper
handling) all support the same media types.
1. Use the procedure in ″Associating a medium with an actual destination″ from

the InfoPrint Manager for AIX: Procedures to specify the media that the actual
destination representing the InfoPrint 4000 or 4100 supports.

2. On the printer, define forms that correspond to the media you specified in step
1, for example:

Medium Object Name Printer_Form Name Printing_Form Description

letter na letter 2-Up letter (8.5 by 11)

legal na legal 2-Up legal (8.5 by 14)

ledger ledger 1-Up (11 by 17)
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3. Set up the CTS for the dimensions required by the supported media. For
example, to support ledger-size paper, set up the CTS for an 11-inch cut width
and a 14-inch cut length. CTS can support a limited set of cut lengths and only
one center slitting option.

Displaying the InfoPrint Manager Operations GUI from the
Enhanced Operator Console

You can display the InfoPrint Manager Operations GUI from either the InfoPrint
4000 or InfoPrint 4100 Enhanced Operator Console by ordering and installing
Feature Code 4560 (Part Number 54P1446) with your printer. For information
about installing this feature on your printer, contact your InfoPrint Solutions
service representative.

To configure this support from your InfoPrint Manager AIX server, you must make
sure that the remote execution daemon (rexecd) process is running on the server.

Also, you must update the /etc/hosts file to include the printer’s IP address. To do
this task, follow these steps::
1. Edit the /etc/hosts file with your AIX editor of choice.
2. Insert the printer’s IP address in a line as shown below:

xx.xx.xx.xx printer # ethernet name/address

where xx.xx.xx.xx is the IP address of the printer control unit that is to display
the InfoPrint Manager Operations GUI, and printer is a printer host name that
is unique to your network.

Note: If you have multiple Enhanced Operator Consoles that can display the
InfoPrint Manager Operations GUI, the /etc/hosts file must contain the IP
address for each printer control unit.

Using the correct halftones for the installed toner version

Multiple versions of toner are available for the InfoPrint 4000 and InfoPrint 4100
printers. For some printer models, InfoPrint Manager ships different halftone
curves for different toners, and provides scripts to replace or install the correct
ones. Make sure you have the correct halftone installed for your toner to achieve
the best print quality.

The toner characteristics can require changes in the halftone resources. When the
toner in the printer is replaced with a different version of toner, you must run the
associated AIX script from the command line.

Notes:

v When you apply InfoPrint Manager PTFs, the appropriate AIX script must be
run again, because the PTF replaces the existing halftone files with the standard
halftone files.

v Some versions of toner do not require different halftones. Therefore, an AIX
script might not be available.

These scripts are located in /usr/lpp/psf/config:
v IP4000-ID5-6.Std
v IP4000-ID5-6.V2toner
v IP4000-ID5-6.V3toner
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v IP4000-IR1-2.Std
v IP4000-IR1-2.V2toner
v IP4000-IR1-2.V3toner
v IP4000-IR3-4.Std
v IP4000-IR3-4.V2toner
v IP4000-IR3-4.V3toner
v IP4100-HD3-HD4.RTtoner
v IP4100-HD3-HD4.Stdtoner
v IP4100-HD3-HD4.V3toner
v IP4100-HD3-HD4.V5toner
v IP4100-MD1-2.Stdtoner
v IP4100-MD1-2.V2toner
v IP4100-MD1-2.V2_PQItoner
v IP4100-HD5-HD6.Stdtoner
v IP4100-HD5-HD6.V7toner
v IP4100-PD1-2.Std
v IP4100-PD1-2V3toner

Each script file changes the InfoPrint Manager system to use the relevant toner; Std
or Stdtoner is the default.

Limitations of actual screen frequencies and angles on
InfoPrint 4000 and 4100 printers

If you change the version of toner used with your printer, you should recalibrate
all customized calibration curves to make sure that they print correctly. The screen
frequencies shown in this section presume the use of a 600 dots per inch (DPI)
printer. Frequencies at other DPI® are proportionally lower. For example, an 85
lines per inch (LPI) screen used on a 300 DPI printer will be 43 LPI. Screen
frequencies match the requested screen frequency as closely as possible, based on
constraints of the halftone design.

For the actual screen frequencies and angles for both InfoPrint 4000 and InfoPrint
4100 printers, see Table 3, Table 4, and Table 5 on page 26.

Table 3. Screen Frequencies for InfoPrint 4000 IR3/IR4 and ID5/ID6 and InfoPrint 4100
HD3/HD4 and HS2 printers with Version 3 Toner

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 74 85 96 117

Actual Screen Angle (Default °
Set)

35.5° 45° 51.3 ° 59°

Actual Screen Angle (90° Set) 54.5° 45° 38.7° 31°

Table 4. Screen Frequencies for InfoPrint 4000 IR3/IR4 and ID5/ID6 and InfoPrint 4100
HD1/HD2, HD5/HD6, PD1/PD2, HS1, HS3, and PS1 printers with Version 2 (enhanced
printing toner) or Standard Toner

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 71 85 103 141

Actual Screen Angle 45° 45° 31° 45°

Chapter 2. Installing and configuring printer devices and related hardware 25

|

|



Table 5. Screen Frequencies for InfoPrint 4000 IR1/IR2 Printers with Version 2, 3, or
Standard Toner

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 71 83 106 141

Actual Screen Angle 45° 34° 45° 45°

Configuring InfoPrint Manager to use the Infoprint Workgroup Printers
(15xx, 16xx, 17xx, 18xx and future models)

These printer models support a variety of data streams and provide a wide range
of finishing options. Depending upon how you plan to use these printers, you
configure them in two different ways:
1. To use Print-and-Hold functions.
2. To use the Booklet Maker (see “Booklet Maker” on page 29).

Using Print-and-Hold functions on the InfoPrint Workgroup
Printers (15xx, 16xx, 17xx, 18xx and future models)

If you define these printer models as either AIX or PSF Other actual destinations,
you can take advantage of the Print and Hold functions to enhance printer
throughput.

To pass data streams through InfoPrint Manager to the printer without
transforming them, complete these steps:
1. From the main window of the InfoPrint Manager Administration GUI, select

Printer → Create → AIX or PSF Other destinations.
2. Fill in the necessary fields in the Create Printer Wizard to create an actual

destination for these printers. Refer to “Creating and managing actual
destinations” in InfoPrint Manager for AIX: Getting Started for detailed
instructions. When the Create Printer Wizard prompts you for a Printer
Command, you can specify one similar to this for the InfoPrint Workgroup
Printer:
/usr/lib/lpd/pio/etc/pioinfo 9.99.99.51

where 9.99.99.51 is the printer’s IP address. The port for the pioinfo backend
defaults to 9100 and does not have to be specified.

3. If you have created a PSF Other actual destination, select Printer → Properties.
Select the Documents tab and make sure that the Formats to RIP at destination
field is set to pass PostScript or PCL data streams.

Using Print and Hold in InfoPrint Workgroup Printers (15xx, 16xx,
17xx, 18xx and future models)
This section describes how you can specify Print and Hold functionality from the
command line and how account information is gathered when Print and Hold is
active.

Note: If jobs that contain requests for function specific to these printers, such as
Print and Hold function, are sent to printers other than these models, the function
is not honored. In addition, jobs that are transformed by InfoPrint Manager do not
contain the function.
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Invoking Print and Hold from the command line:

If you are sending a job to a workgroup printer that supports Print and Hold
functionality (and it is not already specified in the data stream), you can specify it
from the command line. You invoke the Print and Hold function by using the –U
flag and you can choose from the following options:

Table 6. -U flag options

Option Job type Description

1 Off Prints the job immediately.

2 Print and
Hold

Holds the job until you enter your PIN. Make sure that you set
your Personal Identification Number (PIN) by specifying -U2
-Vnnnn. The PIN is the number you need to enter on your printer’s
Held Jobs menu to release the document for printing. If you do not
fill in the nnnn with your PIN, the printer forces this number to
0000.

3 Verify Print Prints one copy and holds the remaining copies.

4 Repeat Print Prints all copies and stores the job.

5 Reserve
Print

Stores the job in memory.

Note:

1. The flags and values available for a specific printer might vary. Refer to the
Readme file of the printer colon file or the driver package to find the proper
flags and values.

2. If the -U flag is not set to anything other than option 2, the printer ignores the
PIN (-V) number.

For example, if you are printing to an AIX actual destination and you want that
printer to print one copy of job1 and then hold the remaining copies, enter the
following command:

pdpr -d ldname -x "destination-pass-through='-U3'" job1

where ldname is the name of the logical destination associated with your InfoPrint
workgroup actual destination in InfoPrint Manager.

If you are printing to a PSF Other actual destination, place a -BE value in the
destination-pass-through attribute in front of the -U flag in order for the Print and
Hold commands to work correctly. For example, if you want your PSF Other
actual destination printer to print one copy of job1 and then hold the remaining
copies, enter the following command:

pdpr -d ldname -x "destination-pass-through='-BE -U3'" job1

where ldname is the name of the logical destination associated with your printer.

If you are printing to an AIX actual destination and you want your InfoPrint
workgroup printer to hold your job until you enter a PIN, enter the following
command:

pdpr -d ldname -x "destination-pass-through='-U2 -Vnnnn'" job1
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where nnnn is your four-digit PIN.

Logging accounting information:

The wait-for-job-completion attribute (Report job completed when printed label on
the InfoPrint Manager Administration GUI) indicates whether InfoPrint Manager
for AIX:
v Waits for the job to print completely before reporting the job as completed (Yes).
v Reports the job as completed as soon as all the data has been sent to the printer

(No).

If the wait-for-job-completion attribute is set to Yes and you are not using the
Print and Hold options 2 through 5, InfoPrint Manager logs the actual number of
pages printed in the accounting log. If you are using the Print and Hold options 2
through 5 or the wait-for-job-completion attribute is set to No, InfoPrint Manager
logs the value from the job-page-count attribute, whether user specified or server
determined. InfoPrint Manager attempts to determine the number of pages by
examining the data stream. When you do not specify a value and the server does
not determine the page count, InfoPrint Manager logs 0 pages.

Note: If the wait-for-job-completion attribute is set to Yes and the Print and Hold
feature is requested, InfoPrint Manager does not require the backend to wait for
the job and reports it as completed as soon as all data has been sent to the printer.

To change this attribute from the InfoPrint Manager Administration GUI:
1. Select Printer → Properties.
2. Select the Job tab.
3. If the Report job completed when printed radio button does not appear at the

bottom of the window, click Show more.

Troubleshooting

If an AIX DSS printer is not waiting long enough to show a successfully-printed
job in the Job Management Information Base (MIB), you can configure settings on
the actual destination so it does not time out. First, make sure that the
wait-for-job-completion attribute (Report job completed when printed field on
the Job tab of the Printer Properties notebook) is set to Yes. Then, you can use this
procedure to set wait-for-job-completion-snmp-timeout (Report job completed
when printed timeout (sec) field on SNMP tab of the Printer Properties notebook)
so that it will not time out as quickly.
1. From the main window of the InfoPrint Manager Administration GUI, select

the Infoprint Workgroup printer actual destination.
2. Click Printer → Properties.
3. Click the SNMP tab.
4. Enter a higher value in the Report job completed when printed timeout (sec)

field.
5. Click OK or Apply.

Note: Increasing this value will increase the amount of time it takes to report that
a job has failed. If you decrease this value, you might get false failures.
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Configuring as TCP/IP printers to use Booklet Maker
If you are interested in using the Booklet Maker function, you must configure these
printers as PSF TCP/IP printers:

Booklet Maker
If you have an Infoprint Workgroup Printer (15xx, 16xx, 17xx, 18xx and future
models), you can use the Booklet Maker feature to use the fold-in-and-staple
finishing function. Booklet Maker supports jobs that are a maximum of 15 pages in
length.

When installed, the Booklet Maker feature is in output bin 3, which is called the
Shift Tray Lower. InfoPrint Manager selects Booklet Maker for a job only when the
job specifies:
1. center-stitch

2. Output bin 3

Note: If you specify output bin 3, but do not specify center-stitch, pages will be
routed to output bin 3 but booklets will not be created.

For more information about specifying the Booklet Maker bin for either PostScript,
PCL, or AFP jobs, see your printer documentation.

Configuring the Halftone Management System
The Print on Demand feature offers the Halftone Management System (HMS). The
HMS supports printer calibration on devices such as the InfoPrint 20 and the
InfoPrint 4000 series. The Halftone Management System gives you the ability to
calibrate halftones for each screen frequency on most Intelligent Printer Data
Stream™ (IPDS) printers. The result is consistent grayscale for each appearance
selection. For a complete list of supported printers, see the calibd.src file located in
the /usr/lpp/pd/ipcal/server directory.

With the Halftone Management System, you can run multiple InfoPrint 4000 and
4100 printers and calibrate each system. For two-engine duplex print systems, the
Halftone Management System also lets you calibrate each print engine separately,
so that whatever document you print , the various levels of gray (grayscale) used
to print the document will look the same on both engines. Note that this applies to
input file types of TIFF, GIF, JPEG, PostScript, and Portable Document Format
(PDF).

From the smallest network printer to the largest production printer, you can either
use the halftone provided with InfoPrint Manager or create your own. You can
calibrate for different paper types to account for differences between supplies.
InfoPrint Manager will save and manage these calibrations, allowing you to select
them on a job-by-job basis.

The Halftone Management System consists of two parts that are only installed with
the Print-on-Demand feature:
1. A client process that can be run from any InfoPrint for AIX server.
2. A server process that runs on all InfoPrint for AIX servers.

You can calibrate printers on any InfoPrint AIX server by using the client from
another InfoPrint AIX server. For example, if you have installed InfoPrint servers
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A, B and C, you can calibrate printers on A using the client on either A, B or C.
The daemon must be running on server A.

This topic describes the procedures that you should make sure have been
completed before trying to use the Halftone Management System:
1. “Starting the Halftone Management System server”
2. “Starting the Halftone Management System client”
3. “Calibrating a densitometer”

Starting the Halftone Management System server

The Halftone Management System server must be started from the command line:
1. Navigate to /usr/lpp/pd/ipcal/bin.
2. Enter ./runcalibd& to initiate the server-starting script.
3. You can make sure that your Halftone Management System server is running

by entering:
ps -ef | grep server

You should see a response that shows the server running. For example:

root 23830 20954 0 Oct 22 pts/0 0:43 java calibd /usr/lpp/pd/ipcal/server/calibd.src /usr/lpp/pd/
ipcal/server/calibd.msg trace.log /usr/lpp/pd/ipcal/bin

Note: The server must be running before you start the Halftone Management
System client.

Starting the Halftone Management System client

On the front panel, open the extended menu above the InfoPrint icon, and click
Start Calibration GUI .

You can also start the Halftone Management System client from the command line:
1. Enter: ./usr/lpp/pd/ipcal/bin/runcalib&

From the client screen, a pop-up Halftone Management System window
announces Starting the Halftone Management System Client.

If you invoke the Halftone Management System client before starting the
Halftone Management System server, InfoPrint Manager displays an error
pop-up message:
Error in connecting to host fully_qualified_server_name -- A remote host
refused an attempted connect operation.

To resolve this problem, you must close the Halftone Management System
client window and restart the client after you start the Halftone Management
System server.

2. Once you have completed these steps, see “Defining InfoPrint servers to the
Halftone Management System client” on page 32.

Calibrating a densitometer

The reflection densitometer must be calibrated to provide accurate density
readings. Prior to using, you must follow the instructions that are provided by the
manufacturer to calibrate the densitometer. The densitometer used must comply to
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the spectral responses defined by ANSI PH2.18 - 1985 and ISO 5/3 - 1984. The
densitometer should not have a polarizing filter. The Greytag Macbeth model
D19C has a polarizing filter and should not be used. Densitometers which are
appropriate to use include the X-Rite Model 504, 508, or 400B.

The densitometer should be used in Absolute Density mode for measurements.
The following procedure describes how to calibrate the X-RITE 400B (1060)
densitometer, using the Reflection Reference Card (part number 400-62). Since the
X-RITE 400B is now obsolete, the following information is provided as reference.

You use the Reflection Reference card to calibrate the densitometer. You will use
only the circular patches labeled 1 (white reference) and 3 (black reference). The
densitometer should be calibrated periodically, or whenever the instrument
displays RECAL. You should store the Reflection Reference Card in its envelope.
1. Press the FUNCTION and ENTER keys in sequence, then release.

After the version and copyright notices appear, the display will show N cal O
Y.

2. Press the ZERO key and release.
After the version and copyright notices appear, the display will show N qcal Y.

3. Press the FUNCTION key and release.
SET LO is displayed momentarily, followed by X.XX, where X.XX should be the
white patch ORTHO value from the Reflection Reference card.

4. If X.XX matches the white patch ORTHO value for your reflection reference,
press the ENTER key. If X.XX does not match, hold down the ZERO key and
press either the FUNCTION or the ENTER key. Decrease (FUNCTION) or
increase (ENTER) the value until the correct number is displayed. When
finished, release the keys and press Enter.
SET HI is displayed momentarily, followed by Y.YYH , where the Y.YY part of
the value should be the black patch ORTHO value from the Reflection
Reference card.

5. If Y.YY matches the black patch ORTHO value for your reflection reference,
press the ENTER key. If Y.YY does not match, hold down the ZERO key and
press either the FUNCTION or the ENTER key. Decrease (FUNCTION) or
increase (ENTER) the value until the correct number is displayed. When
finished, release the keys and press Enter.

6. When you see READ WHT displayed, center the circle on the base of the
densitometer over the white patch (the one labeled ″1″) on the Reflection
Reference. Push the head down and then release it to establish the white patch
Optical Density.
If INVALID displays, repeat the measurement.

7. When you see READ BLK displayed, center the circle on the base of the
densitometer over the white patch (the one labeled ″3″) on the Reflection
Reference. Push the head down and then release it to establish the black patch
Optical Density.
If INVALID displays, repeat the measurement.

Verify the calibration by measuring the black, gray, and white patches. If they
agree in 0.02 OD to the reflection reference values on the card, density is accurately
calibrated. If not, repeat this process until the measurements are accurate.

To find out how you can calibrate and set output appearances, see “Calibrating a
printer using the Halftone Management System” on page 32.
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Calibrating a printer using the Halftone Management System
The Halftone Management System lets you calibrate each of your printers to
achieve a consistent tone curve for a set of generic halftone screens. The system
also lets you define additional calibrations for specific paper types. When
calibrated the dot gain for a fifty percent dot will be nominally zero percent for
Standard appearance, fourteen percent for Highlight Midtone appearance, and
thirty-four percent for Dark appearance.

To use this tool to calibrate your printers, do these procedures in sequence:
1. “Defining InfoPrint servers to the Halftone Management System client”
2. “Defining custom patch sets”
3. “Calibrating a halftone” on page 33
4. “Measuring optical density with a densitometer” on page 34

Defining InfoPrint servers to the Halftone Management System
client

The first time you start the Halftone Management System client, you will see an
empty window. You must connect to the InfoPrint AIX server to see a list of the
printers that are available for calibration:
1. From the Halftone Management System (or Main) window, select the Edit →

Servers option.
2. From the Servers window, select the File → Add Server option.
3. In the Server Properties window, fill in the Server Name field with the

symbolic server name, and the Hostname field with either the explicit name of
the server or the server’s dotted decimal notation IP address.
For example, the Server Name field value could be sage, while the Hostname
field value could be either sage.infoprint.com or 9.99.43.73 .

4. Return to the Main window and either use left mouse button to double-click
on each printer or highlight the printer and press enter to display its output
screens (as displayed below). The Main window displays all printers defined to
the InfoPrint server to which you are connected, but only the IPDS printers
contain screens that can be calibrated.

Defining custom patch sets

A patch set is a step wedge file that has patches with different shades of gray. One
patch set has been defined (patches11 ). It has eleven uniformly-stepped grays.

To define additional patch sets, use this procedure:
1. From the Halftone Management System window, select the Edit → Patch Sets

option.
2. From the Patch Sets window, click a patch set (such as patches11) and select

the Edit → Properties option.
3. From the Patch Set name window (where name indicates the patch set

highlighted in the previous step), use the left mouse button to select the
patches that you would like to modify.
The screen shows 99 squares representing from 1-to-99 percent dot at one
percent increments. Squares which are dark will be printed. To change a patch
selection, point to the patch desired and click the left mouse button. Each click
selects or deselects a patch. 0 percent and 100 percent dot patches are always
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included in each patch set. The example displayed below will print 0, 10, 20,
30, 40, 50, 60, 70, 80, 90, and 100 percent dot patches.

4. Once you have defined the patch set, select the File → Save as option and save
your patch set with a unique name.
The shipped patch set patches11 cannot be modified. However, a user-created
patch set can be modified through the Saveoption. In the example below, the
Save option is grayed-out because no changes have been made to the file.

Calibrating a halftone

Once you have either selected an existing patch set or created your own
customized patch set, you must print it out, use a densitometer to measure the
density of each gray patch. Then you must enter the calibration values in the
Halftone Calibration Management System to create a calibration curve for the
printer.

Note: Ensure that you use the Halftone Management System to both add and
delete patch files and Calibration files.

Use this procedure to accomplish these tasks:
1. If desired, define a custom patch set to print from the Halftone Management

System window from the menu bar by selecting EDIT → PATCH SETS, then
selecting the patch from the list and ACTIONS → SELECT AS CURRENT,
FILE → CLOSE.

2. From the Halftone Management System window, select a printer and a
halftone screen supported by that printer.

3. From the Halftone Management System window, select the Actions → Print
Patches option.

4. If the actual destination you chose has a logical-destination-assigned
attribute, the patch set will be sent to that logical printer. Otherwise, you will
be prompted for a logical printer.

5. From the pop-up window, click OK.
6. Once you retrieve your output from the printer, use the densitometer to

measure the patches. Because the Halftone Management System is designed to
take multiple measurements of each patch and use the average, you could
take three measurements of each patch.

7. Select the same actual destination (printer) and screen that you selected before
you printed the patch set.
The printed patch set identifies the screen, patch set, and printer, along with a
date/time stamp.

8. From the Halftone Management System window, select the Actions →
Calibrate option.

9. From the Enter calibration values window (shown below), set The number of
entries to average field (it defaults to 3) to the number of measurements you
took for each patch.

10. If this is a custom calibration and you want it to replace the default calibration
provided by InfoPrint Manager, allow it to retain the default value in the
Calibration name field. If you want to retain the original default, but have
this custom calibration as a second option, type a name for the calibration in
the Calibration name field.

11. To enter your densitometer readings, begin with the 0% field. Enter your first
0% value and press Enter. The statistics of your values will be displayed
under the columns Average, Min, and Max.
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If you specified more than 1 in the number of entries to average field, the
cursor will remain in the field for your next reading. Otherwise, it will move
on to the next patch field. Continue until all your readings have been entered.
The display below shows a sample customized Calibration named first_run.

12. Once you have filled in your calibration values, press the OK button. Your
calibration is saved in the /usr/lpp/psf/config/custom directory and ready for
use.

Measuring optical density with a densitometer

This procedure describes how you can measure optical density using the XRITE
400B Densitometer. While you can use other densitometers, this procedure has
been verified with this particular make and model. Ensure that the density
readings are absolute, not paper reference.
1. Press the FUNCTION key until DEN appears. If DEN-R appears, press the

ZERO key and try again.
2. Center the circle on the base of the densitometer over the area to be measured.
3. Push the head down and release it to measure the Optical Density (OD).

The density reading will appear as X.XXD.
4. Record the X.XX value as it is displayed.

Several measurements should be taken at different representative locations on
each gray patch and averaged to obtain an accurate OD value. Alternately, you
can enter individual measurements into the calibration value screen and have
the averaging done automatically.

Specifying a halftone for printing on the InfoPrint AIX server

You can use a particular halftone for printing a grayscale file through either
InfoPrint Submit Express interface or the AIX command line.

Note: The Halftone Management System does not need to be running when you
print the job.

Printing from InfoPrint Submit Express

You can print using a particular halftone for printing a grayscale file from a job
ticket (name.jtk file) in InfoPrint Submit Express. Begin by selecting a value in the
Halftone field of the Look tab. Note that all halftones shipped with the product
have the term ’ibm’ prepended to their identifier. If you are accessing this interface
for the first time, all of your previous default calibrations will have ’ibm’ attached
to the name.

InfoPrint Manager lets you determine output appearance on a job-by-job basis by
setting a default halftone in a default document or job object.

Note: InfoPrint Submit Express is part of the InfoPrint Manager Print-on-Demand
feature.

Printing from the AIX command line

You can submit a halftone calibration from the AIX command line by using some
variation of the pdpr command:
pdpr -p sip20-sage -x halftone=ibm106lpi:highlight-midtones grayscale.ps
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where the -x value is the customized calibration file and grayscale.ps is the file to
be printed.

Note: When submitting a pdpr command from the AIX command line, you can
specify the halftone attribute. The actual halftone name for this example
(ibm106lpi:highlight-midtones) can be found either by using the InfoPrint
Manager Administration Interface to look up the halftones supported for the
actual destination, or enter this at the command line: pdls -cp -r
halftones-supported ActualDestination name.
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Chapter 3. Working with SNMP printers

About SNMP communication
For network printers that work with Simple Network Management Protocol
(SNMP) and the standard printer management information block (MIB) RFC 1759,
the InfoPrint Manager server can use SNMP to automatically:
v Set the default of several InfoPrint Manager actual destination attributes in the

printer to the values returned in the standard printer MIB. The actual
destination attributes pertain to trays, media, bins, plexes, and sides. This
process is called smart–defaulting the attributes.

v Detect, report, and recover from printer problems for several conditions, even if
no jobs are currently being printed.

v Assess device specific information directly.
v Execute device commands directly on the device.

Smart-defaulting actual destination attributes
The InfoPrint Manager server can automatically smart-default an actual destination
attribute for an SNMP printer only if an InfoPrint Manager user does one of these:
v Does not explicitly set the attribute when creating or modifying the actual

destination
v Resets the attribute to the InfoPrint Manager default

Before you create the actual destination and let the server smart-default one or
more actual destination attributes for a printer, we recommend that you:
1. Turn the printer on.
2. Make sure the printer is connected to the network.

The actual destination attributes that the server can smart-default are:
v destination-model

v input-trays-medium (also smart-defaults the attributes input-trays-supported
and media-ready)

v media-ready

v media-supported

v output-bin-numbers (also smart-defaults the attribute output-bins-supported)
v plexes-supported

v psf-tray-characteristics (also smart-defaults the attributes input-trays-supported
and media-ready)

v sides-supported

For media, smart-defaulting only detects the size of the medium. If you have
different media that are the same size (for example, three different letter-size
preprinted forms) and you need to differentiate between them in the attributes,
you must explicitly set the attributes instead of using smart–defaulting.

Detecting, reporting, and recovering from printer problems
The InfoPrint Manager server can automatically detect, report, and recover from
printer problems for several needs key operator and needs attention conditions as
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it periodically queries an SNMP printer, even if no jobs are currently being printed.
(To turn off automatic recovery, a key operator can manually disable the actual
destination.)

For example, the server detects that a printer is out of toner, disables the actual
destination, requeues the jobs, and sets the actual destination state to needs
attention or needs key operator. Then, when a key operator replaces the toner, the
server detects that the printer is running again, sets the actual destination state to
idle, and re-enables the actual destination.

Besides automatically managing the state of the actual destination, the InfoPrint
Manager server also updates its problem-message, warning-message, and
snmp-device-conditions attributes and sends out printer-needs-attention and
printer-needs-key-operator notifications. The actual destination’s state, which
message attribute is updated, and what type of notification is sent depends on the
severity of the condition reported by the printer, such as error, warning, or report.

This is the list of SNMP printer conditions that InfoPrint Manager reports:
v Cover open
v Input tray empty
v Interlock open
v Media empty
v Media missing
v Offline
v Paper jam
v Power off
v Service requested
v Fuser over temp
v Input tray missing
v Marker supply empty
v Marker supply missing
v Marker waste full
v Output bin full
v Output bin missing
v Fuser under temp
v Marker supply low
v Marker waste almost full
v Media low
v Moving offline
v Moving online
v Output bin near full
v Warmup

Note: Not all printers report all these conditions. For example, most printers do
not report the Warning conditions.

The same condition can be reported with a different severity depending on the
situation. For example, a printer might report an input tray empty condition as an
error or a warning. It could be a warning if the printer had multiple input trays
linked together with the same media and only one of them is empty. If a condition
is reported as an error, InfoPrint Manager reports these conditions as
needs-key-operator as opposed to needs-attention:
v fuser-over-temp
v fuser-under-temp
v marker-supply-empty
v marker-supply-low
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v marker-supply-missing
v marker-waste-full
v marker-waste-almost-full
v media-missing
v output-bin-missing
v service-requested
v warmup

Regardless of the severity, InfoPrint Manager lists all conditions on the
snmp-device-conditions attribute.

Accessing device information

You can use the InfoPrint Manager Administration GUI or the pdls command to
access information about SNMP devices.

Besides providing information about the actual destination object, InfoPrint
Manager allows you to access information directly from the printer. InfoPrint
Manager uses device-specific attributes to provide this function. While
device-specific actual destination attributes are accessed through an actual
destination, the information comes from the physical printer. The device-specific
attributes are not returned when you ask for all the actual destination’s attributes.
You have to request the device-specific attributes specifically or you can use -r
all-device to query all the device-specific attributes.

This is the list of non-settable device-specific actual destination attributes:
v device-description
v device-input-trays
v device-ip-address
v device-manufacturer
v device-marker-supplies
v device-media-supported
v device-model
v device-op-panel-locked
v device-output-bins
v device-printer-name
v device-ready-media
v device-serial-number
v device-state
v device-version

This is the list of settable device-specific actual destination attributes:
v device-contact
v device-location

Notes:

1. Not all printers report all these attributes.
2. The information returned is not translated.

The InfoPrint Manager Administration Interface can launch a Status window that
displays information returned from SNMP. The window lets you see a detailed
view of the status of an SNMP printer. It includes a graphic representation of the
printer and its current status, such as whether it has a paper jam or a door open.

To see the Status window from the InfoPrint Manager Administration Interface:
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1. Select an SNMP printer.
2. Select Check Status.
3. Select More Information.

You can use the pdls command to access SNMP device information with the -r
flag, such as output-bins, like this:
pdls -c destination -r device-output-bins prt5-ad

Note: You can filter for specific device information with the -f flag.

You can also use the pdls command to access all the information for an SNMP
device by specifying the -r flag with the all-device value.

For more information about the pdls command, see Chapter 2, “InfoPrint Manager
Tools” in the InfoPrint Manager: Reference.

Changing device information
You can use the InfoPrint Manager Administration GUI, the pddeviceop command,
and the pdset command to change information for SNMP devices.

The value of the snmp-active actual destination attribute must be true and the
printer device associated with the actual destination must support the operation.
You must have write permission to the actual destination, and
smnp-write-community-name actual destination attribute must be set properly for
the pddeviceop command or GUI commands to work.

From the Device Information window in the InfoPrint Manager Administration
GUI, you can reset the specific device, take it offline, or put it online. You can also
change the contact or location information.

You use the pddeviceop command to reset a specific device, take it offline, put it
online, as well as lock and unlock the operation panel for the specific device.

You can use the pdset command or the InfoPrint Manager Administration GUI to
change the contact or location information for SNMP devices.

Note: You cannot combine setting device-specific and actual destination attrributes
in the same pdset command.

For more information about the pddeviceop and pdset commands, see the
“InfoPrint Manager Tools” chapter in InfoPrint Manager: Reference.

Setting up and using SNMP
To set up and use SNMP with InfoPrint Manager, you must check and set the
appropriate InfoPrint Manager attributes when you create or modify the physical
printer in InfoPrint Manager.

This section explains:
v Determining if a printer works with SNMP
v Using the InfoPrint Manager Administration Interface
v Procedures
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Determining if a printer works with SNMP

Not all printers work with SNMP and the standard MIB. In addition, only printers
that are attached to a network can work with SNMP. Printers that are
parallel-attached cannot use SNMP.

To determine if a printer works with SNMP:
1. Set the actual destination attribute destination-tcpip-internet-address to the IP

address of the printer to indicate that InfoPrint Manager should try to
communicate with the printer using SNMP. The server sets the actual
destination attribute use-snmp to “true”.

Note: For PSF TCP-IP attached printers, a destination TCP-IP port number of
5002 must be used when driving the second engine in an InfoPrint 4000 or
InfoPrint 4100 dual simplex configuration for SNMP support to work. If 5002 is
used for a printer other than one using SNMP, the actual destination for that
printer will not work. The server will set the actual destination attribute
use-snmp to ″false″.

2. If the server cannot communicate with the printer using SNMP, it pings the
printer. If the ping command:
v Works, the server concludes that the printer is not an SNMP printer. It sets

use-snmp to “false”.
v Does not work, the server concludes that the printer is turned off or is not

currently connected to the network. It leaves use-snmp set to “true” and
continues trying to establish an SNMP connection with the printer.

3. Check the actual destination attribute snmp-active. If it is “true”, the printer
works with SNMP.

Using the InfoPrint Manager Administration Interface

To use the InfoPrint Manager Administration Interface to check and set the
attributes:
1. From the menu bar, select Printer or Server, as appropriate.
2. Select Properties. You see the printer properties or server properties notebook.
3. Select the SNMP tab.
4. Check and set the appropriate attributes on the SNMP tab as explained in

“Procedures.”

Procedures

Do these steps to check and set the attributes:
1. Check these actual destination attributes:
v snmp-community-name

Indicates the name of the SNMP community that the printer belongs to. The
default is “public”. The field on the SNMP tab is Community name”.

v snmp-write-community-name

Indicates the name of the SNMP write community that the printer belongs
to. There is no default. The field on the SNMP tab is Write community
name”.
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When the snmp-write-community-name attribute is set properly and you
have write permission to the actual destination, you can set the contact and
location information and execute device commands on the printer associated
with an actual destination.

v snmp-retry-count

Indicates the number of times the server should retry an SNMP request if it
fails. The higher the number, the more network traffic. Using a lower number
can improve performance. The default is “2”. The field on the SNMP tab is
“Number of times to retry”.

v snmp-timeout

Indicates the number of seconds the server should wait for the printer to
respond to an SNMP request. Using a lower number can improve
performance. The default is “5”. The field on the SNMP tab is “Timeout”.

v use-snmp

Indicates whether the server should try to use SNMP to communicate with
the printer. The default is “true”. The field on the SNMP tab is “Use SNMP”.

2. If the defaults in Step 1 on page 41 in this section are correct, set this actual
destination attribute:
v destination-tcpip-internet-address

Indicates the IP address of the SNMP printer. The field on the tab is “TCP/IP
address”.

3. Check this actual destination attribute:
v snmp-active

Indicates whether the server has been able to establish an SNMP session with
the printer. The field on the SNMP tab is “SNMP is active”.

4. Set these server attributes:
v snmp-discovery-during-startup

Indicates whether the server queries the printer MIB when InfoPrint Manager
starts, or whether the server gets the printer status when it periodically polls
the printer. The default is “true”, but you might want to set it to “false” if
you have several SNMP printers and you want to make the server start
faster. The field on the SNMP tab is “Discover printers at startup”.

v snmp-normal-poll-interval

Indicates the number of seconds that the server should wait after
sequentially polling all the SNMP printers without known problems.
Increasing the polling interval causes the server to use less CPU and network
resources for SNMP polling, but it makes the currently shown printer status
(for printers that are not currently printing) less accurate. The field on the
SNMP tab is “Normal poll interval”.

v snmp-problem-poll-interval

Indicates the number of seconds that the server should wait after
sequentially polling all the SNMP printers with known problems. Increasing
the polling interval causes the server to use less CPU and network resources
for SNMP polling, but it makes the currently shown printer status (for
printers that are not currently printing) less accurate. The field on the SNMP
tab is “Problem poll interval”.

For more information about the SNMP actual destination attributes, see the
“InfoPrint Object attributes” chapter in the InfoPrint Manager: Reference.
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Effects on performance with SNMP
The performance areas that SNMP can influence are:
v Server start-up
v Actual destination queries
v SNMP polling
v Number of SNMP printers on a server

Server start-up
If you set snmp-discovery-during-startup to “true”, the server start-up might be
slow because the server queries the printer MIB for each SNMP enabled actual
destination for the most current information. Setting this attribute to “false” can
improve startup performance. However, the initial actual destination status is not
current and won’t be until the server polls the printer next.

Actual destination queries
On an SNMP printer, when you query an actual destination attribute that might be
affected by the printer MIB (for example, destination-state), the default is that the
server uses SNMP at the same time to get the relevant information from the
printer. If the printer is turned off or not connected to the network, it might take a
long time before the printer times out, which delays the response to your query.

If this is a problem, you can use the pdls command with the when=now attribute
to return the current information instead of querying the printer MIB. Using this
attribute can improve performance.

SNMP polling
The server periodically polls the SNMP printers to get their latest status. If a
printer condition changes while the server is polling a printer (for example, a user
closes an open cover), the server might temporarily miss one of the changes.
However, during the next polling cycle, the server automatically picks up any
changes that it missed.

If the server cannot discover an SNMP printer when InfoPrint Manager starts, it
shows the printer status from the last time the server was shut down.

Increasing the polling interval causes the server to use less CPU and network
resources for SNMP polling, but it makes the currently shown printer status (for
printers that are not currently printing) less accurate.
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Chapter 4. Configuring media

This section describes how to create, configure, and manage media. Use the
InfoPrint Manager Administration Interface or the AIX command line to complete
these tasks.

Determining the media that are in the servers
You can use the InfoPrint Manager Administration Interface or the AIX command
line to show the media in the servers being monitored.

Using the InfoPrint Manager Administration Interface
Start the InfoPrint Manager Administration Interface by double-clicking the icon or
by entering ipguiadvadm at the AIX command line. From the Server menu on the
Main window, select Media → Show Media. The dialog displays the media that is
located on all servers currently being monitored.

Using the AIX command line
To display all the media in specified servers, use the pdls command. For example,
to display the media in Server1, enter:
pdls -c medium -r medium-identifier,associated-server,medium-type Server1:

InfoPrint returns information similar to this:
A4: medium-identifier=A4
A4: associated-server=Server1
A4: medium-type=
letter: medium-identifier=letter
letter: associated-server=Server1
letter: medium-type=
legal: medium-identifier=letter
legal: associated-server=Server1
legal: medium-type=
A4-colored: medium-identifier=A4-colored
A4-colored: associated-server=Server1
A4-colored: medium-type=stationery

For more information, see InfoPrint Manager: Reference or the pdls man page.

Creating a media object
You can use the InfoPrint Manager Administration Interface or the AIX command
line to create a media object.

Using the InfoPrint Manager Administration Interface
From the Server menu, select Media → Create or Copy (and select a media in the
Select Media to Copy dialog) to open the Create Media dialog. You use this
dialog to create a media in the specified server.

The InfoPrint Manager Administration Interface creates a new media with property
settings based on whether you choose to create a new media or copy an existing
media:
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v Use the Create option when you want to create a unique media (with default
settings) without copying properties from an existing media.

v Use the Copy option when you want to create a new media using properties
from an existing media.

Enter values in these fields:

Name Media names can contain up to 255 characters and are case-sensitive.

Server Displays the names of all servers being monitored. Select a server from the
list; this is the server that will contain the media. When you are copying a
media, the server containing the media being copied is initially selected.

Type Displays a list of predefined media types. Select a media type from the list.
When you are copying a media, the type of the media being copied is
initially selected.

Untrimmed width and length
Specifies the physical size of the media. The width is usually the shorter
dimension with respect to how the medium is loaded into the printer
device. The length or height is usually the longer dimension with respect
to how the media is loaded into the printer. Enter a positive real number
for the width and the length fields. When you are copying a media, the
untrimmed width and length (in inches or mm) of the media being copied
is displayed.

Weight
Identifies the media weight. Enter a positive integer. When you are
copying a media, the weight of the media being copied is displayed.

Color Displays a list of predefined media colors. Select a color from the list.
When you are copying a media, the color of the media being copied is
initially selected.

Details
Provides a text entry area for a message to be associated with the media
object. Enter description information about the media. When you are
copying a media, the message for the media being copied is displayed.

Select OK and you have created a new media.

Using the AIX command line
To create a medium, use the pdcreate command and the medium attributes.
Specify:
v The name of the server where you want to create the medium
v The medium identifier
v The size of the medium, using one of these attributes:

– medium-dimensions specifies the width and length of the medium in
millimeters. Be sure to enter the dimensions accurately so that printed output
will be aligned correctly on both sides of the medium. You must use this
attribute if AIX actual destinations are to use the medium.

– medium-size specifies a predefined size by name.

For example, to create a letter-size (8.5 by 11 inches) medium called
na-letter-colored in Server1, enter this command:
pdcreate -c medium -x "medium-size=letter" Server1:na-letter-colored
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For more information, see InfoPrint Manager: Reference or the pdcreate man page.

Viewing or changing attributes of a medium
You can use the InfoPrint Manager Administration Interface or the AIX command
line to view or change attributes of a medium.

Using the InfoPrint Manager Administration Interface
1. From the Server menu, select Media → Properties to open the Select Media

dialog.
2. Select the medium whose properties you want to view or change.
3. Click OK. The Media Properties notebook for that medium opens and you can

view all its attributes.
4. Make any changes and click OK to save those changes.

Using the AIX command line
To view the attributes of a medium, use the pdls command. For example, to view
all the attributes of na-letter-colored in Server1, enter this command:
pdls -c medium -r all Server1:na-letter-colored

To change the attributes of a medium, use the pdset command. For example, to
change the description of na-letter-colored in Server1, enter this command:
pdset -c medium -x "descriptor='Any color but white'"

Server1:na-letter-colored

For more information, see InfoPrint Manager: Reference or the pdls and pdset man
pages.

Associating a medium with an actual destination
You can use the InfoPrint Manager Administration Interface to associate a medium
with an actual destination.

Using the InfoPrint Manager Administration Interface
Depending on the input trays and paper feed mechanisms, a printer device might
have a wide variety of paper sources loaded. You can use the Change Media
dialog (Printer → Change Media) for an actual destination to define the different
paper types that operators can load in the printer on the Media Allowed tab.

To specify the media supported by the actual destination:
1. From the Printer menu, select Change Media to open the Change Media

dialog.
2. On the Media Ready tab, specify the bin and then select the media loaded into

each bin for the printer. You can also specify an input tray name to associate
with the bin.

3. Click OK. InfoPrint updates the actual destination properties notebook with the
values you specified.
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Chapter 5. InfoPrint Email support

InfoPrint Email can be used for interoffice communication or to send emails to
other addresses around the world. You can take advantage of the Email option to
format documents that are both viewable and printable at company workstations.
Send and receive data from a wide variety of sources, whether the data is PCL,
PDF, PostScript, GIF, JPEG, TIFF, or a native SAP R/3 data stream (ABAP or OTF).
Incoming data can be all these types; the Email DSS converts the data to PDF for
viewing. To view output, you can use Adobe® Acrobat Reader (for more
information and available downloads, see the Adobe web site at
http://www.adobe.com).

Note: Color PDF and PostScript jobs will be converted to black and white PDF
emails if not handled appropriately.

Configuring InfoPrint Email
Before you can send Email through InfoPrint Manager for AIX, you must make
sure your SMTP Email server is correctly configured and defined to InfoPrint and
create an InfoPrintEmail destination.

Defining the SMTP Email server to InfoPrint

The InfoPrint Manager for AIX Email DSS uses a Simple Mail Transfer Protocol
(SMTP) server to send email. The SMTP server must have MIME support. The
SMTP server used is defined by the InfoPrint Manager server attributes
smtp-server-host and smtp-server-port. These attributes default to the local AIX
SMTP server. If you want to use a different SMTP server, you can modify these
server attributes.

Note: Your SMTP server must be correctly configured to get outside the firewall if
you plan to send emails outside your firewall.

If you want to change the SMTP server for the InfoPrint AIX server, use this
procedure to accomplish this task.
1. To set the mail server at installation, start the InfoPrint Manager

Administration Interface by entering this from the AIX command line:
ipguiadvadm.

2. From the InfoPrint Manager Administration Servers main window, click Server
→ Properties.

3. From the Server Properties dialog, specify your installation’s mail server in the
SMTP server field and the port in the SMTP port field.

Note: The SMTP server port field defaults to 25, which is the default port for
the SMTP server on most AIX servers.

Note that if you plan to use Email to send large PDF files consisting of fifty pages
or more, you will need to expand the size of the /var/psf/segments file system to
500 MB.
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Creating an InfoPrint Email destination

Before you can send email output through InfoPrint Manager, you must create an
email destination on your InfoPrint AIX server. You should use the Advanced
InfoPrint Manager Administration Interface to do this task.

Note: While users who have purchased the Print-On-Demand feature can use the
Basic InfoPrint Manager Administration Interface , we recommend against it
because you will not be able to view queue objects. This means you cannot select
the queue to add to a logical destination.
1. Start the Advanced InfoPrint Manager Administration Interface by entering

this from the AIX command line: ipguiadvadm.
2. From the main window, select Other → Create → Email Destination.

Note: If the Email Destination option is not available under the Other →
Create path, click the Options → Add/Remove Menu Items path and check the
Create Email Destination from the Customize dialog. Note that you can
specify any actions (delete, enable, disable, etc.) from this particular dialog.

3. In the first panel of the Create Email Destination Wizard:
a. Specify a Name for the Email destination, such as email1.
b. Specify the InfoPrint AIX Server where you are creating the Email

destination, such as server1.
4. In the second panel of the Create Email Destination Wizard, select a logical

destination to feed this Email actual destination.
We recommend that you create a separate logical destination object (email-ld),
so that the same logical destination does not feed jobs to both a printer and an
email destination. This step will make it easier for operators to monitor the
progress of email jobs through the system and make it easier to diagnose any
potential email problems.

5. In the third panel (if you have decided to create a separate logical destination
object in the preceding step), you can select in which to put the new logical
destination object.

6. In the fourth panel of the Create Email Destination Wizard, you can decide to
take the default configuration or to further customize this destination by:
v Changing the InfoPrint logical destination to which jobs are routed (if

different from the logical destination defined in the preceding step).
v Specifying particular job batch values.
v Modifying actual destination properties.
For purposes of this example, we take the default and apply the standard
configuration.

7. In the fourth panel of the Create Email Destination Wizard, accept the default
to enable the destination so that you have an Email destination with a status of
ready.

Submitting Email jobs
Once you have installed and configured the Email option, you can submit jobs to a
particular output destination by using the command line anywhere that you have
the pdpr command installed. This topic shows the command syntax and provides
three examples for submitting email jobs:
v “Submitting a basic email job” on page 51
v “Submitting attributes through a file with the -Z option” on page 51
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v “Submitting files with a Korn shell script” on page 52
v “Submitting text files with a Korn shell script” on page 53
v “Using the InfoPrint Select client” on page 54

Submitting a basic email job

For specific information about the pdpr command and its attributes, see the
InfoPrint Manager: Reference, on the web or the pdpr man page.

To submit a basic email job, you can use this syntax:
pdpr -p email-ld -Z emailfilename

For an explanation of each variable on the command-line, consult this table:

Variable Definition

logical_destination

Example:

-p email-ld

Specifies the logical destination that you defined when
configuring the Email option through the Advanced
InfoPrint Manager Administration Interface.

For more information about configuring both logical
and actual destinations and using the pdpr command,
see the InfoPrint Manager: Reference.

emailfilename

Example:

-Z

/email_script/samp.script

Specifies a file that contains the job attributes, the name
of the file you are sending, and the email destination to
which you are sending the email.

Email attributes include cover sheet information, billing
code information, and other options.

Note that subject-text, email-body, and email-signature
are the only required attributes.

We recommend that you create sample attribute scripts that you can customize for
your particular site. While you can specify email attributes on the command line,
we recommend using an attribute file.

Submitting attributes through a file with the -Z option

You can create a sample attribute file using an input date type of AFP, PostScript,
or Portable Document Format and submit it as the emailfilename for the syntax
listed above:
-x email-from-address=root@serv.us.name.com
-x email-to-address=johndoe@us.name.com
-x subject-text="Test Script"
-x document-type=printable

/usr/lpp/ps/sample.pdf
-x document-type=email-body

/email_script/body.txt
-x document-type=email-signature

/email_script/sig.txt

At the command-line, use this syntax to use this attribute file:
pdpr -p logical_destination -Z emailfilename
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where logical_destination is email1-ld and emailfilename could be named
/email_script/samp.script and stored on your local system. Note that you must
have defined a body.txt file and a sig.txt file for this script to work correctly.

This attribute file sends a report to a ’johndoe’ Internet ID, using a logical
destination (printer) named email1-ld that you specify from the command line.
Note that the convention us.name.com is used to indicate a company-wide
addressing system, where it indicates the country (us), the company name (name)
and the communications name (com) for all fully qualified addresses in the
company.

Note that you cannot put comments in an attributes file using the -Z option.

This script does not print ASCII input data. To print ASCII input files, see
Submitting Text Files with a Korn Shell Script.

Submitting files with a Korn shell script

You can create a Korn shell script (named sendfile for this example) with a simpler
command syntax because the pdpr command is included in the shell script.

Create a file that contains the pdpr command and all its attributes. Create the
following Korn shell script and place it in a directory on the AIX system where
you have installed the pdpr command.

The file should look similar to this:
# Sample Attribute File for InfoPrint Manager Email

# using a script to submit
# sendemail $1 $2
# $1 is required as the name of the file to send.
# $2 is optional as the recipient of the email.
#
#! /usr/bin/ksh
if [[ -a $1 && -n $1] ]
then
if [ $2 ]
then
WHOTO=$2
else
WHOTO="johndoe@us.name.com"
fi
/usr/lpp/pd/bin/pdpr -p email1-ld \
-r brief \
-x email-to-address=$WHOTO \
-x email-from-address=root@serv.us.name.com \
-x "subject-text='Your requested Email file'" \
-x document-type=printable $1 \
-x document-type=email-body /email_script/body.txt \
-x document-type=email-signature /email_script/sig.txt
else

echo " sendfile: could not locate file [$1]"
fi

At the command-line, this Korn shell script would use this syntax:

sendfile outputfilename [destination]

where outputfilename specifies the file that you are sending (sample.pdf) and
destination is the email address (johndoe) to which you are sending the file.
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This script sends an email to either the destination value that you specify as the
second argument on the AIX command line, or to ’johndoe’ Internet ID, if you take
the default. The script uses a logical destination (printer) named email1-ld on your
InfoPrint AIX server.

Note that the convention us.name.com is used to indicate a typical Internet address
for a business.

Submitting text files with a Korn shell script

You can create a Korn shell script (named sendtxtfile for this example) to submit
ASCII text files as Email.

Create a file that contains the pdpr command and all its attributes. Create the
following Korn shell script and place it in a directory on the AIX system where
you have installed the pdpr command.

The file should look similar to this:
# Sample Korn Shell
# Script for InfoPrint Manager Email Text

# Uses a script to submit:
# sendtxtemail $1 $2
# $1 is required as the name of the file to send.
# $2 is optional as the recipient of the email.
#
# This script takes an ASCII file as input and creates
#PostScript output that is submitted with the pdpr command
# as email.
#! /usr/bin/ksh
if [[ -a $1 && -n $1] ]
then
if [ $2 ]
then
WHOTO=$2
else
WHOTO="johndoe@us.name.com"
fi
# Make temporary PostScript file
enscript -p /tmp/$$email.txt $1
/usr/lpp/pd/bin/pdpr -p email1-ld \
-r brief \
-x email-to-address=$WHOTO \
-x email-from-address=root@serv.us.name.com \
-x "subject-text='Your requested Email file'" \
-x document-type=printable /tmp/$$email.txt \
-x document-type=email-body /email_script/body.txt \
-x document-type=email-signature /email_script/sig.txt
# Delete temporary PostScript file
rm /tmp/$$email.txt
else
echo " sendtxtfile: could not locate file [$1]"
fi

At the command-line, this Korn shell script would use this syntax:

sendtxtfile outputfilename [destination]

where outputfilename specifies the file that you are sending (email.txt) and
destination is the email address (johndoe) to which you are sending the file.
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This script sends an email to either the destination value that you specify as the
second argument on the AIX command line, or to ’johndoe’ Internet ID, if you take
the default. The script uses a logical destination (printer) named email-ld on your
InfoPrint AIX server. This file uses the enscript AIX command to convert the text
file to PostScript, stores that PostScript file in the /tmp directory on the submitting
AIX system, and then deletes that file once the pdpr command has submitted the
PostScript file to the InfoPrint AIX server.

Note that the convention us.name.com is used to indicate a typical Internet address
for a business.

Using the InfoPrint Select client

Once you have successfully installed InfoPrint Select and defined an Email
destination (see the ″Using InfoPrint Select to submit a job″ chapter in InfoPrint
Manager for AIX: Getting Started for more information), you can use the following
procedure to email.

Note: In order to configure the port for the InfoPrint server email destination on
your client workstation, the email logical destination (in our example, email-ld) on
the InfoPrint AIX server must have a value filled in for the client-driver-names
logical destination attribute. If this value is not filled in, you will not be able to
display printers from the InfoPrint AIX server when you click Refresh Printers
Selection List.

You must also set the destination-support-system logical destination attribute to
email for InfoPrint Select to send emails.
1. Specify Print from the screen menu.
2. From the Print window, make sure that the Name field contains the name of

the logical destination that you defined to the InfoPrint AIX server, then click
OK.

3. From the InfoPrint Email pop-up window, specify the attribute information in
the fields as indicated.

Color Email

If you have color Portable Document Format (PDF) or PostScript files, you can
send these files to target email address through InfoPrint Manager and receive
color output.

Ensure that your color PDF files pass through the Email DSS without being
transformed no matter what method you use to submit the job to the InfoPrint
Manager AIX server. To do this specify job attribute job-ripped-by-server =
false. Alternatively, you can set the actual destination to not RIP PDF document
formats. However, that would apply to all PDF jobs submitted.

You don’t want to lose the color information contained in color PostScript files.

Note: Color Email is not supported if your Email job sent to an Actual Destination
contains any of the attributes specified in the lists that follow. If these attributes or
conditions are sent to an Actual Destination, the file will print as black-and-white
(MO:DCA-P) output.
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Any job or document attributes that require the Email DSS to transform the data
are not supported. For a list of these attributes and for more information about the
job-ripped-by-server attribute, see InfoPrint Manager: Reference.

Submitting color Email attributes through a file

You can print a color Email job with a batch file that contains these:
v Job name
v Email body text
v Email to address
v Email from address

Here is the sample file:
-x job-name="Titleist"
-x job-ripped-by-server=false
-x email-from-address=gopher1@gopher.com
-x email-to-address=gopher@gopher.com
-x subject-text="testing"
-x document-type=email-body
-f d:\bsi\data\body.txt
-x document-format=pdf
-x document-type=printable

To submit this job to the InfoPrint AIX server, specify this at an AIX command line:
c:\Infoprint\pdpr -p email -Z d:\bsi\options\em_rip.txt \
d:\bsi\data\LogoOnly.pdf

where em_rip.txt is the -Z file above.
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Chapter 6. User-exit programs (PSF, Generalized Fax, and
Email DSS only)

This section describes the sample user-exit programs supplied with InfoPrint
Manager and how you can create your own user-exit programs.

What type of user-exits does InfoPrint Manager support?
InfoPrint Manager supports dynamically loaded user-exit programs. These
programs are loaded with the InfoPrint Manager executable program during
initialization and are called at various points during job processing.

InfoPrint Manager allows eight different types of user-exits. InfoPrint Manager
calls the user-exits in this order:
v Header (Start) page user-exit
v Separator page user-exit
v Input data user-exit
v Output data user-exit
v Accounting user-exit
v Audit user-exit
v Trailer (End) page user-exit
v Post-print accounting user-exit

What sample user-exit programs are available?
InfoPrint Manager supplies sample user-exit programs for the header, separator,
and trailer pages, for accounting and audit data, and for post-print accounting
data. The sample header, separator, and trailer page user-exit programs generate
Advanced Function Presentation (AFP) data stream pages. The sample accounting
and audit user-exit programs generate ASCII data in a report file format or write to
a log file. The sample post-print accounting user-exit program only writes to a log
file. InfoPrint Manager also supplies sample user-exit programs for input data and
output data; however, these user-exit programs do not do any function. You can
use all of these sample programs as they are or you can modify them.

If you choose to modify the existing user-exit programs, the source code for each
one is located in the /usr/lpp/psf/usr/lpp/psf/exits directory. InfoPrint Manager
supplies these sample programs:

Start
sheet

Separator
sheet

Send job
to printer

Accounting Audit
End
sheet

Start

Job Post-print
accounting

(Trailer)(Header)

Inp Data User Exit

Output Data User Exit

ut

Job

Stacked

Other job
processing

Figure 1. Sequence of user-exit programs for InfoPrint Manager
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Table 7. Sample user-exit programs

Type of user-exit File Name Description

Header Page ainuxhdr.c Generates brief style start
sheet.

ainuxhdr2.c Generates full style start
sheet.

ainuxhdrp.c Generates start sheet with
job ticket information.

ainuxhdrx.c Generates start sheet without
vertical lines.

pduxblkh.c Generates a blank start sheet.

Separator Page ainuxsep.c Generates brief style
separator sheet

ainuxsep2.c Generates full style separator
sheet.

ainuxsepp.c Generates separator sheet
with job ticket information.

ainuxsepx.c Generates separator sheet
without vertical lines.

pduxblks.c Generates a blank separator
sheet.

Trailer Page ainuxtlr.c Generates brief style end
sheet.

ainuxtlr2.c Generates full style end
sheet.

ainuxtlrp.c Generates start sheet with
job ticket information.

ainuxtlrx.c Generates end sheet without
vertical lines.

pduxblkt.c Generates a blank end sheet.

Accounting ainuxacc.c Generates brief style
accounting sheet.

ainuxacc2.c Generates full style
accounting sheet.

ainacclog.c Generates accounting log
information.

ainuxaccp.c Generates accounting sheet
log with job ticket
information.

Post-print Accounting ainuxjobcompletion.c Generates accounting log
information about printed
(″stacked″) sheets.
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Table 7. Sample user-exit programs (continued)

Type of user-exit File Name Description

Audit ainuxaud.c Generates brief style audit
sheet.

ainuxaud2.c Generates full style audit
sheet.

ainuxaudp.c Generates audit sheet with
job ticket information.

ainaudlog.c Generates audit log
information.

Input Data ainuxind.c Provides template for writing
your own user-exit program.

Output Data ainuxout.c Provides template for writing
your own user-exit program.

See “User-exit programs for the line-data transform” on page 73 for sample
user-exit programs used with the line-data transform.

Creating and using your own user-exit programs
You can create your own user-exit program at any time; however, you must do
additional tasks to activate your program. You must have the XL C Compiler and
the bos.adt components of the Base Application Development Toolkit of the AIX
operating system installed.

Creating your own user-exit programs

ICONV

If you have written any user-exit programs that use ICONV, you must alter them
to use UCONV instead. See the InfoPrint Manager: Reference for more information.

You can create your own user-exit program in one of these ways:
v Copy one of the sample user-exit programs, rename it, and modify it using an

AIX editor.
v Write your own user-exit program. You can include the variable data shown in

the following sections, for example, USERID; but InfoPrint Manager cannot
process variable data that is not shown in this chapter.

Compiling and installing the user-exit program
When you finish creating your own user-exit program, you must compile the
program code and then install it in the correct directory. You do this by using the
AIX make command.

When the make command executes, it reads the Makefile file, supplied with
InfoPrint Manager, that is located in the same directory as the sample programs.
The Makefile file contains information about the specified target files and the
commands necessary to update the target files.

Before you put your user-exit program into general use at your site, you should
test it first to make sure that it runs correctly. Because your user-exit program
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becomes part of the InfoPrint Manager executable code, a defective user-exit
program could cause problems with InfoPrint Manager.

Compile and install your user-exit program

To compile and install your user-exit program, follow these steps:

Notes: You must have root authority to use the make command in this directory.
1. If you already have an existing executable user-exit program in the

/usr/lpp/psf/bin directory for the user-exit program you are adding, do these
steps first; otherwise, go to step 2.
a. Disable all the logical destinations associated with the queues that are to

receive jobs that will use the new user-exit program.
b. Delete the executable user-exit program from the /usr/lpp/psf/bin directory.

2. To make the directory in which the user-programs are stored the current
directory, enter:
cd /usr/lpp/psf/exits

3. On the AIX command line, enter:
make

The make command reads the Makefile file supplied with InfoPrint Manager,
compiles and generates the user-exit program.

4. On the AIX command line, enter:
make install

The make install command copies the executable user-exit program from the
/usr/lpp/psf/exits directory into the /usr/lpp/psf/bin directory so that the code
executes with InfoPrint Manager.

5. Enable all of the logical destinations that you disabled.

Notes:

1. If you do not want to copy the executable user-exit program into the
/usr/lpp/psf/bin directory, you can copy them into another directory. However,
if you do this, you need to add the path to the PATH statement in the
/etc/environment file so that InfoPrint Manager can locate the module.

2. You can only specify one user-exit program for each function name provided
by InfoPrint Manager per queue.

3. Make sure the function name of the user-exit is one of the following where the
name is in uppercase letters, because that is the entry point in the module:
v ACCOUNTING
v AUDIT
v JOBCOMPLETION
v HEADER
v SEPARATOR
v TRAILER
v INDATA
v OUTDATA

4. If you do not want to use the same name for the user-exit program, you must
edit the Makefile file and change the name of the user-exit program supplied
with InfoPrint Manager to the new name. For example, to call your new header
user-exit program header, you must edit the Makefile file and change the
name of the existing header user-exit program, ainuxhdr to header. In addition,
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you must change the source code file name from ainuxhdr.c to header.c. You
can also add new exit targets in the Makefile file.

5. You must mark the function as an exported symbol during the link-editing
step. See the InfoPrint Manager supplied /usr/lpp/psf/exits/Makefile for more
information.

Activating the user-exit program

Before you can use the new user-exit program, you must activate the program.

From an AIX command line, complete these steps:
1. Enter this command: pdls -caux -rall servername:, where servername refers to

the name of the server you are using.
This command displays the attributes for all current auxiliary sheet objects
available on the server. You can also view attributes for a specific auxiliary
sheet object. For example, to view attributes for the accounting log, enter this
command: pdls -caux -rall servername:accounting-log

2. Use the pdset command to change the values of any of the auxiliary sheet
objects, as necessary.

To do this task from the InfoPrint Manager Administration Interface, you must
select the printer that you want to associate with an auxiliary sheet (in this case,
prt1) and then use the Printer —> Properties menu to access the Printer
Properties notebook. To complete this task, see the online help topic Using
auxiliary-sheet objects in the InfoPrint Manager Administration Interface.

Do this procedure from the AIX command line.
1. To create a new auxiliary-sheet object, type:

pdcreate -c aux-sh -x psf-exit-prog-name=/usr/lpp/psf/exit_name
server1:auxiliary_sheet_name

2. Shut down the actual destination (in this case, prt1).
pdshutdown -cp prt1

3. Associate this new auxiliary-sheet object (in this case, an audit exit) with the
actual destination.
pdset -cp -x dest -x audit-exit=auxiliary_sheet_name prt1

Note: For the post-print accounting exit, instead of this step you will set the
attribute in the accounting auxiliary sheet object for the actual destination,
using this command: pdset —c auxiliary-sheet —x psf-post-print-
accounting-program-name=/usr/lpp/psf/exit_name servername:
accounting-log

By default, the accounting-log auxiliary sheet object is available for all
destinations. This object can point to any combination of the accounting and
post-print accounting exits. For example, you can set either one, both, or
neither of these attributes at the same time:
psf-exit-program-name=name of accounting exit
psf-post-print-accounting-program-name=name of post-print accounting exit

If you want some printers to have different accounting configurations than
others, you must create a new auxiliary sheet object for each configuration.

4. Enable the actual destination (in this case, prt1).
pdenable prt1
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See Chapter 7, “Creating and managing auxiliary sheets and user-exit programs,”
on page 83 for the procedures to activate the various user-exit programs.

User-exit program structures

All input and output variables used in InfoPrint Manager user-exits are defined
through either of these two files:
v The /usr/lpp/psf/exits/ainuexit.h file
v The /usr/lpp/psf/exits/ainurpt.h file

The ainuexit.h file contains definitions for the input, output, header, trailer,
separator, accounting, audit, and post-print accounting exits, while the ainuprt.h
file formats data for these executable reporting utilities that apply to the
accounting, audit, and post-print accounting exits:
v Accounting Log

– ainurpt1

– ainurpt2

– ainurpt3

v Audit Log
– ainurpt4

– ainurpt5

– ainurpt6

v Post-print Accounting Log
– ainurpt7

– ainurpt8

– ainurpt9

These user-exit program structure files are written in the C programming language.
The declarations and statements in these files show the structure of the InfoPrint
Manager user-exit programs, which are imbedded as part of the user-exit program.

Common input and output fields

The following fields can be found in the user-exit programs. For a detailed list of
input and output fields according to user-exit, see the /usr/lpp/psf/exits/ainuexit.h
file. This information can be specified from:
v Migrated jobs
v MVS™ Download jobs
v Fields set in the InfoPrint Manager Administration Interface Job and Document

Defaults notebook
v Fields in the InfoPrint SMIT administrator’s interface Submit an InfoPrint Job

panel

UserID
Identifies the AIX user ID of the person who submitted the job. If you log
in as yourself and then switch to root, the AIX user ID is root.

NodeID
Identifies the name of the AIX system (host). The backend program sets the
NodeID.
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Jobname
Identifies the name of the job. This is the same as the file name in the job.

Job submitters can also specify the job name with the InfoPrint Manager
job attribute job-name=name when they submit a job.

If the job name is not specified for files defined as OTF, PCL, PostScript,
ditroff, line data, unformatted ASCII, double-byte character set (DBCS)
ASCII, EUC, PDF, JPEG, GIF, or TIFF files when the job is submitted,
InfoPrint Manager creates a temporary file for the transform output.
InfoPrint Manager uses the temporary file name for the job name.

SpoolID
Identifies the PSF job ID, which is an integer. InfoPrint Manager sets the
SpoolID.

PrinterName
Identifies the first eight characters of the InfoPrint Manager destination
name.

hab This function is not used in AIX.

Date Identifies the date printed.

Time Identifies the time printed.

Distribution
Identifies the distribution information provided when the job is submitted.

PagePointer
Points to a buffer containing the data produced by any of these exits:
v Header page
v Trailer page
v Separator page
v Accounting
v Audit

PageSize
Indicates the size of the data returned by these exits:
v Header page
v Trailer page
v Separator page
v Accounting
v Audit

This field is initially set to 0 before the exit is called. If no data is generated
by the exit, this field remains set at 0.

PageType
Indicates the type of header or trailer page data (if any) that the exit
generates. The field is initially set to 0 (AFP data stream) before the exit is
called. Valid values are:

0 AFP data stream

1 ASCII data

Job Completion
Indicates the status returned by the exit. This field is initially set to 0
before the exit is called. Valid return codes are:
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0 Good completion, all done, accept resultant page.

-1 Bad completion, non-fatal error, no page generated.

-5 Bad completion, fatal error. The exit is disabled until you shut
down the actual destination.

-8 Bad completion, terminate the current job.

-12 Bad completion: terminate the job and put it in pending state. In
addition, InfoPrint disables the actual destination.

Name Identifies the name information provided when the job is submitted.

The Name field value can be any null-terminated (X’00’) character string.
This value can be any null-terminated (X’00’) character string no greater
than 24 characters.

Userid
Identifies the userid information provided when the job is submitted.

The Userid field value can be any null-terminated (X’00’) character string.
This value can be any null-terminated (X’00’) character string no greater
than 10 characters.

Nodeid
Identifies the nodeid information provided when the job is submitted.

The Nodeid field value can be any null-terminated (X’00’) character string.
This value can be any null-terminated (X’00’) character string no greater
than 10 characters.

Address1
Identifies the first line of address information provided when the job is
submitted.

The Address1 field value can be any null-terminated (X’00’) character
string. This value can be any null-terminated (X’00’) character string no
greater than 57 characters.

Address2
Identifies the second line of address information provided when the job is
submitted.

The Address2 field value can be any null-terminated (X’00’) character
string. This value can be any null-terminated (X’00’) character string no
greater than 57 characters.

Address3
Identifies the third line of address information provided when the job is
submitted.

The Address3 field value can be any null-terminated (X’00’) character
string. This value can be any null-terminated (X’00’) character string no
greater than 57 characters.

Address4
Identifies the fourth line of address information provided when the job is
submitted.

The Address4 field value can be any null-terminated (X’00’) character
string. This value can be any null-terminated (X’00’) character string no
greater than 57 characters.
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Account
Identifies the account information provided when the job is submitted.

The Account field value can be any null-terminated (X’00’) character string.
This value can be any null-terminated (X’00’) character string no greater
than 20 characters.

Building
Identifies the building information provided when the job is submitted.

The Building field value can be any null-terminated (X’00’) character
string. This value can be any null-terminated (X’00’) character string no
greater than 24 characters.

Department
Identifies the department information provided when the job is submitted.

The Department field value can be any null-terminated (X’00’) character
string. This value can be any null-terminated (X’00’) character string no
greater than 24 characters.

Programmer
Identifies the programmer information provided when the job is submitted.

The Programmer field value can be any null-terminated (X’00’) character
string. This value can be any null-terminated (X’00’) character string no
greater than 24 characters.

Room Identifies the room information provided when the job is submitted.

The Room field value can be any null-terminated (X’00’) character string.
This value can be any null-terminated (X’00’) character string no greater
than 24 characters.

Title Identifies the title information provided when the job is submitted.

The Title field value can be any null-terminated (X’00’) character string.
This value can be any null-terminated (X’00’) character string no greater
than 24 characters.

Passthru
Identifies any other information provided when the job is submitted that
will be passed through the user-exit to the backend program.

These Passthru flags are supported:

class Identifies the one-character class attribute.

destination
Identifies the one-to eight-character destination attribute.

forms Identifies the one-to eight-character forms attribute.

segmentid
Identifies the one-to ten-character segmentation identifier.

ServerJobID
Identifies the job identifier.

The Passthru field value can be any null-terminated (X’00’) character string
no greater than 1,024 characters.

LongPrinterName
The full name of the InfoPrint destination.
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Note: Because InfoPrint Manager only allows eight character names,
PrinterName and LongPrinterName are the same.

The header page and trailer page user-exit programs
Because the InfoPrint Manager start page and trailer page user-exit programs
require the same inputs and produce the same outputs, the program descriptions
are similar.

The source code (in the C programming language) for the sample header page
user-exit programs and trailer page user-exit programs listed on page 57 are
located in the /usr/lpp/psf/exits directory. These sample programs generate an AFP
data stream page.

The data structures for the header and trailer page user-exit programs are included
with the source code in the /usr/lpp/psf/exits/ainuexit.h file. The code for these
structures is shown in “User-exit program structures” on page 62.

The declaration of these exits is:
void HEADER (HEADER_EXITDATA *exitdata)
void TRAILER (TRAILER_EXITDATA *exitdata)

The HEADER_EXITDATA and the TRAILER_EXITDATA input/output parameters contain
all of the input and output data needed to communicate between InfoPrint
Manager and the user-exit programs.

See “Common input and output fields” on page 62 and the ainuexit.h file for
explanations of the function and structure of the various components of this
user-exit.

After you create your header page or trailer page user-exit program, you must use
the AIX make command to compile the code (see “Compiling and installing the
user-exit program” on page 59).

The separator page user-exit program
The InfoPrint Manager separator page user-exit program is called before copies of
a job (including the very first copy) print.

The source code (in the C programming language) for the sample separator page
user-exit programs listed on page 57 are located in the /usr/lpp/psf/exits directory.
These sample programs generate an AFP data stream page.

The data structures for the separator page user-exit program are included with the
source code in the /usr/lpp/psf/exits/ainuexit.h file. The code for these structures is
shown in “User-exit program structures” on page 62.

The declaration of this exit is:
void SEPARATOR (SEPARATOR_EXITDATA *exitdata)

The SEPARATOR_EXITDATA input/output parameter contains all the input and output
data needed to communicate between InfoPrint Manager and the user-exit
program.
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See “Common input and output fields” on page 62 and the ainuexit.h file for
explanations of the function and structure of the various components of this
user-exit.

This field is also found in the separator page user-exit program and provides
output information:

Copy Indicates which copy is associated with this call to the exit. Initially set to
1, it increments by one each time the exit is called. The sample separator
page user-exit program generates one separator page for the first copy and
all subsequent copies of the job.

After you create your separator page user-exit program, you must use the AIX
make command to compile the code (see “Compiling and installing the user-exit
program” on page 59).

The accounting, post-print accounting, and audit user-exit programs
The InfoPrint Manager accounting and audit user-exit programs require the same
inputs and produce the same outputs so the program descriptions are the same.
The post-print accounting user-exit program requires more inputs and produces
more outputs.

The source code (in the C programming language) for the sample user-exit
programs listed on page 57 are in the /usr/lpp/psf/exits directory. The sample
programs store the data into a file you can access with these executable reporting
utilities:

ainurpt1
Provides accounting data for the actual destinations defined, based upon
the destination ID.

ainurpt2
Provides accounting data for the actual destinations defined, based upon
the userid.

ainurpt3
Provides detailed accounting data for the destinations defined, based upon
the particular userid supplied.

ainurpt4
Provides audit data for the actual destinations defined, based upon the
destination ID.

ainurpt5
Provides audit data for the actual destinations defined, based upon the
userid.

ainurpt6
Provides detailed audit data for the actual destinations defined, based
upon the particular userid supplied.

ainurpt7
Provides post-print accounting data stored in jobcompletion.log, sorted by
actual destination.

ainurpt8
Provides summary post-print accounting data stored in jobcompletion.log,
sorted by job submitter.
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ainurpt9
Provides detailed entries of times and pages printed for a specific job
submitter in jobcompletion.log.

The source code for these reporting utilities is also located in the /usr/lpp/psf/exits
directory.

These executable reporting utilities are located in the /usr/lpp/psf/bin directory. By
specifying these executable reporting utilities at the AIX command line, you can
display data by either destination ID or userid. For example, to report on print
requests submitted by a specific user to a actual destination for which the
accounting user-exit has been activated, you can specify ainurpt3 and then provide
the userid to the program.

Note: You must activate these exits to generate the log files used by these report
programs. For more information about activating these exits, see “Activating the
user-exit program” on page 61.

The data structures for the accounting, audit, and post-print accounting user-exit
programs are included with the source code in the /usr/lpp/psf/exits/ainuexit.h
and /usr/lpp/psf/exits/ainurpt.h files. The code for these structures is shown in
“User-exit program structures” on page 62.

The declarations of these exits are:
void ACCOUNTING (ACCOUNTING_EXITDATA *exitdata)
void AUDIT (AUDIT_EXITDATA *exitdata)
void JOBCOMPLETION (JOBCOMPLETION_EXITDATA *exitdata)

After you create your user-exit program, you must use the AIX make command to
compile the code (see “Compiling and installing the user-exit program” on page
59).

See “Common input and output fields” on page 62 and the ainuexit.h file for
explanations of the function and structure of the various components of this
user-exit.

The ACCOUNTING_EXITDATA, AUDIT_EXITDATA, and JOBCOMPLETION_EXITDATA
input/output parameters contain all the input and output data needed to
communicate between InfoPrint Manager and the user-exit programs.

These fields are also found in the accounting, audit, and post-print accounting
user-exit programs:

Pages Printed (accounting and audit user-exit only)
Shows the total number of impressions processed for this job.

Bin One Sheets Processed (accounting and audit user-exit only)
Shows the total number of processed sheets that were selected from the
primary bin.

Bin Two Sheets Processed (accounting and audit user-exit only)
Shows the total number of processed sheets that were selected from bins
other than the primary bin.

User Pages Stacked by Bin (post-print accounting user-exit only)
Shows the total number of stacked pages in the user print file. It does not
include system pages, such as the header page, in the count.
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User Sheets Stacked by Bin (post-print accounting user-exit only)
Shows the total number of stacked sheets in the user print file. It does not
include system pages, such as the header page, in the count.

Pages Stacked by Bin (post-print accounting user-exit only)
Shows the total number of pages stacked for this job by bin.

Sheets Stacked by Bin (post-print accounting user-exit only)
Shows the total number of sheets stacked for this job by bin.

Data Object Resources
Shows the total number of Data Object Resources, which can consist of
PDF pages, IOCA images, and Encapsulated PostScript (EPS) files, used in
this job. Data Object Resources are also known as presentation-object
containers (for more information, see the presentation-object-container
attributes in the InfoPrint Manager: Reference).

Note: The counters do not include resources contained in the input file.
The counters only include resources used before the accounting or audit
user-exit is called. Therefore, the resources required for printing error
messages and the trailer page do not appear in the resource totals.

Job Copies Requested (post-print accounting user-exit only)
Shows the total number of results-profile job copies requested in the job.

Fonts used
Shows the total number of fonts used in this job.

Note: The counters do not include resources contained in the input file.
The counters only include resources used before the accounting or audit
user-exit is called. Therefore, the resources required for printing error
messages and the trailer page do not appear in the resource totals.

Overlays used
Shows the total number of overlays used in this job.

Note: The counters do not include resources contained in the input file.
The counters only include resources used before the accounting or audit
user-exit is called. Therefore, the resources required for printing error
messages and the trailer page are not included in the resource totals.

Segments used
Shows the total number of page segments used in this job.

Note: The counters do not include resources contained in the input file.
The counters only include resources used before the accounting or audit
user-exit is called. Therefore, the resources required for printing error
messages and the trailer page are not included in the resource totals.

ExtStart Date
Identifies the date the job started processing.

Start Date
The date the job started processing.

Start Time
The time the job started processing.

ExtStop Date
The date the job finished processing.
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Stop Date
The date the job finished processing.

Stop Time
The time the job finished processing.

Completion Date (post-print accounting user-exit only)
The date all pages in the job printed and stacked.

Note: If errors or operator commands affect the job so that all pages are
not sent to the printer, this field indicates the time when these pages have
been printed and stacked.

Completion Time (post-print accounting user-exit only)
The time all pages in the job printed and stacked.

Note: If errors or operator commands affect the job so that all pages are
not sent to the printer, this field indicates the time when these pages have
been printed and stacked.

DORU
The data object resources used (DORU) by the exit.

DOFU
The data object fonts used (DOFU) by the exit.

The input data user-exit program
The InfoPrint Manager input data user-exit program can be used to:
v Monitor the incoming print data stream to InfoPrint Manager
v Discard an input record before it is processed
v Replace an existing input record with one or more records (which might include

the original record or a modified version of the original record)
v Continue processing with the input record unchanged

This exit can be called for all parts of the job (see Figure 1 on page 57).

Note: The input data user-exit program only processes MO:DCA™ data.

If you are using the exit to insert extra input records, the original input record that
is passed to the exit can be processed before or after the extra input records. This
means that the extra input records can be inserted before or after the current
structured field depending on where the current structured field is placed in the
list of structured fields to insert.
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Important considerations

v Code processing becomes an integral part of PSF and can affect performance and
reliability.

v User-exits should be coded by experienced programmers who are aware of overall
system implications.

v Any delays caused by this exit will translate into a PSF processing delay and could
affect printer performance.

v This exit is not passed any structured fields that are contained in resources that are
processed. This includes: form definitions, overlays, page segments, fonts, data object
resources, internal medium maps, and data object fonts.

v Code processing must be able to handle PSF repositioning.

Repositioning can occur as a result of errors or operator commands. PSF can reposition
items forward into the print job, skip structured fields, or reposition items back into
previously processed data. If PSF repositions back into the print file, it is the responsibility
of the exit to return the same data in the same sequence to PSF, just as it did when the
structured field was originally passed to the exit.

Because of the constraints outlined above, you should first consider using the transform
subsystem to process data, because the transform subsystem does not have these
limitations. For example, a transform object would have access to all of the input data (no
restrictions) and could add, delete, and modify both resources and pages. In addition, the
transform subsystem processing is done before printing begins, so it would have no impact
on printer performance or behavior.

The input data user-exit is not capable of identifying individual document boundaries in a
data stream. For example, your job might have 5 separate documents that each contain 10
pages of data. This is viewed by the exit as 50 pages of data, not 5 units of 10. The
transform subsystem does not have this limitation.

The PSF Input Record Exit is responsible for managing any memory it allocates. It
can reuse the memory across calls through the use of a work area pointer provided
in ainuexit.h. PSF does not free any memory that might be pointed to by fields in
either the INDATA_EXITDATA structure or the PSFINSERTRECS structure. The exit can
point to memory that it has defined or allocated. The exit can reuse allocated
memory or free memory when it is appropriate. PSF might run out of memory if
the PSF Input Record Exit mismanages memory.

The source code (in the C programming language) for the sample input data
user-exit program listed on page 57 is in the /usr/lpp/psf/exits/ainuxind.c file. This
sample program consists of a return code and performs no function.

The data structures for the input data user-exit program are included with the
source code in the /usr/lpp/psf/exits/ainuexit.h file.

The declaration of this exit is:
void INDATA (INDATA_EXITDATA *exitdata)

The INDATA_EXITDATA input/output parameter contains all of the input and
output data needed to communicate between InfoPrint Manager and the user-exit
program.

These fields are also found in the input data user-exit:
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version
This variable was formerly called reserved1. It is designed for use as a
migration aid for future variants of this exit. It contains a version identifier
for this structure:
v X’00’= previous version (before August, 2005)
v X’01’= August, 2005 version adding support for deletion and insertion of

input records

Copy Indicates which copy is associated with this call to the exit. Initially set to
1, it increments by one each time the exit is called.

DataSize
Contains the length of the input data record

DataPointer
Points to the input data record to be processed.

DataType
Always set to 0 (AFP; MO:DCA data only).

Notes: If the exit is being called to indicate end of job processing:
v DataSize is set to 0,
v DataPointer is set to NULL
v DataType is set to 0 — no record is passed in at that time

The PSFINSERTRECS structure contains information about a structured field that
is to be inserted at the request of the input data exit. The PSFINSERTRECS
structure contains these fields:

version
Version identifies to PSF the version of the PSFINSERTRECS structure that
is being supplied. The exit must supply a value of 0x01 or the record
(including the next_p pointer) is ignored.

next_p
Contains the pointer to the next record to insert.

record_p
Contains the pointer to the MO:DCA (AFP) structured field to be inserted.

Important:

See more data definitions and comments in the ainuexit.h source file located in
/usr/lpp/psf/exits/.

After you create your input data user-exit program, you must use the AIX make
command to compile the code (see “Compiling and installing the user-exit
program” on page 59).

Note: The input information fields used by some of the sample programs (see
“Common input and output fields” on page 62 for a complete list) are available
through the alternate sample user-exits. InfoPrint Manager does not provide an
alternate input data user-exit.
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The output data user-exit program
The InfoPrint Manager output data user-exit program is used to monitor the
outgoing print data stream from InfoPrint Manager. This exit is called at the end of
the job before the error messages and the trailer page.

The source code (in the C programming language) for the sample output data
user-exit program listed on page 57 is in the /usr/lpp/psf/exits/ainuxout.c file. This
sample program consists of a return and performs no function.

The data structures for the output data user-exit program are included with the
source code in the /usr/lpp/psf/exits/ainuexit.h file. The code for these structures is
shown in “User-exit program structures” on page 62.

The declaration of this exit is:
void OUTDATA (OUTDATA_EXITDATA *exitdata)

The OUTDATA_EXITDATA input/output parameter contains all the input and
output data needed to communicate between InfoPrint Manager and the user-exit
program.

These fields are also found in the output data user-exit program:

Copy Indicates which copy is associated with this call to the exit. Initially set to
1, it increments by one each time the exit is called.

DataSize
Indicates the number of bytes in the buffer.

DataPointer
Points to a buffer containing the outgoing print data stream.

After you create your output data user-exit program, you must use the AIX make
command to compile the code (see “Compiling and installing the user-exit
program” on page 59).

Note: The output information fields used by some of the sample programs (see
“Common input and output fields” on page 62 for a complete list) are available
through the alternate sample user-exits. InfoPrint Manager does not provide an
alternate Output Data user-exit.

User-exit programs for the line-data transform
InfoPrint Manager provides several sample user-exit programs for the line-data
transform. Use of the user-exits is optional. You specify the names of the exit
programs with the inpexit, indxexit, outexit, and resexit keywords. Each of these
keywords is described in the InfoPrint Manager: Reference.

InfoPrint Manager provides these sample programs:

/usr/lpp/psf/acif/apkinp.c
Input-record user-exit

/usr/lpp/psf/acif/apkout.c
Output-record user-exit

/usr/lpp/psf/acif/apkres.c
Resource exit
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In addition, InfoPrint Manager provides these input-record user-exits programs to
translate input data streams:

/usr/lpp/psf/acif/apka2e.c
Converts ASCII stream data to EBCDIC stream data.

/usr/lpp/psf/acif/asciinp.c
Converts unformatted ASCII data that contains carriage returns and form feeds
into a record format that contains an American National Standards Institute
(ANSI) carriage control character. This exit encodes the ANSI carriage control
character in byte 0 of every record.

/usr/lpp/psf/acif/asciinpe.c
Converts unformatted ASCII data into a record format as does asciinp.c, and
then converts the ASCII stream data to EBCDIC stream data.

The C language header file for all ACIF exit programs is provided in
/usr/lpp/psf/acif/apkexits.h along with the build rules for the ACIF user-exits in
/usr/lpp/psf/acif/Makefile

For more information about compiling user-exit programs, see “Compiling and
installing the user-exit program” on page 59.

Input record exit
The line-data transform provides an exit that enables you to add, delete, or modify
records in the line-data input file. The program invoked at this exit is defined by
the value of the inpexit keyword of the line2afp command.

This exit is called after each record is read from the input file. The exit can request
that the record be discarded, processed, or processed with control returned to the
exit for the next input record. The largest record that InfoPrint Manager can
process is 32756 bytes. This exit is not called when the line-data transform is
processing resources from directories.

Figure 2 contains a sample C language header that describes the control block that
is passed to the exit program.

The address of the control block containing these parameters is passed to the input
record exit:

work (Bytes 1–4)
A pointer to a static, 16-byte memory block. The exit program can use this

/*********************************************************************/
/* INPEXIT STRUCTURE */
/*********************************************************************/
typedef struct _INPEXIT_PARMS /* Parameters for input record exit */
{

char *work; /* Address of 16-byte static work area */
PFATTR *pfattr; /* Address of print file attribute info*/
char *record; /* Address of the input record */
unsigned short in_CCSID; /* input CCSID for translating @06a*/
unsigned short out_CCSID; /* output CCSID for translating @06a*/
unsigned short recordln; /* Length of the input record */
unsigned short reserved2; /* Reserved for future use */
char request; /* Add, delete, or process the record */
char eof; /* EOF indicator */

} INPEXIT_PARMS;

Figure 2. Sample input record exit C language header
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parameter to save information across calls (for example, pointers to work
areas). The 16-byte work area is aligned on a full word boundary and is
initialized to binary zeros before the first call. The user-written exit program
must provide the code required to manage this work area.

pfattr (Bytes 5–8)
A pointer to the print file attribute data structure. See “Attributes of the
line-data input file” on page 80 for more information about the format of this
data structure and the information it contains.

record (Bytes 9–12)
A pointer to the first byte of the input record including the carriage control
character. The record is located in a buffer that is located in storage allocated
by the line-data transform but the exit program is allowed to modify the input
record.

in_CCSID (Bytes 13-14)
The value from the INPCCSID parameter on the line2afp command.

out_CCSID (Bytes 15-16)
The value from the OUTCCSID parameter on the line2afp command.

recordln (Bytes 17–18)
Specifies the number of bytes (length) of the input record. If the input record is
modified, this parameter must also be updated to reflect the actual length of
the record. If recordln is 0 when the exit program returns, line2afp will
terminate with a return code of 99.

reserved2 (Bytes 19–20)
These bytes are reserved for future use.

request (Byte 21)
Specifies how the line-data transform processes the record. On entry to the exit
program, this parameter is X’00’. When the exit program returns control to
line-data transform, this parameter must have the value X’00’, X’01’, or X’02’,
where:

X’00’ Specifies that the line-data transform should process the record.

X’01’ Specifies that the line-data transform should not process the record.

X’02’ Specifies that the line-data transform should process the record and
then return control to the exit program to allow it to insert the next
record. The exit program can set this value to save the current record,
insert a record, and then supply the saved record at the next call. After
the exit inserts the last record, the exit program must reset the request
byte to X’00’.

A value of X’00’ on entry to the exit program specifies that the record be
processed. If you want to ignore the record, change the request byte value to
X’01’. If you want the record to be processed and you want to insert an
additional record, change the request byte value to X’02’. Any value greater
than X’02’ is interpreted as X’00’, and the exit processes the record.

Note: Only one record can reside in the buffer at any time.

eof (Byte 22)
An end-of-file (eof) indicator. This indicator is a one-byte character code that
specifies whether an eof condition has been encountered.

When eof is signaled (eof value=‘Y’), the last record has already been
presented to the input exit, and the input file has been closed. The pointer
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record is no longer valid. Records cannot be inserted when eof is signaled.
These are the only valid values for this parameter:

Y Specifies that eof has been encountered.

N Specifies that eof has not been encountered.

This end-of-file indicator allows the exit program to do some additional
processing at the end of the file. The exit program cannot change this
parameter.

Using the line-data transform user input record exits
apka2e

The apka2e input-record exit program translates data that is encoded in
one code character set (CCSID) to another. You should use this exit when
your job uses fonts such as GT12, which has code points that are different
from your data file. The default translation is from ASCII (code set 00850)
to EBCDIC (code set 00037) if the INPCCSID and OUTCCSID parameters
are not specified on the line2afp command. INPCCSID specifies the input
code page, and OUTCCSID specifies the output code page.

To execute the apka2e input record exit program, set the following
keywords and values in your line-data transform keyword file. The
line2afp parmdd keyword identifies the keyword file.
inpexit=/usr/lpp/psf/bin/apka2e
cc=yes
cctype=z

asciinp
The asciinp input-record exit program transforms an ASCII data stream
into a record format that contains a carriage control character in byte 0 of
every record. If byte 0 of the input record is an ASCII carriage return
(X’0D’), byte 0 is transformed into an ASCII space (X’20’) that causes a data
stream to return and advance one line; no character is inserted. If byte 0 of
the input record is an ASCII form feed character (X’0C’), byte 0 is
transformed into an ANSI skip to channel 1 command (X’31’) that serves as
a form feed in the carriage-control byte.

To execute the asciinp input record exit program, set the following
keywords in your line-data transform keyword file. The line2afp parmdd
keyword identifies the keyword file:
inpexit=/usr/lpp/psf/bin/asciinp
cc=yes
cctype=z

asciinpe
The asciinpe input-record exit program translates data that is encoded in
one code character set (CCSID) to another. You should use this exit when
your job uses fonts such as GT12, which has code points that are different
from your data file. The default translation is from ASCII (code set 00850)
to EBCDIC (code set 00037) if the INPCCSID and OUTCCSID parameters
are not specified on the line2afp command. INPCCSID specifies the input
code page, and OUTCCSID specifies the output code page.

While the asciinp and asciinpe input-record exits do not recognize other
ASCII printer commands, you can modify these exits to account for these:
v backspacing (X’08’)
v horizontal tabs (X’09’)
v vertical tabs (X’0B’)
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For more information about using and modifying these programs, see the prologue
of the asciinp.c source file that is provided with InfoPrint Manager in the
/usr/lpp/psf/acif directory.

Output record exit
Using the output-record exit, you can modify or ignore the records the line-data
transform writes into the output file. The program invoked at this exit is defined
by the outexit keyword of the line2afp command.

The exit receives control before a record (structured field) is written to the output
document file. The exit can request that the record be ignored or processed. The
largest record that the exit can process is 32752 bytes, not including the record
descriptor word. The exit is not called when the line-data transform is processing
resources.

Figure 3 contains a sample C language header that describes the control block
passed to the exit program.

The address of the control block containing these parameters is passed to the
output record exit:

work (Bytes 1–4)
A pointer to a static, 16-byte memory block. The exit program can use this
parameter to save information across calls (for example, pointers to work
areas). The 16-byte work area is aligned on a full word boundary and is
initialized to binary zeros before the first call. A user-written exit program
must provide the code required to manage this work area.

pfattr (Bytes 5–8)
A pointer to the print file attribute data structure. See “Attributes of the
line-data input file” on page 80 for more information about the format of this
data structure and the information it contains.

record (Bytes 9–12)
A pointer to the first byte of the output record. The record is located in a 32KB
(where KB equals 1024 bytes) buffer. The buffer is located in storage allocated
by the line-data transform, but the exit program is allowed to modify the
output record.

recordln (Bytes 13–14)
Specifies the length, in bytes, of the output record. If the output record is
modified, this parameter must also be updated to reflect the actual length of
the record.

request (Byte 15)
Specifies how the line-data transform processes the record. On entry to the exit
program, this parameter is X’00’. When the exit program returns control to the
line-data transform, this parameter must have the value X’00’ or X’01’, where:

typedef struct _OUTEXIT_PARMS /* Parameters for resource record exit */
{

char *work; /* Address of 16-byte static work area */
PFATTR *pfattr; /* Address of print file attribute information */
char *record; /* Address of the record to be written */
unsigned short recordln; /* Length of the output record */
char request; /* Delete or process the record */
char eof; /* Last call indicator */
}OUTEXIT_PARMS;

Figure 3. Sample output record exit C language header
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X’00’ Specifies that the line-data transform should process the record.

X’01’ Specifies that the line-data transform should ignore the record.

A value of X’00’ on entry to the exit program specifies that the record be
processed. If you want to ignore the record, change the request byte value to
X’01’. Any value greater than X’01’ is interpreted as X’00’; the exit processes
the record.

Note: Only one record can reside in the buffer at any time.

eof (Byte 16)
An end-of-file (eof) indicator. This indicator is a one-byte character code that
signals when the line-data transform has finished writing the output file.

When eof is signaled (eof value=‘Y’), the last record has already been
presented to the output exit. The pointer record is no longer valid. Records
cannot be inserted after eof is signaled. These are the only valid values for this
parameter:

Y Specifies that the last record has been written.

N Specifies that the last record has not been written.

This end-of-file flag, used as a last-call indicator, allows the exit program to
return control to the line-data transform. The exit program cannot change this
parameter.

Resource exit
The line-data transform provides an exit that enables you to “filter” (exclude)
resources. This exit is useful in controlling resources at the file-name level. For
example, assume you only wanted to use those fonts that are not shipped with
InfoPrint Manager. You could code this exit program to contain a table of all fonts
shipped with InfoPrint Manager and filter those from the resource file. Security is
another consideration for using this exit because you could prevent certain named
resources from being included. The program invoked at this exit is defined by the
resexit keyword of the line2afp command.

This exit receives control before a resource is read from a directory. The exit
program can request that the resource be processed or ignored (skipped), but it
cannot substitute another resource name in place of the requested one. If the exit
requests that any overlay be ignored, the line-data transform automatically ignores
any resources the overlay might have referenced (that is, fonts and page segments).

Figure 4 on page 79 contains a sample C language header that describes the control
block that is passed to the exit program.
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The address of the control block containing these parameters is passed to the
resource-record exit:

work (Bytes 1–4)
A pointer to a static, 16-byte memory block. The exit program can use this
parameter to save information across calls (for example, pointers to work
areas). The 16-byte work area is aligned on a full word boundary and is
initialized to binary zeros before the first call. A user-written exit program
must provide the code required to manage this work area.

pfattr (Bytes 5–8)
A pointer to the print file attribute data structure. See “Attributes of the
line-data input file” on page 80 for more information about the format of this
data structure and the information presented.

resname (Bytes 9–16)
Specifies the name of the requested resource. The exit program cannot modify
or change this value.

restype (Byte 17)
Specifies the type of resource the name refers to. This is a one-byte
hexadecimal value where:

X’03’ Specifies a GOCA (graphics) object

X’05’ Specifies a BCOCA (barcode) object

X’06’ Specifies an IOCA (IO image) object

X’40’ Specifies a font character set

X’41’ Specifies a code page

X’FB’ Specifies a page segment

X’FC’ Specifies an overlay

The line-data transform does not call this exit for these resource types:
v Page definition

The page definition (pagedef keyword) is a required resource for
transforming a line-data file.

v Form definition
The form definition (formdef keyword) is a required resource for printing a
transformed line-data file.

v Coded fonts

/*********************************************************************/
/* RESEXIT STRUCTURE */
/*********************************************************************/
typedef struct _RESEXIT_PARMS /* Parameters for resource record exit */
{

char *work; /* Address of 16-byte static work area */
PFATTR *pfattr; /* Address of print file attribute info*/
char resname[8]; /* Name of requested resource (8 byte) */
char restype; /* Type of resource */
char request; /* Ignore or process the resource */
char eof; /* Last call indicator */
unsigned short resnamel; /* Length of resource name @05A*/
char pad1[3]; /* padding byte @05A*/
char resnamf[250]; /* Rsrc name if more than 8 bytes@05A*/

} RESEXIT_PARMS;

Figure 4. Sample resource exit C language header
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The line-data transform must process coded fonts to determine the names of
the code pages and font character sets they reference. This is necessary in
creating Map Coded Font-2 (MCF-2) structured fields.

request (Byte 18)
Specifies how the line-data transform processes the resource. On entry to the
exit program, this parameter is X’00’. When the exit program returns control to
the line-data transform, this parameter must have the value X’00’ or X’01’
where:

X’00’ Specifies that the line-data transform should process the resource.

X’01’ Specifies that the line-data transform should ignore the resource.

A value of X’00’ on entry to the exit program specifies that the resource be
processed. If you want to ignore the resource, change the request byte value to
X’01’. Any value greater than X’01’ is interpreted as X’00’ and the resource is
processed.

resnamel
Specifies the length of the meaningful characters in the resnamef field.

pad1
A padding byte to get the resnamef on a word boundary.

resnamef
The actual name of the resource if it is greater then 8 characters in length. If
the name is 8 characters or less in length, the name is stored in the resname
field instead.

eof (Byte 19)
An end-of-file (eof) indicator. This indicator is a one-byte character code that
signals when the line-data transform has written the last record.

When eof is signaled (eof value = ‘Y’), the last record has already been
presented to the resource exit. The pointer record is no longer valid. Records
may not be inserted after eof is signaled. These are the only valid values for
this parameter:

Y Specifies that the last record has been written.

N Specifies that the last record has not been written.

This end-of-file flag, used as a last-call indicator, returns control to the
line-data transform. The exit program cannot change this parameter.

Non-zero return codes
If the line-data transform receives a non-zero return code from any exit program,
the line-data transform issues message 0425-412 and terminates processing.

Attributes of the line-data input file

Note: This data structure is provided for informational purposes only.

The line-data transform provides information about the attributes of the line-data
input file in a data structure available to the line-data transform user-exits. Figure 5
on page 81 shows the format of this data structure.
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The address of the control block containing these parameters is passed to the
user-exits:

cc (Bytes 1–3)
The value of the cc keyword as specified with the line2afp command. The
line-data transform uses the default value, yes, if this keyword is not explicitly
specified.

cctype (Byte 4)
The value of the cctype keyword as specified with the line2afp command. The
line-data transform uses the default value, z for ANSI carriage-control
characters that is encoded in ASCII, if this keyword is not explicitly specified.

chars (Bytes 5–24)
The value of the chars keyword as specified with the line2afp command,
including any commas that separate multiple font specifications. Because the
chars keyword has no default value, this field contains blanks if no values are
specified.

formdef (Bytes 25–32)
The value of the formdef keyword as specified with the line2afp command.
Because the formdef keyword has no default value, this field contains blanks if
no value is specified.

pagedef (Bytes 33–40)
The value of the pagedef keyword as specified with the line2afp command.
Because the pagedef keyword has no default value, this field contains blanks if
no value is specified.

prmode (Bytes 41–48)
The value of the prmode keyword as specified with the line2afp command.
Because the prmode keyword has no default value, this field contains blanks if
no value is specified.

trc (Bytes 49–51)
The value of the trc keyword as specified with the line2afp command. The
line-data transform uses the default value, no, if this keyword is not explicitly
specified.

typedef struct _PFATTR /* Print File Attributes */
{

char cc[3]; /* Carriage controls? - "YES" or "NO " */
char cctype[1]; /* Carriage control type - A(ANSI), M(Machine), Z(ASCII) */
char chars[20]; /* CHARS values, including commas (eg. GT12,GT15) */
char formdef[8]; /* Form Definition (FORMDEF) */
char pagedef[8]; /* Page Definition (PAGEDEF) */
char prmode[8]; /* Processing mode */
char trc[3]; /* Table Reference Characters - "YES" or "NO " */

} PFATTR;

Figure 5. Sample print file attributes C language header
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Chapter 7. Creating and managing auxiliary sheets and
user-exit programs

Besides logical destinations, queues, and actual destinations, the InfoPrint server
also controls auxiliary-sheet objects. This section contains information and
procedures for creating and configuring these objects.

Preparing to work with auxiliary sheets
These sections describe auxiliary-sheet terms, default auxiliary sheets, and user-exit
programs supplied by InfoPrint and provide examples of printed auxiliary sheets.

Terms relating to auxiliary sheets

To understand auxiliary sheets and how InfoPrint generates the information that
appears on them, you need to understand these terms:

Auxiliary sheet
Represents a particular sheet of paper, blank or otherwise, that can precede
a job, separate documents in a job, or follow the job. PSF and AIX actual
destinations print auxiliary sheets.

Auxiliary-sheet object
Represents a set of user-exit programs that you can specify for InfoPrint
PSF, generalized fax, and E-mail actual destinations. User-exit programs
process information that can be printed on an auxiliary sheet or recorded
in an accounting or audit log. Both the actual destination and the
auxiliary-sheet objects must reside in the same InfoPrint server.

Note: AIX actual destinations print auxiliary sheets, but they do not
support auxiliary-sheet objects. Generalized fax and email destinations
support the input-data and output-data auxiliary-sheet objects, but they do
not send auxiliary sheets.

Two auxiliary-sheet styles supplied with InfoPrint generate a file that you
can use with an executable reporting utility to view job statistics. See
Chapter 8, “Gathering accounting and auditing data about print jobs,” on
page 97 for more information about viewing statistics.

Auxiliary-sheet object name
Identifies the auxiliary sheet. The names of some of the default auxiliary
sheets indicate the style of the auxiliary sheet: brief, full, or blank.

User exit
A point during InfoPrint processing that lets you run a user-exit program
and return control of processing to InfoPrint after the user-exit program
ends. InfoPrint provides data at each exit point that can serve as input to
the user-exit program. InfoPrint can use the output from the user-exit
program for InfoPrint processing; for example, a user-exit program can
pass instructions about how to format a start sheet to InfoPrint. InfoPrint
provides user exits for these InfoPrint auxiliary-sheet objects:
v Start sheet
v End sheet
v Separator sheet
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v Accounting log
v Accounting sheet
v Audit log
v Audit sheet
v Input data stream
v Output data stream
v Post-print accounting (log file only)

Note: Generalized fax and e-mail destinations support only the log, input
data stream, and output data stream user exits.

See “Sequence of user-exit programs” on page 89 for more information
about user exits and user-exit programs.

User-exit program
Defines the data that prints and creates the format of the auxiliary sheet
style. InfoPrint extends its function by providing user-exit programs that
you can use to format start, end, or separator sheets for the job, track
accounting and audit information, or extract information about the
incoming and outgoing job data streams.

Form definition
Defines the characteristics of the form or printed media, which includes:
overlays used, the paper source (for cut-sheet printers), duplex printing,
text suppression, fonts, and the position of composed-text data on the
form.

See InfoPrint Manager: Reference for more information about form and page
definitions.

Edge marks
Marks that print at the edges of auxiliary sheets and help to identify job
boundaries in printed output.

Interrupt Message Pages
IMPs are pages that are similar to the message pages that print at the end
of a print job, but IMPs are printed at the point of an error where a
possible data loss has occurred. See “Using Interrupt Message Pages” on
page 93 for more information.

InfoPrint default auxiliary-sheet objects

InfoPrint Manager provides default auxiliary-sheet objects which it creates when
you first create a server. InfoPrint Manager automatically identifies these as
supported values for PSF actual destinations. The default auxiliary-sheet objects
with their associated user-exit programs and form definitions are shown in Table 8.

Table 8. Default auxiliary sheet objects

Auxiliary
sheet object

Form
definition

Description User exit
program

Additional Information

none n/a InfoPrint
generates no
auxiliary
sheet.

n/a n/a
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Table 8. Default auxiliary sheet objects (continued)

Auxiliary
sheet object

Form
definition

Description User exit
program

Additional Information

brief F1A10110 Start sheet ainuxhdr

Separator
sheet

ainuxsep

End sheet ainuxtlr

Accounting
exit

ainuxacc

Audit exit ainuxaud

full F1A10110 Start sheet ainuxhdr2

Separator
sheet

ainuxsep2

End sheet ainuxtlr2

Accounting
exit

ainuxacc2

Audit exit ainuxaud2

blank F1A10110 Start sheet pduxblkh Blank sheet of paper

Separator
sheet

pduxblks

End sheet pduxblkt

accounting-
log

n/a Accounting
exit

ainacclog Writes accounting information to
the /var/psf/ accounting.log file.
Does not produce a printed sheet.

Audit exit ainaudlog Writes audit information to the
/var/psf/ audit.log file. Does

not produce a printed sheet.

Post-print
accounting
exit

ainuxjob
completion

Writes post-print accounting
information to the /var/psf/
jobcompletion.log file if the
auxiliary sheet object’s
psf-post-print-accounting-program-
name is set to ainuxjobcompletion.
Does not produce a printed sheet.

job-ticket n/a Start sheet ainuxhdrp

Separator
sheet

ainuxsepp

End sheet ainuxtlrp

Accounting
exit

ainuxaccp Writes accounting information to
the /var/psf/ podaccount.log
Does not produce a printed sheet.

Audit exit ainuxaudp

64xx, 65xx
printers

F1A10110 Start sheet ainuxhdrx

Separator
sheet

ainuxsepx

End sheet ainuxtlrx
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You can create your own auxiliary-sheet styles using the InfoPrint pdcreate
command on the AIX command line. See “Creating new auxiliary-sheet objects
using the pdcreate command” on page 91 for the procedure.

Examples of Brief-Style and Full-Style Auxiliary Sheets
These examples of auxiliary-sheet printouts were produced using the InfoPrint
brief and full default auxiliary-sheet objects.

Start Sheet Examples
In Figure 6, the user-exit program ainuxhdr generated the brief style of the start
sheet and user-exit program ainuxhdr2 generated the full style of the start sheet.

Separator Sheet Examples
In Figure 7 on page 87, the user-exit program ainuxsep generated the brief style of
the separator sheet and user-exit program ainuxsep2 generated the full style of the
separator sheet.
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Figure 6. Brief and Full Styles of Start Sheets
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End Sheet Examples
In Figure 8, the user-exit program ainuxtlr generated the brief style of the end
sheet and user-exit program ainuxtlr2 generated the full style of the end sheet.

Accounting Sheet Examples
In Figure 9 on page 88, the user-exit program ainuxacc generated the brief style of
the accounting-log sheet and user-exit program ainuxacc2 generated the full style
of the accounting-log sheet.
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Figure 7. Brief and Full Styles of Separator Sheets
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Figure 8. Brief and Full Styles of End Sheets
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Audit Sheet Examples
In Figure 10 on page 89, the user-exit program ainuxaud generated the brief style
of the audit sheet and the user-exit program ainuxaud2 generated the full style of
the audit sheet.

IP
R

W
A

U
X

A
U

N a m e =

S u p p l i e d U s e r i d =

S u p p l i e d N o d e i d =

A d d r e s s 1 =

A d d r e s s 2 =

A d d r e s s 3 =

A d d r e s s 4 =

A c c o u n t =

B u i l d i n g =

D e p a r t m e n t =

P r o g r a m m e r =

R o o m =

T i t l e =

S e g m e n t i d =

C l a s s =

F o r m s =

D e s t i n a t i o n =

P a s s t h r u =

E x t e n d e d S p o o l I D =

A C C O U N T I N G :

S y s t e m U s e r I D = r o o t

S y s t e m N o d e I D = s t a r w a r s

J o b N a m e = / i n f o / a f p / t w o p a g e . a f p

S p o o l I D = 1 3 6 7

P r i n t e r N a m e = p s f 4 3 1 7

P a g e s P r i n t e d = 3

B i n O n e S h e e t s = 3

B i n T w o S h e e t s = 0

F o n t s U s e d = 2

R e s i d e n t F o n t s U s e d = 0

O v e r l a y s U s e d = 0

H a r d S e g m e n t s U s e d = 0

S o f t S e g m e n t s U s e d = 0

D a t a O b j e c t R e s o u r c e s U s e d = 0

S t a r t D a t e = 1 1 / 0 1 / 2 0 0 0

S t a r t T i m e = 1 4 : 5 1 : 4 6

E n d D a t e = 1 1 / 0 1 / 2 0 0 0

E n d T i m e = 1 4 : 5 1 : 4 8

F i l e D a t e = 0 5 / 0 5 / 2 0 0 0

F i l e T i m e = 0 7 : 5 9 : 1 3

A C C O U N T I N G :

U s e r I D = r o o t

N o d e I D = s t a r w a r s

J o b N a m e = / i n f o / a f p / t w o p a g e . a f p

S p o o l I D = 1 3 6 6

P r i n t e r N a m e = p s f 4 3 1 7

P a g e s P r i n t e d = 3

B i n O n e S h e e t s = 3

B i n T w o S h e e t s = 0

F o n t s U s e d = 2

R e s i d e n t F o n t s U s e d = 0

O v e r l a y s U s e d = 0

H a r d S e g m e n t s U s e d = 0

S o f t S e g m e n t s U s e d = 0

D a t a O b j e c t R e s o u r c e s = 0

S t a r t D a t e = 1 1 / 0 1 / 2 0 0 0

S t a r t T i m e = 1 4 : 5 0 : 1 4

E n d D a t e = 1 1 / 0 1 / 2 0 0 0

E n d T i m e = 1 4 : 5 0 : 1 5

F i l e D a t e = 0 5 / 0 5 / 2 0 0 0

F i l e T i m e = 0 7 : 5 9 : 1 3

E x t e n d e d S p o o l I D =

Figure 9. Brief and Full Styles of Accounting-Log Sheets
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Sequence of user-exit programs
Figure 11 shows the order in which InfoPrint calls the user-exit programs during
job processing. You cannot change this order.

Note: Separator sheets are printed only between copies of a job, not between
documents in a job.

Directory locations of user-exit programs supplied with
InfoPrint

When you create the auxiliary-sheet object, you specify the name of the user-exit
program and other options, such as the form definition, if the program produces
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Figure 10. Brief and Full Styles of Audit Sheets
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printed output. You identify which auxiliary-sheet objects you want associated
with each actual destination using the InfoPrint Manager Administration Interface
attributes notebook for each actual destination. InfoPrint loads the user-exit
programs that are called out into memory and runs the programs when you
submit a job to that printer.

Table 9 shows the sample executable user-exit programs that InfoPrint supplies.

Table 9. User-exit programs

Program Description

Start Sheets

/usr/lpp/psf/bin/pduxblkh Prints a blank start sheet.

/usr/lpp/psf/bin/ainuxhdr Prints a brief-style start sheet.

/usr/lpp/psf/bin/ainuxhdr2 Prints a full-style start sheet.

/usr/lpp/psf/bin/ainuxhdrp Prints job ticket information about the start
sheet.

/usr/lpp/psf/bin/ainuxhdrx Prints a start sheet without vertical lines for
64xx & 65xx printers.

Separator Sheets

/usr/lpp/psf/bin/pduxblks Prints a blank separator sheet.

/usr/lpp/psf/bin/ainuxsep Prints a brief-style separator sheet.

/usr/lpp/psf/bin/ainuxsep2 Prints a full-style separator sheet.

/usr/lpp/psf/bin/ainuxsepp Prints job ticket information about the
separator sheet.

/usr/lpp/psf/bin/ainuxsepx Prints a separator sheet without vertical
lines for 64xx & 65xx printers.

End Sheets

/usr/lpp/psf/bin/pduxblkt Prints a blank end sheet.

/usr/lpp/psf/bin/ainuxtlr Prints a brief-style end sheet.

/usr/lpp/psf/bin/ainuxtlr2 Prints a full-style end sheet.

/usr/lpp/psf/bin/ainuxtlrp Prints job ticket information about the end
sheet.

/usr/lpp/psf/bin/ainuxtlrx Prints an end sheet without vertical lines for
64xx & 65xx printers.

Accounting

/usr/lpp/psf/bin/ainuxacc Prints a brief-style accounting sheet.

/usr/lpp/psf/bin/ainuxacc2 Prints a full-style accounting sheet.

/usr/lpp/psf/bin/ainuxaccp Writes accounting information to
/var/psf/podaccount.log.

/usr/lpp/psf/bin/ainacclog Writes accounting information to
/var/psf/accounting.log.

Post-print Accounting

/usr/lpp/psf/bin/ainuxjobcompletion Writes accounting information to
/var/psf/jobcompletion.log.

Audit

/usr/lpp/psf/bin/ainuxaud Prints a brief-style audit sheet.

/usr/lpp/psf/bin/ainuxaud2 Prints a full-style audit sheet.
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Table 9. User-exit programs (continued)

Program Description

/usr/lpp/psf/bin/ainuxaudp Prints job ticket information about the audit
sheet.

/usr/lpp/psf/bin/ainaudlog Writes accounting information to
/var/psf/audit.log.

Input Data

/usr/lpp/psf/bin/ainuxind Performs no tasks; use it as a model for
writing your own user exit program.

Output Data

/usr/lpp/psf/bin/ainuxout Performs no tasks; use it as a model for
writing your own user exit program.

In addition, you can use the source code of the sample user-exit programs to write
your own user-exit programs. InfoPrint provides the source code in the
usr/lpp/psf/exits directory.

Creating and configuring auxiliary-sheet objects (PSF, Generalized Fax,
and Email DSS only)

When you first create a server, InfoPrint creates the default auxiliary-sheet objects
described in “InfoPrint default auxiliary-sheet objects” on page 84. The following
topics describe how you can create and configure auxiliary-sheet objects.

Creating new auxiliary-sheet objects using the pdcreate
command

Create auxiliary-sheet objects from the AIX command line; you cannot create them
through the InfoPrint Manager Administration Interface. Use -c auxiliary-sheet
with the pdcreate command and specify the server name and an auxiliary-sheet
object name to create a new auxiliary-sheet object. Specify a name that uniquely
identifies the auxiliary-sheet object in the server. Two servers can each contain an
auxiliary-sheet object with the same name, but possibly with different values for
their attributes.

You also specify the psf-exit-form-definition, psf-exit-page-mark, and
psf-exit-program-name attributes with the command to specify the form definition,
whether edge marks print, and the user-exit program used.

For example, to create an auxiliary-sheet object named custom-start contained in
Server1 that specifies the ainuxhdr user-exit program, the F1A10110 form definition,
and includes edge marks, enter the command:
pdcreate -c auxiliary-sheet -x "psf-exit-program-name=ainuxhdr

psf-exit-form-definition=F1A10110 psf-exit-page-mark=true"
Server1:custom-start

Refer to ″Attributes for Auxiliary Sheet Objects″ in the ″Attributes for
auxiliary-sheet objects″ chapter of InfoPrint Manager: Reference for more information.

Associating auxiliary-sheet objects with PSF printers

Use the InfoPrint Manager Administration Interface to associate auxiliary sheet
objects with PSF printers. Start the InfoPrint Manager Administration Interface and
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select the printer that you want to associate with an auxiliary sheet. Then, click
Printer → Properties to open the Printer Properties notebook. To complete this task,
see the online help in the InfoPrint Manager Administration Interface, starting
with the topic Using auxiliary-sheet objects.

Associating auxiliary sheets for accounting or audit
information

You can use the InfoPrint Manager Administration Interface to specify auxiliary
sheet objects to collect accounting and audit information about jobs processed (as
opposed to printed) by a selected PSF printer. Start the InfoPrint Manager
Administration Interface and select the printer that you want to associate with an
auxiliary sheet. Then, click Printer → Properties to open the Printer Properties
notebook. To complete this task, see the online help in the InfoPrint Manager
Administration Interface, starting with the topic Using auxiliary-sheet objects.

To activate the accounting user-exit program , specify one of the accounting
user-exit programs names as the value for the psf-exit-program-name (for example,
psf-exit-program-name=ainacclog) in the auxiliary sheet object associated with the
destination. To activate the audit user-exit program, specify one of the audit
user-exit program names as the value for the psf-exit-program-name (for example,
psf-exit-program-name=ainaudlog) in the auxiliary sheet object associated with the
destination.

Each PSF actual destination can have one, both, or neither or the two accounting
methods (accounting and post-print accounting) active. If the accounting setup is
intended to be the same for all PSF printers, this can all be done with one auxiliary
sheet object, which can either be one you have created or the default
accounting-log auxiliary sheet object supplied by InfoPrint.

Associating the post-print accounting user-exit program with
an actual destination

You can use the InfoPrint Manager Administration Interface to specify auxiliary
sheets to collect post-print accounting information about jobs processed (as
opposed to printed) by a selected PSF printer. Start the InfoPrint Manager
Administration Interface and select the printer that you want to associate with an
auxiliary sheet. Then, click Printer → Properties to open the Printer Properties
notebook. To complete this task, see the online help in the InfoPrint Manager
Administration Interface, starting with the topic Using auxiliary-sheet objects. Then
set the attribute of the auxiliary sheet object using the command shown in
“Activating the user-exit program” on page 61.

To activate the post-print accounting exit program, specify psf-post-print-
accounting-program-name=ainuxjobcompletion in the auxiliary sheet object
associated with the destination.

Each PSF printer actual destination can have one, both, or neither of the two
accounting methods (accounting and post-print accounting) active. If the
accounting setup is intended to be the same for all PSF printers, this can all be
done with one auxiliary sheet object, which can either be one you have created or
the default accounting-log auxiliary sheet object supplied by InfoPrint.
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Associating an input data user-exit program with an actual
destination

You can use the input data user-exit program to monitor the contents of the data
stream coming into InfoPrint Manager from the InfoPrint Manager
Administration Interface. Start theInfoPrint Manager Administration Interface and
select the printer that you want to associate with an auxiliary sheet. Then, click
Printer → Properties to open the Printer Properties notebook. To complete this task,
see the online help in the InfoPrint Manager Administration Interface, starting
with the topic Using auxiliary-sheet objects.

Associating an output data user-exit program with an actual
destination

You can use the output data user-exit program to monitor the contents of the data
stream created by InfoPrint from the InfoPrint Manager Administration Interface.
Start the InfoPrint Manager Administration Interface and select the printer that you
want to associate with an auxiliary sheet. Then, click Printer → Properties to open
the Printer Properties notebook. To complete this task, see the online help in the
InfoPrint Manager Administration Interface, starting with the topic Using
auxiliary-sheet objects.

Using Interrupt Message Pages
Interrupt Message Pages (IMPs) provide a way for printer operators to find the
cause and location of a printing problem. IMPs are pages that are similar to the
message pages that print at the end of a print job, but IMPs are printed at the
point of an error where a possible data loss has occurred. This will allow the
operators to make sure that no data is missing, or to compensate for issues during
the post-processing phase of the print job.

IMPs are for use with PSF TCP/IP attached printers using the PSF DSS or the
Distributed Print Function (DPF). They are associated with an Actual Destination
(AD), and cannot be changed for each job. IMPs do not work with other PSF
attachment types. IMPs and finishing processes are incompatible and we do not
recommend combining these functions.

Scenario/Condition Produce interrupt message page?

Pause/Resume job Yes

Pause/Resume printer No

AD shutdown - Synchronous (same as pause job) Yes

AD shutdown - Now (stop as soon as possible) No

Recoverable data and hardware exceptions
(including paper jams, pre-/post-processor exceptions)

Yes

Back/Forward spacing Yes

Back/Forward spacing with no pages committed No

Print a page range No

Cancel job
- Pdrm/pddelete
- Cancel button on the printer

No
Yes
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Scenario/Condition Produce interrupt message page?

Stop button on the printer No - on ready/not ready

Communication lost No

Activating IMPs

Follow this procedure to enable a printer to produce IMPs:
1. Open the InfoPrint Manager Administration GUI.
2. Right-click the printer that you want to enable and select Properties. The

properties notebook will open for that printer.
3. Click Auxiliary/Separator Sheets.
4. Click Yes next to Activate interrupt message page.
5. If you want to use a form definition that is different than the default, enter the

name of the definition in the Interrupt message page form definition entry
field.

6. If you want to use page marks, click Yes next to Interrupt message page edge
marks. The Interrupt message page edge marks setting prints a mark on the
edge of the forms so that the mark is visible in a stack of paper when viewed
from the side. Continuous forms printers that are folding the forms will print
the mark where the fold in the pages occurs.

IMPs have a default message page form definition that is already assigned and is
designed to print on all paper sizes. This form definition is named F1MG0110, and
has these default settings:
v One copy
v No overlay
v Use paper from bin 1

There is also a new form definition named F1MGIMP that is identical to the default
form definition, except that it specifies offset stacking.

You can create your own form definition, but be aware that doing so might alter
the ability of your form definition to print on all paper sizes. To create a form
definition, you must use the Page Printer Formatting Aid (PPFA) feature. See the
InfoPrint Page Printer Formatting Aid: User’s Guide, S550-0801 for more information.

If you are creating your own form definition and wish to use offset stacking, you
can use PPFA and specify JOG YES in the form definition.

Allowing the auxiliary-sheet-selection job attribute with the BSD DSS

BSD actual destinations do not generate auxiliary sheets. The system where the
printer device is attached can create auxiliary sheets, but you cannot control them
using InfoPrint Manager attributes. For example, an auxiliary sheet, such as a
header sheet, could be printed if the job was sent to a remote queue that is actually
printing auxiliary sheets.

BSD actual destinations do not support the auxiliary-sheet-selection attribute.
Many print command options generate an auxiliary-sheet-selection attribute, and
the BSD actual destinations will reject these jobs. Some examples for the AIX client
follow:
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Command Action

qprt -Pbsdld -Bnn file Sets auxiliary-sheet-selection=none in the job.

lpr -Pbsdld file Sets auxiliary-sheet-selection=start in the job.

lpr -Pbsdld -h file Sets auxiliary-sheet-selection=none in the job.

You can use this procedure to allow BSD DSS actual destinations to accept jobs
with an auxiliary-sheet-selection attribute. Although this procedure allows BSD
DSS destinations to accept jobs with the auxiliary-sheet-selection specified, the
BSD DSS does not process or print auxiliary sheets.
1. Use the pddisable command to disable the BSD actual destination.
2. Issue this pdset command:

pdset -cp -x "auxiliary-sheet-selections-supported=none
job-attribute-supported+=auxiliary-sheet-selection" bsdad

where bsdad is the BSD actual destination on which you are working.
3. Determine the queue associated with the destination, and then issue this pdset

command to unregister the actual destination from its queue:
psdet -cp -x "associated-queue==" bsdad

4. Issue this pdset command to re-register the actual destination to its queue:
psdet -cp -x "associated-queue=bsdq" bsdad

where bsdq is the queue identified in the previous step. This command tells the
queue about the new actual destination attribute settings so it can schedule jobs
correctly.

5. Use the pdenable command to enable the BSD actual destination.

Note: You could modify this procedure to specify other values for
auxiliary-sheet-selection since the BSD DSS ignores these values as well.
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Chapter 8. Gathering accounting and auditing data about print
jobs

InfoPrint allows you to gather accounting information about print jobs from two
sources:
v The InfoPrint Manager AIX server that applies to all device support systems

(DSS). For more information, see “Working with InfoPrint AIX server accounting
information.”
You should use accounting information from the InfoPrint Manager if you:
– need to track accounting information for all types of InfoPrint DSSs.
– want to take advantage of the pdaccount command to summarize data in a

spread sheet program.
v The PSF auditing and accounting user-exit programs (applies only to PSF,

Generalized FAX, and Email DSSs). For more information, see “Working with
PSF accounting, post-print accounting, and auditing user-exit programs” on page
102.
You should use accounting information from the PSF auditing and accounting
user-exit programs if you:
– use only PSF attached printers.
– need more detailed information than that provided by the pdaccount

command.

Working with InfoPrint AIX server accounting information
While all DSSs can store information about jobs processed, some DSSs are more
accurate than others. All actual destination accounting logs are enabled through the
server and actual destination log-accounting-data attribute. When you specify
log-accounting-data=true, InfoPrint stores data into server accounting logs (one
for each destination), which you can either view directly from the command-line or
through the pdaccount command. The pdaccount command lets you create views
of summary information in a comma-delimited format
(Printer1,12997,1989787763). This information can be saved in a file, which can be
imported into a spread sheet to calculate the cost of consumables, the usage rate of
printers, or the cost of printing by individual user. The summary information
includes both the total pages and total octets (the number of bytes) printed, either
by destination or by user as requested for a specified time period. You can also
obtain the complete accounting records for a specified time period, instead of the
summary data.

How does the pdaccount command collect InfoPrint AIX
server accounting information?

To activate InfoPrint AIX server account log support, you must change the
log-accounting-data value. By default, the InfoPrint Manager value is
log-accounting-data=false, and the actual destination default is to use the server
setting. As a result, you must set the log-accounting-data attribute as follows:
v To activate accounting for all destinations on a server:

Set the server’s log-accounting-data attribute to True (if an actual destination
hasn’t specified this attribute, the server’s log-accounting-data attribute is used).

v To activate accounting for a specific actual destination:
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Set the log-accounting-data attribute to True for that specific actual destination.
Otherwise, the value of the log-accounting-data attribute for the server is used.

v To deactivate accounting for all destinations on a server:
Set the log-accounting-data attribute to False (if an actual destination hasn’t
specified this attribute, the server’s log-accounting-data attribute is used).

v To deactivate accounting for a specific actual destination:
Set the log-accounting-data attribute to False for that specific actual destination.
Otherwise, the value of the log-accounting-data attribute for the server is used.

You can change the log-accounting-data attribute with a pdset command or the
InfoPrint Manager Administration GUI. For more information about the InfoPrint
Manager Administration GUI, see InfoPrint Manager for AIX: Getting Started.

The pdaccount command obtains this accounting information from one or more
InfoPrint Manager AIX servers:
v actual destination name

v job owner

v global job-id

v submission time

v completion time

v pages-completed

v octets-completed

v data stream

v job name

Note: You only get all these accounting options if you specify pdaccount —t all on
the command line.

If you wanted to request summary information group by destinations on an
InfoPrint Manager server named Server1 from 8 a.m. on 9/20/99 to 8 a.m. on
9/27/99, specify this command from an AIX command line:
pdaccount -t destination -s '08:00:00 09/20/99' -e '08:00:00 09/27/99'
Server1

InfoPrint displays the information in a format similar to this:
Destination Name,Pages Completed,Octets Completed
Printer1,12997,1989787763
Printer2,2455,17676836
Printer3,86673,189808083

where Printer1 specifies the actual destination, 12997 indicates the pages
completed, and 1989787763 indicates the octets completed in the specified week.

For more information about using the pdaccount command, see InfoPrint Manager:
Reference or the pdaccount man page.

The various DSSs for actual destinations report pages-completed differently. For
example, actual destinations created using the PSF DSS report the number of
Intelligent Printer Data Stream (IPDS) pages printed, based upon the number of
begin-page and end-page structured field pairs in the data. As a result, if you
print a 2–up document as duplex, you could get a page count of 4 for a single
sheet of paper. However, if you created an actual destination through the AIX DSS
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(which does not support number-up printing), it counts each side-sheet printed as a
single page. As a result, if you print duplex, you will get a page count of 2 for
each sheet printed out.

How do you manage the contents of the InfoPrint AIX server
accounting logs?

Once you specify log-accounting-data=true on either an InfoPrint AIX server or
an actual destination, these accounting logs start growing without bound. The
accounting logs must be managed carefully to avoid potential performance
problems. Periodically, the log files must be either purged or moved to a different
directory. If you do not do either of these tasks, your installation will run out of
space on the file system, preventing you from printing any more jobs. To avoid this
problem, you should purge or move the accounting and audit logs as part of your
system maintenance.

The accounting logs reside in a subdirectory of the server’s directory. This is a
description of the names and location of the files, as well as their default
permissions:
$PDBASE/ servername/accounting.logs

where servername indicates the name of your InfoPrint AIX server. InfoPrint
provides one accounting log for each destination, named
actual_destination_name.accounting.log.v1, where actual_destination_name specifies
the actual destination where the job is processed. Locating them in a separate
directory makes them easier for you to manage.

InfoPrint restricts direct access to the logs by setting the permissions on the
accounting.log directory to rwx (read, write, execute) for root and the system
group. The logs themselves will be created with root having read and write access
and the system group having read access.

To retain a record of InfoPrint AIX server accounting data, you need to move the
existing log files to a new directory. Use this procedure:
1. Go to the directory where the log file, for example, prt1.accounting.log.v1 on

server1, is located by specifying:
cd $PDBASE/server1/accounting.logs

2. Move the prt1.accounting.log.v1 file to a directory named 1qrt2000 by
specifying:
mv prt1.accounting.log.v1 /1qrt2000

This command moves the existing file to the new directory and removes it from
the $PDBASE/server1/accounting.logs directory. When the next job is processed
on prt1, InfoPrint creates a new prt1.accounting.log.v1 file.

We recommend you move the data to another file system rather than deleting it
from the system. This lets you store accounting data and delete it from the system
when you no longer need to refer to it. To delete the podaccount.log file without
storing the data in another directory,
1. Specify

cd $PDBASE/server1/accounting.logs

This command moves you into the correct path.
2. Enter

rm prt1.accounting.log.v1
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When the AIX command-line prompt returns, you know that the
prt1.accounting.log.v1 file has been deleted from the system.

3. Enter
ls

This command displays the contents of your directory for you to verify that the
file has been deleted. When the next job is submitted for printing, InfoPrint
creates a new prt1.accounting.log.v1 file and writes the data into that file.

The pdaccount command only finds and processes the information in the original
files. Once you move or rename the files, you cannot use the pdaccount command
to summarize the data. You might want to use the pdaccount command to find
and process the information and summarize it, store the summaries in a different
location, and then delete the logs.

Attention: Requesting information for all accounting records can consume a lot
of the server’s memory since all the data is read into memory to be sent to you. If
you have a lot of data to retrieve, you should consider requesting it for smaller
time periods and concatenating the returned data.

For example, to retrieve all the accounting records for a one month period, you
could issue four pdaccount commands like this:
v pdaccount -t all -s '00:00:00 03/01/00' -e '00:00:00 03/08/00' Server A

>March1.accting.data

v pdaccount -t all -s '00:00:00 03/08/00' -e '00:00:00 03/15/00' Server A
>March2.accting.data

v pdaccount -t all -s '00:00:00 03/15/00' -e '00:00:00 03/22/00' Server A
>March3.accting.data

v pdaccount -t all -s '00:00:00 03/22/00' -e '00:00:00 03/31/00' Server A
>March4.accting.data

Usage considerations by DSS for accounting information
This section contains more information about server accounting information by
DSS. It also gives suggestions for working with the various DSSs when using the
accounting information in InfoPrint Manager.

In general, InfoPrint Manager logs jobs that complete or are paused, cancelled, or
are cleaned while being processed by the actual destination. InfoPrint Manager
does not log jobs that are not completed when the printer is shutdown because of
a printer problem, but puts them back in the queue.

AIX DSS

v If wait-for-job-completion is set to True and the job completes
successfully or is paused or cancelled, then the page count shown in the
accounting log is the number of pages stacked at the printer. For
example, a three-page document printed simplex records three pages in
the accounting log and three pages are stacked; a four-page document
printed duplex records four pages in the accounting log even though
only two sheets are stacked.

Note: If your physical printer has a time-out setting, make sure it is
disabled when you specify True or Yes for wait-for-job-completion

v If wait-for-job-completion is set to False, the page count is not based on
the number of pages stacked on the printer. In this case, InfoPrint
Manager uses these methods to calculate a page count:
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1. The printer backend can return a non-zero page count that is based
on the number of pages it is sending to the printer. If this number is
returned, InfoPrint Manager uses it for the page count that is
reported in the accounting log.

2. If the printer backend returns a zero for the page count and if the
user has specified a job-page-count with the job, InfoPrint Manager
reports that page count in the accounting log.

3. If the printer backend returns a zero for the page count and the user
has not specified a job-page-count and the job is PCL or PostScript,
then InfoPrint Manager tries to calculate a page count and records
that calculated page count in the accounting log.

v Limitation: The octet count reported for cancelled or paused jobs might
not be accurate.

PSF DSS with TCP/IP attachment type

v On jobs that complete successfully, the page count shown in the
accounting log is the number of AFP pages stacked on the printer,
including start pages and end pages.

Note: For n-up documents, up to n pages are counted for each
sheet-side that prints.

v Limitations:

– When printing a multiple-document job in which all the documents
are ASCII, the accounting log only shows pages for the last document
printed.

– If a job is paused or cancelled, the page count shown in the
accounting log might not be accurate.

– On paused jobs, the octet count is always zero (0).

PSF DSS with Other-Driver attachment type

v If wait-for-job-completion is set to True and the job completes
successfully, then the page count shown in the accounting log is the
number pages stacked at the printer. For example, a three-page
document printed simplex records three pages in the accounting log and
three pages stacked; a four-page document printed duplex reports four
pages in the accounting log even through only 2 sheets are stacked.

v If wait-for-job-completion is set to False, the page count is not based on
the number of pages stacked on the printer. In this case, InfoPrint
Manager uses these methods to calculate a page count:
1. The page count recorded in the accounting log is the number of

pages PSF reports it has sent to the printer driver, except for the case
when the document-formats-ripped-at-destination actual destination
attribute is set.

2. If the document-formats-ripped-at-destination actual destination
attribute is set to the input datastream and the job is PCL or
PostScript, then InfoPrint Manager attempts to calculate a page count
and records that calculated page count in the accounting log. The
only exception occurs when the user specifies a job-page-count
attribute and InfoPrint Manager records the user specified value of
that attribute

v Limitations: The page count and octet count reported in the accounting
log for cancelled jobs is not accurate.
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PSF DSS Command and Upload attachment types
The page count recorded in the accounting log for destinations using the
command or upload attachment types is the number of pages PSF
generates and sends to the printer or host system. It is not based on the
number of pages received or printed by the printer or host system.

Email DSS
The page count recorded in the accounting log for destinations using the
Email DSS reflects the number of pages generated and sent to the email
recipient by InfoPrint Manager. It is not based on the number of pages
received by the email recipient.

Metacode DSS
The page count recorded in the accounting log for destinations using the
Metacode DSS reflects the number of pages generated and sent to the
destination by InfoPrint Manager. It is not based on the number of pages
stacked on the printer.

Generalized Fax DSS
The page count recorded in the accounting log for destinations using the
Generalized Fax DSS reflects the number of pages generated and sent to
the destination by InfoPrint Manager. It is not based on the number of
pages processed by the fax machine.

InfoPrint 2000 DSS
The page count recorded in the accounting log for destinations using the
InfoPrint 2000 DSS reflects the number of pages generated and sent to the
destination by InfoPrint Manager. It is not based on the number of pages
stacked on the printer.

BSD DSS
The page count recorded in the accounting log for destinations using the
BSD DSS is based on these criteria:
v If the user specifies a job-page-count job attribute or a page-count

document attribute with the print job, InfoPrint Manager records that
number in the accounting log.

v If the user has not specified job-page-count or page-count, and the data
being printed is PCL or PostScript, InfoPrint Manager tries to calculate
the page count and records the calculated page count in the accounting
log.

Working with PSF accounting, post-print accounting, and auditing
user-exit programs

The accounting, post-print accounting, and audit PSF DSS user-exit programs
record data about jobs. For each job printed, InfoPrint Manager activates the
accounting and audit user-exit programs before processing the print job’s trailer
page. InfoPrint Manager activates the post-print accounting user-exit program when
the job stacks. More than one InfoPrint Manager actual destination can use the
same user-exit program to write into the same log file.

What do these user-exit programs provide?
The accounting and auditing user-exit programs record statistical data on jobs
processed by InfoPrint actual destinations. Table 10 on page 103 shows the most
common accounting and auditing user-exit programs, the files where they record
data, and the types of data that they record.
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Table 10. PSF DSS accounting, post-print, and audit user-exit programs

Program Log File Records

/usr/lpp/psf/bin/
ainuxaccp

/var/psf/podaccount.log Job submitter, job ID, actual
destination, pages per job,
pages per actual destination,
pages per output bin, data
object resources, start date,
start time, copies per job

/usr/lpp/psf/bin/ainacclog /var/psf/accounting.log Job submitter, job name, actual
destination, pages per job,
pages per actual destination,
jobs per output bin, data object
resources, start date, start time,
fonts, resident fonts, overlays

/usr/lpp/psf/bin/
ainuxjobcompletion

/var/psf/
jobcompletion.log

Job submitter, job ID, job
name, spool ID, actual
destination, global ID, user
pages stacked by tray, user
sheets stacked by tray, actual
pages stacked by tray, actual
sheets stacked by tray, copies
requested, fonts and resident
fonts used, overlays used, hard
and soft segments used,
processing start and stop
date/time, job completion
date/time, file date/time,
extended user ID, extended job
ID, address, account, building,
department, programmer,
room, title, job ticket name

/usr/lpp/psf/bin/
ainaudlog

/var/psf/audit.log Job submitter, job name, actual
destination, pages per job,
pages per actual destination,
jobs per output bin, data object
resources, start date, start time,
fonts, resident fonts, overlays

Note: /usr/lpp/psf/bin/ainacclog and /usr/lpp/psf/bin/ainaudlog record the same
information in different files.

This information is specified in flat ASCII format, with a single line for each job
that is processed. You can use this information to determine billing procedures, to
assess the workload of different output devices, or to determine how resources are
used at your installation.

The ainuxjobcompletion exit is called when the printer reports back to InfoPrint
Manager that all of the pages for a job have printed. This includes a partial job
(due to a data stream error or because the job was paused/canceled or
forward-spaced) and also any extra pages produced as a result of a backspace or
other recovery. For the last job that prints on a continuous forms printer, the exit is
not called until an NPRO (non-process run out) is done, either by an operator or
automatically by InfoPrint Manager.

Only one record is written for a job that prints, unless a job is paused. In this case,
a record is written for the part of the job that was printed up to the pause point;
later, if the job is resumed another record is written for the rest of the job.
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Note: If InfoPrint Manager does not receive feedback from the printer that all
pages have stacked, such as when the printer is shut down in the middle of a job
or when an error such as a server failure occurs, no record is written.

A new procedure has been added to the InfoPrint Manager Administration GUI to
show you how to activate the default PSF ainuxjobcompletion accounting logs.
The ainuxjobcompletion accounting exit interface can be used for PSF-driven IPDS
printers. It provides actual (versus projected) accounting data and provides
additional information about completed print jobs.

Customers who migrate from an existing V4.2 InfoPrint Manager server to
InfoPrint Manager V4.3 will continue to find the previous accounting exit interface
intact. Accounting programs that count on the previous accounting interface, which
include the InfoPrint supplied samples, will function without modification.

Customers installing an InfoPrint Manager V4.3 server for the first time will see
the post-print accounting exit activated and the accounting data written to
/var/psf/jobcompletion.log.

The intent is to minimize migration issues for existing customers, but to start new
customers out with the preferred accounting exit. The default installation for new
machines will not activate both accounting exits. However, when V4.3 is installed,
both new and migrated customers can choose to have the old, preferred, or both
accounting exits active.

If a migrating installation wants to activate the preferred (new) exit, the
administrator must set the psf-post-print-accounting-program-name auxiliary
sheet attribute in the appropriate auxiliary sheet object to provide the name of
either the InfoPrintsupplied sample exit or a custom version of the preferred exit.
The administrator can also choose to deactivate the old exit by resetting the value
of the psf-exit-program-name auxiliary attribute in the appropriate auxiliary sheet
object to <not set>.

If a new installation wants to deactivate the preferred exit and instead run the old
exit, the administrator must reset the psf-post-print-accounting-program-name
auxiliary sheet attribute in the appropriate auxiliary sheet object to <not set>. The
administrator can also choose to activate the old exit by setting the value of the
psf-post-print-accounting-program-name auxiliary sheet attribute in the
appropriate sheet object to the name of either the InfoPrint supplied sample exit or
a custom version of the old exit.

In both cases, the administrator can also choose to have both exits active by setting
the psf-exit-program-name and the psf-post-print-accounting-program-name
auxiliary sheet attributes to the names of the two accounting programs (old and
preferred). The administrator can also choose to deactivate both exits by leaving
both attributes unset.

How do you format PSF DSS accounting, post-print
accounting, and audit data for viewing?

To view PSF DSS accounting and audit data, you can use one of these executable
reporting utilities that are provided with InfoPrint:

ainupod1
Reports accounting data stored in podaccount.log, sorted by job submitter.
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ainupod2
Reports accounting data stored in podaccount.log, sorted by job ID.

ainupod3
Reports times and pages printed by the job submitter from podaccount.log.

ainurpt1
Reports accounting data stored in accounting.log, sorted by actual
destination.

ainurpt2
Reports accounting data stored in accounting.log, sorted by job submitter.

ainurpt3
Reports times and pages printed by the job submitter from accounting.log.

ainurpt4
Reports audit data stored in audit.log, sorted by actual destination.

ainurpt5
Reports audit data stored in audit.log, sorted by job submitter.

ainurpt6
Reports times and pages printed by the job submitter from audit.log.

ainurpt7
Reports post-printing accounting data stored in jobcompletion.log, sorted
by actual destination.

ainurpt8
Reports summary post-printing accounting data stored in
jobcompletion.log, sorted by job submitter.

ainurpt9
Reports detailed entries of times and pages printed for a specific job
submitter in jobcompletion.log.

For examples using these utilities, see InfoPrint Manager: Reference or the man pages
for the utilities.

How do you manage the contents of the PSF DSS accounting
data file?

An installation with a regular schedule of printing jobs will accumulate accounting
and audit data that must be managed carefully to avoid potential performance
problems. Periodically, the log files must be either purged or moved to a different
directory. If you do not do either of these tasks, your installation will run out of
space on the file system, preventing you from printing any more jobs. To avoid this
problem, you should purge or move the accounting and audit logs as part of your
system maintenance.

To retain a record of PSF DSS accounting and audit data, you need to move the
existing log files to a new directory. Use this procedure:
1. Go to the directory where the log file, for example, podaccount.log, is located

by specifying:
cd /var/psf

2. Move the podaccount.log file to a directory named 1quarter96 by specifying:
mv podaccount.log /1quarter96

This command moves the existing file to the new directory and removes it from
the /var/psf directory. The next time a job is submitted for printing from
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InfoPrint Submit, InfoPrint will create a new podaccount.log file in the /var/psf
directory and write a single line of data for each job.

We recommend you move the data to another file system rather than deleting it
from the system. This lets you store accounting data and delete it from the system
when you no longer need to refer to it. If you want to delete the podaccount.log
file without storing the data in another directory,
1. Specify

cd /var/psf

This command moves you into the correct path.
2. Enter

rm podaccount.log

When the AIX command-line prompt returns, you know that the
podaccount.log file has been deleted from the system.

3. Enter
ls

This command displays the contents of your directory for you to verify that the
file has been deleted. When the next job is submitted for printing, InfoPrint
creates a new podaccount.log file and writes the data into that file.

106 InfoPrint Manager for AIX: Procedures



Chapter 9. Creating and managing resource-context objects

Resource-context objects identify the locations of different types of Advanced
Function Presentation (AFP) resources that jobs sent to PSF physical printers can
reference. Resource-context objects let you encapsulate the directory path name in
one place. Then you specify the resource-context object name rather than directory
names with documents and actual destinations when specifying where to find
resources. Later, if the location of a resource changes, you only need to modify the
path name specified in the corresponding resource-context object.

The different types of AFP resources are:

Color management resources (CMRs)
CMRs are the foundation of color management in AFP print systems. They
provide all the color management information, such as ICC profiles and
halftones, that an AFP system needs to process a print job and maintain
consistent color from one device to another.

Notes:
1. CMRs are stored in resource libraries that use resource access tables

(RATs). When you update an existing CMR or add a new CMR to a
resource library, the RAT is updated. You must restart PSF so the
changes take effect.

2. CMRs are considered data objects for accounting purposes.
3. For retention of resources across print jobs, CMRs are counted as part

of the maximum-presentation-object-containers-to-keep.

Data object font resources
A data object font resource can be an OpenType font collection, an
OpenType set of linked fonts, or OpenType fonts that are installed in one
or more directories on your InfoPrint Manager server. Data object font
resources are the only fonts registered through a RAT that are located in
the same directory as the fonts. For more information about using data
object font resources with InfoPrint Manager, see “Using OpenType Fonts”
on page 222.

Data objects
Data objects can be IOCA files or types of files natively supported by a
particular model of printer (for example, an EPS file on an InfoPrint Color
130 Plus). In addition, if you use the transforms that come with InfoPrint
Manager to convert objects into AFP first, these non-native types of files
can be used as data objects. In InfoPrint Manager, data objects are grouped
with BCOCA and GOCA objects, and they are collectively known as
presentation object containers.

Note: Data objects are stored in resource libraries that use RATs. When
you update an existing data object or add a new data object to a resource
library, the RAT is updated. You must restart PSF so the changes take
effect.

Fonts A font is a single size and typeface in a particular type family, including
letters, numerals, punctuation marks, special characters, and ligatures.

Form definitions
Form definitions provide instructions on how output devices position data
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on the page. Form definitions can specify overlays, a paper source for
cut-sheet printer devices, duplexed printing, text suppression, data
position, and the number and modifications of pages.

Page definitions
Page definitions contain the formatting controls for line data. Page
definitions can include controls for the number of lines per logical page,
font selection, print direction, and the mapping of individual fields to
positions on the logical page.

Page segments
Page segments contain text and images that you can include at any
addressable point on a page or an electronic overlay.

Overlays
Overlays are collections of predefined data such as lines, shading, text
boxes, or logos, that can merge with variable data on a page or a form
during printing or transmission.

You use the pdcreate command to identify the directory or directories where the
AFP resources reside and provide a name for the resource-context object. You use
the AFP Resources tab of the actual destination and default document attributes
notebooks in the InfoPrint Manager Administration GUI, or the Command Prompt
window from an InfoPrint Manager for Windows server, to identify the
resource-context object name or which paths you want to associate with that object.
Jobs can also reference resource-context objects through their contained documents.
See “The search order for AFP resources” for the search order InfoPrint uses to
locate resource-context objects for a job. Both the actual destination and the
resource-context objects that are referenced must reside in the same InfoPrint
server.

You can also purchase additional resources or even create your own custom
resources. To create page definitions and form definitions, you can purchase the
Page Printer Formatting Aid (PPFA) for Windows, which is an optional feature of
InfoPrint Manager for Windows.

The search order for AFP resources
This section describes the order and the conditions on which InfoPrint searches for
AFP resources:
1. For fonts, paths specified by the -osrchfontlib keyword on the enq, lp, qprt, or

lprafp command
2. Paths specified by the -oreslib keyword on the enq, lp, qprt, or lprafp

command
3. The path specified by the resource-context-user document attribute.
4. The paths specified by one of these document attributes, depending on the type

of resource:
v resource-context-font

v resource-context-form-definition

v resource-context-overlay

v resource-context-page-definition

v resource-context-page-segment
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Note: When one of these document attributes contains a value, InfoPrint
ignores any location specified by the same attribute of a default document
object if one is used with the job.

5. The path specified by the resource-context document attribute.
6. The path specified by the PSFPATH environment variable.

If you are using OpenType Fonts, you must allow the Infoprint Fonts product
to install its resource access table for keeping track of these fonts in the default
directory. On an InfoPrint Manager Windows server, if you change the location
of this table from the folder where it was installed, you can update the global
search path on your Windows system with the global resource path for these
fonts.

7. The paths specified by the resource-context attributes of the actual destination.
8. For fonts, the directory where your fonts are installed.

Once a resource is located, the search ends, and the located resource is used to
process the job, as long as the user can access the resource. If InfoPrint Manager
ultimately cannot find a required resource, it prints an error message advising you
of the missing resource. InfoPrint Manager reports that the job completed
successfully.

If the only AFP resources you use are the AFP resources that shipped with
InfoPrint Manager, there is no need to use resource-context objects. All of your
resources are located automatically because these resources reside in the reslib,
fontlib, and font directories described above. If, on the other hand, you have
custom AFP resources, make sure that you do not store them in the reslib, fontlib,
or font directories listed. Any custom resources stored in these locations might be
corrupted by installing, uninstalling, or servicing the software. Store any custom
AFP resources in a directory outside these locations and use resource-context
objects to provide access to them.

When InfoPrint Manager puts together the total of all resource contexts for a
particular resource type, InfoPrint Manager tries this list of extensions in order
while searching each directory for a particular resource. For example, InfoPrint
Manager is searching for a 300–pel raster font named C0H20000 and these
conditions are true:
v Document attributes are set to resource-context-font=\myfonts

v resource-context=\all_resources

v The $PSFPATH environment variable has not been set.
v The resource-context-font actual destination attribute has not been set.

A list of files similar to this would be checked in sequence:
1. x:\myfonts\C0H20000.300

2. x:\myfonts\C0H20000.FONT300

3. x:\myfonts\C0H20000

4. x:\all_resources\C0H20000.300

5. x:\all_resources\C0H20000.FONT300

6. x:\all_resources\C0H20000

7. With InfoPrint Manager for AIX:
a. The /usr/lpp/psf/reslib directory.
b. For fonts, the /usr/lpp/afpfonts directory.
c. For fonts, the /usr/lpp/psf/fontlib directory.
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Once InfoPrint Manager finds a matching file, the search ends.

If InfoPrint Manager cannot find the resource in any of the paths, it stops the job
and prints an error message at the end of the job.

CMRs and data objects search order
The search order for CMRs and data objects is different from the order used for
other AFP resources.

CMRs and data objects must reside in the same directory as the RAT where the
resources are identified. That is, the CMR RAT and the data object RAT can be
located in different directories, but the resources that are associated with the
specific RAT must reside in the same directory as the RAT.

The InfoPrint 5000 printer Models AS1 and AD1/2 and InfoPrint 4100 printers
support CMRs and data objects.

The search order for CMRs
InfoPrint Manager searches for CMRs in different locations and in a different order
than it uses for other AFP resources.

InfoPrint Manager searches for CMRs in these locations in this order:
1. Inline objects
2. The path specified by the resource-context-presentation-object-container

document attribute
3. The path specified by the resource-context document attribute
4. The path specified by the PSFPATH environment variable
5. The path specified by the resource-context-presentation-object-container actual

destination attribute
6. The path specified by the resource-context actual destination attribute
7. The system dependant library:

For AIX, /usr/afp/reslib/legacy

Notes:

1. InfoPrint searches for CMRs using the UTF-16 name provided in the data
stream.

2. If a CMR changes after a job prints, recycle the actual destination by disabling
and enabling the connection.

The search order for data objects
InfoPrint Manager searches for data objects in different locations and in a different
order than it uses for other AFP resources.

InfoPrint Manager searches for data objects in these locations in this order:
1. Inline objects
2. The path specified by the resource-context-page-segment document attribute if

object is IOCA that is not installed in a data object RAT
3. The path specified by the resource-context-presentation-object-container

document attribute
4. The path specified by the resource-context document attribute
5. The path specified by the PSFPATH environment variable
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6. The path specified by the resource-context-presentation-object-container actual
destination attribute

7. The path specified by the resource-context actual destination attribute
8. The system dependant library:

For AIX, /usr/afp/reslib/legacy

Notes:

1. InfoPrint Manager searches for data objects using the UTF-16 name and the
eight-character name provided in the data stream. The search process is
different from previous versions. InfoPrint Manager now searches items one
through four by UTF-16 name and then search items one through four by eight
byte name. Then, InfoPrint Manager searches items five through eight by
UTF-16 name and then by eight byte name.

2. If a data object changes after a job prints, recycle the actual destination by
disabling and enabling the connection.

Reuse of CMRs and data objects across printer jobs
Using CMRs and data objects in more than one print job can improve printer
performance. InfoPrint Manager includes two actual destination attributes that you
can use to specify reuse: maximum-presentation-object-containers-to-keep and
capture-inline-cmr-resources.

If you use the same resources (such as company logos) in different print jobs, you
can improve print performance by storing those resources on the printer.

Use the maximum-presentation-object-containers-to-keep actual destination
attribute to specify the maximum number of CMRs and data objects to store in the
memory of the printer device between jobs. The default value is 100 objects. Both
CMRs and data objects are included in this count.

The printers control the actual retention of resources based on the value of the
maximum-presentation-object-containers-to-keep actual destination attribute and
the available resources downloaded to the printer.

Note: If the printer is reset, the printer memory is cleared.

If you include CMRs inline with your print jobs, you can use the
capture-inline-cmr-resources actual destination attribute to indicate whether inline
CMRs can be captured and reused by PSF TCP/IP printers. Capturing a CMR
means the resource is downloaded to the printer and remains resident in the
printer memory for future reuse. The default for this attribute is false (not active).

File extensions for resources

This table contains file extensions for specific types of resources and lists the order
that the extensions are tried by InfoPrint when searching for that resource.

Table 11. File extensions for resources

Type of Resource File Extensions Searched (see note)

BCOCA (bar code) objects 1. No file extension

2. OBJ

3. OBJECT
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Table 11. File extensions for resources (continued)

Type of Resource File Extensions Searched (see note)

Code pages 1. ECP

2. No file extension

3. FONT3820

4. FONT38PP

5. CDP

6. FONT300

Coded fonts 1. No file extension

2. FONT3820

3. FONT38PP

4. CFT

5. FONT300

Font character sets, 240-pel resolution 1. No file extension

2. 240

3. FONT3820

4. FONT38PP

5. CFT

6. CDP

Font character sets, 300-pel resolution 1. No file extension

2. 300

3. FONT300

4. CFT

5. CDP

Outline fonts 1. No file extension

2. OLN

3. FONTOLN

4. CFT

5. CDP

TrueType and OpenType fonts, CMRs, and
data object resources

Entire file name, including extension; comes
from the Resources Access Tables (RATs)
creaetd by the AFP Resource Installer. If a
CMR or a data object RAT is altered, PSF
must be restarted for the changes to take
effect.

Form definitions 1. No file extension

2. FDEF3820

3. FDEF38PP

4. FDE

5. FIL

GOCA (graphics) objects 1. No file extension

2. OBJ

3. OBJECT

IOCA (IO image) objects 1. No file extension

2. OBJ

3. OBJECT
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Table 11. File extensions for resources (continued)

Type of Resource File Extensions Searched (see note)

MO:DCA Objects 1. No file extension

2. OBJ

3. OBJECT

Overlays 1. No file extension

2. OVLY3820

3. OVLY38PP

4. OVL

5. OLY

6. OVR

Page definitions 1. No file extension

2. PDEF3820

3. PDEF38PP

4. PDE

Page segments 1. No file extension

2. PSEG3820

3. PSEG38PP

4. PSG

5. PSE

Color mapping table 1. No file extension

2. SETUP

3. SET

Presentation object container

For data object resources not installed in a
Resource Access Table (RAT).

1. No file extension

2. DOR

Setup data 1. No file extension

2. SETUP

3. SET

4. COMSETUP

Note: All file extensions must be in uppercase.

How InfoPrint Manager provides resource access for PSF DSS printers
By default, InfoPrint allows all users to access the resource by setting all resource
permissions to -r--r--r--. The instance of the program that tries to access a resource
is created with an id of root and a group of printq.

PSF DSS printers limit resource access based on the userid of the person that
submitted the job. The userid must have a local ID defined, or InfoPrint uses
anonymous resource access (requiring a minimum of -r--r--r-- access permissions to
access the resource).

Access for PSF DSS resources is granted if the userid:
1. Exists locally (in the local /etc/passwd file), and they are a member of the

system group.
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2. Owns the resource.
3. Can access the resource with group permissions.
4. Can access the resource because global access is allowed for that resource.

If all these checks fail, the userid cannot access the resource and InfoPrint Manager
issues an error message indicating that the resource could not be found.

Creating a new resource-context object
You create resource-context objects from the AIX command line; you cannot create
them through the InfoPrint Manager Administration GUI.

To create a new resource-context object from the command line, type a pdcreate
command using -c resource-context and typing:
1. The context-address

2. The server name
3. The resource-context object name

For example, to create a resource-context object named Resfont1 contained in
server Server1 that identifies x:\resource\fonts\group1 as the context-address or
directory containing AFP font resources, enter the command:
pdcreate -c resource-context -x "context-address=/resource/fonts/group1"

Server1:Resfont1

Note:

1. Specify a name that uniquely describes the resource-context object in the server.
All resource-context objects in a server appear in the selection lists for the fields
in the PSF Resource tab of the Printer Properties window. Two servers can
each contain a resource-context object with the same name, but possibly with
different values for their attributes.

2. InfoPrint uses resource-context object names as values for the lists associated
with the fields in the actual destination attributes notebook (Printer Properties
window) or as valid values you can enter in the fields of the default document
attributes notebook. Job submitters can also use them as values for attributes of
a document in a job.

For more information about the attributes used in creating resource-context objects,
see ″Attributes for Resource Contexts″ in InfoPrint Manager: Reference.

Changing a directory path for a resource-context object
If you need to change the path to a resource-context object, use the pdset
command.

For example, to change the path for the resource-context object named Resfont1
contained in server Server1 to /resource/fonts/group2 as the directory containing
AFP font resources, enter the command:
pdset -c resource-context -x "context-address=/resource/fonts/group2"

Server1:Resfont1

To read more about resource-context attributes, enter this at the AIX command
prompt to view the associated man pages:
man pd_att_res_context
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Assigning resource-context objects to an actual destination
You can use either the InfoPrint Manager Administration GUI or the AIX
command line to assign resource-context objects to a PSF actual destination, fax
destination, or e-mail destination.

Using the AIX command line
To assign resource-context objects to a PSF actual destination, fax destination, or
e-mail destination from the AIX command line, use the pdset command and the
resource-context-font, resource-context-overlay, resource-context-form-definition,
resource-context-page-definition, or resource-context-page-segment attribute. For
example, to associate the font resource context object Resfont1 with the PSF actual
destination Serv1–pp residing in server Server1, enter this command:
pdset -c destination -x "resource-context-font=Resfont1"

Server1:Serv1-pp

If you have not created a resource-context object, you can assign the path name of
a directory containing resources to the actual destination in the same way. For
example, to associate the directories /resource/overlays/julia and
/resource/overlays/henry, which contain overlays, with the fax destination
Serv1–fax residing in server Server1, enter this command:
pdset -c destination -x

"resource-context-overlay=/resource/overlays/julia:/resource/overlays/henry"
Server1:Serv1-fax

InfoPrint Manager searches the directories specified by the resource-context objects
or the directories you specified for resources required by jobs.

Assigning a resource-context object to a default-document object
You can use either the InfoPrint Manager Administration GUI or the AIX
command line to assign resource-context objects to a default-document object.

Using the AIX command line
To assign resource-context objects to a default-document object from the AIX
command line, use the pdset command and the resource-context-font,
resource-context-overlay, resource-context-form-definition, resource-context-page-
definition, resource-context-page-segment, or resource-context attribute. For
example, to associate the font resource context object Resfont1 with the default
document report residing in server Server1, enter this command:
pdset -c initial-value-document -x "resource-context-font=Resfont1"

Server1:report

If you have not created a resource-context object, you can assign the path name of
a directory containing resources to the default document in the same way. For
example, you want InfoPrint to search for resources of any type that it cannot find
in the other resource contexts associated with a default document in the directory
/resource/any. To associate this directory with the default document report
residing in server Server1, enter this command:
pdset -c initial-value-document -x "resource-context=/resource/any"

Server1:report

You can now assign the default-document object to an actual destination (use the
InfoPrint Manager Administration GUI) or inform the job submitters of the
resource objects assigned to this default-document object.

Chapter 9. Creating and managing resource-context objects 115



116 InfoPrint Manager for AIX: Procedures



Chapter 10. Using InfoPrint Manager notifications

InfoPrint Manager can detect events (such as job completed or destination needs
attention) as they occur, generate messages about those events, and deliver the
messages to users who need the information. For example, users can receive
messages about jobs they submit, operators can be notified about InfoPrint objects
that require their attention, and administrators can be notified if someone makes a
configuration change. With notifications, you don’t have to query for status of the
objects in your system—you just receive messages when specific events occur so
you can take care of them.

You can tailor who receives these messages and how they are delivered based on
the notification profile that is set for a particular InfoPrint object.

Understanding notification profiles
Most InfoPrint objects (the server, actual destinations, logical destinations, queues,
jobs, and default jobs) have notification profiles associated with them. A
notification profile is composed of one or more notification profile entries. Each
notification profile entry has three main components:

Event Identifiers
Which events cause messages to be sent. See “Event identifiers” on page
118 for more information.

Delivery method
How the messages are delivered. See “Delivery method and delivery
address” on page 118 for more information.

Delivery address
Where the messages are sent. See “Delivery method and delivery address”
on page 118 for more information.

In addition, a notification profile entry can include a comment (text that InfoPrint
will add to the general message text) and a locale (to set the language that the
message will be sent in). Comments are optional. If you don’t specify a locale,
InfoPrint delivers messages using the locale (language) that the user is running in.

Some objects need only one entry in their notification profiles. For example, when
a person submits a job, he is probably the only one who needs to receive
information about it, and he will probably be content to have all of the messages
about that job delivered the same way.

For other objects, there are very good reasons to have multiple entries. For
example:
v If operators manage printers from more than one workstation, you can create an

entry for each workstation. That way, all of the messages go to all of the
machines.

v If operators can address some messages (like destination-needs-attention), but
an administrator needs to address others (like object-deleted), you can create an
entry for each operator and one for the administrator. Messages are delivered to
the person who can handle them.
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v If an administrator likes to use InfoPrint Manager Notifications while he’s at
work, and wants to keep a more permanent record of how often some events
occur, he can set up two entries. One delivers messages to the InfoPrint Manager
Notifications client and one writes certain messages into a file that he can check
periodically.

Event identifiers
The event identifiers component lists the InfoPrint events that trigger notifications.
You can find a full list of InfoPrint notification events and their descriptions in the
″Notification events and event classes″ chapter of the InfoPrint Manager: Reference.
In the descriptions, you will see what objects each event supports. If you add an
event to an object that it does not support, no messages will ever be generated for
that event. For example, you can add the queue-backlogged event to a notification
profile entry for an actual destination, but queue-backlogged only supports the
queue, job, and server objects. As a result, the actual destination notification profile
will not generate any messages about that event.

That chapter also lists the InfoPrint Manager event classes, or groups of related
notification events. When you add event identifiers to a notification profile, you
can add individual events, event classes, or a combination of the two.

Each type of InfoPrint object has a default set of event identifiers. See “Default
notification profiles” on page 122 for a list of defaults for each object.

Delivery method and delivery address
The delivery method component shows how you want notification messages to be
delivered. The delivery method and delivery address components are strongly
related; the delivery method you select determines the type of value you use for
the delivery address.

In addition, delivery method and delivery address are the keyed components in
notification profile entries; they are the two values that InfoPrint Manager checks
when you modify a notification profile. If the delivery method and delivery
address that you specify match the delivery method and delivery address of an
existing entry, InfoPrint Manager updates that entry. If both values don’t match
any of the existing entries, InfoPrint Manager adds a new entry to the profile.

There are various delivery methods defined for InfoPrint objects. All methods are
valid for all objects except for job-log; job-log is only valid for jobs. Table 12 on
page 119 lists the delivery methods, along with descriptions and how to set the
delivery address for each type. 1

1. Two other delivery methods, sapcb and sapconnect exist, but they are only used internally with the InfoPrint Manager SAP Print
Feature. You should never use either of those values in a notification profile entry.
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Table 12. InfoPrint notification delivery method characteristics

Delivery Method Description Delivery address

message

Message is the default
delivery method for all
objects.

Sends a message to the InfoPrint
Manager notification server,
where it waits for an InfoPrint
Manager Notifications client to
pick it up. Once a message is
picked up, it is deleted from the
notification server; there are no
further records of those
messages.

The delivery address listed in
the notification profile can be
whatever you want it to be– a
user id, office number, IP
address, driver’s license
number– as long as it is
unique. In order to receive
messages sent to that address,
you must set the delivery
address listed in the Settings
dialog in the InfoPrint
Manager Notification client to
the same value. The InfoPrint
Manager Notifications client
will only pick up messages
that specify an identical
delivery address.

electronic-mail
(synonyms: e-mail,
email)

Sends an E-mail to the address
listed in the delivery address,

The E-mail address that you
want notification messages to
be sent to. For example,
kjones@printerco.com.

exit Doesn’t actually send a message.
Instead, when the event
specified in the event identifier
occurs, InfoPrint Manager runs
an exit program or script. See
“Using the ’exit’ delivery
method” on page 121 for more
information.

The full path to the notification
exit program or script (with
hard-coded arguments, if any).

delivery-method-
wireless

Sends notifications to wireless
devices, such as pagers, cellular
phones, palm pilots, and laptop
computers.

Because wireless notifications
are delivered as emails, you
must set both the
smtp-server-host and the
smtp-server-port server
attributes on this InfoPrint
server.

If your InfoPrint server is
behind a firewall, you might
have to configure your SMTP
server. For information about
this task, see Configuring and
Using InfoPrint Email on the
web at http://
www.infoprint.com.

Note that this URL has been
divided so it prints correctly in
the text.
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Table 12. InfoPrint notification delivery method characteristics (continued)

Delivery Method Description Delivery address

file Writes the message in the file
you specify in the delivery
address. If the file doesn’t exist,
InfoPrint Manager will create it.
If the file does exist, InfoPrint
Manager will overwrite it the
first time it writes a message.
After that, messages are added
to the end of the file.

The directory path and name
of the file that you want to
write your notification
messages in. This file must
reside on the same system as
your InfoPrint Manager server.

file-add-to Adds the message to the end of
the file you specify in the
delivery address. If the file
doesn’t exist, InfoPrint Manager
will create it.

The directory path and name
of the file that you want to
write your notification
messages in. This file must
reside on the same system as
your InfoPrint Manager server.

job-log

Only valid for jobs.

Writes messages into the job-log
attribute of the job. To see the
messages, enter the pdls
command for the job-log
attribute on the job you want to
know about.

No value needed.

none Does not send any notifications;
turns notification off.

No value needed.

Working with Select notifications
By default when you submit a job using InfoPrint Select, a notification profile is
sent with the job. If you have the Select message windows running when you
submit a print job using InfoPrint Select, notifications are requested. If the Select
message window is not running, notifications are not requested. When notifications
are requested, they are delivered by e-mail. InfoPrint Select does not use the
standard e-mail port for notifications to avoid conflict with other SMTP servers. If
you have a conflict with the port that Select is using for notification, you can select
another port by following: Start → Programs → InfoPrint Select → InfoPrint Select
Notification → InfoPrint Manager Message Port, and entering another port.

The InfoPrint Select Notification message window usually starts automatically
when Windows first loads, but if you need to start the Notification message
Window at another time, go to Start → Programs → InfoPrint Select → InfoPrint
Select Notification.

To turn off the Notification message window, click the X in the upper right corner
of the screen and then click OK on the warning message.

Note: If you receive a communication error when using the Select Message
Window with Windows XP with Service Pack 2 or Windows 2003 with Service
Pack 1, you might have to include ipnotify.exe on the Exceptions tab of the
Windows Firewall dialog.

Setting up your own InfoPrint Select notification profile:

The Select notification profile overrides any notification settings that you configure
in a default job. If you don’t want to use the Select notification profile, use the
appropriate procedure for your operating system:

120 InfoPrint Manager for AIX: Procedures



v Windows XP

1. On the Windows system that InfoPrint Select is installed on, right-click My
Computer and select Properties.

2. Click the Advanced tab, and click Environment Variables.
3. Click one of the variables listed under System Variables to signal that you

want to create a system variable. The variable and its value will appear in
the fields at the bottom of the dialog.

4. Clear the Variable and Value fields.
5. In the Variable field, type: pdnotify and in the Value field type:

override_select.
6. Click Set.
7. Verify that pdnotify appears in the list of System Variables and not in the

User Variables. If it appears in the list of User variables, delete it and start
again from step 3.

8. Click OK.
9. Restart your system to make the changes take effect.

v Windows 2000

1. On the Windows system that InfoPrint Select is installed on, right-click My
Computer and select Properties.

2. In the System Properties window, click the Advanced tab.
3. On the Advanced tab, click Environment Variables.
4. In the System variables box on the Environment Variables dialog, click

New.
5. In the Variable Name field, type pdnotify and in the Variable Value field,

type override_select.
6. Click OK.
7. Verify that pdnotify appears in the list of System variables and not in the

User variables. If it appears in the list of User variables, delete it and start
again from step 4.

8. Click OK in the Environment Variables dialog.
9. Click OK in the System Properties window.

10. Restart your system to make the changes take effect.

Using the ’exit’ delivery method
The exit delivery method lets you set up automatic responses to system events
beyond just sending a message. When you set the delivery method for a given
event to exit, you use the delivery address to specify the explicit path to a script or
program on your system. Whenever that event occurs, InfoPrint Manager runs the
script or program you specify.

For example, if the InfoPrint Manager server runs low on disk space, the
disk-space-low event generates a message for the system administrator. The
administrator then has to do something to clean up the disk so InfoPrint Manager
can continue to run effectively. However, using the exit delivery method can
automate that process by launching a ″disk clean up″ script. The administrator can
still receive the message, but will know that the script is already working on the
problem.

By default, when you use the exit delivery method, InfoPrint Manager only passes
two values along to the script or program: the message number of the event that
occurred and the text of the message. As a result, the command line that the exit
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delivery method executes is composed of the path that you specified in the
delivery address, the last three digits of the message number, and the text of the
message.

Therefore, if you create a notification profile entry for the job-completed event,
setting the delivery method to exit and the delivery address to
/infoprint/exits/myscript, when a job finishes printing, InfoPrint Manager will
generate and execute a command line similar to this one:
/infoprint/exits/myscript 280 "5010-280 Finished processing job ofc,
Job 20 (3520800004)."

The scripts or programs you write might require other information, such as the
destination name or the printer model. To pass those values, you can include them
in the delivery address of the notification profile entry; they will be added to the
end of the command line when InfoPrint Manager creates it.

Default notification profiles
By default, the person who creates an object (server, destination, queue, job)
receives the notification messages about that object. The default notification profile
settings provide information such as object status, error conditions, or
configuration changes. Some of these events require the person managing the
object to intervene; for example, someone might need to clear a paper jam.

By default, the events listed in this table generate messages for the corresponding
objects. These messages are delivered to the user who created the object: job
submitters receive messages about their print jobs; the administrator receives
messages about destinations and servers that he or she created. The default
delivery method is message, so the notifications are sent to the InfoPrint Manager
Notification client on the system that the person used to create the object.

Table 13. Default notification profile settings

Object Events

Actual destination v destination-needs-administrator
v destination-needs-attention
v destination-needs-operator
v destination-timed-out
v object-cleaned
v object-deleted

Default Job No defaults set. See “Using notification
profiles with default jobs” on page 123 for
more information.

Job v destination-needs-attention
v destination-needs-operator
v destinations-not-ready-for-job
v document-aborted-by-destination
v document-aborted-by-server
v document-cancelled-at-destination
v job-aborted-by-server
v job-cancelled-by-operator
v job-cannot-be-scheduled
v job-completed
v past-discard-time

Logical destination v object-cleaned
v object-deleted
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Table 13. Default notification profile settings (continued)

Queue v object-cleaned
v object-deleted
v queue-backlogged

Server v internal-server-error
v low-on-memory
v memory-exhausted
v object-cleaned
v object-deleted
v out-of-disk-space
v out-of-dpf-haids
v out-of-dpf-job-numbers
v out-of-dpf-raids
v sapcbd-down
v sapconnect-down
v server-shutdown-complete

Determining how much notification administrators, operators, and job submitters
require takes some planning and, as you familiarize yourself with InfoPrint, you
should discover when you require more or less notification. You can start by using
the defaults and see how many and what kind of messages you receive. If you find
that you need more or less notification, or to modify which users receive
notifications, or if you want messages to be sent using a different delivery method,
you can change the notification profiles.

Using notification profiles with default jobs
When someone submits a print job, InfoPrint Manager sends messages about that
job based on a default notification profile. As a result, the delivery method is
message, the delivery address is ″the user ID of the person who submitted the
job @ the address of the system the job was submitted from,″ and the event
identifiers are those listed in Table 13 on page 122. (If you submit jobs using
InfoPrint Select, the default notification profile is different. See “Working with
Select notifications” on page 120 for additional information.)

If you want to change the settings in the default notification profile, you can create
a notification profile on a default job. There are several things to keep in mind
when you set up a notification profile on a default job:
v You can only set one default job on each logical destination. As a result, all of

the jobs will use the same notification profile.
v If you set a delivery address in the notification profile for the default job, all

messages will go to that address. However, if you leave the delivery address
blank, InfoPrint Manager will fill it in with the address that the job was
submitted from (you can’t specify this address; it is sent with the job). This
option only works with the message and e-mail delivery methods and is the
only time that the notification profiles are merged.

v If you submit a job with an explicit notification profile (for example, by
including the notification-profile attribute when you submit a job using pdpr),
that profile overrides the one set in the default job.

Note: If you submit jobs using InfoPrint Select, an explicit notification profile is
sent with every job. If you want to use a notification profile on a default job
with InfoPrint Select, see“Working with Select notifications” on page 120 for
information about overriding Select notifications.
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Changing notification profiles

For jobs, default jobs, servers, queues, and actual
destinations

You can use the properties notebooks in the InfoPrint Manager Administration GUI
to change notification profiles for jobs, default jobs, servers, queues, and actual
destinations. Open the properties notebook and click the Notification tab for an
actual destination, a job, or a default job. For a server, click the Other tab. On the
page that opens, you can see the notification profile entries that already exist,
including:
v How messages about that object are delivered
v Who they are sent to
v What events generate messages
v Any comments that are included with the messages

Use the Add, Modify, and Delete buttons to make changes to the notification
profile. See the online help for the InfoPrint Manager Administration GUI for
additional information. You can also change notification for jobs in the InfoPrint
Manager Operations GUI.

Note: If you change the delivery method, make sure you change the delivery
address appropriately.

For logical destinations
The only way to change a notification profile for a logical destination is to use the
pdset command. The procedures below provide examples of some common
modifications you might want to make. You can use these procedures to change
the notification profiles for other InfoPrint objects as well, but you might find it
easier to use the properties notebooks in the InfoPrint Manager Administration
GUI.

This procedure describes how to modify notification profiles by:
v “Adding or modifying events or users in a notification profile” on page 125
v “Removing users from a notification profile” on page 126
v “Changing the delivery method” on page 127

If you need to change other parts of a notification profile, see InfoPrint Manager:
Reference for information about the pdset command and the notification-profile
attribute.

Important: When you modify a notification profile, InfoPrint Manager compares
the new delivery method and delivery address to the delivery methods and
delivery addresses in the existing entries and behaves accordingly:
v If you specify both of the values and both match the values in an existing entry,

the modification replaces that entry.
v If you only specify one of the values, InfoPrint Manager fills in the other value

with the default values. Then, it checks to see if any of the existing entries match
that combination. If they match, InfoPrint Manager replaces that entry. If they
don’t match, InfoPrint Manager creates a new entry.

v If you specify both values but only one matches, InfoPrint Manager creates a
new entry.
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v If you specify both values and neither one matches, InfoPrint Manager creates a
new entry.

When you delete a notification profile entry, the delivery method and delivery
address in your command must match those in an existing entry exactly.

Viewing an existing notification profile

If you want to see what values are set for a notification profile, follow these steps.
1. Type the following command. Fill in the values for the italicized items as

defined below.
pdls -c Type of Infoprint object -r notification-profile Objectname

Type of InfoPrint object
What type of object you want to do this command on, not the specific
object. For example, type destination not printer1-ld.

Objectname
The name of the destination or queue that this notification profile refers
to.

2. Press Enter.

The notification profile will be displayed.

Note: If you have messages about a particular object sent to more than one person,
the notification profile will display multiple entries, one for each person.

Adding or modifying events or users in a notification profile

Follow these steps to add or remove events in the notification profile for a
particular delivery address, or to add another entry to the notification profile, so
that messages will be sent to another address as well.
1. Type the following command. Fill in the values for the italicized items as

defined below.
pdset -c Type of Infoprint object-x “notification-profile+={event-
identifiers= event(s) delivery-method= method delivery-
address=”address“}” Objectname

Type of InfoPrint object
What type of object you want to perform this command on, not the
specific object. Type destination, queue, job, or server.

event-identifiers
The events that cause InfoPrint Manager to send a message. You can
have messages sent for any of the events that are listed in the
events-supported attribute for the server. For a list of these values, see
the ″Attributes for Servers″ section in the ″InfoPrint object attributes″
chapter of InfoPrint Manager: Reference. Not all events support all
objects. See the ″Notification events and event classes″ chapter in the
InfoPrint Manager: Reference for lists of what objects each event supports.

Note: You must type all of the events for this object that you want the
user you specify in the delivery address to receive, even if they already
appear in the notification profile. Any events that you do not type will
not be listed in the notification profile.
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delivery-method
How you want messages to be sent. See Table 12 on page 119 for
information about the various delivery methods.

delivery-address
Where you want to have messages sent. See Table 12 on page 119 for
information about what kinds of delivery address value to use with
each delivery method. Enclose the value in double quotes.

Note: You cannot specify more than one delivery address here. If you
want another user to receive messages about the same (or different)
events, finish this procedure, then enter the command again with that
user’s delivery address.

Objectname
The name of the destination or queue that this notification profile refers
to.

2. Press Enter.
3. Repeat the process for other users and objects.

Example: The default notification profile for queues is set to send you messages
when the queue-backlogged, object-cleaned, and object-deleted events occur. You
need to change the notification profile for the print queue printer1-q so that you
receive messages when the queue-no-longer-backlogged and queue-state-changed
events occur as well. Your backup person does not currently receive any messages
about queues, but needs to receive all of the same messages you do.

Issue this command to change your notification profile. Remember to list the
event-identifiers for all of the events that you want this user to receive
notifications about. This list of event-identifiers replaces the existing list entirely.

pdset -c queue -x “notification-profile+={event-identifiers=object-cleaned
object-deleted queue-backlogged queue-no-longer-backlogged
queue-state-changed delivery-address=”administrator@mydesk.office.com“}”
printer1-q

Then, issue this command to have the same queue messages sent to your backup
person.

pdset -c queue -x “notification-profile+={event-identifiers=object-cleaned
object-deleted queue-backlogged queue-no-longer-backlogged
queue-state-changed delivery-address=”backup@hisdesk.office.com“}”
printer1-q

Use the “Viewing an existing notification profile” on page 125 procedure to make
sure the changes took effect.

Removing users from a notification profile

Follow these steps to remove an entire entry from a notification profile.
1. Use the “Viewing an existing notification profile” on page 125 procedure to

find the entry you want to remove.
2. Type the following command. Type the correct delivery-method and the

delivery-address exactly as it is displayed for the entry that you want to
remove.
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pdset -c Type of Infoprint object -x "notification-profile-={delivery-
method=electronic-mail or message delivery-address=“address”}"Objectname

3. Press Enter.
4. Use the “Viewing an existing notification profile” on page 125 procedure to

verify that the entry has been removed.
5. Repeat the process for other entries.

Example: You and two other people currently receive messages about the logical
destination printer1-ld. You don’t want to receive them any longer. You view the
notification profile, and see these three entries:
printer1-ld: notification-profile=

{event-identifiers = object-cleaned object-deleted delivery-method = message
delivery-address = “admin@desk1.office.com” locale = en_US}

{event-identifiers = object-cleaned object-deleted delivery-method = message
delivery-address = “helpdesk@desk2.office.com” locale = en_US}

{event-identifiers = object-cleaned object-deleted delivery-method = message
delivery-address = “backup@desk3.office.com” locale = en_US}

Issue this command to remove your entry from the notification profile.

pdset -c destination -x "notification-profile-={delivery-method=message
delivery-address = “admin@desk1.office.com”}" printer1-ld

Note: If you display the notification profile to verify that the entry has been
removed and find that it has not been removed, enter the command again, but this
time instead of only specifying the delivery-address, type the entire notification
profile exactly as it appears.

Changing the delivery method

You can choose to receive your notification messages in a variety of ways, as listed
in Table 12 on page 119. Follow these steps to change the delivery method from the
default to some other value.
1. Use the “Viewing an existing notification profile” on page 125 procedure to

find the entry you want to change.
2. Type the following command. Fill in the values for the italicized items exactly

as they appear in the entry you want to change. Replace the delivery-method
and delivery-address values as specified in Table 12 on page 119.
pdset -c Type of Infoprint object -x “notification-profile+={event-
identifiers=event(s) delivery-method=method delivery-address=”address“
locale=yourlocale}”Objectname

3. Press Enter.
4. Use the “Viewing an existing notification profile” on page 125 procedure to

verify that the entry was added.
5. Follow the procedure for removing a user to remove the old entry.

Example: You want to receive your messages about printer1-q in your E-mail
instead of through InfoPrint Manager Notifications. You view the notification
profile, and see this entry:
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printer1-q: notification-profile={event-identifiers = object-cleaned
object-deleted queue-backlogged delivery-method = message delivery-address
= “admin@desk1.office.com” locale = en_US}

Issue this command to add another entry to the notification profile with a different
delivery method and delivery address.

pdset -c queue -x “notification-profile+={event-identifiers=object-cleaned
object-deleted queue-backlogged delivery-method=electronic-mail
delivery-address=”admin@mycompany.com“ locale=en_US}” printer1-q

Then view the notification profile again and see two entries:

printer1-q: notification-profile= {event-identifiers = object-cleaned
object-deleted queue-backlogged delivery-method = message delivery-address
= “admin@desk1.office.com” locale = en_US} {event-identifiers =
object-cleaned object-deleted queue-backlogged delivery-method =
electronic-mail delivery-address = “admin@mycompany.com” locale = en_US}

Follow the procedure for removing a user to delete the entry that would send
messages to InfoPrint Manager Notifications.

Getting help for notification messages
If you receive a notification message that you don’t understand, InfoPrint Manager
provides a way to get more information about the situation. In some cases, the
explanation even suggests some things you can do to resolve the problem.

To see the full text of an error message, use the pdmsg utility and specify the
message number to display help for notification messages you received.

For example, you receive this notification message about the PrintQueue1
contained in server MainServer.
To:nrharvey@hope.bpc.infoprint.com
Subject: 5010-192 Message from InfoPrint server: MainServer
********
[05/30/97 07:26:381] 5010-304 The queue MainServer:PrintQueue1 is backlogged.

To receive help for message 5010-304, enter the command:
pdmsg 5010-304

InfoPrint displays information similar to this:
5010-304 The queue _________:________ is backlogged.
5010-304
EXPLANATION: InfoPrint calculates that there are too many jobs in
this queue for all the jobs to print within the time specified by the
queue-backlog-upper-bound value.
A notification-profile value requested that you be notified of the event
queue-backlogged.
SYSTEM ACTION: The queue continues to accept jobs, but there will
be a delay before they print.
RESPONSE: Alleviate the backlog by moving some of the
jobs to a different queue or by adding actual destinations to this queue.

Note: The LANG environment variable and the message catalogs installed control
the language in which the pdmsg utility displays message help information.
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Other notification methods

Notify-operator attribute
The notify-operator attribute is a scaled-down version of a notification profile. It
can only be set on InfoPrint Manager queues and actual destinations and can only
use the e-mail, message, exit and wireless delivery methods. In addition, it only
sends messages when one of these events occur.
1. A job is added to a queue.
2. An actual destination starts processing a job.
3. An actual destination finishes processing a job.

The syntax of the notify-operator attribute is:
delivery-method:delivery-address

See Table 12 on page 119 for descriptions of the e-mail and message delivery
methods and their corresponding delivery addresses. By default, the
notify-operator attribute is set to message:your user ID@your node when you
create an actual destination or a queue. To change the value for an actual
destination, you can use the Notification tab of the properties notebook. To change
the value for a queue, use the pdset command.

The messages that the notify-operator attribute delivers are not standard error
messages like the ones you receive when you use a full notification profile. Instead,
you write the messages that you want to send and specify them as attributes of
jobs when you submit them.

Note: You must either specify those attributes in the command when you submit
the job or set the text in the job and document defaults for the appropriate logical
destination.
To specify your messages, you use these job attributes:
v job-message-to-operator

The message that InfoPrint Manager sends when it adds a job to the queue.
v job-start-message

The message that InfoPrint Manager sends when the job starts processing.
v job-end-message

The message that InfoPrint Manager sends when the job finishes processing.

You can type the text for all three of these messages in the appropriate field on the
Job Notification tab of the properties notebook for a job or a default job.

In addition, you can use the job-start-message attribute in conjunction with the
job-start-wait attribute. If you set the job-start-wait attribute on a job (or in a
default job) to true, the actual destination receives the job and sends the job-start
message. Then, it pauses the actual destination (whether a job is currently being
printed) until the operator intervenes. This function is useful when different jobs
need to be printed on different types of paper. Operators don’t need to manually
pause the actual destination to change paper between jobs; InfoPrint Manager does
it automatically. Once the printer is ready, the operator must resume the actual
destination and the job prints. This function should be set for the first in a series of
jobs, once you are certain that there are no jobs printing on the printer. Because it
compels InfoPrint Manager to pause the printer for every job with
job-start-wait=true, you should not specify this value on the default job.
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To use the job-start-wait attribute, you must set it to yes on the job or default job.
You can specify the attribute in the command when you submit a print job or set it
on the Job Notification tab of the properties notebook for default jobs.
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Chapter 11. Managing security for InfoPrint Manager for AIX

InfoPrint Manager Security, a feature that you administer through SMIT, lets you
protect your printing system by associating an Access Control List (ACL) with an
InfoPrint object or operation. An ACL is the list of users and groups who have
permission to do something to or with an object, and what type of permission that
is.

Note: InfoPrint Manager Security only uses the login ID permissions. Therefore, if
a user logs in and does an SU to root or to another user, the permissions associated
with the original login ID remain in effect.

Types of permission
In InfoPrint Manager, users can have three levels of permission: read, write, and
delete. The levels provide these types of access:
v Read

For operations, the user can do the operation. For servers and queues, the user
can view the attributes. For destinations, the user can view attributes and submit
jobs to that destination.

v Write

For all objects, the user can view and modify attributes.
v Delete

For all objects, the user can view and modify attributes and can delete the object.

If you place userA on the ACL for the logical destination “print2ld” and give her
read permission, she can send her print jobs to it and can open the “print2ld”
object to see its properties. However, she cannot make changes to those properties.
If she tried to change any of them or tried to delete the destination, she would
receive an error message. If you decide that userA needs to be able to do more and
give her write permission as well, she will be able to change the properties of
“print2ld,” but still will not be able to delete it.

Important: If you protect a destination (logical or actual) so that only certain users
can modify or delete its properties, you might inadvertantly prevent other users
from submitting print jobs to it. To be sure that all of your users can still print to
the destination, add the wildcard character (*) to the ACL as a user with read
permission.

You can also attach ACLs to the operations that you can do on InfoPrint objects.
Allowing you to protect both operations and objects means that InfoPrint Manager
Security provides different levels of security: you can protect all objects by using
ACLs at the operation level or you can protect individual objects with ACLs
applied only to them. Or you can do both: protect all objects by using
operation-level ACLs for some operations and limit access to sub-sets of objects by
using object-level ACLs.

All InfoPrint object names, including security groups and ACL members, are
case-sensitive.
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For operations, there is only one level of permission: read. If a user has read
permission, they can do that action; if he does not, he cannot do the action. For
example, userB is a printer operator and must be able to move jobs to different
positions in the print queue because some jobs need to be printed before others.
You can give userB read permission for the operation Reorder Job to allow him to
do his job. On the other hand, userC submits print jobs from his office workstation
and doesn’t like to wait for the jobs ahead of his in the queue to print. If you want
to prevent him from moving jobs, don’t put him on the ACL for the Reorder Job
operation. When he tries to move his job to the top of the queue, the action will be
denied.

When you install InfoPrint Manager, many operations are already protected so that
only members of the admin and oper groups can do them. You can see the ACLs
for operations in the Management Console by selecting the Security-ACL-
Operations item in the left pane. If you want users to be able to do those
operations, you must either add those users to the individual ACLs or to a group
that has permission (either the existing admin and oper groups or a new group
that you create).

Note: If an object is protected, a user can only do an operation on that object if he
has both read permission for the operation and the appropriate level of permission
for the object. If the object is not protected, only users in the default admin or oper
groups are able to do the action. If a user is added to a non-standard group, they
are not able to do the action unless they are the owner of the job in question.

If the object has an ACL the permission needed depends on the operation. For
example, List requires read, Set requires write, and Delete requires delete.

Security groups
No matter what size organization you work in, manually adding every user to
every ACL can be a time-consuming process. To reduce some of the work, you can
create security groups, groups of users who need to have the same levels of
permission for the same objects. You use the name of the security group like a user
ID; instead of adding each user ID to an ACL, you add the group name. For
example, if you want all ten of your print operators to be able to perform the same
operations, create a group and name it operators. Then, add operators to the
appropriate ACLs.

When you install InfoPrint Manager, three security groups are created by default:
v acl_admin

Users who have authority to manage security by changing access control lists
and groups. The default members are administrator and the user who was
logged on when InfoPrint Manager was installed.

v admin

Users who have administrator authority. The default members are administrator
and the user who was logged on when InfoPrint Manager was installed.

v oper

Users who have operator authority. The default member is administrator.

Notes:

1. There is another security group called JobTicketer that is created if you have
installed InfoPrint Job Ticketer as part of the Print-on-Demand feature. Unlike
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the other groups, there are no default users created during installation. See
InfoPrint Job Ticketer: Administrator’s Guide for more information.

2. You can modify these groups as needed. In the example above, you could have
simply added your operators to the default oper group and modified any
permissions that weren’t set to the level that you wanted them.

3. AIX is case-sensitive when it comes to user IDs, whereas Windows is not.
When you are using AIX and Windows machines together, make sure that you
take this into consideration. For example, you might want to add both
Administrator and administrator to your ACLs.

You can add users to multiple groups, but you cannot make one group a member
of another group. For example, if you hire five new print operators, you might
create a group for them called trainees, since you only want them to have limited
permissions until they are finished with their training. When they finish their
training, you cannot add trainees as a member of the operators group. You will
have to add their user IDs to the operators group one at a time. In addition, you
will have to either delete the trainees group or delete the members from
it—otherwise those users will have conflicting levels of permission.

When users are members of more than one group and each group has a different
level of permission for a particular object, the most restrictive permission applies.
In the example above, if you forgot to remove the new employees from the
trainees group at the end of their training, they wouldn’t be able to perform the
tasks their job required- they would still be restricted.

Identifying users and groups: wildcarding
When you add users to ACLs or Security groups, you identify them by their user
ID and the computer that they work on in this format: username@computername.
The permissions you assign will only apply when that person accesses InfoPrint
Manager from that workstation.

If, however, you or any of your users want to be able to work with InfoPrint
Manager objects from various workstations, you might not want to add multiple
user ID/computer name combinations for the same person—you can use
wildcarding instead. When you use wildcarding, you replace the computer name
or user ID with the wildcard character (*) when you add a member to an ACL or
Security Group. The wildcard character stands for “any computer” or “any user
ID.” So, if you create an ACL member called administrator@*, no matter what
computer you log on to as administrator, you have the same permissions. If you
use the wildcard character before the computer name, for example *@computer,
any user who logs on to computer1 can do the actions that the ACL member has
permission for.

Working with ACLs and groups
Use the AIX SMIT utility to manage the security of your print system. Open an
AIXterm window and enter smit on the command line. The line InfoPrint Printing
System will appear as an option. By following the menu item to the right with
your cursor, you can navigate the this directory structure of menu choices:

Tab #1 Tab #2 Tab #3 Choices
InfoPrint Printing Systems→ Security→ Groups→ Add Group

Show Group
Add User to Group
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Remove User from
Group

Tab #1 Tab #2 Tab #3 Tab #4 Choices
InfoPrint Printing
Systems→

Security→ Access Control→ Operations→ Show Access
Control List

Servers→ Change Access
Control List

Destinations→ Remove Access
Control List

Queues→

These three groups are created for you by default and display when you select the
Groups→Show Group option: acl_admin, admin, and oper. The root user is placed
in the acl_admin group. To have the access necessary to modify the security
characteristics, the user must be a member of the acl_admin group. There is
another security group called JobTicketer that is created if you have installed
InfoPrint Job Ticketer as part of the Print-on-Demand feature. Unlike the other
groups, there are no default users created during installation. See InfoPrint Job
Ticketer: Administrator’s Guide for more information.

For specific information supporting a menu choice, press F1 for help.
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Chapter 12. Setting InfoPrint Manager and AIX environment
variables

InfoPrint Manager uses environment variables:
v To define its environment in the AIX system
v To define the objects managed by and options available in the InfoPrint SMIT

operator’s interface

Environment variables are strings that have a name and a value in the form of
NAME=value. See InfoPrint Manager: Reference for a complete list of InfoPrint
Manager environment variables and AIX environment variables that affect
InfoPrint Manager.

Preparing to work with InfoPrint Manager and AIX environment
variables

Read through theses topics to become familiar with environment-variable structure
and terms.

Where are environment variables found?
InfoPrint and AIX environment variables can be found in these files:

InfoPrint SMIT operator’s interface environment file
The name of this file is the value of the PPO_DEFAULT_ENV environment
variable, by default, /usr/lpp/pd/bin/ppo.env. It contains environment
variables that define values used by the InfoPrint SMIT operator’s
interface.

/etc/environment
This file contains environment variables that apply to all sessions for all
users on a given AIX system.

.profile
The .profile file in a user’s home directory contains environment variables
that apply to all the user’s AIX sessions. Values in this file override values
in /etc/environment.

How are environment variables set?
You can use these methods to set or change values for environment variables:
v If you are an administrator, you can set AIX environment variables and InfoPrint

Manager environment variables in the /etc/environment file or in the InfoPrint
SMIT operator’s interface environment file by using an AIX editor.
Settings in these files apply to all sessions for all users, unless users override
them through their .profile files or from the command line.

v You can modify your .profile file in your home directory by using an AIX editor.
Settings in the .profile file override settings in the /etc/environment file. These
settings apply only to you and are in effect for all AIX sessions, unless you
override the settings from the command line.

v You can enter one of these commands on the command line to set environment
variables for a single AIX session:
– In the Korn shell or the Bourne shell, use the export command.
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– In the C shell, use the setenv command.

Command line settings override settings in the /etc/environment file and
.profile file. These settings apply only to you and are in effect only until you
exit the AIX session from which you issued the command.

You cannot change the environment of a running process. If you change the value
of an environment variable, you must restart any process that was started before
the change if the change is to take effect for that process. For example, an InfoPrint
Manager server is a process. If you change the /etc/environment file, you must
stop and start the server again for the change to take effect.

What restrictions apply?
These restrictions apply when you create or define values for environment
variables:
v Ensure that newly created environment variables do not conflict with standard

variables, such as MAIL, PS1, PS2, and IFS. See AIX documentation for further
information.

v Ensure that the information in the /etc/environment file is in the NAME=value
format. The /etc/environment file is not a shell script and does not accept data
in any format other than the NAME=value format.

v Do not use variables to represent values in the /etc/environment file. For
example:
PATH=$PATH:/path1:/path2

is not a valid entry in the /etc/environment file. Instead of $PATH, enter a full
path name.

v The format in which you specify the value for any variable that defines directory
paths determines whether your value is appended to the current value or
overrides it.
– This format overrides the current value:

export PATH=/path1:/path2

If you do not include the InfoPrint Manager directories in the value you
specify, you will not have automatic access to InfoPrint Manager.

– This format appends your value to the current value:
export PATH=$PATH:/path1:/path2

Querying environment variables
You can use one of these AIX commands to query the value of an environment
variable:
v In any shell, use the echo command.
v In the Korn shell, use the print command.

For example, to determine the default logical printer, enter:
echo $PDPRINTER

Note: InfoPrint Manager uses default values for some InfoPrint Manager
environment variables without setting the environment variable. When you query
those environment variables and you have not set a value, the response is a blank
line.

To query all environment variables that have values set, enter: env
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Editing the /etc/environment file

To set an environment variable in the /etc/environment file, you need to edit the
file with an AIX editor. See “How are environment variables set?” on page 135 and
“What restrictions apply?” on page 136 for additional information.

This example shows how to set the PDPRINTER environment variable in the
/etc/environment file using the vi editor:
1. Enter this command to change to the /etc directory:

cd /etc

2. Enter this command:
vi environment

A typical /etc/environment file contains lines similar to this:
NLSPATH=/usr/lib/nls/msg/%L/%N:/usr/lib/nls/msg/%L/%N.cat
LANG=en_US

3. Insert or modify this line in the /etc/environment file:
PDPRINTER=LogicalDestinationName

where LogicalDestinationName is the name of the logical printer you want to set
as the default logical printer for all users.

4. Save the change in plain text format and exit from the editor.
5. Make the change effective by entering the command:

. ./etc/environment

6. Verify the change by entering the command:
echo $PDPRINTER

The logical destination name you entered displays.

Editing a .profile file

To set an environment variable in the .profile file, you need to edit the file with an
AIX editor. See “What restrictions apply?” on page 136 for information about
restrictions.

This example shows how to set the PDPRINTER environment variable in your
.profile file, using the vi editor.
1. Enter this command to change to your home directory:

cd

2. Enter this command:
vi .profile

3. A typical .profile file contains lines similar to these:
PATH=.:$HOME/bin:/bin:/usr/bin:/etc:/usr/ucb:/usr/bin/X11:tools/
usr/bin:/usr/lpp/cmvc/bin:/usr/OV/bin:/usr/local/tools/rs6/bin:/usr
/local/tools/rs6:/usr/dt/bin

export PATH
export EDITOR=vi

4. Insert or modify this line in the .profile file:
export PDPRINTER=LogicalDestinationName

where LogicalDestinationName is the name of the logical printer you want to set
as your default.
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5. Save the change in plain text format and exit from the editor.
6. Make the change effective by entering this command:

. .profile

7. Verify the change by entering the command:
echo $PDPRINTER

The logical printer name you entered displays.

Setting an environment variable from the command line

To set the value of the environment variable PDPRINTER to Printer3 for a single
AIX session, enter one of these commands:
v In the Korn shell or the Bourne shell, enter:

export PDPRINTER=Printer3

v In the C shell, enter:
setenv PDPRINTER Printer3

Verifying the setting of environment variables

You can verify the setting of environment variables that InfoPrint set or appended
during InfoPrint installation by doing the following procedures.

Verifying the setting of the PATH environment variable

During the installation process, InfoPrint updates the AIX PATH environment
variable to include the directory location of the InfoPrint executable files; InfoPrint
appends /usr/lpp/pd/bin and /usr/lpp/psf/bin to the paths already specified.

To verify that the PATH environment variable is set and contains /usr/lpp/pd/bin
and /usr/lpp/psf/bin, enter the command:
echo $PATH

Verifying the setting of the PDBASE environment variable

During the installation process, InfoPrint adds the InfoPrint PDBASE environment
variable to the /etc/environment file and specifies /var/pd as the working directory
where InfoPrint stores its object code.

To verify that the PDBASE environment variable is set and contains /var/pd, enter
the command:
echo $PDBASE

Verifying the setting of the MANPATH environment variable

During the installation process of an InfoPrint Manager server or an InfoPrint
Manager client, InfoPrint appends :/usr/share/man/$LANG to the value of this
variable. The :/usr/share/man/$LANG directory is the location of the cat7
subdirectory, which contains the InfoPrint man pages. $LANG is the locale.

To verify that the MANPATH environment variable is set and contains
:/usr/share/man/$LANG, enter the command:
echo $MANPATH
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Chapter 13. Monitoring memory and space on your AIX
system

InfoPrint Manager provides a method for monitoring memory use on your
InfoPrint AIX server. This support also provides you the opportunity to define and
establish recovery options through exit programs or shell scripts that you can
customize and add to the system.

AIX allocates space for the printing and monitoring tasks required in an InfoPrint
environment through different file systems. A file system is a structure of parent
directories, subdirectories, and files. A directory is a unique type of file that contains
only the information need to access files or other directories. Directories contain
files, subdirectories, or a combination of both. The directory containing a
subdirectory is the parent directory.

On occasion, you might have to make sure that work files used in printing jobs do
not consume too much space on your file systems. For example, PostScript or TIFF
job tickets that are ripped for printing might leave work files in the /var/psf file
system. Over time, these files can reduce system performance and eventually stop
the system. Develop a maintenance strategy with your InfoPrint Solutions
Company service representative.

Monitoring memory use on your InfoPrint AIX server

By default, the Memory Usage tab of the server property notebook is left blank;
you must set these values and create the customized shell scripts or programs to
activate this support.

You can access this support from the InfoPrint Manager Administration GUI:
1. Select Server → Properties.
2. Click the Show more button.
3. Select the Memory Usage tab.

From the Memory Usage page, you can specify a low memory threshold
percentage and a high memory threshold percentage that cause InfoPrint to invoke
a customized exit program or shell script that you can write for your print
installation. For example, if the server’s system memory usage goes above 60% (the
value for the upper memory usage threshold field), InfoPrint invokes a
user-customized shell script (the /localtools/uplimit value for the Upper
memory usage exit field) that contains specific recovery actions for your print
installation. If the server’s system memory usage drops below 59% (the value for
the lower memory usage threshold field), InfoPrint calls a user-customized shell
script (the /localtools/lowlimit value for the Lower memory usage exit field)
that contains specific recovery actions for your print installation. This exit usually
restores the previous state of the server, undoing temporary changes made by the
upper threshold exit.

The customized exit programs or shell scripts can do as little or as much as you
specify. For example, you might write a script to disable a certain set of printers.
The script could also move jobs to other servers. Both the lower-memory-usage-
exit and upper-memory-usage-exit server attributes allow you to substitute values
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in the commands that are generated to run the exit program. For example, %s is
equivalent to server name and %t is equivalent to threshold value. If a particular exit
attribute contains a value of memprob %s in the server server1, then when InfoPrint
invokes the memory usage shell script it passes server1 as the first argument.

For example, a shell script named uplimit might:
1. Prevent new jobs from arriving at a logical destination by disabling that

InfoPrint object.
2. Prevent the listing of jobs so that queries of the current backlog do not add to

the memory constraints.
3. Ensure that any actual destinations (in this case, the three pooled actual

destinations named adn) are re-enabled, so that they can reduce any backlog of
jobs that could be causing the problem.

The uplimit script might look like this:
#!/bin/ksh
pddisable prt1-ld
pdset -cserv -xdisallow-list-obj-class=job server1
pdenable ad1 ad2 ad3

The lowlimit script might look like this:
1. Re-enable the logical destination so that new jobs are being accepted.
2. Reset the server to allow the listing of job queries.

The lowlimit script might look like this:
#!/bin/ksh
pdenable prt1-ld
pdset -cserv -xdisallow-list-obj-class== server1

Note: You can use the Queries to Prevent section on the Memory Usage page to
both add and remove the listing of any queries against a specified InfoPrint object,
such as Jobs. The Jobs object is the most useful to restrict, but this should be done
cautiously, because once it has been set, you cannot query any jobs from either the
InfoPrint Manager Administration Interface or the InfoPrint Manager Operations
GUI.

Note that if the shell scripts or programs are not in the system path, you must
specify the fully qualified path for the shell scripts that you have customized. If
you misspell a shell script name or refer to a file that does not exist, InfoPrint lets
you change the setting. For more information about the lower-memory-usage-
threshold, lower-memory-usage-exit, upper-memory-usage-threshold, and
upper-memory-usage-exit server attributes that support this feature, see InfoPrint
Manager: Reference.

Once you have selected the appropriate values, click OK to apply this change and
close the Server Properties dialog.

Monitoring file system use (automatically)
InfoPrint Manager includes support to help you monitor file system usage. The
InfoPrint Manager server polls these critical file systems at regularly scheduled
intervals, and it increases the polling as the usage increases. Initially, the file
system is polled for usage every 16 minutes.

Here is the polling schedule:
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80% usage
Every 8 minutes

90% usage
Every 4 minutes

95% usage
Every 2 minutes

97.5% usage
Every minute

If the usage for a file system goes above the InfoPrint Manager pre-defined
threshold of 80%, InfoPrint Manager logs a message and generates a
disk-space-low notification event. As usage increases above each threshold, more
messages and disk-space-low events are logged and generated. See “Configuring
your notification profile for disk-space-low events” for information about how to
configure your notification profile so you can be notified of the disk-space-low
event.

Each time usages goes above the 80, 90, 95, and 97.5 percent usage levels, the
disk-space-low event is generated and logged. However, InfoPrint Manager only
issues one event for each usage level.

Note: The threshold is reset if the file system usage drops below the previous
threshold; for example, when the file system usage drops to 70% after an 80%
disk-space-low event, it is reset.

Configuring your notification profile for disk-space-low events

It is recommended that you include both the disk-space-low and out-of-disk-space
events in your notification profiles. The InfoPrint Manager server sends
out-of-disk-space notifications by default, so that when your file system usage
reaches 100%, this event is generated. You can modify the server notification
profile to add the disk-space-low event. However, the messages from the file
system usage monitoring are always logged; regardless of the events in the server
notification profile.

To add a disk-space-low event notification, open the Administration GUI and
select Server→Properties→Other→Notification Profile and click Add. Add the
disk-space-low event to the notification profile. You must also select the
notification method to use on the same panel.

InfoPrint Manager for AIX monitors these file systems:
v PDBASE
v PDNAMESPACE
v /var/psm

v /var/psf

v /var/psf/segments

v /var

v /var/spool/lpd

v /tmp
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Monitoring file system use (manually)

Using the disk usage tool

The Disk Usage icon on the front panel of the CDE allows you to manually
display information about total space and available space on a file system. To find
this icon:
v With the POD feature, click the User Tools icon (the paper and pencil) to open a

subpanel.
v Without the POD feature, click the Application Manager icon (the file drawer

containing a ruler, calculator, and pencil) to open a window. In this window,
click the Desktop_Tools icon.

When you click the Disk Usage icon, AIX displays information for all currently
mounted file systems as shown in this example:
Filesystem 512-blocks Free %Used Iused %Iused Mounted on
/dev/hd4 16384 7024 58% 1069 27% /
/dev/hd2 1359872 493128 64% 17071 11% /usr
/dev/hd9var 16384 13528 18% 305 15% /var
/dev/hd3 32768 30984 6% 87 3% /tmp
/dev/hd1 16384 15368 7% 136 7% /home
/dev/lv00 1015808 983440 4% 66 1% /var/psf
/dev/lv01 2015232 1951888 4% 16 1% /var/psf/segments
/dev/lv02 3014656 2919936 4% 17 1% /var/pd

The first column displays AIX file systems that are also directories. These
directories are all subdirectories of the /dev parent directory, which means that
they contain special files for I/O devices. The most important column is the fourth
from the left that displays the percentage of each file system used.

Using the df command

You can see how your AIX system uses space in a single file system by using the
df command. To manually display the space on the file system where your current
directory is located, enter this command on the AIX command line:
df .

AIX displays this:
Filesystem 512-blocks Free %Used Iused %Iused Mounted on
/dev/hd1 16384 15368 7% 136 7% /home

File systems and directories to clean up
Certain file systems and directories tend to fill up. You should check, and if
necessary, clean up these file systems and directories regularly. See Chapter 33,
“Customizing error logs in the InfoPrint Manager AIX server,” on page 313 for
more information that will help reduce the amount of clean up that is necessary.

File systems used by all InfoPrint installations
If either the /var/psf or the /var/pd file system is more than 85% full, you should
contact your InfoPrint service representative to determine whether you need to
clean out files or modify any configuration settings. You might consider removing
some files, such as large error or accounting logs. You can find these files in the
following locations:
v Server accounting logs: /var/pd/servername/accounting.logs
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– For more information about accounting logs, see “How do you manage the
contents of the InfoPrint AIX server accounting logs?” on page 99 in
Chapter 8, “Gathering accounting and auditing data about print jobs,” on
page 97.

v PSF accounting logs: /var/psf/. See “How do you manage the contents of the
PSF DSS accounting data file?” on page 105.

v Error logs: /var/pd/server.BAK/error.log.BAK.timestamp

For more information about accounting logs, see the topics ″How does the
pdaccount command collect InfoPrint AIX server information?″ and ″How do you
manage the contents of the InfoPrint AIX server accounting logs?″ in the
″Gathering accounting and auditing data about print jobs″ chapter in theInfoPrint
Manager for AIX: Procedures manual.

If you want to customize your log settings, see Chapter 33, “Customizing error
logs in the InfoPrint Manager AIX server,” on page 313.

Segment Size parameter

The Default SEGMENT SIZE parameter affects the disk I/O performance of the
/var/ psf/segments file system. This parameter determines the maximum size of
any temporary file created by the Input Manager component that is stored in /var/
psf/segments. This setting determines the number of temporary files that Input
Manager requires for all print jobs submitted to InfoPrint Manager: the smaller the
setting, the more files required to process the AFP input data. This parameter can
be set by using SMIT: InfoPrint Printing System→Miscellaneous→Customize the
Input Manager.

For Basic Server configurations, the default setting of 5000 KB per segment can be
raised to reduce the disk I/O usage associated with reading and writing data to
the /var/psf/segments file system.

For Advanced Server configurations, the default setting of 1000 KB per segment
can be raised to reduce the disk I/O usage associated with reading and writing
data to the /var/psf/segments file system; however, the default setting usually
works well with most AFP production applications.
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Chapter 14. Using the InfoPrint Manager System Migration
(ismu) Utility

You use the InfoPrint System Migration (ismu) utility for backing up, restoring, or
migrating your InfoPrint Manager environment. This utility is based on the
existing server archive functionality, and it backs up your current configuration
from a specific level of InfoPrint Manager and restores it on the same or different
InfoPrint Manager environment.

Using this utility, you can back up any level of your InfoPrint Manager
environment.

When using this utility for restoring purposes, we recommended having the
InfoPrint Manager and the backup archive at the same level. If they are not at the
same level and you proceed with the restoring or migration process, two warning
messages will prompt you that you are not on the same level and the results might
be unpredictable. This still enables you to have the backup or restore process ran
at slightly different levels (for example x.2.0.255 versus x.2.0.256).

If you need to perform a migration between different levels of InfoPrint Manager,
follow these steps:
v Make sure that InfoPrint Manager is at the same level on the backup and target

environments
v Perform the backup and restore required operations, as documented in InfoPrint

Manager: Reference.

v If necessary, upgrade InfoPrint Manager to the required level.

Note:

v The ismu utility must not be used to perform crossover migrations, such as
migrating the AIX environment to the Windows environment and backwards.
Use this command to backup and restore only similar operating system
environments.

v For the Version 4 Release 2 customers convenience, we are delivering the
InfoPrint Manager System Migration Utility on the server CDs starting with the
next update for Release 2.

Supported operating environments

The ismu utility can run on any of these operating systems:
v AIX 5.1
v AIX 5.2
v AIX 5.3
v AIX 6.1

InfoPrint System Migration Utility requires that the minimum level of InfoPrint
Manager is Version 4 Release 2 . The utility does not support Version 4 Release 1
migrations. The tool will not limit the migration from Version 4 Release 1 but the
results might be unpredictable.
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Prerequisites

Before using the ismu utility, make sure you are aware of these recommendations:
v To run this utility, you must have administrative rights on the system InfoPrint

Manager is running.
v The InfoPrint Manager server(s) must be installed and running at all times.
v The InfoPrint Manager target server(s) must not contain any objects.
v To run the ismu utility, these programs must be installed on your machine:

tar, gzip, gunzip and diff

Note: You can only run the ismu utility locally. This utility does not have network
functionality.

Migrating your InfoPrint Manager settings

Before migrating your InfoPrint Manager settings and objects, read the following
sections to find out more about what files are automatically backed up and what
files are not automatically backed up. For the files and settings that are not
automatically backed up, you should use the manual back up procedure.

Automatic process

This section lists the files that will be automatically backed up and restored by the
ismu utility.

Table 14. Files that the ismu utility automatically backs up and restores

Files automatically backed up and restored

Custom notification and PSF exits

FST security settings

PSF Direct configuration

Custom or modified halftones.

Transform configuration files.

Server Admin/Operator GUI configuration/customization.

Custom 64xx GRID mapping tables.

Custom ICU tables.

Custom auxilliary-sheets.

Automatic tasks during migration

This section details all sections of InfoPrint Manager that are automatically backed
up during the migration process.

Custom notification and PSF exits

The program automatically backs up and restores any custom exits and/or PSF
exits it founds including these two server exits:

lower-memory-usage-exit
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upper-memory-usage-exit

FST security settings

The ismu utility automatically backs up and/or restores all the files within the
/var/pddir/default_cell/acl directory.

PSF Direct configuration

The ismu utility copies all the /var/psf/psfdirect/*.profile files from source to the
target server.

Custom or modified halftones

The ismu utility backs up and/or restores all files from the /usr/lpp/psf/config/
custom directory.

Transform configuration files

By default, InfoPrint Manager comes with this transforms: gif2afp, img2afp,
jpeg2afp, pcl2afp, ps2afp, tiff2afp and xml2afp. There are two other transforms that
are installed separately: afp2pdf and sap2afp. The configuration files for all the
transforms are located in /usr/lpp/psf/<transform_name_directory>, and if you had
modified them, then the modified files will be copied onto the new server.

Server Admin/Operator GUI configuration/customization

Copy all the ipgui_*.cfg files from /var/pd/gui directory on the new server.

Custom 64xx GRID mapping tables

Copy all the customized *.grd files from /var/psf/<printer_name>

Custom ICU tables

Copy all the customized .cnv files from /usr/lpp/psf/unicode/data/mappings.

By default it contains 6 cnv files:
v icudt24b_ibm-1388-sap2afp.cnv
v icudt24b_ibm-933-sap2afp.cnv
v icudt24b_ibm-937-sap2afp.cnv
v icudt24b_ibm-939-sap2afp.cnv
v icudt24b_ibm-1399-sap2afp.cnv
v icudt24b_IBM-943C.cnv

If exist, the tool will copy and/or restore all the files from /usr/lpp/psf/afp2pdf/
cnv.

Custom auxilliary-sheets

If the output shows more than the default sheets that come with InfoPrint Manager
(64xx, accounting-log, blank, brief, full, job-ticket and none) then the program
automatically copies the customized sheets to the new server. Also the customized
user-exits from usr/lpp/psf/exits/psf are copied, too.
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Manual process
The following list contains parts that the ismu utility will not automatically back
up and restore.
v Third party applications
v Fast Connect/SAMBA software and configuration for IPDATA and

interoperating
v IPPGW configuration
v Channel configuration
v Associated installed products and/or InfoPrintManager features
v IJT and Web Server
v Halftone Management System
v Native print queues
v Drivers (backends and colon files)
v Custom ACIF exits
v MVS download

Specific tasks during migration
During the migration process, it is very important to make sure that all objects are
correctly backed up and your initial configuration is correctly restored. Therefore,
these sections list all important areas where you should take additional steps for
an accurate migration process.

Fast Connect/SAMBA software and configuration for IPDATA and
interoperating

If the source pdserver that must be migrated is inter-operated with another server,
you must set up the interoperating environment on the new server.

To find more information about this procedure, follow the instructions from
InfoPrint Manager for AIX: Procedures: (G550-1066), Chapter 23 ″Configuring InfoPrint
systems for interoperability″ and InfoPrint Manager for Windows: Procedures:
(G550-1073) Chapter 22 ″Setting up interoperating environments″.

If job ticketing is used, you must configure the IPDATA folder. The documentation
for this task is found in ″InfoPrint Job Ticketer: Administrator’s Guide: (S550-1056)″,
Chapter 3 ″Installation and Configuration″ - ″Setting up shared file support″.

Channel configuration

The channel configuration is no longer supported. The printers will be created, but
they won’t start.

Associated installed products and/or InfoPrint Manager features

PPFA

If you have this feature installed, you must install it from the InfoPrint PPFA
Feature CD on the new server. If you have customized PPFA source files, you need
to copy them to the new server for later processing.

AFP Resource Installer
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This is an independent Windows application. You need to make sure that the
resources used by the InfoPrint Manager objects are available on the new system.

InfoPrint Job Ticketer and Web Server

If you have InfoPrint Job Ticketer installed on your machine, follow these steps:
1. On the new server, install the InfoPrint Print-on-Demand Feature with Job

Ticketer.
2. Copy the /var/pdjt/JobLibrary directory from the old server to the new one

and also copy the database from /var/db/ibmdb.
3. Open the Job Ticketer application in the browser and select ″Preferences″ from

the left panel.
4. Make sure that the same settings on the new server (measurement units,

submitted jobs to retain and file sharing folder) exist.
5. Click ″Print Devices″ in the menu and make a list with the print servers, port

numbers, and active/inactive status.
6. Add these print servers in InfoPrint Job Ticketer on the new server.

Backends and colon files

The ismu utility does not automatically back-up and restore the AIX drivers. This
operation has to be done manually.

Custom ACIF exits

You need to manually back up and restore any customized ACIF exits that you
created. These are located in /usr/lpp/psf/bin(apk*, asciinp* and dbblank files)
and the source files are located in /usr/lpp/psf/acif/.

MVS Download

You need to complete these steps:
v To see if any MVS Download daemons are running on the source system, enter

this command:
#ps -ef | grep mvsprsd

v If the MVS Download daemons are running, you need to copy and restore the
following files, in case you have modified them:
– /etc/rc scripts
– /etc/inittab scripts
– /usr/lpp/pd/bin/mvsprpsm.sh script

IPPGW configuration
1. You need to use the #lsippgw command to see if the IPP Gateway daemon is

running and also to get the port the daemon is started on.
2. If the IPP Gateway daemon is running, its configuration should be migrated to

the target server.

To do this, you must perform the following tasks:
1. On the new server, start the IPP Gateway using the startippgw daemon utility

or SMIT by following this path: InfoPrint Printing Systems -->InfoPrint
Utilities --> IPP Gateway Daemon.
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2. Verify that the gateway is working by opening the Internet browser and
entering the following web address, replacing serverhostname with the DNS
hostname of the system where the IPP gateway daemon is running:
http://serverhostname:631/printers
where 631 is the default port. If the daemon is using a different port, specify
the number of the port you are using. If the gateway is working correctly, you
should see a list of the printers that are available through the gateway. All of
the InfoPrint destinations should be listed there. Then you need to find the
address (URL) of the destination you can print to.

3. If your InfoPrint Manager environment has two InfoPrint Manager systems in
different name spaces on the same machine, you need to start an IPP gateway
daemon for each InfoPrint Manager system.

Halftone Management System

If you have the Print-on-Demand Feature installed, you also have he Halftone
Management System (HMS) server running.

To verify this, enter:

# ps –ef | grep server

If the HMS server is running, a line like this will be displayed:

root 23830 20954 0 Oct 22 pts/0 0:43 java calibd /usr/lpp/pd/ipcal/server/
calibd.src /usr/lpp/pd/ ipcal/server/calibd.msg trace.log
/usr/lpp/pd/ipcal/bin

Start the HMS server on the target InfoPrint Manager machine. The configuration
does not need to be migrated as the halftones are handled automatically.
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Part 2. Administrative procedures: Customizing for special
jobs
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Chapter 15. Working with transforms

InfoPrint provides transform programs for these data streams:
v Printer control language (PCL) data stream
v PostScript data stream
v Portable document format (PDF) data stream
v Tag image file form (TIFF) data stream
v Joint photographic experts group (JPEG) data stream
v Graphic interchange format (GIF) data stream
v ditroff data stream
v Double-byte ASCII and EUC data streams
v line-data data stream
v SAP data
v XML data
v PPML data

These transforms also support color management:
v PostScript Portable document format (PDF)
v Joint photographic experts group (JPEG)
v Graphic interchange format (GIF)
v Tag image file format (TIFF)

The transforms convert the incoming data stream into the Advanced Function
Presentation (AFP) format.

When a job in any of these formats is submitted to print on a PSF actual
destination, InfoPrint automatically invokes the appropriate transform. You can
also run the transforms from the AIX command line without printing the
generated output. You might find this useful if you intend to print the job later.
Jobs print more quickly if they have already been transformed.

Most transforms have flags or option keywords that you can use to specify
processing information. For a list of the flags or options and values for each
transform, see InfoPrint Manager: Reference or to the transforms’ man pages.
Configuration files, environment variables, and user-exit programs allow you to
specify processing information for InfoPrint to use when it invokes the transform
automatically. You can also use configuration files and environment variables
instead of typing flags on the command line whenever you run a transform.

Customizing the PCL, PostScript, and PDF transforms
You can customize the transforms for PCL, PostScript, and PDF data by specifying
values in the transform configuration files. Table 15 on page 154 shows the default
configuration files that InfoPrint provides. You can either modify these files or
create your own.
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Table 15. Default PCL, PostScript, and PDF transform configuration files

Data Stream Transform Configuration File Daemon Configuration File

PCL pcl2afp /psf/pcl2afp/pcl2afp.cfg /psf/pcl2afp/pcl2afpd.cfg

PostScript ps2afp /psf/ps2afp/ps2afp.cfg /psf/ps2afp/ps2afpd.cfg

PDF pdf2afp /psf/ps2afp/ps2afp.cfg /psf/ps2afp/ps2afpd.cfg

Notice that the PostScript and PDF transforms use the same default configuration
files.

Sample configuration file
Figure 12 shows an example of a configuration file for the PostScript and PDF
transforms. The configuration file for the PCL transform is similar, although it does
not contain a pcl_server_timeout keyword. As a result, the PCL transform does not
support the -s flag from the command line for the pcl2afp command described in
“Hierarchy of transform options” on page 155.

The configuration file uses keyword equivalents of the transform flags. See
InfoPrint Manager: Reference for the keywords and values that you can specify in the
configuration file.

Daemon configuration files
The PCL, PostScript, and PDF transforms all require a daemon to be running
before you can use them. The pcl2afpd daemon manages the PCL interpreter
portion of the pcl2afp transform. The ps2afpd daemon manages the PostScript
interpreter portion of the ps2afp and pdf2afp transforms. For more information
about these daemons, see InfoPrint Manager: Reference.

Each daemon, like the corresponding transform, uses a configuration file. The
daemon configuration file can contain the same keywords as the transform
configuration file, except server, plus some keywords that control the operation of
the daemon. See InfoPrint Manager: Reference for the daemon keywords.

Improving performance in the PDF RIP
You can improve the performance of the PDF RIP by configuring it to run parts of
itself in parallel. These changes improve the performance of the core RIP; for
improving performance by running multiple PDF RIPs on an AIX multi-processor,

# ps2afp configuration file
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
###################################################################
port = 8251 # -P which TCP/IP port to use
server = 127.0.0.1 # -S which server to connect with
ps_max_memory = 14000K # -M maximum amount of memory that

# PostScript uses; the 'K' is ignored
ps_job_timeout = 20 # -j maximum number of minutes

# to process PostScript job
ps_server_timeout = 20 # -s maximum number of minutes

# server waits between jobs
ps_width = 8.5i # -w width of generated image
ps_length = 11i # -l length of generated image
ps_x_offset = 0i # -x left and right margins
ps_y_offset = 0i # -y top and bottom margins
ps_resolution = 600 # -r resolution of printer
ps_output_type = IO1_G4 # -a type of AFP image to generate

Figure 12. Sample PostScript or PDF configuration file
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see“Using the PDF Parallel RIP” on page 170. If you have a multi-processor AIX
server, make the changes described below to the PDF RIP daemon configuration
file (ps2afpd.cfg) that are shown below in boldface text in Figure 13.

Notes:

1. If your InfoPrint AIX server has only a single processor, you should not make
these configuration changes because they would result in reduced performance.

2. Both -pragma bwModel=banded and -pragma beThread=yes can also improve
performance of the PostScript RIP.

3. If you are processing double-byte fonts (for example, with Kanji printing), you
must set pdfParallel=no.

Hierarchy of transform options
InfoPrint assigns a hierarchy to its use of flags and configuration-file information
when it runs the PCL, PostScript, or PDF transform program. The following lists
the order in which InfoPrint uses flags and information specified in configuration
files:
1. Any values you specify on the command line, including values in the

configuration file you specify with the -C flag.

# ps2afpd configuration file
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
###################################################################
port = 8251 # -P which TCP/IP port to use
work_directory = /var/psf/ps2afp

# directory to put work files into
log_file = /var/psf/ps2afp/ps2afpd.log

# where to write log messages
notify = root # who to notify if problems encountered
mail_command = /usr/bin/mail

# program used to send notifications
ps_program = /usr/lpp/psf/bin/ps2api

# name of the PostScript interpreter program
ps_init_file = /usr/lpp/psf/ps2afpe.ps

# name of the PostScript interpreter
# initialization file

ps_files_path = /usr/lpp/psf/ps2afp :\
/usr/lpp/psf/config :\
/usr/lpp/psf

# path to search for jobInit files
ps_max_memory = 32000K # -M maximum amount of memory that

# PostScript uses; the 'K' is ignored
ps_job_timeout = 999 # -j maximum number of minutes

# to process PostScript job
ps_server_timeout = 180 # -s maximum number of minutes

# server waits between jobs
ps_font_map_files = /usr/lpp/psf/ps/psfonts.map :\

/var/psf.psfonts/user.map
# list of font mapping files

ps_width = 8.5i # -w width of generated image
ps_length = 11i # -l length of generated image
ps_x_offset = 0i # -x left and right margins
ps_y_offset = 0i # -y top and bottom margins
ps_resolution = 600 # -r resolution of printer
ps_output_type = IO1_G4 # -a type of AFP image to generate
pragma = pdfParallel=yes ;\

beThread=yes ;\
bwModel=banded

Figure 13. Sample High Performance PDF Daemon configuration file
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InfoPrint commands process flags from left to right. If you enter the same flag
more than once, InfoPrint uses the last occurrence of the flag to determine the
value to use. For example, if you specify this command:
ps2afp -Cconfig.file -r240 -r300 myfile.ps

The ps2afp command transforms the file using 300-pel resolution. InfoPrint
ignores the resolution value specified in the configuration file config.file and
the first -r240 flag and value.

2. Values specified in the pcl2afp.cfg or ps2afp.cfg configuration file in the
current directory, if one exists and if you enter the transform command directly.
InfoPrint ignores values in the current directory if you invoke the transform
command indirectly by submitting a job to print.

3. Values specified in the pcl2afp.cfg or ps2afp.cfg configuration file in your
home directory, if one exists.

4. Values specified in the default transform command configuration file named in
Table 15 on page 154.

5. Values specified in a customized configuration file identified with the -C flag of
the pcl2afpd or ps2afpd command when the transform daemon started.

6. Values specified in the default transform daemon configuration file named in
Table 15 on page 154.

7. Default values that are built into InfoPrint. These are the same as the transform
defaults except that the default PostScript or PDF output type is an IM1
uncompressed image.

Stapling and punch options available from the ps2afp transform
You can use the ps2afp transform to specify both staple and punch finishing
options. However, you must:
1. Ensure that the IPDS (Intelligent Printer Data Stream) capable printer supports

either staple or punch finishing options.
2. Ensure that the PostScript input file contains either staple or punch

information.
3. Ensure that the keyword finishing is assigned to the device_controls option in

the ps2afpd.cfg configuration file, as shown in the bold-faced example in
Figure 14 on page 158.

4. Ensure that the application or driver that generated the PostScript supports the
subset of staple or punch operations enabled in the ps2afp transform. See
“Staple and punch operations supported by the ps2afp transform” on page 158
for a list of these staple and punch options.

If you are interested in using this finishing support, the PostScript drivers available
with the following printers contain this support. These InfoPrint printers should be
specified in a TCP/IP DSS:
v InfoPrint 2085
v InfoPrint 2105
v InfoPrint 2060ES
v InfoPrint 2075ES
v InfoPrint 2090ES
v InfoPrint 2105ES
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Specifying finishing in the ps2afpd.cfg file

This shows how you can specify finishing values in the ps2afp data stream
transform:
1. From a command line, access the ps2afpd.cfg file that is located in the

/usr/lpp/psf/ps2afp/ directory.
2. Using your editor of choice, edit the file.
3. Find the heading #ENABLING STAPLING OR PUNCH FINISHING

OPTIONS THROUGH THE TRANSFORM and remove the hash mark (#) that
comments out this line:
device_controls=finishing

4. Save and close the file.

Notes:

1. The device_controls option also accepts bin numbers and plex key words.
2. If you omit plex, the ps2afp transform creates duplex output.
3. If you omit bin numbers, the ps2afp transform creates output that indicates

that the first input tray should be used.
4. Not all printers support using the staple and punch options that the ps2afp

transform generates. If you send a document with staple or punch operations
to an IPDS printer that does not support the request, InfoPrint Manager issues
a message and completes the job, without either staples or punch holes. See
your printer documentation to determine which (if any) staple or punch
operations are available.

For further examples, see the ps2afpd.cfg file shipped with the latest version of
InfoPrint Manager, which includes the device_controls option.
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Staple and punch operations supported by the ps2afp
transform

The following tables list the subset of PostScript information transformed to
Advanced Function Presentation (AFP) MO:DCA-P structured fields and triplets to
support staple and punch operations. The changes described below should only be
done by someone with extensive knowledge of the PostScript language, such as
someone writing their own PostScript driver.

The << /Staple 3 information below is a particular example drawn from Table 16
on page 159 and Table 17 on page 159. Both tables contain pertinent information
for adding stapling operations to your PostScript data stream.
{ << /Staple 3 /StapleDetails << /Type 17 /Position 17 >> >> setpagedevice }
{ << /Staple 3 /StapleDetails << /Type 17 /Position 18 >> >> setpagedevice }

This example indicates that the printer will place two staples at the top of a page,
whether the page has either a Portrait or a Landscape orientation.

/Staple 3
The key that introduces the StapleDetails Dictionary.

/Type 17
A required key reserved for future use.

# ps2afpd configuration file
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
###################################################################

port = 8251 # which TCP/IP port to use

work_directory = /var/psf/ps2afp
# directory to put work files into

log_file = /var/psf/ps2afp/ps2afpd.log
# where to write log messages

notify = root # who to notify if problems encountered
mail_command = /usr/bin/mail

# program used to send notifications
ps_program = /usr/lpp/psf/bin/ps2afpi

# name of PostScript interpreter program
ps_init_file = /usr/lpp/psf/ps2afp/ps2afpe.ps

# name of PostScript interpreter
# initialization file

ps_files_path = /usr/lpp/psf/ps2afp :\
/usr/lpp/psf/config

# path to search for jobInit files
:
:
:
######################################################################

# ENABLING STAPLING OR PUNCH FINISHING OPTIONS THROUGH THE TRANSFORM
# If you want to use the stapling or punch finishing options and have
# ensured that your PostScript driver supports these options,
# use the following options:

device_controls=finishing

Figure 14. Sample PostScript Daemon configuration file sections with staple and punch options
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/Position
A key that indicates the placement of the staples, using the settings
displayed in Table 17.

The << /Punch 4 information below is a particular example drawn from Table 18
on page 160, Table 19 on page 160, and Table 20 on page 161. All three tables
contain pertinent information for adding stapling operations to your PostScript
data stream.

{ << /Punch 4 /PunchDetails << /Type 7 /HoleType 0 /Pattern 0 /Position 1 >> >> setpagedevice }
{ << /Punch 4 /PunchDetails << /Type 7 /HoleType 0 /Pattern 0 /Position 5 >> >> setpagedevice }

This example indicates that the printer will place a punch on the left side of a
page, whether the page has either a Portrait or a Landscape orientation.

/Punch 4
The key that introduces the PunchDetails Dictionary.

/Type 7
A required key reserved for future use.

/Pattern 0
A key that indicates the default punch setting, using the settings displayed
in Table 20 on page 161.

Note: Most PostScript drivers use /Pattern 0 because Finishers tend to
have one particular setting. /Pattern 0 works with all Finishers. If you
specify /Pattern 6 in the PostScript driver and your Finisher only
supports two-hole punch, InfoPrint Manager will print the job and
generate an error message without performing the finishing.

/Position
A key that indicates the placement of the staples, using the settings
displayed in Table 19 on page 160.

Table 16. Default staple locations

Staple Key name PostScript Staple

Do not staple None /Staple 0

Staple Not supported /Staple 3

Table 17. Additional PostScript staple details

Staple details Key name PostScript staple details

Do not staple None Portrait:
/Position 0

Landscape:
/Position 0

Single left diagonal LeftDiagonal Portrait:
/Position 1

Landscape:
/Position 5

Single left
horizontal

LeftHorizontal Portrait:
/Position 3

Landscape:
/Position 7

Chapter 15. Working with transforms 159



Table 17. Additional PostScript staple details (continued)

Single left vertical LeftVertical Portrait:
/Position 2

Landscape:
/Position 6

Single right
diagonal

RightDiagonal Portrait:
/Position 9

Landscape:
/Position 13

Single right
horizontal

RightHorizontal Portrait:
/Position 11

Landscape:
/Position 15

Single right vertical RightVertical Portrait:
/Position 10

Landscape:
/Position 14

Double left DoubleLeft Portrait:
/Position 4

Landscape:
/Position 8

Double right DoubleRight Portrait:
/Position 12

Landscape:
/Position 16

Double top DoubleTop Portrait:
/Position 17

Landscape:
/Position 18

Booklet Booklet Portrait:
/Position 20

Landscape:
/Position 20

Table 18. Default punch locations

Punch Key name PostScript Punch

Do not punch None /Punch 0

Punch Not supported /Punch 4

Table 19. Additional PostScript punch details

Punch details Key name PostScript punch details

Do not punch None Portrait:
/Position 0

Landscape:
/Position 0

Left PunchLeft Portrait:
/Position 1

Landscape:
/Position 5
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Table 19. Additional PostScript punch details (continued)

Top PunchTop Portrait:
/Position 3

Landscape:
/Position 7

Right PunchRight Portrait:
/Position 2

Landscape:
/Position 6

Bottom PunchButtom Portrait:
/Position 4

Landscape:
/Position 8

Table 20. Punch Setting for the /Pattern value

Punch Key Name PostScript Punch
Details

Default Punch* /Pattern 0

2–holes Punch*2 /Pattern 6

3–holes Punch*3 /Pattern 5

4–holes Punch*4 /Pattern 7

Customizing the TIFF, JPEG, and GIF transforms
You can customize the transforms for TIFF, JPEG, and GIF data by:
v Specifying values in the transform configuration files
v Setting the transform environment variables

Table 21 shows the default configuration files that InfoPrint provides. You can
either modify these files or create your own.

Table 21. Default TIFF, JPEG, and GIF transform configuration files

Data Stream Transform Configuration Files

TIFF tiff2afp
/usr/lpp/psf/tiff2afp/tiff2afp.cfg
/usr/lpp/psf/tiff2afp/tiff2afp.3160cfg
/usr/lpp/psf/tiff2afp/tiff2afp.3900cfg

JPEG jpeg2afp
/usr/lpp/psf/jpeg2afp/jpeg2afp.cfg
/usr/lpp/psf/jpeg2afp/jpeg2afp.3160cfg
/usr/lpp/psf/jpeg2afp/jpeg2afp.3900cfg

GIF gif2afp
/usr/lpp/psf/gif2afp/gif2afp.cfg
/usr/lpp/psf/gif2afp/gif2afp.3160cfg
/usr/lpp/psf/gif2afp/gif2afp.3900cfg

InfoPrint uses the .3160cfg and .3900cfg configuration files to transform documents
that have been submitted to print on an InfoPrint 60 printer or InfoPrint 4000 laser
printer respectively.
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Sample configuration file
Figure 15 shows an example of a configuration file for the TIFF transform. The
configuration files for the JPEG and GIF transforms are similar.

The configuration file uses options in the same format as the transform options
that you specify on the command line, except that command line options begin
with a dash (–). See InfoPrint Manager: Reference for the options and values that you
can specify in the configuration file.

Transform environment variables
Many of the TIFF, JPEG, and GIF transform options have equivalent environment
variables. Environment variables have this format:

transform_option

wheretransform is the name of the transform command in uppercase and option is
the command line option without the initial dash (–). For example, the
environment variable that corresponds to the —scale option of the jpeg2afp
transform is JPEG2AFP_scale. See InfoPrint Manager: Reference for the options and
values that you can specify as environment variables.

Hierarchy of transform options
InfoPrint assigns a hierarchy to its use of options and configuration-file
information when it runs the TIFF, JPEG, or GIF transform program. The following
lists the order in which InfoPrint uses command–line options and information
specified in configuration files:
1. Any values you specify on the command line, including values in the

configuration files you specify with the -C option.
InfoPrint commands process options from left to right. If you enter the same
option more than once, InfoPrint uses the last occurrence of the flag to
determine the value to use. For example, if you specify this command:
tiff2afp -Cconfig.file -r240 -r300 myfile.tif

the tiff2afp command transforms the file using 300-pel resolution. InfoPrint
ignores the resolution value specified in the configuration file config.file and
the first -r240 flag and value.

2. Values specified in the default transform command configuration file named in
Table 21 on page 161.

a=ioca10
choice=full
cmp=g4
ms=5120
msf=0.01
nosniff=yes
noterm=yes
v=yes
pagetype=page
r=600
x=0
y=0

Figure 15. Sample TIFF configuration file
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3. Transform environment variables that you set with the export command, if you
enter the transform command directly. InfoPrint ignores these environment
variables if you invoke the transform command indirectly by submitting a job
to print.

4. Transform environment variables in the .profile file in your home directory.
5. Transform environment variables in the /etc/environment file.
6. Default values that are built into InfoPrint. These are the same as the transform

defaults.

Customizing the img2afp transform
The img2afp transform can be used to transform color (FS45) images into
monochrome bilevel (FS10) images for printing. This transform is valuable for
transforming color images so that they print well in black-and-white. You can
customize the img2afp transform only by specifying options on the command line.
Unlike other transforms shipped with the InfoPrint Manager, this transform is not
invoked automatically. Instead, you must specify it at the command line to
preprocess the data before printing. For specific information about the syntax and
use of this command, see InfoPrint Manager: Reference.

While you can create an img2afp.cfg file, InfoPrint Manager supplies a series of
img2afp.cfg configuration files that are based on the printer model. For example,
the img2afp.4000–708cfg file on an InfoPrint Manager for AIX server contains these
settings:
#img2afp Infoprint 4000-708 configuration file

a=fs10
respath=.:/usr/lpp/psf/config
thresh=4000-708.ibm106lpi.ta.ps
gcorr=4000-708.ibm106lpi.tf.dt.ps
pagetype=page
v=yes
r=600

img2afp.cfg files observe these basic rules:

Notes:

1. Any item specified in a configuration file can be overridden on the command
line.

2. Configuration file syntax is attribute = value.
3. A hash mark (#) indicates a comment to the end of the line.
4. All attribute names are the same as the command-line names.
5. For options that do not take values, you must type yes in the configuration file

(as shown below).
#sample img2afp configuration file

v = yes #equivalent to -v flag
a = fs10 #bilevel output

To invoke the transform from the command line, you must specify at least:
v -a fs10 to indicate bilevel output .
v -thresh {name} to specify the PostScript level 3 halftone dictionary that you are

using.
When you install some printers with InfoPrint Manager, the product makes
PostScript level 3 halftone dictionaries available on your server. For example, on
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an AIX server an InfoPrint HD1-HD2, HD3-HD4, HD5-HD6, HS1, HS3,
MD1-MD2, MS1, PS-1, PD1-PD2 or 4100 printer provides these:
– /usr/lpp/psf/config/4100.ibm71lpi.ta.ps

– /usr/lpp/psf/config/4100.ibm85lpi.ta.ps

– /usr/lpp/psf/config/4100.ibm106lpi.ta.ps

– /usr/lpp/psf/config/4100.ibm141lpi.ta.ps

– /usr/lpp/psf/config/4100.ibm71lpiRot90.ta.ps

– /usr/lpp/psf/config/4100.ibm85lpiRot90.ta.ps

– /usr/lpp/psf/config/4100.ibm106lpiRot90.ta.ps

– /usr/lpp/psf/config/4100.ibm141lpiRot90.ta.ps

v -gcorr filename to specify grayscale mapping tables to halftone the grayscale and
color images to bilevel for output.
When you install particular printers with InfoPrint Manager, you also install the
following grayscale mapping tables for each type of PostScript level 3 halftone
dictionary option.
For example, on an AIX server an InfoPrint HS1, HD1-HD2, HD5–HD6, HS3,
PS-1, PD1-PD2 or 4100 printer provides printer provides these:
– /usr/lpp/psf/config/4100.ibm71lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.lr.ps for standard halftones
For example, on an AIX server an InfoPrint HD3–HD4, HD5–HD6, HS3, MD1–2
MS1, PD1–PD2, or PS1 4100 printer provides printer provides these:
–
– /usr/lpp/psf/config/4100.ibm71lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.ls.ps for accutone halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.oc.ps for dark2 halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.ls.ps for accutone halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.oc.ps for dark2 halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.ls.ps for accutone halftones
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– /usr/lpp/psf/config/4100.ibm106lpi.tf.oc.ps for dark2 halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.ls.ps for accutone halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.oc.ps for dark2 halftones

and -gcorr and -thresh must be used to select an appropriate halftone.

Limitations of the img2afp transform
When using the img2afp transform, be aware of these limitations:
v Only jobs that contain either pure IOCA data or IOCA overlaid by other

bilevel-compatible OCAs print correctly.
v img2afp does not support one bit per spot CMYK data (FS42) data conversions.

Examples
For each of these examples, the user has an AFP input file of an FS45 image that
they are converting to an FS10 file for printing on a black-and-white printer. To
obtain their FS45 input file, they might have used either the tiff2afp, gif2afp,
jpeg2afp, pdf2afp, or ps2afp transform to convert an image file from one of those
formats

To convert an FS45 image (sampleFS45.afp) to an FS10 image (outFS10.afp) from
an InfoPrint command line for printing on an InfoPrint 21 printer, type this on the
command line:

img2afp -a fs10 -thresh 4322.ibm106lpi.ta.ps -gcorr 4322.ibm106lpi.tf.dt.ps sampleFS45.afp \
-o outFS10.afp

To print the resulting FS10 image (outFS10.afp) on an InfoPrint 21 printer, type
this on the command line:

pdpr -p ip21-ld outFS10.afp

To convert an FS45 image (DSC011FS45.afp) to an FS10 image (DSC011FS10.afp)
with standard halftones from an InfoPrint command line for printing on an
InfoPrint 4100–HD3/HD4 Advanced Function Printing™ System printer, type this
on the command line:

img2afp -a fs10 -thresh 4100-HD3-HD4.ibm106lpi.ta.ps -gcorr 4100-HD3-HD4.ibm106lpi.tf.lr.ps \
DSC011FS45.afp -o DSC011FS10.afp

To print the resulting FS10 image (DSC011FS11.afp) on an InfoPrint
4100–HD3/HD4 Advanced Function Printing System printer, type this on the
command line:

pdpr -p silver-ld DSC011FS10.afp

To convert an FS45 image (DSC015FS45.afp) to an FS10 image (DSC011FS15.afp)
with dark halftones from an InfoPrint command line for printing on an InfoPrint
4000 Advanced Function Printing System printer, type this on the command line:

img2afp -a fs10 -thresh 4000.ibm106lpi.ta.ps -gcorr 4000.ibm106lpi.tf.ap.ps \
DSC015FS45.afp -o DSC015FS10.afp

To print the resulting FS10 image (DSC011FS15.afp) on an InfoPrint 4000 Advanced
Function Printing System printer, type this on the command line:

pdpr -p ip40001-ld DSC015FS10.afp
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Working with the transform for line data
InfoPrint Manager includes a line-data transform program that transforms line data
into the Advanced Function Presentation (AFP) data stream. Converting the line
data lets you print it on high-speed AFP printer devices.

About line data
Read through the following sections to become familiar with line-data terms.

Note: Throughout this chapter references are made to ACIF because the line2afp
command is linked to the acif command. When you use this transform and if
errors occur, you might receive some error messages that make reference to ACIF.
See the ACIF User’s Guide for more information about the ACIF command.

What Is line data?
Line data is simply unformatted data — that is, data with few or no embedded
control characters to create font changes, page breaks, and so on. The line data is
typically created by an application program. For example, an application might
produce a bank statement that has line data indicating an account’s daily balance.

The InfoPrint line-data transform lets you format these kinds of data with a page
definition and form definition for printing on InfoPrint-managed printer devices:
v Single-byte ASCII data with no embedded control characters except for newlines.
v Single-byte ASCII data that contains ANSI carriage-control characters,

table-reference characters, or both.
v Single-byte ASCII data that contains carriage returns and form feed controls if

you specify the asciinp or asciinpe user-exit program.

When you transform the line-data job, you must specify a page definition and a
form definition.

Notes:

1. You cannot use the line-data transform when printing files containing
Proprinter ASCII.

2. When the line2afp command processes any unrecognized or unsupported
keyword, line2afp issues a message, ignores the keyword, and continues
processing any remaining keywords. The line2afp command then stops
processing.

3. InfoPrint also lets you transform and print DBCS ASCII data without a page
definition. See InfoPrint Manager: Reference or the db2afp man page.

ANSI and machine carriage controls
In many environments (including IBM® mainframes and most minicomputers),
printable data normally contains a carriage control character. The carriage control
character acts as a vertical tab command to position the paper at the start of a new
page, at a specified line on the page, or to control skipping to the next line. The
characters can be one of two types: ANSI carriage control or machine carriage
control.

ANSI carriage control characters: The most universal carriage control is ANSI,
which consists of a single character that is a prefix for the print line. The standard
ANSI characters are:

ANSI Action
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space Single space the line and print

0 Double space the line and print

- Triple space the line and print

+ Do not space the line and print

1 Skip to channel 1 (the top of the form, by convention)

2-9 Skip to a hardware-defined position on the page

A,B,C Defined by a vertical tab record or forms control buffer (FCB)

All ANSI control characters perform the required spacing before the line prints.
Using line2afp command keywords and values, ANSI controls can be encoded in
EBCDIC (cctype=a) or in ASCII (cctype=z).

Machine carriage control characters: Machine carriage controls were originally
the actual hardware control commands for InfoPrint printers and are often used on
non-InfoPrint systems. Machine controls are literal values, not symbols. They are
not represented as characters in any encoding, and therefore, machine controls
cannot be translated. Typical machine controls are:

Machine
Action

X’09’ Print the line and single space

X’11’ Print the line and double space

X’19’ Print the line and triple space

X’01’ Print the line (do not space)

X’0B’ Space one line immediately (do not print)

X’89’ Print the line, then skip to channel 1 (top of form, by convention)

X’8B’ Skip to channel 1 immediately (do not print)

Machine controls print before doing any required spacing. There are many more
machine control commands than ANSI. Carriage controls might be present in a file,
but every record in the file must contain a carriage control if the controls are to be
used. If the file contains carriage controls, but the line2afp command keyword and
value cc=no is specified, the carriage controls are treated as printing characters. If
no carriage controls are specified, the file prints as though it were single spaced.

Variable-length and fixed-length files
The line-data transform program needs to know two things about a file in order to
transform it:
v The length of each print record
v The kind of carriage control used

Some files contain information in each record that describes the record length;
these are called variable-length files. Other files require an external definition of
length; these are called fixed-length files.

For variable- and fixed-length files using length prefixes, MO:DCA–P structured
fields are treated as a special case. All such structured fields are self-identifying
and contain their own length. They need not contain a length prefix to be correctly
interpreted but are processed correctly if there is a length prefix that matches the
structured field length.
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Variable-length files: Variable-length files can use a length prefix, which means
they contain a prefix that identifies the length of the record in the file. Each record
contains a two-byte field that gives the length of the record. If the record contains
a length, that length must be a prefix for each record and it must be a 16-bit binary
number that includes the length of the 2-byte length prefix. Use the
fileformat=record keyword and value to identify files with length prefixes.

Variable-length files may use a separator or delimiter to indicate the end of a
record, instead of using a length prefix. All of the bytes up to, but not including,
the delimiter are considered part of the record. For AIX, the default delimiter is
X’0A’. If the file uses EBCDIC encoding, the default newline character is X’25’. Use
the fileformat=stream keyword and value to designate files that use newlines to
indicate record boundaries.

You can also specify the explicit newline characters that InfoPrint should use to
delimit records. This is specified as a subparameter of the fileformat keyword. For
example, fileformat=stream, (newline=CRLF,ASCII). For details, see the
description of the line2afp command in the InfoPrint Manager: Reference.

If you do not explicitly specify the newline characters, InfoPrint reads the first six
bytes and tests for all ASCII characters (code points from X’00’ to X’7F’) to
determine if a file is encoded in ASCII or EBCDIC. If no non-ASCII characters are
found, line-data transform program assumes the file uses the ASCII newline
character, X’0A’. Otherwise, the transform assumes the file uses the EBCDIC
newline character, X’25’. Because an input file can misguide the line-data
transform, you should specify newline on the file format keyword to make sure
that InfoPrint will use the correct characters.

Fixed-length files: Fixed-length files contain records that are all the same length.
No other separators, prefixes, or self-identifying information exists that indicates
the record length. You must know the record length and use the
fileformat=record,nnn keyword and value, where nnn represents the length of each
record.

How the imageout keyword affects processing
The line-data transform converts image formats (IM1) in the input file, in overlays,
and in page segments to uncompressed IOCA format, if line2afp imageout=ioca
keyword and value is specified (the default). An uncompressed IOCA image might
use a significantly higher number of bytes than an IM1 image and might take more
processing time to convert, especially for shaded or patterned areas. Although
IOCA is the MO:DCA-P standard for image data, and some data stream receivers
might require it, all products might not accept IOCA data. All software products
from the InfoPrint Solutions Company do, however, accept IOCA data as well as
IM1 image data.

We recommend that you specify imageout=asis, unless you have a specific
requirement for IOCA images.

Customizing the line data transform
InfoPrint provides several sample programming exits to assist you in customizing
the line-data transform. Use of the programming exits is optional. You specify the
names of the exit programs with the inpexit, outexit, and resexit keywords. Each
of these keywords is described in InfoPrint Manager: Reference or the line2afp man
page. If you are using InfoPrint’s sample user exits or your own user exit to
convert incoming data streams from one code page to another code page, then the
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INPCCSID parameter indicates the code page of the incoming data stream. The
OUTCCSID parameter indicates the code page of the output from UCONV.

ICONV:

If you have written any user-exit programs that use ICONV, you must alter them
to use UCONV instead. See the InfoPrint Manager: Reference for more information.

InfoPrint provides these sample exits:

/usr/lpp/psf/acif/apkinp.c
Input record exit

/usr/lpp/psf/acif/apkout.c
Output record exit

/usr/lpp/psf/acif/apkres.c
Resource exit

In addition, InfoPrint provides these user input record exits to translate line-data
data streams:

/usr/lpp/psf/acif/apka2e.c
Converts the ASCII stream data into the EBCDIC 2stream data.

/usr/lpp/psf/acif/asciinp.c
Converts unformatted ASCII data that contains carriage returns and form feeds
into a record format that contains ANSI carriage control characters. This exit
encodes the ANSI carriage control character in byte 0 of every record.

/usr/lpp/psf/acif/asciinpe.c
Converts unformatted ASCII data into a record format as does asciinp.c and
then converts the ASCII stream data into EBCDIC1 stream data.

/usr/lpp/psf/acif/dbblank
Processes EBCDIC double-byte line data downloaded from the z/OS® spool by
adding an extra blank to the end of the input record if:
1. The last byte in the record is a blank (x’40’ in EBCIDIC).
2. The second to the last byte is not a blank.
3. The input record is line data; that is, it is not a structured field.

This exit also updates the record length by 1 if the blank is added. The exit has
no way of determining if the data is DBCS or not, so this will happen to every
input record that ends in a single blank. The exit assumes that the input data is
EBCIDIC, and that the output data is also EBCIDIC. In other words, the exit
does not do any code page translation, but it simply adds an extra blank if
needed.

Notes:

1. This exit is only intended to be used if the spool file consists of double-byte
or mixed single- or double-byte data that has blank truncation. Adding a
blank to other types of data files could cause formatting errors, depending
on how the page definition is coded.

2. This exit only checks for a single trailing blank, so if a different number of
odd blanks is present in the data, it is up to the user to make sure the data
is formatted with the correct font.

2. The default conversion is from code page 805 to code page 037. You can override the defaults with the inpccsid and outccsid
parameters.
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The C language header file for all line-data transform exit programs is also
provided:
v /usr/lpp/psf/acif/apkexits.h

along with the build rules for the line-data transform user exits:
v /usr/lpp/psf/acif/Makefile

The source code for the sample exits is provided in /usr/lpp/psf/acif. You can
modify these source files or create your own. In order to compile and build your
exit, you must have the XL C Compiler and the bos.adt components of the Base
Application Development Toolkit of the AIX operating system installed. You can
use the /usr/lpp/psf/bin/Makefile as an example of how to compile the exits.

For more information about compiling user exit programs, see “Compiling and
installing the user-exit program” on page 59.

Using the PDF Parallel RIP
InfoPrint Manager for AIX provides the PDF Parallel RIP to improve the speed of
PDF transforms for most color jobs. It divides a PDF input file into separate pages
and distributes these pages to several RIPs running in parallel. Then, it combines
the resulting AFP data stream into a printable document. If you define two RIPs on
the same InfoPrint AIX server for a PDF input file with pages of a uniform
complexity, the Parallel PDF RIP client can render this file into AFP in half the time
of the standard PDF transform. While the greatest performance improvements
occur for jobs printing on the InfoPrint Color 130 Plus printer, you can use the
Parallel PDF RIP client on any printers that produce AFP data.

Installing the PDF Parallel RIP client

The Parallel PDF RIP client (pdfprs) replaces the standard pdf2afp client on your
system.

The pdfprs component consists of these:
v The pdfprs executable in the /usr/lpp/psf/bin directory
v The pdf2afp configuration file in the /usr/lpp/psf/ps2afp directory.

The Parallel PDF RIP client is best used on an AIX server or servers, which can
have from four to 16 processors. We recommend you set up a configuration to
allow for system memory use like that displayed in Table 22.

Table 22. Processors required to use the Parallel PDF RIP client

Processors Allocated Function Performed

1 network traffic, I/O processes, and general system
overhead.

1 pdfprs client as defined in “Sample configuration file for
the pdfprs client” on page 172.

1
This first RIP transforms PDF into PostScript data.

Each RIP is likely to use an entire processor to RIP the
PDF files.

1 to n For each additional daemon RIP as defined in “RIP
Daemon configuration files” on page 173.
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The most basic configuration (the pdfprs client and two additional RIPs) requires a
minimum of four processors. Please make sure that your configuration can support
this feature before installing it and submitting jobs through the InfoPrint Manager
pdpr print command.

You must create the first RIP to transform PDF input data to PostScript data, then
use at least a two-RIP configuration on your InfoPrint AIX server to transform the
PDF into AFP data. To demonstrate how this support can be expanded by adding
RIPs, this example creates a three-RIP configuration, with the first RIP
transforming PDF input data into PostScript data. These RIPs still use the
PostScript daemon (ps2afpd), just like the standard PDF transform.

From an AIX window, complete this procedure:
1. Create a directory for the PDF Parallel RIP client to distinguish it from the

standard PDF data stream transform:
mkdir /var/psf/pdf2afp;chmod 777 /var/psf/pdf2afp

2. Create working directories for each of the new PDF RIPS:
mkdir /var/psf/pdf2afp/1;chmod 777 /var/psf/pdf2afp/1

mkdir /var/psf/pdf2afp/2;chmod 777 /var/psf/pdf2afp/2

mkdir /var/psf/pdf2afp/3;chmod 777 /var/psf/pdf2afp/3

mkdir /var/psf/pdf2afp/4;chmod 777 /var/psf/pdf2afp/4

3. Install new configuration files for each of these RIPS:
v /var/psf/pdf2afp/8261.cfg

v /var/psf/pdf2afp/8262.cfg

v /var/psf/pdf2afp/8263.cfg

v /var/psf/pdf2afp/8264.cfg

Note that for each new configuration file, you must change the port,
work_directory, and log_file values. These three parameters are highlighted in
Figure 17 on page 174 so you can see the directory structure recommended for
this configuration.

4. From either the command line or the ps2afpd.cfg file, start daemons for each
configuration file:
ps2afpd -C /var/psf/pdf2afp/8261.cfg

ps2afpd -C /var/psf/pdf2afp/8262.cfg

ps2afpd -C /var/psf/pdf2afp/8263.cfg

ps2afpd -C /var/psf/pdf2afp/8264.cfg

Note: In the path where the working directories reside, you can create a
startcfg script similar to this example to do this task:
#!/bin/sh
cd /var/psf/ps2afp
if [$# -gt 0 ]
then
for i in $*
do
/usr/lpp/psf/bin/ps2afpd -C 826$i.cfg
done
else
for i in 1 2 3 4
do
/usr/lpp/psf/bin/ps2afpd -C 826$i.cfg
done
fi
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5. To make sure that the pdfprs command is linked to the pdf2afp command, you
must enter these commands:
a. Access the correct directory by specifying: cd /usr/lpp/psf/bin

b. Create the necessary logical link to submit jobs to the PDF parallel RIP by
specifying: ln -sf pdfprs pdf2afp

Note: If you need to restore the old pdf2afp client, you can specify this from
an AIX command line: ln -sf ps2afp pdf2afp.

This configuration will automatically invoke four RIPs and generally run faster
than the standard PDF transform.

Customizing the PDF Parallel transform
You can customize the transforms for PDF data by specifying values in the
transform configuration files. Table 23 shows the default configuration files that
InfoPrint provides. You can either modify these files or create your own.

Table 23. Default parallel PDF transform configuration files

Data
Stream Transform Configuration File Daemon Configuration Files

PDF pdf2afp /usr/lpp/psf/ps2afp/pdf2afp.cfg

The pdfprs configuration file.
/var/psf/pdf2afp/8261.cfg

/var/psf/pdf2afp/8262.cfg

/var/psf/pdf2afp/8263.cfg

/var/psf/pdf2afp/8264.cfg

Note: This represents the
3–RIP configuration of our
example, with the first RIP
serving as the PDF to
PostScript RIP.

Sample configuration file for the pdfprs client
Figure 16 on page 173 shows an example of a configuration file for the PDF
parallel transform client. Note the three parameters that have been highlighted to
show values you want to specify exactly as shown to enhance the performance of
the parallel PDF RIP.
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This sample configuration file uses keyword equivalents of the transform flags. See
InfoPrint Manager: Reference for the keywords and values that you can specify in the
configuration file.

Note: For this sample pdf2afp.cfg configuration to work correctly, you must have
a configuration with a minimum of four processors dedicated to this task.

RIP Daemon configuration files
The PDF parallel transform requires that at least three daemons be running to
manage the PostScript interpreter portion of the pdf2afp transform. To simplify
your configuration, InfoPrint recommends naming these daemons after the ports
that they are running on. For this document, the configuration example begun in
Figure 16 will use the names 8261.cfg, 8262.cfg, 8263.cfg, and 8264.cfg. For more
information about this daemon, see InfoPrint Manager: Reference.

The daemon, like the corresponding transform, uses configuration files. The
daemon configuration files reside in the /var/psf/ directory. It is recommended that
you create a /pdf2afp subdirectory where all support related to the Parallel PDF
RIP client (pdfprs) can reside.

Figure 17 on page 174 shows an example of a configuration file for the PDF
parallel transform client that RIPs a color (FS45) file.

# pdf2afp.cfg configuration file
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
####################################################################
width = 8.5i # -w width of generated image
length = 11i # -l length of generated image
x_offset = 0i # -x left and right margins
y_offset = 0i # -y top and bottom margins
resolution = 600 # -r resolution of printer
output_type = FS45 # type of AFP image to generate
job_timeout = 120 # maximum number of minutes to process a job
[pdf] # location of PDF -> PS conversion rip
port = 8261
server = server1
[rip1] # location of this rip
port = 8262
server = server1
[rip2] # location of this rip
port = 8263
server = server1
[rip3] # location of this rip
port = 8264
server = server1

Figure 16. Sample PDF parallel transform (pdf2afp.cfg) configuration file
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If you are defining and configuring daemon RIPs across several AIX servers, you
must define the resources in the daemon RIP configuration file as shown in the
highlighted section of Figure 17. This step ensures that NFS can find all the
resources and concatenate the result into a single file. You only need to specify the
resourceNameFilename= value on the pragma parameter this way if you are using
inline resources and the FS45 IOCA color format.

These daemon configuration files can contain many of the same keywords as the
transform configuration file, except server, plus some keywords that control the
operation of the daemon. See InfoPrint Manager: Reference or man pages for the
daemon keywords.

# 8264.cfg configuration file
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
####################################################################
port = 8264 # which TCP/IP port to use
work_directory = /var/psf/pdf2afp/4 directory to put work files in
log_files = /var/psf/pdf2afp/4/ps2afpd.log

where to write log messages
notify = root # notify if problems are encountered
mail_command = /usr/bin/mail

# program used to send notifications
ps_program = /usr/lpp/psf/bin/ps2afpi

# name of the PostScript interpreter program
ps_init_file = /usr/lpp/psf/bin/ps2afpe.ps

# name of the PostScript interpreter
# initialization file

ps_files_path = /usr/lpp/psf/ps2afp :\
/usr/lpp/psf/config :\
/usr/lpp/psf

# path to searhc for jobInit files
ps_max_memory = 32000K # maximum amount of memory that

# PostScript uses; the 'K' is ignored
ps_job_timeout = 9999 # maximum number of minutes

# to process PostScript job
ps_server_timeout = 180 # maximum number of minutes

# server waits between jobs
ps_font_map_files = /usr/lpp/psf/ps/psfonts.map :\

/var/psf/psfonts/user.map
# list of font mapping files

ps_width = 8.5i # width of generated image
ps_length = 11i # length of generated image
ps_x_offset = 0i # left and right margins
ps_y_offset = 0i # top and bottom margins
ps_resolution = 600 # resolution of target printer
ps_output_type = FS45 # type of output to generate
pragma = resources=none ;\

printerSpeed=130 ;\
linkBandWidth=6000000 ;\
resourceNameFilename=../.resNames;

Figure 17. Sample PDF parallel transform (8264.cfg) configuration file for color
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Configuring for a dual engine halftone printer
If you have either an InfoPrint 4000 Advanced Function Duplex Printing System –
Models ID5/ID6 or an InfoPrint 4000 High Resolution Duplex Printing System,
you can use the pdfprs client to drive a dual-engine configuration with customized
halftone support for each engine. Note that while the pdfprs client can RIP both
the color and the black-and-white (monochrome) PDF files, these printers only
print black-and-white output. In addition, these printers do not provide as
extensive a performance benefit as that you will see when printing color PDF files.
If you do print color PDF files and then want to switch to black-and-white PDF
files, you must stop the RIPs and change the configuration files.

For this support, you must configure and start an even number of RIPs. The first
RIP must be customized to use the first print engine’s halftone configuration, and
the second RIP must be customized to use the second print engine’s halftone
configuration. This pattern must be repeated for each RIP that is configured.

In addition, each RIP must be configured to use the desired halftone configuration
at the daemon configuration level. For example, if you are using two InfoPrint
4000 printers, all the even-numbered RIPs should match the halftone configuration
specified on printer1, while all the odd-numbered pages should match the halftone
configuration specified on printer2. Figure 18 provides an example of a

# 8264.cfg configuration file
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
####################################################################
port = 8264 # which TCP/IP port to use
work_directory = /var/psf/pdf2afp/4

directory to put work files in
log_files = /var/psf/pdf2afp/4/ps2afpd.log

where to write log messages
notify = root # notify if problems are encountered
mail_command = /usr/bin/mail

# program used to send notifications
ps_program = /usr/lpp/psf/bin/ps2afpi

# name of the PostScript interpreter program
ps_init_file = /usr/lpp/psf/bin/ps2afpe.ps

# name of the PostScript interpreter
# initialization file

ps_files_path = /usr/lpp/psf/ps2afp :\
/usr/lpp/psf/config :\
/usr/lpp/psf

# path to searhc for jobInit files
ps_max_memory = 32000K # maximum amount of memory that

# PostScript uses; the 'K' is ignored
ps_job_timeout = 9999 # maximum number of minutes

# to process PostScript job
ps_server_timeout = 180 # maximum number of minutes

# server waits between jobs
ps_font_map_files = /usr/lpp/psf/ps/psfonts.map :\

/var/psf/psfonts/user.map
# list of font mapping files

ps_width = 8.5i # width of generated image
ps_length = 11i # length of generated image
ps_x_offset = 0i # left and right margins
ps_y_offset = 0i # top and bottom margins
ps_resolution = 600 # resolution of target printer
ps_output_type = IO1_G4 # type of output to generate

Figure 18. Sample PDF parallel transform (8264.cfg) configuration file for black and white
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monochrome RIP daemon configuration file, with the variables changed from the
Color daemon configuration file in bold–face type.

Hierarchy of transform options
InfoPrint assigns a hierarchy to its use of flags and configuration-file information
when it runs the PDF transform program. The following lists the order in which
InfoPrint uses flags and information specified in configuration files:
1. Any values you specify on the command line, including values in the

configuration file you specify with the -C flag.
InfoPrint commands process flags from left to right. If you enter the same flag
more than once, InfoPrint uses the last occurrence of the flag to determine the
value to use. For example, if you specify this command:
pdfprs -C8263.cfg -r240 -r300 myfile.ps

The pdfprs command transforms the file using 300-pel resolution. InfoPrint
ignores the resolution value specified in the configuration file 8263.cfg and the
first -r240 flag and value.

2. Values specified in the default transform command configuration file named in
Table 23 on page 172.

3. Values specified in a customized configuration file identified with the -C flag of
the ps2afpd command when the transform daemon started.

4. Values specified in the default transform daemon configuration file named in
the /usr/lpp/psf/ps2afpd.cfg file.

5. Default values that are built into InfoPrint. These are the same as the transform
defaults, except that the default PDF output type is an IM1 uncompressed
image.

Troubleshooting the parallel PDF RIP client
There are certain factors that can enhance the performance of your pdfprs client.
This section provides some recommendations.

Defining RIPs on an InfoPrint AIX server
The more RIPs you define, the greater the performance improvement.
However, because a single RIP uses an entire CPU, you should never start
more RIPs than your InfoPrint Server can support. The pdfprs client
generally uses one processor, so be sure that your configuration can
support the number of RIPs that you define and start. For guidelines see
Table 22 on page 170. For more information about defining RIPs across AIX
servers, see 174.

Specifying an uneven number of RIPs
If you have PDF files that have simple text data on the front page and
more complex image data on the back page consistently throughout the
job, a two-RIP configuration will not result in enhanced performance. Since
the second RIP always gets the more complex pages, the job will take the
same time to RIP as if a single RIP were used, while the first RIP remains
idle. Use an uneven number of RIPs to distribute the pages in the job more
evenly.

Using –p or –g options from the command line
While you can specify a page subset for a particular job by using the –p or
the –g flags on the pdfprs command, we recommend that you avoid these
flags. If InfoPrint has to determine a subset of the pages in the job, it slows
down processing and reduces the benefit of having parallel RIPs.
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Working with the InfoPrint PPML transform program
The Print-on-Demand feature of InfoPrint Manager for AIX provides a transform
program to convert Personalized Print Markup Language (PPML) data streams
into the Advanced Function Presentation (AFP) format. PPML is an emerging
XML-based print data stream that is divided into subsets. InfoPrint Manager for
AIX supports the Graphic Arts Conformance Subset for processing objects in the
data stream that can consist of PostScript, PDF, TIFF, and JPEG objects. Sample
files that demonstrate the power of this transform are provided in the default
directory of /usr/lpp/psf/ppml2afp with the names samplePS.ppml,
samplePDF.ppml, sampleJPEG.ppml, and sampleTIFF.ppml.

Users can submit PPML jobs to InfoPrint through these methods:
v Hot folder interfaces from PC or Macintosh systems.
v Use of the pdpr command from the AIX command line.
v Use of the standard AIX print commands (enq, lp, qprt) from an AIX command

line.
v Use of the lprafp command from other UNIX® systems.

For more information about how to submit PPML jobs to InfoPrint Manager, see
InfoPrint Manager: Reference.

When a PPML print job is submitted to print on a PSF actual destination, InfoPrint
automatically invokes the transform. You can also run the transforms from the AIX
command line without printing the generated output. You might find this useful if
you intend to print the job later. Jobs print more quickly if they have already been
transformed.

The PPML transform has options that you can use to specify processing
information. For a list of the options or options and values for each transform, see
InfoPrint Manager: Reference. Configuration files, environment variables, and
user-exit programs allow you to specify processing information for InfoPrint to use
when it invokes the transform automatically. You can also use configuration files
and environment variables instead of typing options on the command line
whenever you run a transform.

Customizing the PPML transform
You can customize the transform for PPML data by specifying values in the
transform configuration files. Table 15 on page 154 shows the default configuration
files that InfoPrint provides. You can either modify these files or create your own.

Table 24. Default PPML transform configuration file

Data Stream Transform Configuration File

PPML ppml2afp /psf/ppml2afp/ppml2afp.cfg

Sample PPML configuration file
Figure 19 on page 178 shows an example of a configuration file for the PPML
transform.
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The configuration file uses keyword equivalents of the transform options. See
InfoPrint Manager: Reference for the keywords and values that you can specify in the
configuration file.

Hierarchy of PPML transform options
InfoPrint assigns a hierarchy to its use of options and configuration-file
information when it runs the PPML transform program. The following lists the
order in which InfoPrint uses options and information specified in configuration
files:
1. Any values you specify on the command line, including values in the

configuration file you specify with the -C option.
InfoPrint commands process options from left to right. If you enter the same
option more than once, InfoPrint uses the last occurrence of the option to
determine the value to use. For example, if you specify this command:
ppml2afp -C config.file -r240 -r300 myfile.ps

The ppml2afp command transforms the file using 300-pel resolution. InfoPrint
ignores the resolution value specified in the configuration file config.file and
the first -r240 option and value.

2. Values are specified in the default transform command configuration file, which
is /usr/lpp/psf/ppml2afp/ppml2afp.cfg. InfoPrint ignores values in the default
transform command configuration file if you invoke the transform command
indirectly by submitting a job to print.″

3. Default values that are built into InfoPrint. These are the same as the transform
defaults.

# default ppml2afp configuration file
#

# directory where PPML2AFP can create and maintain other files
ppml_work_directory = /var/psf/ppml2afp

# port number of the server running the PS2AFP transform
ps_server_port = 8251

# server name of the server running the PS2AFP transform
ps_server_name = 127.0.0.1

# resolution of the AFP being created; only supported values are 240, 300, 480
# and 600
ppml_resolution = 600

# output type format; only supported values are FS45 (color), FS10 (monochrome)
# or IO1_G4 (monochrome)
ppml_outdatatype = FS45

# page height (measurement units: i (inches), c (centimeters), m (milimeters))
page_height = 11i

# page width (measurement units: i (inches), c (centimeters), m (milimeters))
page_width = 8.5i

# ignore all relative paths from the zip file and store all the resources under
# a single directory
ignore_path = true

# enable tracing
trace = off

Figure 19. Sample PPML configuration file
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Working with the XML transforms
XML provides a standard method for the exchange and processing of data across
different computing platforms. XML data is structured according to standards from
the World Wide Web Consortium (W3C). Specifically designed for Web
applications, XML differs from HTML in that, while HTML contains information
about how data is formatted for presentation on Web pages, XML contains data
with no presentation information. A W3C standard stylesheet language, called
Extensible Stylesheet Language (XSL), uses formatting objects to describe how
XML data is presented. XML data containing XSL formatting objects is called
XSL-FO. XSL-FO describes document presentation details, such as pagination,
layout, and styling information.

Using the XML transforms with InfoPrint Manager
XML has become the key standard in the deployment of new technologies for Web
services, data interchange, messaging, and application integration. Support for
XML is found in several printing products, including XML Extender and Print
Services Facility™ (PSF) for z/OS.

The XML transforms are the preferred method for printing highly-dynamic XML
data on AFP printers because the transforms can efficiently process data that
changes from job to job. The XML transforms are also an efficient, cost-effective
alternative to paper-based communication because it can transform XML data to
PDF documents for electronic delivery to customers.

Other benefits of using xml2afp and xml2pdf to transform XML data to AFP or
PDF include:
v You can use your existing AFP output system to print or view your XML data

without worrying about compatibility issues.
v The XML transforms provide you with significant formatting flexibility for your

XML documents.
v Print delivery is guaranteed when you transform your XML data to AFP and

then print to an AFP printer.
v Once XML data is transformed, you can use different tools to:

– Print to an AFP printer or transform AFP data to PostScript (PS) or printer
control language (PCL) for printing on a PS or PCL printer.

– Send PDF data to an electronic destination.
– View or archive AFP or PDF data.

The XML transforms let you take advantage of XML for data interchange and
content management while using AFP’s print and presentation technology and
PDF’s electronic document exchange. Figure 20 on page 180 shows what you can
do with XML data when you use the XML transforms.

Chapter 15. Working with transforms 179



The InfoPrint products you can use with the AFP or PDF output include:

AFP view/browse
AFP Viewer plug-in or Content Manager OnDemand

PDF view/browse
Content Manager OnDemand

Distributed AFP print
InfoPrint Manager and PSF for z/OS

Distributed PS/PCL print
InfoPrint Manager, Infoprint Server, and Infoprint Server Transforms

E-mail IP PrintWay™ component of Infoprint Server

Archive
Content Manager OnDemand

How do the XML transforms work?
You use the xml2afp and xml2pdf to transform XML data to an AFP or a PDF data
stream. To do this, you must supply one of these to the XML transforms::
v XML files (or data sets), which do not contain data placement and presentation

information, and an accompanying XSL style sheet
v XSL-FO files (or data sets), which contain XML data with XSL formatting objects

To transform XML data to AFP or PDF, the XML transforms use the data you
supply and do one of these:
v Uses the XSL style sheet to transform the XML files into XSL-FO and then

completes the transformation to AFP or PDF
v Directly transforms your supplied XSL-FO files to AFP or PDF

Figure 21 on page 181 shows how the XML transforms process data from XML to
AFP or PDF data.

Figure 20. Scenarios for using XML data that has been transformed to AFP or PDF
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Running the XML transforms
You can run the XML transforms as:
v A standalone transform
v A transform managed by InfoPrint Manager

Capabilities and limitations
The XML transforms have these capabilities and limitations, depending on how
data is being transformed:
v Capabilities and limitations for transforming all data
v Capabilities and limitations for transforming data to AFP
v Capabilities for transforming data to PDF

General capabilities and limitations for transforming all data
Output document size

Output document size is dependent on the amount of memory available;
however, no checking is done between document size and available
memory. If the output document is too big for the available memory, you
receive an out of memory error and the transform stops processing.

XSL support
The transforms support most, but not all, formatting objects, properties,
and features of the XSL Version 1.0 standards as documented by the W3C
(http://www.w3.org/TR/xsl/).

Style sheets embedded and referenced in XML files are not supported.

Capabilities and limitations for transforming data to AFP
Bar code support

The transform does not support bar codes.

Font support
The first font in the font index with properties that most closely match the
desired characteristics is used. Condensed and expanded fonts are usually
only used when the font-stretch property is selected. Italic and oblique
fonts are considered the same and are used interchangeably.

Figure 21. Process for transforming XML data to AFP or PDF
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The XML transforms support converting double-byte character set (DBCS)
fonts from one code page to another.

The XML transforms work with the OpenType fonts from the command
line. For more information about OpenType Fonts, see Using OpenType
Fonts in an AFP System, G544-5876.

Graphic support
You can specify graphic data in one of these AFP resources:

Overlay
An overlay contains a collection of constant image data (such as
lines, shading, boxes, or logos) that can be merged with variable
data during printing. The AFP output file references the name of
an overlay, which is located in a resource directory. Because the
overlay is not included but is only referenced in the output file,
you must specify the image size in the XSL external-graphic
formatting object. For example:
<fo:external-graphic src="overlay:corplogo" content-height="4in"
content-width="2in"/>

Page segment
A page segment contains image data (such as bar codes, signatures,
logos, or graphics in image format) that can be merged with
variable data during printing. The AFP output file references the
name of a page segment, which is located in a resource directory.
Because the page segment is not included but is only referenced in
the output file, you must specify the image size in the XSL
external-graphic formatting object. For example:
<fo:external-graphic src="pageseg:corpsign" content-height="4in"
content-width="2in"/>

IOCA object
An Image Object Content Architecture (IOCA) object contains a
series of picture elements (pels) arranged in rows and columns,
and specifies where the image is placed on a page. The XML
transforms access the first IOCA object in a specified MO:DCA-P
file and place it inline in the AFP output file (only MO:DCA-P
image data is supported). The transforms obtain the actual size
from the image; therefore, you do not need to specify the size in
the XSL external-graphic formatting object. If you do specify the
size with the external-graphic formatting object, the transforms
crop the image to make it the specified size or add whitespace to
the bottom-right corner, so the image appears in the upper-left
portion of the allotted space. Here is an example of the formatting
object you specify for an IOCA object:
<fo:external-graphic src="myfile/image.afp"/>

MO:DCA-P output
Output from the transform conforms to the MO:DCA Interchange Set 1
(IS/1) architecture (see Mixed Object Document Content Architecture Reference,
SC31-6802).

Capabilities for transforming data to PDF
PDF output

The transform converts XML data to PDF 1.1 data streams.
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Customization tasks for the XML transforms
The system administrator can customize the XML transforms as standalone
transforms or as transforms managed by InfoPrint Manager. If you have InfoPrint
Manager installed, InfoPrint recommends you use it to manage the XML
transforms.

This section details the common, standalone, and InfoPrint Manager customization
tasks the administrator must do before the job submitter can run the XML
transforms. The administrator does the common customization tasks and either the
standalone or InfoPrint Manager customization tasks, depending on whether the
XML transforms are run as a standalone transform or managed by InfoPrint
Manager.

Common customization tasks
The common customization tasks you do depend on whether you are using the
XML to AFP transform or the XML to PDF transform.

Tasks for using the XML to AFP transform: The sample xml2afp configuration
file is provided in /usr/lpp/psf/xml2afp/xml2afp.cfg. These items are set in the
file and can be modified:
1. The default location of the AFP fonts.
2. The default paper size.

Additionally, defaults for all the xml2afp options can be set in the configuration
file.

The syntax of the configuration file is exactly the same as the command line syntax
with these additional rules:
1. Blank lines are ignored.
2. All data on a line after a pound sign is ignored. The pound sign can occur

anywhere on a line.
3. To include a pound sign in parameter data, it must be escaped; that is, it must

be preceded by a backwards slash.
4. White space before and after parameter data is removed.
5. Parameter data on successive lines is concatenated with a single space between

them.
6. Parameters can span lines as long as they follow rules 1 through 5.

Customizing the xml2afp.cfg file:

You can either create a new configuration file or modify the sample that is
provided:
1. Create a new xml2afp configuration file, xml2afp.cfg, which lets you configure

the xmp2afp transform.
To create the file on AIX, copy the sample configuration file,
/usr/lpp/xml2afp/samples/xml2afp.cfg to /etc/xml2afp.cfg:
cp /usr/lpp/xml2afp/samples/xml2afp.cfg /etc/xml2afp.cfg

Note: If you want to modify the sample configuration file, you still need to
copy it.

2. Edit the file using your preferred editor, such as vi or notepad.
a. On the FONTLIB keyword, specify the location of the AFP font libraries to

be used by the xml2afp transform. For example,
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FONTLIB="//SYS1.FONTOLN://SYS1.FONT300"

You can use MVS partitioned data set names, which are fully qualified and
prefixed with two slashes. Use colons to separate entries in the list.

b. If necessary, customize these items:
v Font index files

If you want to customize the way the xml2afp transform maps character
data from your documents to AFP fonts, create or modify a font index file
and then specify, under the XML2AFP_CUSTOM keyword, the directory
where your font index file is located. Font index files are located in the
same directory as the device types file (for example, /etc/xml2afp).
You can create your own font index file or use the ones supplied with the
xml2afp transform.. The font index files describe the file syntax and
include one file that specifies outline fonts (/usr/lpp/psf/xmltransform/
outline_font_index and one file that specifies raster fonts
(/usr/lpp/psf/xmltrasnform//raster_font_index. See either of those font
index files for information to help you create a font index file.

v XML Toolkit location with the TOOLKIT and CLASSPATH keywords
v Java™ executable location with the JAVA keyword
v The xml2afp tranform location with the XML2AFP_BASE keyword, if it is

installed in a location other than /usr/lpp/psf/xml2afp.
v Memory the Java virtual machine uses to run the transform with the

HEAP_SIZE keyword

Keep in mind: The configuration file is a shell script. You can use any
commands that are valid according to /bin/sh. However, because the script
runs for each invocation of xml2afp transform when it is not managed by
InfoPrint Manager, avoid using any commands that take a long time to
complete.

See ″xml2afp Command: transforms XML data to AFP″ in the ″InfoPrint Manager
Tools″ chapter in InfoPrint Manager: Reference for the sample XML transforms
configuration file, /usr/lpp/psf/xml2afp/samples/xml2afp.cfg, that is shipped
with the xml2afp transform.

Customizing the font index file for xml2afp:

The sample font index file for xml2afp is provided in /usr/lpp/psf/xmltransform.
The samples include a outline_font_index and a raster_font_index that you use
to map XML font names to both outline FOCA fonts and raster fonts in the font
path.

Note: If you are using OpenType fonts, the font index files are not necessary.

A font is referenced in XSL-FLO using these attributes:
family
size
style
weight

Font index files describe AFP fonts using these attributes. In addition, a map is
defined that maps unicode code points into AFP code points.

The font index file consists of a sequence of key and value pairs, separated by
whitespace (such as a space, tab, or a newline). Comments can be inserted
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anywhere between the delimiters /* and */. You can also use // to indicate that
the remainder of the current line is a comment.

The keys and their meanings are:

Key Meaning

map Select the named character map, creating it if it does not exist. A character
map is used to map unicode code points to AFP code page names and
code points. The default is default.

codepage
Set the code page to use for subsequent character mappings.

to End a range of mapped unicode code points. The value must be an integer
representing a valid unicode code point, and it must be greater than the
beginning value of the range given by the closest preceding value for the
char keyword. The value must be a valid unicode code point.

at Creates a mapping using the closed range given by a preceding char value
and an optional to value. The unicode characters from begin to end are
mapped to the AFP code point range from the at value to the at value +
end - begin, inclusive, using the closest preceding codepage value. This
value must be an integer from 0 to 65535.

family Establish the current font family name. The value must be a string
containing no whitespace characters.

size A font size, expressed as a floating point value giving the vertical size of
the font, in points (1/72nds inches). Size must be omitted when defining
outline technology fonts, since they can take any size.

style A font style. The value must be one of these keywords:
normal
italic
oblique
backslant

The default is normal.

weight
A font weight. The value can be one of these keywords:

normal
bold

The value can also be one of the values between 100 and 900 inclusive, in
increments of 100. The keyword normal is equivalent to 400, and the
keyword bold is equivalent to 700. The default value is normal (400).

charset
Define a font with the preceding values given for the font properties
(family, size, style, and weight), or default values if no preceding property
values have been established. The currently selected character map is
associated with the font, and it is used for mapping unicode code points
when the font is selected. If modifications are made to the map later in the
file, those changes do not affect the defined font.

alias Establish a font family alias for the current family.

Of the keywords listed, only two are active: at and charset. The other
keywords collect values used when an active keyword is found. This
allows for a variety of possible arrangements for a font index. For example:
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family courier
alias monospace
size 7
weight normal
style normal
charset C04200070
style italic
charset C0430070

weight bold
style normal
charset C0440070
style italic
charset C0450070

Defines the same set of fonts as:
family courier size 7 weight normal style normal charset C0420070
family courier size 7 weight normal style italic charset C0430070
family courier size 7 weight bold style normal charset C0440070
family courier size 7 weight bold style italic charset C0450070
alias monospace

But might be considered more difficult to read.

Tasks for using the XML to PDF transform: The sample xml2pdf configuration
file is provided in /usr/lpp/psf/xml2pdf/xml2pdf.cfg. The default paper size can
be modified. Additionally, defaults for all the xml2pdf options can be set in the
configuration file.

The syntax of the configuration file is exactly the same as the command line syntax
with these additional rules:
1. Blank lines are ignored.
2. All data on a line after a pound sign is ignored. The pound sign can occur

anywhere on a line.
3. To include a pound sign in parameter data, it must be escaped; that is, it must

be preceded by a backwards slash.
4. White space before and after parameter data is removed.
5. Parameter data on successive lines is concatenated with a single space between

them.
6. Parameters can span lines as long as they follow rules 1 through 5.

These are the common tasks you must do when using the XML to PDF transform:
1. Create the XML Extender configuration file, xml2pdf.cfg, which lets you

configure XML Extender. To create the file:
v Copy the sample configuration file, /usr/lpp/xml2afp/samples/xml2pdf.cfg, to

/etc/xml2pdf.cfg:
cp /usr/lpp/xml2afp/samples/xml2pdf.cfg /etc/xml2pdf.cfg

Note: If you want to modify the sample configuration file, you still need to
copy it.

2. Edit the file using your preferred editor.
If necessary, customize these items:
v Java executable location with the JAVA keyword
v The xml2pdf transform location with the XML2PDF_BASE keyword, if it is

installed in a location other than install_path\xml2pdf
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v Memory the Java virtual machine uses to run the transform with the
HEAP_SIZE keyword

Keep in mind: The configuration file is a shell script. You can use any
commands that are valid according to /bin/sh. However, because the script runs
for each invocation of the xml2pdf transform when it is not managed by
InfoPrint Manager, avoid using any commands that take a long time to
complete.

See ″xml2pdf Command: transforms XML data to PDF″ in the ″InfoPrint Manager
Tools″ chapter in InfoPrint Manager: Reference for the sample XML transforms
configuration file that is shipped with the xml2pdf transform.

Color management resource transform support
InfoPrint Manager enables these transforms to do color management:
v ps2afp
v jpeg2afp
v tiff2afp
v gif2afp

Note: The PCL and SAP transform do not support color management.

Transforms capable of color management allows the specification of color resource
information at job submission time and the implementation of color management
at the transform level within InfoPrint Manager. This support will provide color
fidelity with better printer performance.

Submitting job using transforms for color management

Before you use transforms to do color management, make sure that you have
installed the ICC Profiles using the Resource Installer into the Resource library as
Color Management Resources (CMRs). For more information, see cac_CMRs.dita
and cac_ResInst.dita.

Notes:

v You can specify the ICC Profile directly in a pure PS/PDF transform.
v Only audit color conversion, instruction color conversion, and link color

conversion CMRs are supported.

To submit a job:
1. Select your destination printer.
2. Right-click and select Job and Document Defaults.
3. Click Modify.
4. Click Document AFP Color. If this tab is not visible, click Show more and

then select Document AFP Color.
5. Enter one or more input color management resources in Input color

management resources.
6. Next, enter an output color management resource in Output color

management resource.
7. From Color rendering indent, select one option.
8. Then, select the output color resource tagging from Tag output CMR.
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9. In the Place CMR inline option, click Yes to inline the color resource
information in the FS45. Default is No.

10. Click Submit.

For more information about the values that you can specify, see InfoPrint Manager:
Reference.

188 InfoPrint Manager for AIX: Procedures



Chapter 16. Understanding transform objects and the
configurable transform subsystem

This chapter contains information about the following:
v “Transforms”
v “Defining a transform sequence” on page 190
v “Configuring transforms” on page 191
v “Examples of creating transform objects” on page 196

Transforms
Transforms are InfoPrint objects (like queues and destinations) that you create and
configure in InfoPrint Manager. Transforms receive data in a particular format or
formats, process the data in some way, and output the changed data. When you
create a transform, you have complete control over what data format or formats it
operates on and what type of processing it does. The processing that the transform
performs can be anything from simply copying the data to a different place on
disk, to filtering the data stream that the transform receives (for example, to
remove a particular PostScript order), to transforming the data to a completely
different format (for example, converting PCL to AFP).

When you create a transform, you specify several things, including:
v Input data format

The data stream that is sent to the transform. The input data format is what the
transform uses to determine whether it has any work to do. If you send a
PostScript job through a transform that has its input data stream set only to
PCL, the job will bypass the transform without being changed at all. You can set
the transform to accept multiple input data formats.

v Transform options

The program or command that actually does the work of the transform; what
happens during the processing stage. The transform options can be system
commands (such as copy), programs provided with InfoPrint Manager (such as
ps2afp), or your own custom transform programs (for example, mypclfixup).
When you create a transform, you specify the complete command line needed to
invoke this program or command. Within this command line, you can also
specify various substitution variables, place holders which InfoPrint Manager
replaces with a value when InfoPrint Manager runs the transform. For example,
if you include %i in the line, InfoPrint Manager will replace it with the name of
the file that the transform receives; if you include %o, it will be replaced with the
name of the file that the transform needs to put the changed data into.

v Output data format

The output data format is the data stream that results from the transform. You
can only specify one output data format.

In addition, you can specify whether you want the file that the transform produces
to be printed. If the transform doesn’t return the file to be printed (for example, if
the transform completes its processing and saves the file to a different location), it
is called a terminating transform. In addition to the terminating transform, you can
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also create a conditionally-terminating transform. To create this, define a unique
return code to indicate the transform was successful but does not return data to
print.

Transforms do not do anything by themselves. They remain inactive until you
associate them with an actual destination as a transform sequence. A transform
sequence is an attribute of an actual destination that contains an ordered list of
transforms. Every job that is submitted to that actual destination is sent through
that list of transforms in the order specified before it is printed.

InfoPrint Manager lets you create a sequence for transforming print data before the
system sends it to a printer. This provides users with a feature similar to the
configurable transform sequences that you could create in PSF/2 using the
XFMFLTR utility. For more information about creating transform sequences, see
“Defining a transform sequence.”

Notes:

1. If you include a terminating transform in a transform sequence, it must be the
last transform in the sequence.

2. If you invoke a terminating transform for a document in a job, the entire job
ends after all the documents in that job finish processing. It does not matter
whether any other documents in the job use the terminating transform.

Defining a transform sequence

A transform sequence lets you string together a series of transform objects to do a
series of tasks. This topic provides an example of a transform sequence, followed
by the specific procedure you can use to create a sequence of transform objects.

You want to define an actual destination that will copy AFP versions of all print
jobs sent to it into a directory on your InfoPrint Manager server system. This
directory is used as an archive of AFP versions of print jobs that might need to be
viewed later.

To accomplish this, you use the InfoPrint Manager Administration GUI to create
these three transforms:
1. tranps

You set the input data format to PostScript, the Transform options to use
ps2afp, and the output data format to MODCA-P (Mixed Object Document
Content Architecture).

2. transpcl

You set the input data format to PCL, the Transform options to use pcl2afp,
and the output data format to MODCA-P.

3. saveafp

You set the input data format to AFP, the Transform options to issue a copy
command, and the output data format to MODCA-P. In addition, you make
this a terminating transform by selecting Transform only in the Create
Transform dialog.

Then, create an actual destination that you want to do the transform sequence.
When the Printer Creation wizard asks if you want to change the configuration for
the printer, click yes, then click the Configuration tab to define the transform
sequence as follows:
1. transps
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2. transpcl
3. saveafp

Note: If you already have the destination created, open the properties notebook for
that actual destination and click the Configuration tab to define the transform
sequence.

When you send a job to this actual destination, this sequence of actions occurs:
1. transps checks to see if the incoming data is PostScript. If it is

PostScript,transps transforms the data into AFP using ps2afp. If it is not
PostScript, transps does nothing.

2. transpcl checks to see if the incoming data is PCL. If it is PCL, transpcl
transforms it to AFP using pcl2afp. If it is not PCL, transpcl does nothing.

3. saveafp copies the AFP file produced by either of the above steps into a
specific directory.

4. Since saveafp is a terminating transform, the job is not printed but is marked
complete at this point.

To create a transform sequence, use this procedure from the InfoPrint Manager
Administration GUI:
1. Select the printer that you want to send the job to.
2. Click Printer → Properties to open the Printer Properties notebook for the

selected printer.
3. In the Printer Properties notebook, click the Configuration tab.

The data stream transforms that this printer can use are listed in the
Transforms to use field.

Note: If you can’t see the Transforms to use field, click Show more.
4. Use the Add and Remove buttons to specify the transforms in the sequence

that they should be run in the Values field.
For example, you might want to create the three-step transform sequence that
runs the tranps , transpcl, and saveafp transforms in sequence as described
above. To accomplish this task, the Values field would contain this:

5. When you have entered the transforms in the correct sequence, click Apply to
associate this transform sequence with the selected printer.

Configuring transforms
To configure a transform, you must do these two tasks:
1. “Creating transforms.”
2. “Associating a transform with an actual destination” on page 195.

Creating transforms

You can create a transform sequence through the InfoPrint Manager
Administration GUI (for more specific information, see the online help topic in
this GUI entitled ″Server transform tasks″).

To create a transform using the InfoPrint Manager Administration GUI, an
InfoPrint Manager system administrator must set the following values on the
Create Transform window. You can access this window by clicking the Server
menu, and select Transform → Create.
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1. Start the InfoPrint Manager Administration GUI.
2. Select Server → Transform → Create.
3. Fill in these values:

Name Type a meaningful name for the transform.

InfoPrint Manager references the transform name in transform
sequences that are associated with actual destinations.

Server If not filled in, either type or select the InfoPrint Manager server in
which you want to create the transform.

Transforms can only be associated with actual destinations in the same
server. If the InfoPrint Manager Administration GUI is only monitoring
one server, this field contains that server name.

Format of output file
Select a format for the output file produced from this transform.

Description
Type a description of this transform that will appear whenever you
show this transform through the InfoPrint Manager Administration
GUI.

Transform options
Type the command-line transform and its options, including any
InfoPrint Manager substitution variables.

How to process jobs
Select how to process jobs. The options are:
a. A transform that returns the transformed data to InfoPrint Manager

for printing (Transform and print radio button with the
Conditional terminating return code field left blank).

b. A terminating transform that completes without returning data to
InfoPrint Manager to print (Transform only radio button).

c. A conditionally terminating transform that might print the data
after it has been transformed (Transform and print radio button
with the Conditional terminating return code field set to a value
that tells InfoPrint Manager not to print the data if the transform
returns that return code value).

Document formats allowed
Add a format for the input file or file(s) that are being transformed as
Values in the Document formats allowed field.

Note: You can specify either one or many document formats as Values.
The format of the input file determines whether this transform is called
for a job sent to this actual destination.

Use server locale
Decide whether InfoPrint Manager should pass the values of attributes
specified in the %% substitution variables in the Transform options
field in the language of the InfoPrint Manager server or in English, by
using the Use server locale radio button. By default, this radio button
passes information in the language of the server (Yes).

The transform examples that follow demonstrate common uses of transform
objects, using the substitution values shown in Table 25 on page 193. Some of these
examples presume that an application programmer has created a program with the
name specified at the start of the Transform options field.
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Notes:

1. If you are specifying any substitutions for which the passed values can contain
a blank space, such as job name, be sure to put quotes around the substitution
so it is passed correctly. Note that this only applies to single % substitution
variables. Do not put quotes around any %% substitution variables.

2. The examples that follow presume that the PATH environment variable has
been set to the appropriate path so you do not have to specify the fully
qualified path name in the Transform options field.

Table 25. Transform substitution variables

Transform options substitution variables Meaning

%i The name of the input file to transform.

%o The name of the file in which to store the
output of the transform.
Note: If this is a non-terminating transform,
data must be stored in the file named by %o.

%e The name of the file in which to store any
transform information or error messages. If
anything is written to this file, it is logged in
the InfoPrint Manager server log.
Notes:

1. If the transform exits with an exit code of
0 or the value set in the Conditional
terminating return code field, the error
messages from the transform are logged
as debug severity.

2. If the transform exits with a non-zero
return code, but not with the value set in
the Conditional terminating return code
field transform attribute, the error
messages from the transform are logged
as error severity.

3. InfoPrint Manager writes transform error
messages to either the file specified
through this substitution variable, or to
standard error (stderr). You should not
mix output to %e and stderr in a single
run of the exit program. You should use
either one or the other in any given run.

%u The name of the file for updating the
pages-completed and job-page-count job
attributes.
Note: This file should only be accessed
through the transform_update utility.

%j The name of the original print file, minus
the path (from the document-file-name
attribute).
Note: This should only be used to construct
another name, such as a temporary file.

%n The name of the original print file, minus
the path and minus the extension (from the
document-file-name attribute).
Note: This should only be used to construct
another name, such as a temporary file.
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Table 25. Transform substitution variables (continued)

Transform options substitution variables Meaning

%d A text string that represents the document
format of the input file. This value can be:

v ASCII for ASCII line data.

v AFPDS for Advanced Function
Presentation data

v PCL for Printer Control Language data

v PS for PostScript data

Note: You can also acquire document format
through the %%Ddocument-format
substitution value.

%p The value of the document’s
destination-pass-through attribute.
Note: This value is passed to all subsequent
transforms and the actual destination.

%q The actual destination that is processing the
job.

%s The document-sequence-number for the
document.

%t The value of the document’s
other-transform-options attribute.
Note: If you want to write one transform,
but use it differently for different actual
destinations or jobs, you can pass values into
the transform with this parameter.

%g The global job identifier for the job.

%# The job-identifier (10 digits maximum).

%%Aad_attribute%% The value of the InfoPrint Manager actual
destination attribute specified. For example,
if %%Aresource-context%%, InfoPrint Manager
passes the actual destination’s
resource-context attribute value.
Note: See the ″Considerations when using
the %%Nattributename substitution control
sequences″ section under the ″Usage
guidelines″ for the other-transform-options
attribute in InfoPrint Manager: Reference
before using this substitution variable.

%%Ddoc_attribute%% The value of the InfoPrint Manager
document attribute specified. For example, if
you use %%Ddepartment-text%%, InfoPrint
Manager passes the document’s
department-text attribute value.
Note: See the ″Considerations when using
the %%Nattributename substitution control
sequences″ topic under the ″Usage
guidelines″ for the other-transform-options
attribute in the InfoPrint Manager: Reference
before using this substitution variable.
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Table 25. Transform substitution variables (continued)

Transform options substitution variables Meaning

%%Jjob_attribute%% The value of the InfoPrint Manager job
attribute specified. For example, if you use
%%Jjob-owner%%, InfoPrint Manager passes
the job-owner attribute value of the job that
owns the document being transformed.
Note: See the ″Considerations when using
the %%Nattributename substitution control
sequences″ topic under the ″Usage
guidelines″ for the other-transform-options
attribute in the InfoPrint Manager: Reference
before using this substitution variable.

Associating a transform with an actual destination

Now that you have created a transform object, you must associate it with an actual
destination before you can use it.

To associate a data stream transform with an actual destination from the InfoPrint
Manager Administration GUI, use this procedure:
1. Select the printer that you want to send the job to.
2. Click Printer → Properties to open the Printer Properties notebook for the

selected printer.
3. In the Printer Properties notebook, click the Configuration tab.

The data stream transforms that this printer can use are listed in the
Transforms to use field.

Note: If you can’t see the Transforms to use field, click Show more.
4. Use the Add and Remove buttons to specify the transform in the Values field

(the equivalent of setting the transforms-sequence actual destination attribute
from the command line).

Note: You can string multiple transforms together to do a sequence of tasks.
For more information about this feature, see “Defining a transform sequence”
on page 190.

5. When you have entered the transforms in the correct sequence, click Apply to
associate this transform sequence with the selected printer.

If you prefer to use the command line, you can use these InfoPrint commands
from either an AIX command line or an MS/DOS window with transform objects:
v pdcreate

v pddelete

v pdset

v pdls

For more information about the attributes in creating transform sequences, see the
″Attributes for Transforms″ topic in the ″InfoPrint Object Attributes″ chapter of the
InfoPrint Manager: Reference.
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Examples of creating transform objects
The following shows three specific examples (from simple to more advanced) for
creating transform objects. The second and third examples require additional
programming to create the programs that are called from the Transform options
field. This topic should suggest how you can use transform objects to customize
your InfoPrint Manager installation.

Creating a transform object to copy to a file without printing

To define a data stream transform object from the InfoPrint Manager
Administration GUI that takes an AFP input file and copies it to a file location on
the hard drive without printing the output, use this procedure:
1. Start the InfoPrint Manager Administration GUI.
2. Click the Server menu, and select Transform → Create.
3. In the Create Transform dialog, fill in the fields as shown in either Figure 22 on

page 197 or Figure 23 on page 198, depending upon your operating system.
These values create a transform that copies AFP input data to an \afp folder on
a specific drive on Windows or a /usr/samp file system on AIX. Also, it names
the transformed file with the name of the original file name because of the %n
substitution variable.

4. Since you do not want the job to be printed, select the Transform only radio
button to indicate that this transform is a terminating transform.
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Figure 22. Create Transform dialog: Define a transform that copies an AFP file to a folder without printing on Windows
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5. Click OK.
InfoPrint Manager creates a transform object under the name you provided in
the Name field so that you can see its values by selecting Transform →
Properties from the Servers menu.

Creating a transform object to convert data and print only
smaller files

If your transform might want to terminate the processing of the job in some cases
but return data to be printed in other cases, you can create a conditionally
terminating transform. For example, you might want to transform and store some
documents but transform and return for printing other documents. You can define
a return code that your transform can return to indicate when it has completed its
task successfully, but is not returning any data for printing.

In the example below, the actual destination activates the pics2gif transform when
incoming JPEG and TIFF jobs enter the system. These jobs are transformed into
GIF format and then uploaded to the Internet by an application outside of
InfoPrint Manager. When the transformed GIF files are smaller than 3 KB, they are
returned to InfoPrint Manager for printing on a proof printer. To observe
cost-cutting mandates across the installation, transformed GIF files that are larger

Figure 23. Create Transform dialog: Define a transform that copies an AFP file to a directory without printing on AIX
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than 3 KB are not printed. The transform checks the size of the transformed file
and sends a return code of 5 if the job is too big to be printed.

To define a data stream transform object from the InfoPrint Manager
Administration GUI as a conditionally-terminating transform, use this procedure:
1. Start the InfoPrint Manager Administration GUI.
2. Click the Server menu, and select Transform → Create.
3. In the Create Transform dialog, fill in the fields as shown in Figure 24. These

values create a transform that transforms both JPEG and TIFF input data into
GIF output and then provides a return code of 5 if the transform has completed
successfully without returning to InfoPrint Manager for printing.
In the Transform options field, you can use a series of substitution variables to
provide special options for the transform sequences. In this example, besides
the standard input (%i) and output (%o), this transform object also uses the %q
flag so the InfoPrint server passes the name of the actual destination processing
the job.

4. Click OK.
InfoPrint Manager saves the transform under the name you provided in the
Name field so that you can see its values by selecting Transform → Properties
from the Servers menu.

Figure 24. Create Transform dialog: Define a conditionally terminating transform
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Creating a transform object that updates the job’s page count

By default, InfoPrint Manager has no knowledge of the number of pages in a
transformed job. However, if you have a transform that knows how many pages
are in the job, you can create a transform object that can update InfoPrint Manager
with this information. InfoPrint Manager can pass transform objects an update_file
with the %u option. This update_file can be updated with how many pages are in
the transformed job, and InfoPrint Manager then updates the job with this
information. To modify the update_file, the user supplied transform needs to call
the transform_update utility that is supplied with InfoPrint Manager. For the
syntax of the transform_update utility, see“Using the transform_update utility” on
page 201.

To define a data stream transform object from the InfoPrint Manager
Administration GUI, use this procedure:
1. Start the InfoPrint Manager Administration GUI.
2. Click the Server menu, and select Transform → Create.
3. In the Create Transform dialog, fill in the fields as shown in Figure 25 on page

201.
For this example, the passvals program that is called by the PASSVALUES
transform object gets passed both the resource-context document attribute and
the job-owner job attribute, as well as an update file. You should change the
passvals program to your transform program that knows how many pages are
in the job, and then change the parameters in ″Transform options″ to what your
program expects with the ″%u″ being the update_file that will be passed to the
transform_update utility when your transform calls it. Other attributes, like
resource-context and job-owner, can be included or omitted as required by the
needs of your transform.
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4. Click OK.
InfoPrint Manager saves the transform under the name you provided in the
Name field so that you can see its values by selecting Transform → Properties
from the Servers menu.

Using the transform_update utility
Use the transform_update utility to update InfoPrint Manager about the job page
count or number of pages completed.

You can use the %u transform option to access an update file that lets you update
the document page count or the job’s pages-completed attribute. Never access the
file identified with %u directly. The transform should only use the
transform_update utility. InfoPrint Manager only checks for updates while the
transform is running and immediately after it completes. The transform_update
utility can be called either once or multiple times while the transform is running.
Once the transform returns, InfoPrint Manager deletes the update file.

The transform_update utility provides these return codes:

1 An English message for basic problems, including:
v Invalid option specified.

v No option or option value specified.

Figure 25. Create Transform dialog: Define a transform to pass job attributes
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v No status file name specified.

v Cannot open status file named ____.

v Cannot read status file named ____.

0 A successful update

-1 The update of the status file was not successful.

transform_update [-t delta_pages_transformed]
[-d delta_pages_delivered]
update_file

-t Specifies the number of additional pages since the last update in the
transformed document file. InfoPrint Manager uses this information to
recalculate the job’s job-page-count attribute. The total of values that this
option passes cannot exceed 2,147,483,647.

-d Specifies the number of additional pages delivered by the transform since
the last update. InfoPrint Manager uses this information to update the job’s
pages-completed attribute. The total of values that this option passes
cannot exceed 2,147,483,647.

Often, it is unnecessary for transforms to update the pages-completed
attribute because it indicates how many pages have actually printed or
stacked for the job, and this attribute is updated by the print backend in
InfoPrint Manager with the number of pages that were printed. Any pages
referenced here should have been removed from any file returned to
InfoPrint Manger for further processing.

update_file
The file passed to the transform through the %u option.

Notes:

1. If a transform calls the transform_update utility more than once, each call
should pass a value for the change since the last call, not a cumulative value.

2. If InfoPrint Manager can neither open nor read the file, it logs an error and
continues processing.

3. If you use a transform to update the job-page-count attribute, you must
provide a page-count for the document. This page-count information provided
by the transform should be the pages in the transformed document for a single
copy of that document.

4. If a transform updates the pages-completed attribute and returns a job for
printing, the pages the actual destination completes are added to the pages the
transform reported it had completed.
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Chapter 17. Managed IPDS Dialog support

The Managed IPDS Dialog (MID) support enables additional sharing capabilities
for specific printers. Current sharing of a print device is based on the setting of an
inactivity timer. MID support overcomes these current limitations:
v Release for sharing requires physical intervention to disconnect the print device,

and the PSF host must re-acquire the TCP/IP connection to process additional
print requests. When the original connection is released, all downloaded
resources are generally lost. Furthermore, there is a possibility that another host
might acquire the TCP/IP connection and prevent the current host from
processing additional print requests.

v Release of the print device is controlled by a specific time value. This causes the
release of the printer even when there are no additional print requests pending.

With MID support, the printer can request that the PSF host release its control of
the print device (but not drop the TCP/IP connection), thus allowing the print
engine to print non-IPDS data streams when IPDS activity is minimal. MID
support also enables the sharing of the print mechanism with other non-IPDS data
streams.

This chapter includes the following sections:
v “Enabling MID support”
v “Considerations to activate MID support”

Enabling MID support

Set these parameters to enable MID support:
1. mid-support-enabled

a. Right-click the actual destination in the InfoPrint Manager GUI and click
Properties.

b. Click Tuning.
c. Enter Yes in the Enable MID Support field to activate MID. The default

value is No.
2. mid-release-timer

a. Right-click the actual destination in the InfoPrint Manager GUI and click
Properties.

b. Click Tuning.
c. Specify a numeric value for MID Release Timer from 1 to 9999. The default

value is 15.

Note: The value for the MID-release-timer must be less than the value for
the destination-release-timer-setting. The MID will never be enabled if the
destination-release-timer-setting value is less than the MID-release-timer
value.

Considerations to activate MID support

Consider these before you activate MID support for your print device:
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v Your print device must be capable of supporting MID. Contact your InfoPrint
representative if you are not sure of your print device capability.

v If you want incoming non-IPDS print requests to be intermingled with IPDS
print requests, it is suggested that you maintain control over the print
mechanism rather than activate MID.

v Jobs must be “stacked″ before the print mechanism is released. This might lead
to paper loss for the print device.

v Releasing the print mechanism might prevent the IPDS host from processing
subsequent print requests until the control is returned to the host (the time
depends on the capacity of each print device).

v The MID support does not allow for sharing of the print mechanism between
two IPDS hosts for InfoPrint printers.
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Chapter 18. Printing PCL or PostScript to PSF destinations:
Specifying which paper bin to use

In general, when you submit a print job through a PCL or PostScript driver, you
can use the printer options to specify which input paper bin you want the printer
to use. For example, if you know that white 8.5 × 11 inch paper is always loaded
in bin one and letterhead is always in bin two, you can select bin one when you
want to print a draft and bin two when you’re ready to print a real letter.

When you send PCL or PostScript print jobs to a PSF Destination in InfoPrint
Manager, the data stream is transformed into Advanced Function Presentation
(AFP) before it is printed. By default, most PCL jobs that are transformed use
paper bin one, regardless of the bin you specify. Transformed PostScript jobs
default to letter-sized paper if no other options are specified, and look for a bin
that contains that size paper; they either print on paper from the first bin that
contains the right size or fail because they don’t find the right paper.

If you want the transform program to check for your bin selection and include it in
the AFP data that is sent to the printer, you must specify mappings between the
PCL and PostScript bins and the AFP bins. The transform will use your mappings
to convert the bin number it finds in the PCL or PostScript into an AFP bin
number. You can configure InfoPrint Manager so that you can specify up to 20
different input paper bins. For information about how to figure out which PCL and
PostScript bins map to which AFP bins, see “Determining bin mappings.”

To set up bin mapping, see “Editing configuration files” on page 210.

Determining bin mappings

PCL printing
When you submit a print job through a PCL print driver and select a paper bin to
print from, the driver generates a bin number and puts it into the data stream.
Unfortunately, different drivers generate different bin numbers for the same bin.
For example, one driver might make ″Tray 1″ equal to bin 4 and ″Auxiliary tray″
equal to bin 2, while another driver makes ″Tray 1″ equal to bin 1 and ″Auxiliary
tray″ equal to bin 8. To add more difficulty, the generated PCL bin numbers can
range from 0 to 59. While most drivers use low numbers (0 through 10), keep in
mind the other possibilities.

During the transformation from PCL to AFP, InfoPrint Manager takes the bin
number that the driver generated and compares it to the bin mappings you set.
The pcl2afp transform inserts the AFP bin number that you assigned and sends the
job to the destination you requested. The printer prints the job on paper from the
bin you chose. As a result, it is essential that all of the users who submit jobs to a
given InfoPrint Manager printer use the same driver. If they do not, the mappings
you set up will not work correctly for them.

The first challenge for you in setting up the mappings is determining what bin
number the PCL driver places in the data stream. For various InfoPrint printers,
the drivers actually generate the same bin numbers. If you are using the PCL5e
driver for an InfoPrint Network Printer 12, Network Printer 17, Network Printer
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24, InfoPrint 20, InfoPrint 21, InfoPrint 32, or InfoPrint 40, the numbers listed in
Table 26 are placed in the data stream.

Table 26. InfoPrint PCL5e bin numbers

Tray (what you select in Device Settings) PCL bin number (what the driver puts in
data stream)

Automatically Select 0

Tray 1 1

Manual feed paper 2

Manual feed envelope 3

Auxiliary tray 4

Tray 2 5

Envelope feeder or Envelope tray 6

Tray 3 7

Tray 4 8

Tray 5 or 2000 sheet input tray 9

If you are using a different driver, the documentation that came with your printer
might provide these numbers; look for a section on the PCL driver. Alternatively, if
you are able to capture the PCL data that is sent to a specific bin in your printer,
you can look for the bin number in the data stream. In some cases, however, it
might be just as easy to use trial and error to determine the correct mappings.
Again, keep in mind that PCL bin numbers can range from 0 to 59.

The second challenge is in determining the AFP bin numbers that correspond to
your printer. AFP bin numbers range from 1 to 255, and are not standard from
printer to printer. Some printers have hard-coded bin numbers: each bin on the
printer actually has a number written on it. In other cases, the AFP bin numbers
are more difficult to discover. In fact, the numbering scheme for some printers
changes completely when you add one of the optional paper bins, and still other
printers allow you to change the bin numbers yourself. As a result, it is difficult to
predict exactly what the AFP bin numbers for your printers are. However, there are
some guidelines that you can use.
v Most AFP paper bins use numbers 1 through 10, with 1 being the biggest,

topmost, or bottommost bin.
v Envelope feeders/bins start at number 65 and can go up to 69.
v The manual feed tray is usually number 100.

If you are printing to InfoPrint printers, the best place to find the default
numbering schemes for each printer is the IPDS and SCS Technical Reference and the
IPDS Handbook for printers that use the AFCCU, both of which are available from the
InfoPrint Solutions Company web site at http://www.infoprint.com. (Under Get
support, click Product publications => IPDS Technical Reference and find the
IPDS and SCS Technical Reference and IPDS Handbook for printers that use the AFCCU
in the list.

If you find the AFP bin numbers for your printer in this documentation, be aware
that the number is written in hexadecimal notation. You must convert the number
to decimal before you put it in the mapping file. In addition, the numbers that are
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listed are the machine numbers, not the numbers the software requires. After you
convert the number to decimal, add 1 to it to get the number that you should put
in the mapping file.

Given this information, the best way to determine the correct AFP bin numbers is
to start with these guidelines and use the trial and error method until you have the
mappings set correctly.

For example, if you have a printer with three paper bins and a manual feed bin,
you could do this.
1. On your InfoPrint Manager Windows client system, install the PCL driver that

you plan to use.
2. Create a printer that uses the driver you just installed and has a PSF printer

as its target destination.
3. From the Windows Client, click the Start button and select Settings → Printers

to open the Printers window.
4. Right-click the printer you just created and select Properties from the pop-up

menu.
5. Click the Device Settings tab to show the printer options that are available for

this driver. For example, some drivers show a list of ″paper trays″ and allow
you to select a paper size for each one.

6. Make sure all of the paper trays you plan to use are activated and have the
correct size paper selected.

7. Click OK to close the dialog and make the settings take effect.
8. Follow the appropriate procedure below: “Editing configuration files” on page

210.
When you have to enter PCL and AFP bin numbers, start with the guidelines
above and create some logical mappings, such as the ones shown in table
Table 27 for an InfoPrint 20.

Table 27. Sample mapping table for an InfoPrint 20

Tray selection PCL bin number AFP bin number

Tray 1 1 1

Tray 2 5 2

Tray 3 7 3

Manual feed tray 2 100

Envelope tray 1 6 60

Envelope tray 2 4 61

Complete the procedure.
9. Load each paper bin (including the manual feed bin) with a different kind,

color, or specially marked paper.
10. Submit a test job to each bin and see which paper it is printed on. Keep track

of your results and use them to change the mappings to meet your
configuration.

11. Once you have the mappings worked out correctly, tell your operators this
information:
v What options to set in the device settings.
v What kind of paper is in each bin.
v How to print to each bin.
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PostScript printing
PostScript drivers use different methods to determine what paper bin to print a job
on. Some drivers allow you to select which paper tray you want the paper to come
from. When you submit a job, the driver sends a number to the printer to ask for
the corresponding tray. Other drivers allow you to select different paper options
(such as size, color, or weight). When you submit a print job, these options are sent
with the print job and are used to determine which paper bin to use (paper size is
the only option that you have to set for this function to work).

When you configure InfoPrint Manager correctly, it will work with either type of
driver. There are three steps involved in performing this configuration:
1. “Gathering paper tray information”
2. “Identifying paper trays to InfoPrint Manager” on page 209
3. “Testing tray mappings” on page 210

Gathering paper tray information
The first step in configuring InfoPrint Manager is to figure out :
v How many paper trays does your printer have?
v What is the AFP bin number for each tray?

Guidelines for figuring out the bin numbers are provided below.
v What kind of paper will you be loading into each tray?

At a minimum, you should know what size paper will go in each tray. If you
need to, you can also specify a color or weight of the paper.

Use this chart to record your data.

Table 28. Paper tray chart

AFP bin number (in decimal
notation)

Paper tray on printer Paper loaded

100 Manual feed tray

There is trial and error work involved in figuring out the correct bin numbers. AFP
bin numbers range from 1 to 255, and are not standard from printer to printer.
Some printers have hard-coded bin numbers; each bin on the printer actually has a
number written on it. In other cases, the AFP bin numbers are more difficult to
discover. In fact, the numbering scheme for some printers changes completely
when you add one of the optional paper bins. Still other printers allow you to
change the bin numbers yourself. As a result, it is nearly impossible to predict
exactly what the AFP bin numbers for your printers are. However, there are some
guidelines that you can use.
v Most AFP paper bins use numbers 1 through 10, with 1 being the biggest,

topmost, or bottommost bin.
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v Envelope feeders/bins start at number 65 and can go up to 69.
v The manual feed tray is usually number 100.

If you are printing to InfoPrint printers, the best place to find the default
numbering schemes for each printer is in the IPDS and SCS Technical Reference and
the IPDS Handbook for printers that use the AFCCU, both of which are available from
the InfoPrint Solutions Company web site at http://www.infoprint.com. (Under
Get support, click Product publications => IPDS Technical Reference and find
the IPDS and SCS Technical Reference and IPDS Handbook for printers that use the
AFCCU in the list.

Important: If you find the AFP bin numbers for your printer in this
documentation, be aware that the number is written in hexadecimal notation. You
must convert the number to decimal before you put it in the mapping file. In
addition, the numbers that are listed are the machine numbers, not the numbers
the software requires (they’re the IPDS bin numbers, not the AFP bin numbers).
After you convert the number to decimal, add 1 to it to get the number that you
should put in the mapping file.

Identifying paper trays to InfoPrint Manager
Once you have the chart filled in with your first attempt at mappings, you can
move to the second step: identifying all of the bins to InfoPrint Manager.

By default, InfoPrint Manager assumes that all PostScript printers have only one
paper tray. When you identify the trays, you let InfoPrint Manager know how
many there really are. Then, when you submit a job, you can select any one of
them.

You identify the paper bins to InfoPrint Manager either in the configuration file or
in the transform you create. In this step, you will determine the syntax that you
will be able to use in either place. The general syntax of the identification
statement is:

inputX=(size,type=xxx,weight=xxx,color=xxx),inputX=(size,
type=xxx,weight=xxx,color=xxx)

Where these conditions apply:
v Each inputX corresponds to a different paper tray. You should have as many

inputX entries as you have paper trays. Separate them with commas, no spaces.
v The X in each inputX is replaced with the AFP bin number from Table 28 on

page 208 for each tray.
v Size is the only required paper attribute. Replace the word size with the size of

the paper that will be in the tray, such as letter, legal, 8.5ix11i, or A4.
v Other paper attributes can be specified or left out entirely.

All of these are valid identification statements:

input1=(letter),input2=(legal),input100=(letter)

input1=(8.5ix11i,color=blue),input2=(8.5ix11i,color=yellow),
input3=(11ix17i),input100=(8.5ix11i)

input1=(A4,color=white),input2=(A4,color=blue),input3=(A4,color=yellow),
input65=(C5),input100=(A4,type=letterhead)
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Write out your identification statement before moving on to the next step.

Testing tray mappings

Once you have your identification statement created, you can test your mappings
to make sure they are correct. This procedure explains one way to verify the
mappings.
1. On your InfoPrint Manager Windows client system, install the PostScript

driver that corresponds to your printer.
2. Create a printer that uses the driver you just installed and has a PSF printer

as its target destination.
3. Click the Windows Start button and select Settings → Printers to open the

Printers window.
4. Right-click the printer you just created and select Properties from the pop-up

menu.
5. Click the Device Settings tab to show the trays and options that are available.
6. If your driver lists the paper trays that are available, activate them and select

paper sizes for each one. Set the options to match your identification
statement.

7. Click OK to close the dialog and make the settings take effect.
8. See “Editing configuration files” so you can use the same mappings for all of

your printers.
9. Follow the appropriate procedure.

When you have to change the configuration file or enter the command that
your transform will use, replace the inputX=... statement with your
identification statement from “Identifying paper trays to InfoPrint Manager”
on page 209, and complete the procedure.

10. Load each paper bin (including the manual feed bin) with a different kind,
color, or specially marked paper.

11. Test your settings by submitting print jobs to each bin of the Windows
gateway printer and making sure that it prints on the correct paper. If a job
does not print on the correct paper, adjust your AFP bin numbers and input
numbers as necessary.

12. Once you have the mappings worked out correctly, tell your operators this
information:
v What options to set in the device settings.
v What kind of paper is in each bin.
v How to print to each bin.

Editing configuration files

There are five configuration files that come with the InfoPrint Manager PCL to
AFP and PostScript to AFP transforms. For the PCL transform, they are: pcl2afp.cfg
and pcl2afpd.cfg. For the PostScript transform they are:ps2afp.cfg, ps2afpd.cfg
(used with InfoPrint 3000 and InfoPrint 4000 printers), and 3160d.cfg (used with all
other IPDS printers). You will only need to edit one of these files based on the data
stream that your driver produces, the printer you send your jobs to, and on these
considerations.
v Edit pcl2afpd.cfg, ps2afpd.cfg, or 3160d.cfg if you want everyone to use the

same mappings. This method is recommended.
v Edit pcl2afp.cfg or ps2afp.cfg if different people have to use different mappings.
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Follow these steps to edit the appropriate file.
1. On the system that your InfoPrint Manager server is installed on, locate the file.

It should be in the install_path\pcl2afp or the install_path\ps2afp directory.
2. Open the file in a text editor, such as Notepad.

At the bottom of the file, you will see blocks of instructions and sample
commands.

3. Modify the file according to the instructions in the file.
Choose one of the options and uncomment that line, then enter your mapping
numbers. If you are using the ps2afp transform, replace the inputX=... portion
of the device_controls line with your identification statement from “Identifying
paper trays to InfoPrint Manager” on page 209.

4. Save the file.

Note: It is recommended that you save a copy of your changes in a directory
outside of the installation path so that you have a copy in case you ever have
to re-install or apply service to InfoPrint Manager.

5. Close the file.
6. Restart the computer to have the new settings take effect.
7. Tell your users what kind of paper is in each bin and how to print to each of

them.

Creating a transform with bin mappings

You can use the InfoPrint Manager transforms to process print jobs with different
options, including which paper bins to use. First, you create a transform using the
InfoPrint Manager Administration GUI, specifying an input data stream and an
output data stream. Then, you associate it with one or more printers. When you
send a print job to that printer, your transform checks to see if the file is the data
stream that needs to be transformed. If it does, the transform converts the file as
you specified; if it is not, the transform passes the file to the logical destination. As
a result, if you don’t want to use the same bin mappings for all of your printers,
you can create several different transforms, all with different mappings. Then,
associate each transform with whichever printer or printers you want.

Note: If you will be sending both PCL and PostScript jobs to the same printer, you
can create two transform objects (one that accepts PCL and one that accepts
PostScript) and associate them both with that printer.

Follow these steps to create a transform that maps PCL or PostScript bins to AFP
bins.
1. In the InfoPrint Manager Administration GUI, click the Server menu and

select Transform → Create.
2. In the Create transform dialog, fill in the fields:
v Name: Type a name for the transform.
v Server: Choose the correct InfoPrint Manager server.
v Format of output file: Select MODCA-P.
v Description: Type a description that will help you remember which printer

uses this transform.
v Transform options: The command line that will execute when the transform

runs.
If this transform accepts PCL, type:
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pcl2afp -o "%o" "%i" –device
'plex,inputX=(pcl_bin=Z),inputX=(pcl_bin=Z)'

Replace the Xs with the number of the AFP bin (on the printer) and Zs with
the number of the PCL bin. You can specify up to 20 mappings.
If this transform accepts PostScript, type:
ps2afp -o "%o" "%i" –device
'plex,inputX=(size,type=xxx,color=xxx,weight=nnn),
inputX=(size,type=xxx,color=xxx,weight=nnn)'

Replace the inputX=... portion of the command with your identification
statement from “Identifying paper trays to InfoPrint Manager” on page 209.
Replace size with a paper size such as letter, legal, A4, or the dimensions of
the paper in inches (8.5ix11i), millimeters (216mx279m), or points
(612px792p) and the Xs with the number of the AFP bin (on the printer).
Size is the only required value; the others you can either fill in or delete.

v Select Transform and print.
v Document formats allowed: The data stream that your transform accepts.

Select PCL or PostScript and add it to the allowed values.
v Click OK.

3. Select the printer that you want to associate this transform with and open its
properties notebook.

4. Click the Configuration tab.
5. Find the Transforms to use field.
6. Select the transform you just created in the Possible values box and add it to

the Values box.
7. Click Apply.
8. Click the Document tab.
9. Find the Formats allowed section.and look in the Values box. Make sure that

modca-p and either pcl or PostScript are listed.
10. Click OK.
11. Tell your users what kind of paper is in each bin and how to print to each of

them.
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Chapter 19. Submitting PSF printer input to a PCL or PPDS
printer

In addition to AFP printing, InfoPrint Manager allows you to submit PSF printer
input data to PCL and PPDS printers as well. There are two methods that you can
use to do this: using a PSF command DSS or PSF other-driver DSS. If you choose
to use the PSF command DSS, you need to be aware of the following information.
See the InfoPrint Manager for AIX: Getting Started guide for additional information.

When you use the Create Printer wizard in the InfoPrint Manager Administration
GUI to create a printer object that will send jobs to a PCL or PPDS printer, you
must specify the path for the command in the Printer command field. For
example, by default the lpr command is located at c:\winnt40\system32\lpr.exe.
Because InfoPrint Manager does not search the PATH environment variable for the
command, you must either add that directory to the PATH for that system or
specify the entire path of the command, as in this example:
c:\winnt40\system32\lpr -P printername -S servername

If you need to specify a file name in the command in a location other than at the
end of the command, you must include the text-string -IPMF- in the command
string. The temporary file name used to store either the PCL or PPDS data
generated by InfoPrint Manager is substituted into the command wherever the
-IPMF- text-string is located.

Note: The dashes (-) on either side of the -IPMF- text-string are part of the syntax
and cannot be omitted.

You can only specify one -IPMF- text-string in a print command, as in the example
below:
e:\usrapp\copyit -IPMF- /b e:\tmp

where copyit represents a user-written application for moving either the PCL or
PPDS file that InfoPrint Manager generated to the specified directory (in this case,
\tmp on the e drive), and giving it a unique name.

Setting up PCL tray mappings

Follow these steps to map the input trays requested in the AFP data stream to the
input trays on your PCL printer:
1. Determine the AFP bin number and PCL bin number for each input tray.

Table 29 on page 214 shows the default bin numbers associated with some
standard names for input trays.

Note: You can use any tray names you wish, but these names are defined by
the PCL data stream and are the most common names. For more information
about the limitations of trays and paper with a PSF other-driver or PSF
command DSS see the psf-tray-characteristics attribute in the InfoPrint Manager:
Reference.
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Table 29. Default bin mappings

Input tray name AFP bin number PCL bin number

alternate 3 5

bottom 2 4

envelope 65 6

manual 100 2

top 1 1

If these mappings are not appropriate for your printer, reverse the process
described in “Determining bin mappings” on page 205. In this case, the AFP
bin number is the bin number in the data stream and the PCL tray number is
the bin number used by the printer. Note that AFP bin numbers must be
unique, but different AFP bin numbers can map to the same PCL tray number.

2. Open the InfoPrint Manager Administration GUI.
3. Click the printer that you want to set up trays on.
4. From the Media/Bins/Trays tab of the Actual Destination Properties notebook,

in the Media ready table, select Add to define a new tray or Modify to change
an existing one. You can define up to 15 trays.

5. Complete these fields:

Input bin number
This field specifies the AFP bin number.

Media ready
This field shows the medium loaded in the input tray. The drop-down
list lets you select from all media supported by the printer.

Input tray name
This field shows the name associated with the input tray. Standard
names for PCL input trays are:

alternate

envelope

lower

manual

upper

Formerly, these were the only names allowed. You can now use any
name you like, subject to these restrictions:
v Manual trays must have the string manual somewhere in the name,

in any combination of upper and lowercase, for example,
transparentMANUALa4. You can define multiple manual trays.

v Envelope trays must have the string envelope somewhere in the
name, in any combination of upper and lowercase, for example,
Number10Envelope. You can define multiple envelope trays.

Tray number
This field specifies the PCL bin number.

Duplex
This field specifies whether two-sided printing is possible from this
input tray.

6. Click OK.
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To make your changes take effect, you must now stop and restart PSF, the printer,
or both. Follow the steps corresponding to your job submission method.
v If you use DPF to submit jobs, perform the following steps:

1. On your host system, stop PSF.
2. In the InfoPrint Manager GUI, click the printer to select it, then select Printer

→ Stop.

Note: If you don’t see Stop on the Printer menu, use Add/Remove Menu
Items to add it.

3. Open the Management Console and click the DPF Host Receivers item in the
left pane.

4. Click the DPF Host Receiver that feeds this printer to select it.
5. Click Actions→ Obtain Printer Characteristics.
6. Go back to the InfoPrint Manager GUI and start the printer again.
7. Restart the host PSF.

v If you use any other method to submit jobs:
1. In the InfoPrint Manager GUI, click the printer to select it, then select Printer

→ Stop.

Note: If you don’t see Stop on the Printer menu, use Add/Remove Menu
Items to add it.

2. In the Stop command dialog, select Shut down and click OK.
3. Select Printer → Enable to restart the printer.
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Chapter 20. Enabling capture for CMRs

If the jobs that run through your system use the same CMRs, you might want to
enable your actual destination to capture inline CMRs.

These inline CMRs must have an object identified (OID) so can capture them.

From the Administration GUI:
1. Click on the actual destination and select Printer → Properties.
2. From the actual destination’s Printer Properties notebook, click the Tuning tab.
3. Find the Capture inline CMR resources radio button. If you can’t see the

Capture inline CMR resources radio button, click Show more.
4. Scroll to the bottom of the screen and click the Yes radio button for the Capture

inline CMR resources setting.
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Chapter 21. Working with fonts

This chapter describes the fonts required for printing different data formats. It also
describes what you must do so that InfoPrint can use them.

Fonts for printing transformed PostScript and PDF data
The InfoPrint PostScript transform program uses Type 1 outline fonts when
transforming PostScript and PDF files. InfoPrint includes the IBM Type 1 outline
fonts and these fonts are installed in subdirectories of the /usr/lpp/psf/ps/fonts
directory during installation. If you have other Type 1 outline fonts, you can also
use them with the transform program.

Note: When InfoPrint runs the PostScript transform program during job
submission, it can search other directories for fonts.

Font-mapping files
A font-mapping file identifies the file names of the Type 1 outline fonts on the AIX
system. The InfoPrint PostScript transform program requires at least one
font-mapping file. InfoPrint installs the default font-mapping file, psfonts.map in
the /usr/lpp/psf/ps directory during installation. If you have other Type 1 outline
fonts installed on your system, you can create additional font-mapping files to
define their names.

PostScript font-mapping file considerations
When you create your own font-mapping files, consider that:
v You can create more than one font-mapping file.
v At least one font-mapping file must contain the Courier font. The PostScript

transform program substitutes Courier for any missing fonts.
v Fonts cannot span network file systems.

Creating a PostScript font-mapping file

Use the InfoPrint mkfntmap command to create a font-mapping file for use with
the InfoPrint PostScript transform program. You specify one or more input files
containing Type 1 outline fonts and a name for the font-mapping file.

For example, to use the input file FontFile and create a font-mapping file named
font.map, enter:
mkfntmap FontFile > font.map

Using font-mapping files with the ps2afp or the pdf2afp
command
By default, InfoPrint uses the psfonts.map font-mapping file when you enter the
ps2afp or the pdf2afp command; you do not have to specify the name of the
default font-mapping file with the command.

To use font-mapping files that you have created when you enter the ps2afp or the
pdf2afp command, you must do one of these:
v Enter the path and name of the font-mapping file as the value of the

ps_font_map_files keyword in the transform daemon configuration file. For
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performance reasons, this is the recommended method. You can specify more
than one font-mapping file, if necessary. Separate the font-mapping files with
colons.
For example, to specify the font-mapping files font1.map and font2.map, enter
this:
ps_font_map_files=/path/font1.map:/path/font2.map

v Enter the path and name of the font-mapping file as the value of the
ps_font_map_files transform command configuration file. Use the same syntax
as described for entering the value in the transform daemon configuration file.
Using this method can result in significant performance degradation.

v Specify the font-mapping file, including its path name, from the command line
using the -F flag of the ps2afp or the pdf2afp command. You can specify
multiple files using multiple -F flags; InfoPrint concatenates them from
left-to-right (first entered to last entered) in that order.
For example:
ps2afp -F/path/font.map

This method can also result in degraded performance.

Note: If you use the ps2afp -F or the pdf2afp -F command flag or the
ps_font_map_files keyword in the transform command configuration file to
specify a font-mapping file, and the value is different than that specified in the
transform daemon configuration file, the transform daemon restarts the PostScript
interpreter so that the new value for the font-mapping file takes effect. However,
restarting the PostScript interpreter decreases performance.

Specifying font substitution through initialization files

Sometimes jobs request fonts that are neither included inline with the job nor
resident on the printer. If InfoPrint Manager cannot find the fonts that the job
requires, the job might fail. To avoid job failure because of missing fonts, you can
issue a PostScript command that substitutes a Courier font to make sure that the
job prints.

To do this task, use this procedure:
1. From a command line, access the UserInit file that is located in either the

/var/psf/ps2afp2 directory on an InfoPrint Manager AIX server or the
\install_path\var\psf\ps2afp2 folder on an InfoPrint Manager Windows server.
If you are using a configuration file and daemon other than the default
3160d.cfg postscript daemon configuration file, the you will need to determine
which daemon is being used and change the initialization file for that daemon.

2. Using your editor of choice, edit the file.
3. Add this to the UserInit file to make sure that missing fonts are replaced by

Courier fonts to allow the job to print :
%!
turnFontSubstitutionOn

Note: If you want to make sure that fonts not inline with the job or resident on
your printer do not print, type this change in the UserInit file:
%!
turnFontSubstitutionOff

4. Save and close the file.
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Note: For your convenience, InfoPrint has provided a sample UserInit file,
UserInit.turnFontSubstitutionOn.sample, in either the /var/psf/ps2afp2 directory
on an InfoPrint Manager AIX server or the \install_path\var\psf\ps2afp2 folder on
an InfoPrint Manager Windows server.

You can use the desktop Text Editor to rename the
UserInit.turnFontSubstitutionOn.sample file and use this UserInit file at your
installation.

Adding non-IBM fonts to AIX for a PostScript job
If your InfoPrint system receives a PostScript job from a personal computer system,
the fonts required for that job might not reside on the AIX system. An InfoPrint
Submit operator might find that either:
v Fonts are not available on AIX
v Fonts are not in the .pfa or .pfb format required for PostScript fonts

If either of these conditions occur, the AIX administrator must make these fonts
available before printing the PostScript job.

Adding Type 1 fonts to a personal font library

You can add .pfa or .pfb files that print regularly at your installation to your
InfoPrint Manager AIX server by using the /var/psf/fonts directory. Use this
procedure, ensuring that you are the root user:
1. Open a dtterm session on your InfoPrint Manager AIX server.
2. From the AIX command line, access the correct directory by typing:

cd /var/psf/psfonts

Note: To further qualify the location of your personal fonts, you might want to
create a subdirectory or directories, such as pkg_a or pkg_b, using the mkdir
command.

3. From either a CD-ROM or your location of choice, download the files to your
InfoPrint Manager AIX server, ensuring that you copy the files in binary
format.

4. From your InfoPrint Manager AIX server in either the /var/psf/fonts directory
or the subdirectory you created, make sure that the downloaded files have the
correct permissions by entering these commands:
a. chown root.printq *

to make sure that the /root/printq ID owns all downloaded files.
b. chmod 444 *

to make sure that all files have read access.
c. chmod 664 user.map

to make sure that you can write to the user.map file.
5. From the AIX command line in either the /var/psf/fonts directory or the

subdirectory you created, create a font mapping file that lists PostScript Type 1
font names and their locations on the InfoPrint Manager AIX server by typing:
mkfntmap pkg_a/*.pfb pkg_b/*.pfb >> user.map

InfoPrint Manager appends the *.pfb files that you stored in the pkg_a/*.pfb
and pkg_b/*.pfb subdirectories to the user.map file. This user.map file is
referenced in the ps_font_map_files resource path in the /usr/lpp/psf/ps2afp/
ps2afpd.cfgfile:
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ps_font_map_files = /usr/lpp/psf/psfonts.map :\
/var/psf/psfonts/user.map

The >> option adds the names to the user.map file without overwriting existing
information.

Note: If you did not create a subdirectory, you can map the files to the
user.map file by entering this command:
mkfntmap *.pfb >> user.map

Create a backup directory on your InfoPrint Manager AIX server where you can
store system changes. For example, if you create a /customSYS directory at / on
your server, you can copy both the new font and the resulting user.map file to that
directory:
cp /var/psf/psfonts/CodeZ /customSYS/
cp /var/psf/psfonts/user.map /customSYS

Using OpenType Fonts
This section describes what you need to use OpenType Fonts for printing with
InfoPrint Manager.

These fonts offer many benefits over printing with standard font resources. They
provide users with these benefits:
v A wide range of non-Latin typefaces from which to choose
v A multilingual presentation environment through the support of Unicode
v A migration path towards a single font technology across all presentation

environments

OpenType Fonts have these three characteristics in the font file:
1. A Microsoft® Unicode version of Version 3 Release 1.
2. Microsoft Unicode Full Font Names
3. A Unicode character map (CMAP)

A CMAP defines the mapping of code points to glyph indices, which are used
to index the actual character shape information.

If your fonts do not contain all these elements, they cannot be used with InfoPrint
Manager. If the InfoPrint AFP Resource Installer (Program Number 5639-EE2) does
not install a font, that font does not meet this criteria.

Note: You can use the standard AFP code pages you use for other font resources
with OpenType fonts. For more information about doing this task, see Using
OpenType Fonts in an AFP System.

Using the Resource Installer to install OpenType fonts

If you have OpenType fonts, you must install them using the InfoPrint AFP
Resource Installer (Program Number 5639-EE2). If you create a new library or
subdirectory for these fonts, you must also update the global search path on your
InfoPrint Manager server. If you place them in an existing subdirectory, InfoPrint
Manager should already have this location in its global search path.

Each time you either add new OpenType fonts or modify existing ones, you must
reinstall them with the Resource Installer to make sure that InfoPrint Manager can
access them correctly. The search order of directories for a data object font
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resources is the same as the search order for AFP font resources. Make sure that
the path where you install the OpenType Fonts is in the font search order that
InfoPrint Manager uses. For more information about how the font search order is
defined see “The search order for AFP resources” on page 108.

An administrator installs the OpenType fonts in a particular directory on each
system. On an AIX server, the default path for installing these fonts is the
/usr/lpp/ipfonts directory. On a Windows server, the default path is set up by the
administrator who configured the system.

Once the OpenType fonts have been installed through the IBM Infoprint Fonts for
Multiplatforms product, you must run the Resource Installer to create the Resource
Access Table (IBM_DataObjectFont.rat) and store it in the same directory where
the fonts reside. The Resource Installer does not prompt you to do this task
because the Resource Installer is not aware of changes to the directory. As a result,
the system administrator who installed the new fonts must do this task whenever
fonts are either added or removed from the directory.

The Resource Access Table contains an entry for each installed font so that
InfoPrint Manager can access it.

For more information about how to use the Resource Installer of Infoprint Fonts,
either access the online help system of the Resource Installer or see Using OpenType
Fonts in an AFP System.

Using font capture with OpenType fonts

Font capture allows a printer to capture a downloaded font and treat it as if it
were a printer-resident font. Treating a downloaded font as a printer-resident font
improves performance for future jobs that use the same fonts. Printers retain
captured fonts across job boundaries and power cycles. Captured fonts can be
deleted from the printer when additional space is required. Because OpenType
fonts are large, you might want to make sure that your InfoPrint printer is set to
support font capture.

If you want to capture OpenType fonts that reside in a library on a particular
drive, click the Font Installer’s Capture check box. (far right column of the Top
pane) for each font that you want to capture. For more information, consult the
Resource Installer online help system.

Note: Do not capture sensitive fonts, such as signatures, because an unauthorized
person could access the captured font, even from another system.

Enabling font capture for inline fonts

If the jobs that you run through your system use the same fonts, you might want
to enable your actual destination to capture inline font resources. These inline fonts
must have an object identifier (OID) so InfoPrint can capture them.

Note: For many systems, this procedure is not recommended because captured
inline fonts can be deleted when your printer needs more storage. If InfoPrint
Manager cannot access these fonts, the jobs can either fail or print incorrectly.

From the InfoPrint Manager Administration GUI:
1. Click the actual destination and select Printer → Properties.
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2. From the actual destination’s Printer Properties notebook, click Tuning.
3. Find the Capture inline OTF resources radio button. If you can’t see it, click

Show more.
4. Scroll to the bottom of the screen and select the Yes radio button for the

Capture inline OTF resources setting.

Using multiple fonts with limited printer memory

When you are using the OpenType fonts and you receive the Out of memory error
message, you can decrease the Maximum fonts to keep configuration item for
InfoPrint Manager or increase the size of the character cache from the Printer
console.

To decrease the number of Maximum fonts to keep, complete these steps:
1. Right-click the actual destination in the InfoPrint Manager GUI and click

Properties.
2. Click Tuning.
3. Find and change the Maximum fonts to keep value to a smaller number, such

as 5.

To increase the character cache size from the Printer’s console, complete these
steps:
1. Click Printer Definition.
2. Click Printer.
3. Click Resource Utilization.
4. Increase Font Usage to the highest setting.

Using Unicode extended code pages
Unicode Extended Code Pages (ECP) are code pages with additional information
used by OpenType and TrueType fonts. This is a introduction for using extended
code pages:
v If OpenType and TrueType fonts are used without ECP, Unicode scalars must be

defined in the hardcoded GUM (GCGID-to-Unicode-Mapping, where GCGID
stands for Graphic Character Global IDentifier) table resident in the printer or
code points will be undefined. While the use of predetermined mappings might
meet many needs, if customization of GCGID to Unicode mappings is required,
an extended code page must be used.

v The extended code pages can be used on printers that do not support the
extensions. However, the extensions will be stripped out of the code page as it is
downloaded to the printer appearing as if an unextended code page was used.

v The extended code pages are files on disk just like unextended code pages. The
search order defined in the InfoPrint Manager: Reference in the description of the
resource-context-font attribute still applies. However, a new file extension of
.ECP is supported for all code pages. Inside the same directory, a code page with
the .ECP file extension will be selected before any other code page with a
matching name but a different file extension.

v File extensions are secondary search criteria. The search order of directories is
the primary search criterion when searching for any code page resource,
including Unicode extended code pages. The first possible match on the resource
name is used. For example, there might be two code pages called T1USV500.ECP
and T1USV500. The T1USV500.ECP code page is located in a directory only
specified by resource-context. The T1USV500 code page is located in a directory
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specified in resource-context-font. In this case, the T1USV500 code page is used.
Conversely, if T1USV500.ECP and T1USV500 are located in the same directory,
the T1USV500.ECP code page is used.

v Code pages created or modified by the AFP Resource Installer will always have
an .ECP file extension. Use installation software to manage the installation of
this new kind of resource.

v To force a code page to be downloaded instead of using a printer resident code
page and to prevent run-time substitution of code pages, follow this procedure
“Using the ’no resident’ version of the sample grid files” on page 246.

Updating the global search path on an InfoPrint AIX server

If you did not use default directories when installing OpenType fonts on your
system, you must update the global search path on an InfoPrint Manager AIX
server. You update the global search path by updating the PSFPATH environment
variable to point to the directory or directories where you have installed the
OpenType fonts.

Note: If you do not update the global search path, you must update each actual
destination that you use to print OpenType fonts.

To set the PSFPATH environment variable, use the procedure ″Editing the
/etc/environment file″ from InfoPrint Manager for AIX: Procedures to add this line:

PSFPATH=$PSFPATH:path1:path2

where path is the path name to the directory containing the AFP resources. You can
specify multiple path names, just separate these with a colon (:).

Specify these values in the /etc/environment file so that the system retains them
after your InfoPrint Manager AIX server is rebooted.

Using OpenType fonts with line data
When printing line data with OpenType fonts through InfoPrint Manager, you
need to specify the appropriate parameters on the line2afp command. To define
the location of the OpenType fonts to the line2afp command, you can either use
the InfoPrint Manager global search path (using “Updating the global search path
on an InfoPrint AIX server”) or use the appropriate values on the line2afp
command. For more information about these values, see either Using OpenType
Fonts in an AFP System or ACIF: User’s Guide.

For more information about either creating or modifying page definitions for line
data jobs to print with OpenType fonts, see Page Printer Formatting Aid: User’s
Guide.

Limitations when printing line data with OpenType fonts
Before you can print this data, you must transform it to Unicode Transformational
Format (UTF-16), with big-endian byte order. Big-endian byte order means that in
a two-byte UTF-16 code point the high-order byte is specified first, followed by the
low-order bytes. You can transform it through the uconv utility, or any other
application that transforms ASCII to Unicode. For more information about the
uconv utility see the AIX operating system documentation.

Chapter 21. Working with fonts 225



Line data using OpenType fonts supports using the Byte Order
Mark (BOM) and little endian data
InfoPrint Manager can process the Unicode Byte Order Mark (BOM) when printing
line data with OpenType fonts. (For UTF8 or UTF16-BE data, the BOM is skipped
and not printed. For UTF16-LE, the data is reversed to BE before it is printed, and
the BOM is not printed.) In addition, InfoPrint Manager can now recognize
multi-byte carriage return and line feed characters when parsing Unicode line data.

This support lets you process UTF8 and UTF16 line data in either little-endian or
big-endian order using a traditional line data or record-format page definition. As
many Windows and AIX editors default to UTF8 or UTF16LE encodings and
automatically insert a BOM at the beginning of the file, you can now print
documents created with these editors using Unicode-enabled Open Type Fonts.

Mixed mode data is line data mixed with MODCA structured fields. You can use
mixed mode data with UTF8, UTF16LE, and UTF16BE with a BOM as long as the
BOM is the first bytes (following any cc or trc bytes) of the first line of data.

To mix UTF8 or UTF16BE data with other data encodings, you can do that if there
is no BOM. In this case, the font selected for the data tells InfoPrint Manager the
data encoding. You can’t do this with UTF16LE data because it always requires a
BOM.

This support includes a -o newlineencoding flag for the -o flag, a
stream,(newline=characters,encoding) value for the fileformat parameter on the
line2afp transform, and a new-line-option-data-encoding document/default
document attribute. For more information about this support, see InfoPrint
Manager: Reference.

Fonts for printing ditroff data
This section describes the files that InfoPrint provides for printing ditroff files on
AFP printer devices and the directories in which they reside.

AFP code pages for AFP fonts
InfoPrint supplies the following three code pages for use with the AFP fonts for
ditroff. These code pages map the existing characters in troff files to their
corresponding AFP characters in the AFP character sets.

T1001038
Adobe Symbols (ASCII)

T1001108
ditroff Base Compatibility

T1001109
ditroff Specials Compatibility

When you install InfoPrint, both the 240-pel and 300-pel code page files are
automatically installed in the /usr/lpp/psf/fontlib directory.

Note: If you transform a file for printing that requires fonts on a font cartridge
and the printer device does not have the font cartridge installed that supports the
fonts specified in the /usr/lib/font/devhplj directory, your file might not print
correctly. See your printer documentation to install bit-mapped fonts into the
/usr/lib/font/devhplj directory.
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AFP characters mapped to ditroff characters
InfoPrint supplies AFP character sets in raster format. The character sets, which
map to corresponding ditroff fonts, are listed in the devafp.fontmap file located in
the /usr/lib/font/devafp directory. The character sets themselves are installed in the
/usr/lpp/psf/fontlib directory.

InfoPrint supplies AFP character sets for these troff type families: B, BI, C, CB, CI,
CBI, H, HB, HI, HBI, I, R, SG, and SS.

The following character list provides a mapping from the ditroff names of
characters to the IBM graphics character identifier. The “IBM Graphic Character
Identifier” column can be used to view the printed character as printed in a code
page table. The “ditroff Name of Character” column can be used to print any of
these characters by typing it into a text file as a special character that is processed
by troff.

Mapping for code pages T1001038, T1001108, and T1001109
Table 30. Mapping for code pages T1001038, T1001108, and T1001109

IBM Graphic Character
Identifier ditroff Name of Character Character Description

GA010000 *a alpha

GA020000 *A capital Alpha

GB010000 *b beta

GB020000 *B capital Beta

GD010000 *d delta

GD020000 *D capital Delta

GE010000 *e epsilon

GE020000 *E capital Epsilon

GE310000 *y eta

GE320000 *Y capital Eta

GF010000 *f phi

GF020000 *F capital Phi

GG010000 *g gamma

GG020000 *G capital Gamma

GH010000 *x chi

GH020000 *X capital Chi

GI010000 *i iota

GI020000 *I capital Iota

GK010000 *k kappa

GK020000 *K capital Kappa

GL010000 *l lambda

GL020000 *L capital Lambda

GM010000 *m mu

GM020000 *M capital Mu

GN010000 *n nu

GN020000 *N capital Nu
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Table 30. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character
Identifier ditroff Name of Character Character Description

GO010000 *o omicron

GO020000 *O capital Omicron

GO310000 *w omega

GO320000 *W capital Omega

GP010000 *p pi

GP020000 *P capital Pi

GP610000 *q psi

GP620000 *Q capital Psi

GR010000 *r rho

GR020000 *R capital Rho

GS010000 *s sigma

GS020000 *S capital Sigma

GS610000 ts terminal sigma

GT010000 *t tau

GT020000 *T capital Tau

GT610002 *h theta

GT620000 *H capital Theta

GU010000 *u upsilon

GU020000 *U capital Upsilon

GX010000 *c xi

GX020000 *C capital Xi

GZ010000 *z zeta

GZ020000 *Z capital Zeta

LA010000 a a

LA020000 A A

LB010000 b b

LB020000 B B

LC010000 c c

LC020000 C C

LD010000 d d

LD020000 D D

LE010000 e e

LE020000 E E

LF010000 f f

LF020000 F F

LF510000 ff ff ligature

LF530000 fi fi ligature

LF550000 fl fl ligature

LF570000 Fi ffi ligature
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Table 30. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character
Identifier ditroff Name of Character Character Description

LF590000 Fl ffl ligature

LG010000 g g

LG020000 G G

LH010000 h h

LH020000 H H

LI010000 i i

LI020000 I I

LJ010000 j j

LJ020000 J J

LK010000 k k

LK020000 K K

LL010000 l l

LL020000 L L

LM010000 m m

LM020000 M M

LN010000 n n

LN020000 N N

LO010000 o o

LO020000 O O

LP010000 p p

LP020000 P P

LQ010000 q q

LQ020000 Q Q

LR010000 r r

LR020000 R R

LS010000 s s

LS020000 S S

LT010000 t t

LT020000 T T

LU010000 u u

LU020000 U U

LV010000 v v

LV020000 V V

LW010000 w w

LW020000 W W

LX010000 x x

LX020000 X X

LY010000 y y

LY020000 Y Y

Chapter 21. Working with fonts 229



Table 30. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character
Identifier ditroff Name of Character Character Description

LZ010000 z z

LZ020000 Z Z

ND010000 1 one

ND020000 2 two

ND030000 3 three

ND040000 4 four

ND050000 5 five

ND060000 6 six

ND070000 7 seven

ND080000 8 eight

ND090000 9 nine

ND100000 0 zero

NF010000 12 1/2

NF040000 14 1/4

NF050000 34 3/4

NF180000 18 1/8

NF190000 38 3/8

NF200000 58 5/8

SA000000 \- minus

SA000000 mi minus

SA010000 + plus sign

SA010000 pl math plus

SA020000 +- plus or minus

SA030000 < less than sign

SA040000 = equal sign

SA040000 eq equal sign

SA050000 > greater than sign

SA060000 di divide sign

SA070000 mu multiplication sign

SA160000 ap approximates

SA240000 ib improper subset

SA270000 ip improper superset

SA380000 ca intersection

SA390000 cu union

SA400000 sb subset

SA410000 sp superset

SA450000 if infinity

SA470000 pt proportional to symbol

SA480000 == identity
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Table 30. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character
Identifier ditroff Name of Character Character Description

SA490000 pd partial differential symbol

SA510000 is integral symbol

SA520000 <= less than or equal

SA530000 >= greater than or equal

SA540000 != not equal

SA670000 mo element of

SA700000 ~= approximately equal

SA800000 sr square root

SA870000 es empty set

SC030000 $ dollar sign

SC040000 ct cent sign

SD110000 ’ acute accent

SD110000 aa acute accent

SD130000 ` grave accent

SD130000 ga grave accent

SD150000 ^ circumflex accent

SD190000 ~ tilde accent

SD410000 cd cedilla accent

SF640000 br box rule

SA860000 rn root extender

SV300600 ul underrule

SV300200 ru rule

SG050000 lc left ceiling

SG060000 lf left floor

SG070000 rc right ceiling

SG080000 rf right floor

SG090000 lt upper left curly bracket

SG100000 lk left middle curly bracket

SG110000 lb lower left curly bracket

SG120000 rt upper right curly bracket

SG130000 rk right middle curly bracket

SG140000 rb lower right curly bracket

SG170000 bv vertical bold

SL030000 gr gradient

SM010000 # number sign

SM020000 % percent sign

SM030000 & ampersand

SM040000 * asterisk

SM040002 ** math star
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Table 30. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character
Identifier ditroff Name of Character Character Description

SM050000 @ at

SM060000 [ left bracket

SM070000 \ backslash

SM070000 \e backslash

SM080000 ] right bracket

SM110000 { left brace

SM130000 or or bar

SM130000 | or bar

SM140000 } right brace

SM190000 de degree

SM240000 sc section

SM300000 <- left arrow

SM310000 -> right arrow

SM320000 ua up arrow

SM330000 da down arrow

SM340000 dg dagger

SM350000 dd double dagger

SM450000 sq open square

SM470000 bx solid square, histogram,
square bullet, filled box

SM520000 co copyright

SM530000 rg registered

SM540000 tm trade mark

SM570000 bu bullet

SM590000 rh right hand

SM630000 lh left hand

SM660000 no logical not

SM750000 ci circle

SM900000 em em dash

SP020000 ! exclamation point

SP040000 ″ double quote

SP050000 fm foot mark (minutes symbol)

SP060000 ( left paren

SP070000 ) right paren

SP080000 , comma

SP090000 \_ underscore

SP090000 _ underscore

SP100000 hy hyphen

SP110000 . period
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Table 30. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character
Identifier ditroff Name of Character Character Description

SP120000 / slash

SP120001 sl fraction

SP130000 : colon

SP140000 ; semicolon

SP150000 ? question mark

SP190000 \‘ open quote

SP200000 \’ close quote

SS000000 bs smiley face

SS680000 - dash, minus sign (en dash)

SS680000 en dash, minus sign (en dash)

Special symbols added for code page T1001038

These non-standard special symbols were added:

Table 31. Special symbols added for code page T1001038

IBM Graphic Character
Identifier ditroff Name of Character Character Description

SA370000 tf therefore, math and proof
symbols

SS020000 ht heart

SS030000 dm diamond

SS040000 cl club

SS050000 sd spade

Special symbols added for code page T1001108

These non-standard special symbols were added:

Table 32. Special symbols added for code page T1001108

IBM Graphic Character
Identifier ditroff Name of Character Character Description

SM790000 hs house character

ND011000 s1 One superscript

ND021000 s2 Two superscript

ND031000 s3 Three superscript

ND041000 s4 Four superscript

ND051000 s5 Five superscript

ND061000 s6 Six superscript

ND071000 s7 Seven superscript

ND081000 s8 Eight superscript

ND091000 s9 Nine superscript

ND101000 s0 Zero superscript
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Special symbol added for code page T1001109
This non-standard special symbol was added:

Table 33. Special symbol added for code page T1001109

IBM Graphic Character
Identifier ditroff Name of Character Character Description

SV300400 ol overrule

Adding other troff fonts
InfoPrint provides AFP fonts that map to existing troff fonts in the Courier,
Helvetica, and Times type families and AFP fonts for special characters. The
font-mapping table contained in the devafp.fontmap file maps the AFP fonts to the
corresponding troff fonts.

If you want to add troff fonts or special characters, contact your InfoPrint
Solutions Company representative.

ditroff font files
InfoPrint installs other files for ditroff in the /usr/lib/font/devafp directory,
including these:

devafp.fontmap
File that maps ditroff fonts to AFP fonts.

*.d2afp
Special versions of the ditroff font descriptions. The d2afp command uses
these files.

DESC (no extension)
troff device description, ASCII version.

DESC.out
troff device description, binary version.

*.out troff font descriptions, binary version.

Fonts for printing DBCS ASCII and EUC data
In ideographic languages, like Japanese, Chinese, and Korean, there are thousands
of characters. A single byte of information cannot represent all of these characters
because a single byte only accommodates 256 characters. Therefore, at least one
more byte of information is required.

For DBCS ASCII files, each ideographic character is exactly two bytes. For
Extended UNIX Code (EUC) files, each ideographic character can be two, three, or
four bytes, depending on the EUC implementation and language. Single-byte
ASCII characters can be mixed in with DBCS ASCII and EUC characters.

InfoPrint supports printing DBCS ASCII and EUC files in these formats:
v DBCS ASCII files in the Japanese and Traditional Chinese languages, which can

contain formatting controls for the IBM 5577 or 5587 printers.
v EUC files in the Japanese, Traditional Chinese, and Korean languages. EUC files

cannot contain any formatting control characters.
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Fonts required to print a double-byte transformed file
You can use the db2afp transform command to transform input files that use these
code pages:
v Japanese PC (code page IBM-932)
v Japanese EUC (code page IBM-eucJP)
v Traditional Chinese PC (code page IBM-938)
v Traditional Chinese EUC (code page IBM-eucTW)
v Korean EUC (code page IBM-ecuKR)

The transformed files contain font references to the double-byte character set. You
set the character set, code page, you want by setting the PSFDBLANG
environment variable; see Chapter 12, “Setting InfoPrint Manager and AIX
environment variables,” on page 135.

After you have used the db2afp command to transform DBCS ASCII and EUC files
into AFP data stream files, you must have access to DBCS fonts when you print
the transformed files. The DBCS fonts for Japanese, Traditional Chinese, and
Korean are not part of InfoPrint but are available for the MVS, VM, and AIX
operating systems as separately orderable licensed programs.

Installing DBCS fonts on AIX
To make the fonts available on your system and to InfoPrint, once you have the
licensed programs, you must do one of these:
v Use the AIX licensed programs to install the fonts onto your AIX system.
v Use the AIX licensed programs to install the fonts onto a AIX system other than

yours and use the Network File System (NFS) mount command to mount the
AIX file system onto your AIX system.

v Use the NFS mount command to mount the MVS or VM minidisk to your AIX
system.

Setting up font resources for DBCS ASCII and EUC printing

To print the transformed files that contain font references to the double-byte
character set, you must make the double-byte fonts known to InfoPrint through
one of these methods:
v Create a resource-context object that identifies the location of the double-byte

fonts and associate the resource-context object with a default-document object
and an InfoPrint logical printer; see Chapter 9, “Creating and managing
resource-context objects,” on page 107 for these procedures. Using this method
makes the fonts known to InfoPrint for any job submitted to the logical printer
associated with the default-document object.

v Add the directories to the search path for actual destinations using the InfoPrint
Manager Administration Interface Printer Properties notebook. In the AFP
Resources tab, enter the directory path in the Location of fonts field. See
“Assigning resource-context objects to an actual destination” on page 115 for an
AIX command line equivalent of the procedure. Using this method makes the
fonts known to InfoPrint for any job processed by those physical printers.

v Set and export the PSFPATH environment variable to your environment by
entering this command:
export PSFPATH=$PSFPATH:path1:path2:pathN
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Using this method makes the fonts known to InfoPrint for all print jobs
submitted from the AIXwindows or High Function Terminal session in which
the PSFPATH environment variable was set.

v Set and export the PSFPATH environment variable in your .profile file (Korn
and Bourne shells) or .cshrc file (C shells) by adding this line to the file:
export PSFPATH=$PSFPATH:path1:path2:pathN

Using this method makes the fonts known to InfoPrint for any job you submit.
v Set the PSFPATH environment variable in the /etc/environment file by adding

this line to the file:
PSFPATH=path1:path2:pathN

Using this method makes the fonts known to InfoPrint for all users on the
system.

Fonts for printing line data

Improve flexibility by specifying the fonts that you want to use for printing line
data in your page definition. See the PPFA User’s Guide, S544–5284 or the PPFA
Quick Reference, G544–3701 for more information. The chars keyword can also be
used.

When you specify a coded font name with the chars keyword of the line2afp
command or with the chars document attribute, the font name is limited to four
characters, excluding the two-character prefix.

Table 34 provides a list of the IBM Expanded Core Fonts for use with unformatted
ASCII input data. Because these fonts have eight-character names, the table also
provides a list of six-character short names. InfoPrint stores these coded fonts in
the /usr/lpp/psf/reslib directory. There are symbolic links of the eight-character
names that correspond to the six-character names. You can use these short names,
without the X0 prefix, to satisfy the four-character limitation for specifying font
names with the chars keyword of the line2afp command. You can use either the
coded font name or the page definition.

For the names of other coded fonts, see IBM AFP Fonts: Font Summary.

Table 34. Font mapping table for use with the chars keyword

Type Family Point Size Coded Font Name
Linked Short Name
(for chars keyword)

Courier 7 X0423072 X04272

Courier 8 X0423082 X04282

Courier 10 X0423002 X04202

Courier 12 X04230B2 X042B2

Courier 14 X04230D2 X042D2

Courier 20 X04230J2 X042J2

Helvetica 6 X0H23062 X0H262

Helvetica 7 X0H23072 X0H272

Helvetica 8 X0H23082 X0H282

Helvetica 9 X0H23092 X0H292

Helvetica 10 X0H23002 X0H202

Helvetica 11 X0H230A2 X0H2A2
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Table 34. Font mapping table for use with the chars keyword (continued)

Type Family Point Size Coded Font Name
Linked Short Name
(for chars keyword)

Helvetica 12 X0H230B2 X0H2B2

Helvetica 14 X0H230D2 X0H2D2

Helvetica 16 X0H230F2 X0H2F2

Helvetica 18 X0H230H2 X0H2H2

Helvetica 20 X0H230J2 X0H2J2

Helvetica 24 X0H230N2 X0H2N2

Helvetica 30 X0H230T2 X0H2T2

Helvetica 36 X0H230Z2 X0H2Z2

Times New Roman 6 X0N23062 X0N262

Times New Roman 7 X0N23072 X0N272

Times New Roman 8 X0N23082 X0N282

Times New Roman 9 X0N23092 X0N292

Times New Roman 10 X0N23002 X0N202

Times New Roman 11 X0N230A2 X0N2A2

Times New Roman 12 X0N230B2 X0N2B2

Times New Roman 14 X0N230D2 X0N2D2

Times New Roman 16 X0N230F2 X0N2F2

Times New Roman 18 X0N230H2 X0N2H2

Times New Roman 20 X0N230J2 X0N2J2

Times New Roman 24 X0N230N2 X0N2N2

Times New Roman 30 X0N230T2 X0N2T2

Times New Roman 36 X0N230Z2 X0N2Z2

Printing with the DBCS Simulation Fonts with the font metric
adjustment triplet

PTF U807769 includes support for printing the DBCS Simulation Fonts (available
with Infoprint Fonts for Multiplatforms, Version 1 Release 1 Modification 0,
Program Number 5648-E77) with the font metric adjustment triplet. The DBCS
Simulation Fonts are available on the AIX and Windows operating systems.

Note: When you use the DBCS Simulation Fonts, set the requested-font-resolution
appropriately or use the NORES grid files.

Installing the Japanese PostScript font feature
You can install Japanese PostScript fonts on your InfoPrint Manager server to print
documents requiring these specialized fonts.

To enable your InfoPrint Manager server to support Japanese PostScript fonts, use
the InfoPrint installer located on the InfoPrint Manager CD-ROM. You will be
prompted to supply your customer ID as well as the access key located on the
invoice that was shipped with your CD.
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Chapter 22. Using global resource identifiers

InfoPrint can identify the fonts required for a job, access AFP font files that are
installed on or NFS-mounted to the RS/6000, and download the appropriate fonts
to an InfoPrint-managed printer device. However, some InfoPrint printers can use
fonts that are resident in the printer, saving the time it takes to download these
fonts. Because the font files on the RS/6000 do not share the same names as the
printer-resident fonts, InfoPrint uses global resource identifiers (GRIDs) to map the
RS/6000-resident fonts to the printer-resident fonts. Use the information in this
chapter to work with GRIDs.

How can you use GRIDs?
GRID files contain pre-assigned mappings that you can modify to map
RS/6000-resident font file names to printer-resident font identifiers. These
pre-assigned mappings include both single-byte character set (SBCS) and
double-byte characters set (DBCS) outline fonts.

If you have a printer that supports outline fonts, you can use the GRID files to
map raster character-set names to outline font global identifiers.

A third use of GRID files is to support Mixed Object Document Content
Architecture for Presentation (MO:DCA-P) files that specify fonts using GRIDs
rather than character-set names. You can customize the GRID files to define which
fonts InfoPrint uses when the data stream of the job specifies GRIDs.

Note: If a data stream specifies only GRID parts instead of specific names, then the
fgid.grd table is used to find the name of the font to download or the outline font
to activate. In this case, the data stream must specify a specific width value.

What GRID files ship with InfoPrint?
InfoPrint ships four GRID files that you can customize for use with the types of
printer devices that you use and the types of jobs that you print. These files are
charset.grd.sample, codepage.grd.sample, cpgid.grd.sample, and fgid.grd.sample,
and they are installed in the /usr/lpp/psf/grd directory.

Note: You can either shut down and restart the InfoPrint server (pdserver process)
or shut down and restart all your printers to make sure that .grd file changes are
applied.

This section describes each file:

charset.grd.sample
Specifies which printer-resident fonts are activated for the character-set names
found in the data stream of the job.

This file maps the font character-set name to a:
v Font global identifier (fgid)
v Graphic character set global identifier (gcsgid)
v Font width
v Vertical size value
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v Set of font attributes (bold, italic, and doublewide)

Figure 26 shows an example of the format of a line in the character set sample
file.

codepage.grd.sample
Specifies which printer-resident fonts are activated for the code page names
found in the data stream of the job.

This file maps a code page to the:
v Code page global identifier (cpgid)
v Graphic character set global identifier (gcsgid)

Figure 27 shows an example of the format of a line in the code page sample
file.

fgid.grd.sample
Specifies which font character set InfoPrint should download when
substituting for a global resource identifier that it finds in the data stream of
the job.

This file maps these to a font character set (FCS) name:
v A font global identifier (fgid)
v A graphic character set global identifier (gcsgid)
v A font width
v A vertical size value

Figure 28 shows an example of the format of a line in the font global identifier
sample file.

cpgid.grd.sample
Specifies which code page InfoPrint should download when substituting for a
global resource identifier that it finds in the data stream of the job.

This file maps a code page global identifier and a graphic character set global
identifier to a code page name. Figure 29 shows an example of the format of a
line in the code page identifier sample file.

# FCS name -> fgid gcsgid width vsize attr #
#**********************************************************************#

C0L00GSC 398 - 96 120 - # GOTHIC CONDENSED 1

Figure 26. Sample file for a character set

# code page name -> cpgid gcsgid #
#**********************************************************************#

T1000038 38 123 # US-ASCII Character Set 1

Figure 27. Sample file for a code page

# fgid gcsgid width vsize -> FCS name #
#**********************************************************************#

3 0 144 240 C0E0DE10 # DELEGATE 12 POINT 1

Figure 28. Sample file for a global identifier

# cpgid gcsgid -> code page name #
#**********************************************************************#

29 0 T1V10871 # OLD ICELANDIC 1

Figure 29. Sample file for a code page identifier
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For a detailed explanation of how the different types of identifiers combine to
produce fonts, see InfoPrint Fonts: Font Summary

If you have a job that specifies a font that is not resident on your printer, you can
use the GRID files to map the missing font to one with the same point size that
does reside on your printer. To understand what fonts your printer device has,
consult both your printer documentation and Advanced Function Presentation: Printer
Information.

Where does InfoPrint search for GRID files?
InfoPrint searches these directories, in the order shown, for GRID files:
1. An internal list that matches the charset.grd.sample file.
2. /usr/lpp/psf/grd

3. /var/psf/printername, where PrinterName is the name of a valid InfoPrint
physical printer.

Note: When the same mapping is found in one of these files, InfoPrint uses the
last one (/var/psf/ PrinterName).

When you install InfoPrint, sample GRID files are installed in the /usr/lpp/psf/grd
directory. You can maintain a central location for new or modified GRID files for
specific printers by storing files in the /var/psf/PrinterName directory.

If you are mapping raster fonts to outline fonts, you can map multiple names to
the same GRID part so that different sized fonts can apply to your print job.

Notes:

1. The new or modified GRID files you create have the same names as the sample
files except that you delete .sample from each file name.

2. After creating or modifying GRID files, you must shut down and restart the
InfoPrint physical printer represented by PrinterName for the changes in the file
to take effect.

Understanding the general syntax rules and allowable values for GRID
files

To tailor the InfoPrint-supplied GRID files for your own system needs, you need to
understand the general syntax rules for the four GRID files and the allowable
values for the fields in the files.

Syntax rules applying to all types of GRID files

The GRID files are simple ASCII text files that you can modify through any
standard AIX text editor. These rules apply to all of the GRID files:
v Each line in the file cannot contain more than 255 characters
v Separate fields within a line with one or more delimiters (spaces)
v A pound sign (#) indicates the start of comments, which causes InfoPrint to

ignore the remainder of that line
v A dash, – , indicates the absence of a particular value, for which InfoPrint

substitutes a zero (0)
v An asterisk, * , indicates that a wildcard value (any numeric decimal) is

accepted.
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v InfoPrint ignores blank lines and extraneous fields

Allowable values for the charset.grd file

You can specify these values for fields in the GRID file for a character set for a
font:

fgid
Identifies the character set identifier for the font. Specify a numeric value from
1 to 65534 or enter a dash, – , to disable the mapping of this character set to
GRID values.

gcsgid
Identifies a global identifier for the font. Specify a numeric value from 0 to
65534 or enter a dash, – , to specify no gcsgid. If you specify an asterisk,
InfoPrint issues an error message.

width
Identifies the width specified in the character set. Specify a numeric value from
0 to 32767 or enter a dash, – , to specify no width. If you specify an asterisk,
InfoPrint issues an error message.

vertical_size
Identifies the vertical size specified in the character set. Specify a numeric
value from 0 to 32767 or enter a dash, – , to specify no vertical size. If you
specify an asterisk, InfoPrint issues an error message.

attribute_field
Indicates the attributes of the character set. Specify a lowercase b (bold), i
(italic), d (doublewide), or enter a dash, – , to specify no attribute.

Allowable values for the codepage.grd file

You can specify these values for fields in the GRID file for a code page for a font:

cpgid
Identifies the code page identifier for the font. Specify a numeric value from 1
to 65534 or enter a dash, – , to disable the mapping of this character set to
GRID values.

gcsgid
Identifies a global identifier for the code page. Specify a numeric value from 0
to 65534 or enter a dash, – , to specify no gcsgid. If you specify an asterisk,
InfoPrint issues an error message.

Allowable values for the fgid.grd file

You can specify these values for fields in the GRID file for a font global identifier:

fgid
Identifies the global identifier for the font. Specify a numeric value from 1 to
65534.or enter an asterisk, * , to indicate a wildcard value. If you specify a
dash, InfoPrint issues an error message.

gcsgid
Identifies the global identifier for the font. Specify a numeric value from 0 to
65534 or enter an asterisk, * , to indicate a wildcard value. If you specify a
dash, InfoPrint issues an error message.
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width
Identifies the number of characters per horizontal inch. Specify a numeric
value from 1 to 32767 or enter an asterisk, * , to indicate a wildcard value. If
you specify a dash, InfoPrint issues an error message.

vertical_size
Identifies the vertical size of the font. Specify a numeric value from 1 to 32767
or enter an asterisk, * , to indicate a wildcard value. If you specify a dash,
InfoPrint issues an error message.

Allowable values for the cpgid.grd file

You can specify these values for fields in the GRID file for a code page global
identifier:

cpgid
Identifies code page identifier for the font. Specify a numeric value from 1 to
65534.

gcsgid
Identifies the global identifier for the font. Specify a numeric value from 0 to
65534 or enter an asterisk, * , to indicate a wildcard value. If you specify a
dash, InfoPrint issues an error message.

Modifying GRID files
This section describes the two ways you can modify GRID files to support the
printer devices and types of jobs in your production printing environment.

Note: If you are using InfoPrint to print from the InfoPrint 6400 or 6500 series of
line matrix printer in either native or 4234 emulation mode, you must modify both
the charset.64xx.grd and the codepage.64xx.grd files as described in “Modifying
the charset and code page GRID files” and “Modifying the FGID and CPGID GRID
files” on page 244.

Modifying the charset and code page GRID files

You can avoid having InfoPrint download fonts by adding font entries that map
the font character set or code page that is most referenced in jobs to a global
identifier for a resident font.

For example, if your jobs specify the Prestige 10-point font that is character set
C0S0PR10, and that font is not available, you can map the Prestige 10-point font to
a similar font that is either resident on your printer or available for InfoPrint to
download to your printer. In this procedure, you map the Prestige 10-point font to
Gothic 10-point font, character set C0D0GT10.

Perform these steps:
1. From the AIX command line, change to the /var/psf/PrinterName directory,

where PrinterName is the name of the InfoPrint actual destination representing
the printer device.

2. Create the charset.grd file from the charset.grd.sample file. Enter the command:
cp /usr/lpp/psf/grd/charset.grd.sample charset.grd

3. Using an AIX editor, such as vi, edit the charset.grd file you just created and
copy this line for the Gothic 10-point printer-resident font:
C0D0GT10 40 - 144 240 # GOTHIC TEXT 10
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4. Change the first entry in the copied line, in the FCS name column, to the
character set identifier of the Prestige 10-point font that you want to map to the
Gothic 10-point font. You can change the comment at the end of the copied line
to identify the mapping change you are making.
C0S0PR10 40 - 144 240 # PRESTIGE 10 mapped to GOTHIC TEXT 10

5. Search the remainder of the charset.grd file to make sure that it contains no
other C0S0PR10 entries. A later entry of the same character set would replace
the entry you just made.

6. Save your changes and close the file.

To print jobs that specify the personal computer ASCII code page for Iceland,
T1000861, but that code page is not available, you can map code page T1000861 to
the personal computer multilingual code page for ASCII data, T1000850.

Perform these steps:
1. From the AIX command line, change to the /var/psf/PrinterName directory,

where PrinterName is the name of the InfoPrint actual destination representing
the printer device.

2. Create the codepage.grd file from the codepage.grd.sample file. Enter the
command:
cp /usr/lpp/psf/grd/codepage.grd.sample codepage.grd

3. Using an AIX editor, such as vi, edit the codepage.grd file you just created and
copy this line for the personal computer multilingual code page for ASCII data:
T1000850 850 980 # PC MULTILINGUAL

4. Change the first entry in the copied line, in the code page name column, to the
code page identifier of the personal computer ASCII code page for Iceland font
that you want to map to the multilingual code page. You can change the
comment at the end of the copied line to identify the mapping change you are
making.
T1000860 850 980 # ICELAND MAPPED TO MULTILINGUAL

5. Search the remainder of the codepage.grd file to make sure that it contains no
other T1000860 entries. A later entry of the same character set would replace
the entry you just made.

6. Save your changes and close the file.

Modifying the FGID and CPGID GRID files

You can add new entries to map your GRID data to the resident fonts in your
printer by modifying either the fgid.grd.sample file or the cpgid.grd.sample file. If
you have a printer that does not support the outline font technology (such as the
InfoPrint 3835 Advanced Function Printer), We recommend that you map all the
CZnnnn entries to raster font character-set names. If you do not create this
mapping, InfoPrint issues an error message and does not print the job.

For example, if you wanted to map the Times New Roman Latin 1 character set to
the raster version, you would do these steps:
1. From the AIX command line, change to the /var/psf/PrinterName directory,

where PrinterName is the name of the InfoPrint physical printer representing
the printer device.

2. Create the fgid.grd file from the fgid.grd.sample file. Enter the command:
cp /usr/lpp/psf/grd/fgid.grd.sample fgid.grd

3. Using an AIX editor, edit the file that you just created and copy this line:
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2308 2039 * * CZN200 # Times New Roman Latin1

4. Change the entry in the FCS name column to CON20000.
2308 2039 * * CON20000 # Raster version of TNR Latin 1

5. Save your changes and close the file.

After this substitution, InfoPrint prints jobs that specify the font character-set name
CZN200 and that processed on the physical printer for which you made the change
using the raster version of the font. The CZN200 character set now maps to:
v An FGID of 2308
v A GCSGID of 2039
v A vertical size of 65535
v A width of 0

Note: For more information about the different values available for font character
sets and code pages, see ″IBM Font Interchange Information″ in InfoPrint Data
Stream and Object Architectures Mixed Object Document Content Architecture Reference.

Because the InfoPrint 3835 Advanced Function Printer does not support any
resident outline fonts, the fgid.grd.sample file maps the FGID and the GCSGID
back to the C0N20000 character set. Then, InfoPrint searches the resource library
search path to locate the C0N20000 character for downloading with the job.

To modify the cpgid file so that the personal computer ASCII code page for
Iceland maps to the multilingual code page for ASCII data as described in
“Modifying the charset and code page GRID files” on page 243, do these steps:
1. From the AIX command line, change to the /var/psf/PrinterName directory,

where PrinterName is the name of the InfoPrint physical printer representing
the printer device.

2. Create the cpgid.grd file from the cpgid.grd.sample file. Enter the command:
cp /usr/lpp/psf/grd/cpgid.grd.sample cpgid.grd

3. Using an AIX editor, such as vi, edit the cpgid.grd file you just created and
copy this line for the personal computer multilingual code page for ASCII data:
850 980 T1000850 # PC MULTILINGUAL

4. Change the first entry in the copied line, in the cpgid column, to the code page
identifier of the personal computer ASCII code page for Iceland font that you
want to map to the multilingual code page. You can change the comment at the
end of the copied line to identify the mapping change you are making.
861 980 T1000850 # ICELAND MAPPED TO MULTILINGUAL

5. Search the remainder of the cpgid.grd file to make sure that it contains no
other 861 entries. A later entry of the same character set would replace the
entry you just made.

6. Save your changes and close the file.

Verifying the GRID files

During physical printer initialization, InfoPrint examines the contents of the GRID
files. If InfoPrint detects any syntax errors, it reports an error condition and fails to
enable the physical printer. To correct these errors, you must edit the failing GRID
files. For information about what files, lines, or fields are in error, you must access
the GRID error.log file for the physical printer that is located in
/var/psf/PrinterName.
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Preventing InfoPrint from using GRID files

If you have obtained a 300-pel printer but print 240-pel jobs, the printer-resident
fonts might have different line spacings and endings in the printed output. For
some types of billing statements, these line endings are inappropriate. You can
solve this problem by preventing InfoPrint from using the GRID files. This
prevents the use of the printer-resident fonts. Perform this procedure:
1. Using the AIX mv command, rename your customized GRID files. For example,

if you are in the /var/psf/PrinterName directory and you want to rename the
charset.grd to charset.grd.bak, enter:
mv charset.grd charset.grd.bak

2. Copy the /usr/lpp/psf/grd/charset.grd.sample file to charset.grd in the
/var/psf/PrinterName directory.

3. Using an AIX editor, such as vi, edit the copied charset.grd file and place a
dash (–) in the fgid column.

4. Copy the /usr/lpp/psf/grd/codepage.grd.sample file to codepage.grd in the
/var/psf/PrinterName directory.

5. Edit the copied codepage.grd file and place a dash (–) in the cpgid column.

Using the ’no resident’ version of the sample grid files
There might be situations when you do not want InfoPrint Manager to use
printer-resident fonts.

If you do not have customized GRID files and want to use the ’no resident’ version
of the sample grid files shipped with InfoPrint Manager, complete this procedure:
1. From the AIX command line:

cd /var/psf/PrinterName

Where PrinterName is the name of the InfoPrint physical printer that represents
the actual printer device.

2. Create the charset.grd file from the charset.grd.nores file:
cp /usr/lpp/psf/grd/charset.grd.nores charset.grd

3. Create the codepage.grd file from the codepage.grd.nores file:
cp /usr/lpp/psf/grd/codepage.grd.nores codepage.grd
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Chapter 23. Configuring and using cut-sheet emulation

To enable cut-sheet emulation, make sure that your printer has a microcode level
of at least 9.216, then make sure that the appropriate personnel do these tasks at
your installation on the systems specified:
1. At the InfoPrint AIX server, the print administrator for your installation must

disable the physical printer that you intend to run in cut sheet emulation mode.
2. At the printer console, an operator must set the printer to cut-sheet emulation

mode.
3. The operator must then restart the printer.
4. At the InfoPrint AIX server, the print administrator must create a logical printer

for the physical printer.
5. The print administrator must make sure that both the logical and physical

printer has been enabled.

To submit a job, see ″Using Cut Sheet Emulation.″

Using cut sheet emulation
Job submitters must specify a form definition that will print using cut sheet
emulation through these application programming interfaces:
v “Using InfoPrint Submit Express”
v “Using InfoPrint Job Ticketer”
v “Using the PSF actual destination properties notebook” on page 248
v “Using the pdpr command” on page 248

Before using any of these interfaces, make sure that you are aware of this support’s
“Defaults and limitations of cut sheet emulation support” on page 248.

Using InfoPrint Submit Express
From the Resources tab of the InfoPrint Submit Express Job Ticket window, you
can leave the Use form definition field blank to get the default form definition on
the InfoPrint AIX server, or specify a specific form definition.

By using the default form definition, cut sheet emulation will be invoked.

Note: InfoPrint Submit Express is part of the Print-on-Demand feature that is a
separately orderable feature.

Using InfoPrint Job Ticketer
From the AFP Resources page of the InfoPrint Job Ticketer window, you can leave
the Form definition field blank to get the default form definition on the InfoPrint
AIX server, or specify a specific form definition.

By using the default form definition, cut sheet emulation will be invoked.

Note: InfoPrint Job Ticketer is part of the Print-on-Demand feature that is a
separately orderable feature.
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Using the PSF actual destination properties notebook
1. From the InfoPrint Administration servername window, use the middle mouse

button to drag the printer notebook action icon onto the Actual Destination
(printer) that you want to use for cut-sheet emulation.

2. From the View and Change PSF Actual Destination Properties window, click
the Customization tab.

3. Specify the form definition of choice in the form definition field.
4. Click OK or Apply to make sure that this form definition is applied.

Using the pdpr command
The form-definition document, default document, or actual destination attributes
on the pdpr command also change the form definition on a printer.

For specific examples of how to modify these values on the printer, see InfoPrint
Manager: Reference.

Defaults and limitations of cut sheet emulation support
When a form definition is explicitly named, any attribute found in both the form
definition and either the InfoPrint Manager graphical user interface or the pdpr
command reverts to the value specified in the form definition.

Note that corresponding values specified on the printer-pass-through (or
destination-pass-through) attribute override the values specified in either the PSF
Resource tab of the PSF printer notebook or the form-definition document, default
document, or actual destination attribute.

If you use a form definition that contains a medium map using N_UP commands,
the printer will go out of cut sheet emulation mode while processing that N_UP
command. If the N_UP processing ends, the printer will return to cut sheet
emulation mode. This scenario can occur when printing a large image in the
middle of a job.
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Chapter 24. Generating and submitting color mapping table
source and output files

A color mapping table is a printer resource object that defines a translation from
certain MO:DCA structured fields to new color structured fields used by newer
printers. Color mapping tables are used to provide support for highlight color
attachments with black-and-white printers, such as using the InfoPrint 4005
attachment with the InfoPrint 4000 printer. You can also use a color mapping table
to map highlight colors into richer colors on a color printer like the InfoPrint Color
130 Plus printer. To apply color to black and white documents, you must use the
following procedure to create Color Mapping Table Source and Output Files. See
the InfoPrint Manager: Reference for information about the cmt utility or to the
appropriate man page.

You can define translations from non-color fields to color, old color fields to new
color fields, and from new color fields to different new color fields. Therefore, you
can use existing applications and documents with new color fields without having
to change the documents or applications. Also, you can use various color
mappings with a single document to print the document using color in different
ways without changing the original document.

Using the AFP architectural reference, you can apply color to existing black and
white documents. The sample configuration file cmt.cfg contains user-defined
specifications, and should be available in the usr/lpp/psf/config directory. The cmt
utility that uses the cmt.cfg configuration file should be available in the
/usr/lpp/psf/bin directory on your InfoPrint AIX server. Note that a MOD:CA
sample color mapping table, named cmtsampl, can be found in usr/lpp/psf/config/.
This color mapping table was produced by the sample cmt.cfg file.

The cmt utility lets you create color mappings in a variety of different color modes
that are defined through the ColorSpace parameter. For example, the Highlight
value can be used when printing to an InfoPrint 4000 printer with an InfoPrint
Highlight Color Model HC2 Post-Processor (HCPP). For more information about
the HCPP, see the InfoPrint Hi-Lite Color Printer: Library Catalog.

Parts of a color mapping table
A color mapping table consists of a base part, a set of source groups, and a set of
target groups. The base part identifies the color mapping table with a type of
either reset or normal.

The simplest possible color mapping table is a reset color mapping table, which
tells the printer to do no transformations on the color information found in the
document. A reset color mapping table has no source or target groups; all other
color mapping tables have at least one source and one target group.

Using source groups
Each source group has an identification (ID) number, which is used to match the
source group with a corresponding target group. You can have unique ID numbers;
however, if you create the color mapping table without the cmt Utility and want to
map several source groups to a single target group, you can use the same ID
number on multiple source groups. Valid ID values are 1–127.
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Note: The cmt Utility generates pairs of sources and targets, then assigns
increasing, sequential IDs to each pair. For more information about the cmt Utility,
see InfoPrint Manager: Reference.

Each source group must be classified as one of these color spaces:

Highlight color
Highlight color is used when your existing documents describe color in
terms of the percent to be covered and the percent to be shaded for a color
number. The colors are device dependent. For example, you can have a
printer that allows the use of three colors for highlighting. You could
specify percent coverage and percent shading for colors 1, 2, or 3. Your
printer setup would determine the actual colors.

Standard Object Content Architecture (OCA)
Standard OCA uses defined combinations of red, green, and blue to create:
blue, red, pink, magenta, green, turquoise/cyan, and yellow. Standard
OCA also defines several defaults such as white on a black medium, black
on a white medium, and the same color as the medium. The medium
could be, for example, paper or a display.

GOCA pattern fill
GOCA pattern fill defines patterns for filling areas that you might want to
map to colors with a color mapping table.

For detailed explanations about these color spaces, see Mixed Object Document
Content Architecture Reference.

You can use a color mapping table to pick specific object types to map, such as:
v Object area
v IM image data
v PTOCA data
v Page presentation space
v GOCA data
v Overlay presentation space
v BCOCA data
v IOCA data (bi-level, FS10)
v All PTOCA, GOCA, BCOCA, IOCA, FS10, and IM object data
v All objects, object areas, and presentation spaces

After you pick the color spaces and object types you want to map, you can specify
exact values for the fields you want to map.

Using target groups
If you create the color mapping table without the cmt Utility, you must specify a
target group ID number to match the source groups for a target. Valid ID values
are 1–127.

Note: The cmt Utility generates pairs of sources and targets, then assigns
increasing, sequential IDs to each pair. For more information about the cmt Utility,
see the InfoPrint Manager: Reference.

Each target group must be classified as a color space, which is the kind of color
you want as output. The color spaces defined in the matching source groups are
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transformed to this color space. The color mapping table allows RGB CMYK,
highlight, and CIELAB, but your actual hardware determines your available
choices. For example, if your printer supports only highlight color, your target
group must use highlight color.

You can specify exact values for output colors. For example, if your printer
supports three highlight colors, you can specify colors 1, 2, or 3 with coverage and
shading percentages that are supported by your printer.

Other publications that have helpful references regarding color devices include:
v InfoPrint 4005 Hi-Lite Color Application Design Reference, available from your

InfoPrint marketing representative.
v InfoPrint Hi-Lite Color Introduction and Planning Guide for 4005.

Creating a color mapping table

In the procedure described below, we create a color mapping table to print an
Advanced Function Presentation (AFP) file that contains pie charts in the color
green.

For our AFP files, this pie chart appears as a series of horizontal lines. By accessing
the chapter on ″Graphic primitives and attributes″ in the Graphics Objects Content
Architecture for Advanced Function Presentation Reference manual, we can see that
these horizontal lines are created by a Pattern Output Primitive with a hexadecimal
value of '0B'(11).

To turn these horizontal lines into a shade of green when using a ColorSpace
source group of GOCA to map to a target group value of RGB, make sure that you
specify a low value for red (12), a high value for green (252), and a value under 50
for blue (42) to provide a clear contrast.

You must do these tasks from the AIX command line:
1. From the usr/lpp/psf/config directory, specify:

cp cmt.cfg piel.cfg

This copies the Color Mapping Table configuration file into a file you can
customize for your own purposes (in this case, pie1.cfg)

2. Specify vi piel.cfg.

This lets you edit the configuration file and insert the applicable values to
create the appropriate color mapping (whether GOCA to RGB or OCA to
CIELAB) table. See the sample cmt.cfg configuration file below:
# ******************************************************-
# Required, starts a Color Mapping Definition.
# One definition for each Source to Target mapping.
# ******************************************************-
# ******************************************************-
# BeginSourceDef:
# Required, starts the Source Parameters
# ******************************************************-
BeginSourceDef:
# ******************************************************-
# ColorSpace:
# Required, values= OCA | Highlight | GOCA
# ******************************************************-
ColorSpace: GOCA
# ******************************************************-
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# ColorValue:
# Required, values depend on Color Space
# ******************************************************-
ColorValue: 11
# ******************************************************-
# ObjectType:
# Optional, values= ObjArea | ImageData | PTOCData |
# GOCAData | BCOCAData | AllOCA | Page | Overlay |
# ObjsAll
# default= ObjsAll
# ******************************************************-
ObjectType: GOCAData

# ******************************************************-
# PercentShading:
# Optional, only valid for SourceColorSapce: Highlight,
# values= 0 .. 100, 255 (all percentages),
# default= 100
# ******************************************************-
# PercentShading:
# ******************************************************-
# PercentCoverage:
# Optional, only valid for SourceColorSpace: Highlight,
# values= 0 .. 100, 255 (all percentages),
# default= 100
# ******************************************************-
# PercentCoverage:
# ******************************************************-
# EndSourceDef:
# Required, ends the Source Parameters
# ******************************************************-
EndSourceDef:
# ******************************************************-
# BeginTargetDef:
# Required, starts the Target Parameters
# ******************************************************-
BeginTargetDef:
# ******************************************************-
# ColorSpace:
# Required, values= RGB | CMYK | Highlight | CIELAB
# ******************************************************-
ColorSpace: RGB
# ******************************************************-
# ColorValue:
# Required, values depend on Color Space
# ******************************************************-
ColorValue: 12 252 42
# ******************************************************-
# PercentShading:
# Optional, only valid for TargetColorSpace: Highlight,
# values= 0 .. 100, default= 100
# ******************************************************-
# PercentShading:
# ******************************************************-
# PercentCoverage:
# Optional, only valid for TargetColorSpace: Highlight,
# values= 0 .. 100, default= 100
# ******************************************************-
# PercentCoverage:
# ******************************************************-
# EndTargetDef:
# Required, ends the Target Parameters
# ******************************************************-
EndTargetDef:
# ******************************************************-
# Required, ends a Color Mapping Definition.
# ******************************************************-
# EndMappingDef:
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3. Once you have finished editing the pie1.cfg file, save the file.
4. To create the Color Mapping Table object (MODCA) file that will be used when

you submit the job for printing, run the cmt Utility as the input file (-i flag):
cmt -i pie1.cfg -o pie1.set

This command produces a pie1.set output file.
5. To verify your color mapping table values, or to create a configuration file from

a MODCA object file, specify the cmt utility again, using the newly created
pie1.set as the input file and pie2.cfg as the output file:
cmt -i pie1.set -o pie1.cfg

Note: pie2.cfg is specified so that you don’t overwrite the original file. You can
then compare pie1.cfg to pie2.cfg.

6. Before you try to use this color mapping table to submit a job to InfoPrint
Manager, verify that the source file contains the intended values. In this case,
the pie1.cfg file should resemble this example, where the source definition
represents the input file (in this case AFP) that you are converting to the target
definition (an RGB color value of green):
BeginMappingDef:
BeginSourceDef:
ColorSpace: GOCA
ColorValue: 11
ObjectType: GOCADATA
EndSourceDef:
BeginTargetDef:
ColorSpace: RGB
ColorValue: 12 252 42
EndTargetDef:

EndMappingDef:

7. Once you have verified the contents of the source file, see “ Submitting jobs
using a color mapping table.”

Submitting jobs using a color mapping table
To submit a job using the color mapping tables for spot color, you must make sure
that you also specify a resource-context attribute so that the server knows the
location of the color mapping table. Once you have configured a Color Mapping
Table, you must have defined a logical destination (named prt1 for this example)
to which you can send the job.

Submitting jobs through the AIX command line

Once the logical destination has been defined, you can submit a job to an InfoPrint
Manager printer by specifying these from the command line:

Command Values Meaning

pdpr -d prt1 Print Command with logical destination
name.

-t <jobname> Specifies the name that you want to
assign to the job (optional).

-x resource-context=/usr/lpp/psf/config Explicit path name where the AFP file (in
this case pie1), is located on your
InfoPrint AIX server.

-x color-mapping-table=pie1.set Color Mapping Table that you created in
“Creating a color mapping table” on
page 251 for printing this file.
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<path and file to print> Explicit path to the AFP file that you
want to print.

Note: /usr/lpp/psf/config is a directory that is created automatically.

Example:

pdpr –d ld1 –x resource-context=/usr/lpp/psf/config –x color-mapping-
table=pie1.set /home/user1/test.afp This command will print the input file
test.afp located in the directory /home/user1/ using the color mapping table
pie1.set located in /usr/lpp/psf/config to the logical destination ld1.

-x attributes:

Submitting a job with -x attributes overrides any actual destination configuration
settings. Actual destination settings only take effect by default if no parameters are
passed to InfoPrint Manager when submitting a job. The hierarchy is:
1. -x attribute upon job submission
2. Job and document defaults; color-mapping-table attribute
3. Actual destination color-mapping-table attribute

Configuring an actual destination

When configuring an actual destination with the InfoPrint Manager Administration
GUI, it is important to include the name of the color mapping table. Use this
procedure to configure an actual destination to use the appropriate color mapping
table:
1. From the InfoPrint Administration Servers main window, enable the

appropriate actual destination (in this case, NewP, as shown below) by
right-clicking the actual destination and then selecting Enable.

2. Ensure that the Color mapping table (pie1.set) has been specified on the AFP
Color tab of the Printer Properties notebook and that the Location of resources
(/usr/lpp/psf/config/) has been specified on the AFP Resources tab.

3. Submit your job to InfoPrint Manager, using either the command line or the
InfoPrint Select client.
Using the InfoPrint Select client to submit a job

There are 3 ways to designate a color mapping table when using InfoPrint
Select:
a. Use the Logical destination to designate the color mapping table. Specify

the color-mapping-table attribute in the Job and document defaults
associated with the logical destination to which you are sending the job.

b. Use the Actual destination to designate the color mapping table. Specify
the color-mapping-table attribute of the Actual destination to which you are
sending the job.

c. Use the File → Print method to designate the color mapping table. If you are
using a newer version of InfoPrint Select, a Job settings dialog appears
after the Print button is clicked on the Print window. Specify the name of
the color mapping table by clicking the Other tab of Job settings dialog.
Enter color-mapping-table=pie1.set, where pie1.set is the name of the
color mapping table.
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Chapter 25. Configuring InfoPrint systems for interoperability

This chapter contains these sections:
v “Understanding interoperating environments”
v “Configuring a primary AIX server with a secondary AIX server” on page 257
v “Configuring a primary AIX server with a secondary Windows server” on page

257

Primary Windows servers:

If you are using a Windows operating system for your primary server, see InfoPrint
Manager for AIX: Procedures for interoperability instructions.

Understanding interoperating environments
When you install an InfoPrint Manager server on a system, the install process
creates a namespace for that server. The namespace is a directory structure where
InfoPrint Manager stores the location information of all of your InfoPrint objects,
including the server itself, queues and destinations, and the Access Control Lists
(ACLs) used by InfoPrint Manager Security.

If you install a second InfoPrint Manager server on another system on your
network, that server will create its own namespace and the two servers will
operate entirely independent of each other. In some cases, however, you might
want your servers to be able to work together. To make InfoPrint Manager servers
work together, you set up an interoperating environment in which two or more
InfoPrint Manager servers share the same namespace. The namespace is located in
a directory on one of the servers and the other servers are granted permissions that
allow them to use that directory.

When configuring InfoPrint Manager servers to support interoperability, make sure
that these two rules are followed:
1. Each InfoPrint Manager server must be accessible by all of the other InfoPrint

Manager servers using the same IP address.
For example, if Server1 is an InfoPrint Manager AIX server with an IP address
of 9.99.155.122, then all other InfoPrint Manager servers must use
9.99.155.122 to access Server1.

2. The IP address for each InfoPrint Manager server must be the address that is
identified for the first (or primary) network card that is defined to that server.

Reasons for setting up an interoperating environment
Not every printing system needs multiple InfoPrint servers. In fact, in many
environments one InfoPrint server is adequate. However, in print environments
that do very high volume printing or that print in remote locations (for example, a
main office with branch offices in different parts of the city), interoperating
InfoPrint servers can provide important benefits:
v Interoperating servers are much more scalable than single servers.
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– If your print volume increases and you find that you need more processing
power or memory to be able to meet the demand, you can add a second
server. However, by making the servers interoperate, you still only have one
printing system to administer.

– If your business expands and you add another office, you can add another
server to the namespace. You’ll have to define any new printers that you add
to the network, but you won’t have to redefine existing printers or move
resources again to be able to use them from the new location.

v Interoperating servers allow you to distribute print server functions across
systems.
Remote locations can have their own local servers, but you can administer them
from a central location. This should result in lower costs.

Multiserver configuration examples
There are various ways to set up multiple InfoPrint Manager servers and have
them work together. Below are some example configurations and the benefits they
provide.
v Install two InfoPrint Manager servers in the same physical location.

One of the servers contains all of the InfoPrint print queues and logical
destinations, and the other contains all of the actual destinations. In this setup,
you balance processing between the two systems by spooling and scheduling on
one system and transforming and printing on the other.

v Install one InfoPrint Manager server in the main office and one in each
branch office.

The namespace is installed on the InfoPrint Manager server in the main office,
and the other two servers are set up to share it. All three servers have logical
destinations, queues, and actual destinations defined in them, and the users
submit their print jobs to their local server. About 90% of the time, the servers
handle local print jobs, so it makes sense for each location to have its own
server. However, several times each week, the main office generates reports that
are needed at the branches. Instead of printing the reports and sending them
across town or faxing several hundred pages to each office, they simply send the
print job to printers at the branch offices. If necessary, the branch offices can do
the same thing.
In addition, because of the common namespace, the system administrator can
monitor all of the servers from a central location; if there’s a problem at one of
the branches, he can investigate it from the main office.

Important issues in interoperating environments
Before you set up an interoperating environment, consider these issues.
v Software

All interoperating systems must be at the same InfoPrint Manager software
level. Older versions of InfoPrint Manager will not work with newer versions of
InfoPrint when interoperating.

v Backups

You should always backup your systems before making any major configuration
changes. Follow the recommendations found in InfoPrint Manager for AIX:
Installation Instructions about which file systems should be backed up.

v How many servers can be interoperated?
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In theory, you can interoperate as many servers as you would like, however, the
performance of the servers will depend upon the primary server hardware. For
best performance, use the most powerful system that you have available for the
primary server.

v Which system should contain the namespace?

The namespace does not contain large volumes of data (so it doesn’t have to
reside on the system with the most disk space) and it doesn’t move a lot of data
across the network. However, because all of the other servers will rely on the
namespace server, it must be available and reliable. Put the namespace on the
system that has the most availability (always running), most reliability (doesn’t
have to be rebooted often), and is the most powerful. The namespace must be
located on an AIX system.

v InfoPrint Manager Security

All of the information that InfoPrint Manager Security uses to protect your
printing system (groups and Access Control Lists (ACLs)) is stored in the
namespace. When you share the namespace, the groups and ACLs that you set
on the namespace server apply to all of the servers; the groups and ACLs that
you set on the other servers before they joined the common namespace
disappear. As a result, you should wait until you have the interoperating
environment set up before you set up any security on the systems.

Configuring a primary AIX server with a secondary AIX server
Follow the appropriate instructions according to your configuration needs:

New secondary InfoPrint for AIX server

If you are installing InfoPrint Manager for the first time on an AIX system, and
you want to make the new system a secondary InfoPrint server, see InfoPrint
Manager for AIX: Installation Instructions for information about doing this during the
installation.

Once InfoPrint is installed on the secondary system, see “Installing secondary
InfoPrint servers” in InfoPrint Manager for AIX: Getting Started.

Creating a secondary InfoPrint server from a primary InfoPrint
server

If you have two or more independent InfoPrint Manager primary servers that you
want to change into secondary servers, see “Migrating from a primary server to a
secondary server” in the InfoPrint Manager for AIX: Installation Instructions.

Configuring a primary AIX server with a secondary Windows server

Important:

In order to interoperate InfoPrint Manager for Windows with InfoPrint Manager
for AIX:
v The AIX system must have AIX Fast Connect installed or another Server

Message Block (SMB) solution.

Note: Fast Connect is not supported on Microsoft Windows Vista or Microsoft
Windows Server 2008. Use an SMB solution.
OR
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v The Windows systems must have Microsoft Windows Services for UNIX
installed.

AIX Fast Connect is server software that allows AIX servers and workstations to
share files and printers with personal computer clients running Windows operating
systems. Because AIX Fast Connect uses industry-standard Microsoft networking
protocols, PC clients can access AIX files using Microsoft networking client
software. PC users can use remote AIX file systems directly from their machines
like local file systems. The namespace will appear on the network just like any
other Windows shared folder. AIX Fast Connect provides these services by
implementing the SMB networking protocol to run on NetBIOS over TCP/IP.

Microsoft PCNFS (Microsoft Windows Services for UNIX) allows a Windows
system to mount the exported AIX Network File System (NFS) that InfoPrint uses
to share the namespace.

By doing this set of procedures on both an InfoPrint AIX server and an InfoPrint
Windows workstation, you can configure InfoPrint Manager to support
interoperability between InfoPrint AIX servers and InfoPrint Windows servers.

When configuring InfoPrint Manager for AIX and Windows servers to support
interoperability, make sure that these rules are followed:
1. Each InfoPrint Manager server must be accessible by all other InfoPrint

Manager servers using the same IP address.
For example, if Server1 is an InfoPrint Manager AIX server with an IP address
of 9.99.155.122, then all other InfoPrint Manager servers must use
9.99.155.122 to access Server1.

2. The IP address for each InfoPrint Manager server must be the address that is
identified for the first (or primary) network card that is defined to that server.

3. All printer objects (whether logical destination, actual destination, or queue)
must have unique names if they are used by interoperating InfoPrint servers.
If the printer objects do not possess unique names, you might have trouble
viewing them through the InfoPrint Manager Interface from a non-namespace
server.

4. InfoPrint Manager Notifications should only run on the primary server and
should be stopped on the secondary servers.

LPD service for AIX can be used however, by submitting jobs with the lpr
command to actual destinations on the AIX server. The lpr command can also still
be used as before with Windows printer destinations (just not InfoPrint Manager
printers).

Setting up the InfoPrint AIX server for interoperability

Perform these procedures on your InfoPrint AIX server to prepare for
interoperability with an InfoPrint Windows server. These procedures presume that
you have installed InfoPrint Manager for AIX on your AIX server and have logged
onto the server as root.

Starting NFS and connecting the secondary server
1. Open a dtterm window and type: /etc/rc.nfs to either start the NFS daemon

or make sure that it has been started.
2. Open a dtterm window, type smit. This screen displays.
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3. From this panel, specify the InfoPrint Printing System → InfoPrint Utilities →
Configure Secondary Servers (NFS) → Link from Primary Server to Secondary
Server path.

4. Specify both the host name and the IP address of the InfoPrint Windows server
with which you intend to interoperate for the Secondary Server Host Name
and the Secondary Server IP Address fields respectively. For example, wserv1
and 9.99.193.120 represent the InfoPrint Windows server in the pop-up panel
displayed below:
You should specify no for the Is /ipdata used for job ticketing? field, unless
you are using this AIX InfoPrint Manager server with AIX Fast Connect to
allow for file sharing with an InfoPrint Submit Windows client for preflighting
jobs and saving RIPed files.
You should also allow the Retain secondary server previously defined? field to
default to yes if you have more than one InfoPrint server functioning as a
secondary server.

5. Once verified, click OK, and then click Done.
6. Return to the first SMIT panel displayed in step 2.

Adding users to and modifying permissions for FST security
groups
1. Set up the FST Security groups on your AIX server by taking the InfoPrint

Printing System → Security → Groups → Show Group path. From the Single
Select List pop-up dialog, you should see these three groups: acl_admin,
admin, and oper. There might be a fourth group, jobticketer, if the Job Ticketer
option of the POD feature is also installed.

2. Once you have verified the existence of these two groups, you should make
sure that users in the admin group can issue all the InfoPrint pd* commands.
From SMIT, take the InfoPrint Printing System → Security → Access Control →
Access Control for Operations → Show Access Control List path.

3. From the Single Select List pop-up dialog, highlight each command and make
sure thatGROUP:admin: r** displays for each command.
If a particular pd command does not show admin group read authority, use the
SMIT InfoPrint Printing System → Security → Access Control → Access Control
for Operations → Change Access Control List path to specify GROUP:admin in
the Users or Groups field of the Change Access Control List panel for that pd
command. Note that the admin group requires only read authority for each pd
command.
Note that you might have to do the preceding task only if you are migrating
from an InfoPrint Manager 3.1 system or earlier. If you have installed InfoPrint
Manager on a ″clean″ machine, the admin group will have read authority for
all pd commands by default.

4. Once complete, return to the first SMIT panel displayed in Step 2.
5. Take the InfoPrint Printing System → Security → Groups → Add Users to a

Group path. Then specify acl_admin for the Group Name field. Enter the name
of the Windows administrative user you normally log in to the InfoPrint
Manager for Windows server machine as for the User or Users to Add field.
For the remainder of this procedure we will refer to this Windows
administrative user as ipwinadmin*. Note that ipwinadmin must be followed by
an asterisk (*) to account for the fully qualified host name. (For example,
ipwinadmin@ipwinservermachine.infoprint.com.)
From the Add Users to a Group panel, specify admin for the Group Name
field. Enter the name of the Windows administrative user you normally log in
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to the InfoPrint Manager for Windows server machine as for the User or Users
to Add field. You do not have to do this step for the oper group.

6. Once complete, click OK to make sure the changes take effect and return to the
first SMIT panel displayed in Step 2 on page 259.

Now you can proceed to “Setting up the ipwinadmin id on a Windows domain
controller.”

Setting up the ipwinadmin id on a Windows domain controller

On the Windows domain controller server for the domain where your servers
reside, you must do this task to make sure that the InfoPrint Manager Windows
servers can access the namespace.
1. Log on to the Primary Domain Controller for the domain that your InfoPrint

Manager servers operate in as a domain administrator.
2. From the Start menu, access the Programs → Administrative Tools →

Computer Management path.
3. From the Computer Management window, click the plus (+) sign next to the

Local Users and Groups list.
4. Click the Users folder and select New User from the Action pull down menu

at the top.
5. In the User name field type ipwinadmin. In the Password and Confirm

Password fields type a password value.
We recommend that you select Password never expires so you don’t have to
change the password and update all of your servers on a regular basis.

6. Click the Create button and close the dialog (it will be prompting you to add
another user’s information).

7. From the User window, open the ipwinadmin that you just finished creating
by double-clicking on the list item.

8. Click on the Member Of tab, click Add, then double-click Administrators.
9. Click OK.

10. Click OK a second time to finish.

Creating the ’ntuser’ ID on the InfoPrint AIX server

This procedure creates the example ntuser ID that the InfoPrint Windows server
will use to share and manage namespace directories and files that reside on the
InfoPrint AIX server.
1. Install AIX Fast Connect.
2. Enable namespace sharing: run SMIT and proceed to InfoPrint Printing

Systems → InfoPrint Utilities → Configure Fast Connect for InfoPrint Manager
→ Enable Windows NT/2000 namespace sharing with AIX server. This will
share the /var/pddir/default_cell for Windows systems.

3. Click OK to save the changes and exit the SMIT interface.
4. Login to the server as root and set the initial password.
5. Login as ntuser with the initial password, then change the password for

ntuser. Remember this password, as you will need it later in this procedure.

Ensuring correct AIX file permissions for interoperability
1. Log on to the server as root.
2. From a dtterm window, type cd /var/pddir/default_cell.
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3. Ensure that all the files residing in this directory have the correct permissions
to be read by the InfoPrint Windows server by typing chmod -R 774 * .

4. Ensure that all the files residing in this directory belong to the correct group by
typing chgrp -R printq * .
If these last two steps have been done correctly, entering an ls -l at the
command line should display these permissions and group values:

drwxrwxr** 3 root printq 512 .... acl
drwxrwxr** 3 root printq 512 .... printers
drwxrwxr** 2 root printq 512 .... queues
drwxrwxr** 2 root printq 512 .... servers
-rwxrwxr** 1 root printq 4 .... version

5. Complete your preparations on the InfoPrint AIX server by logging in as
ntuser.

Once you have completed these steps, the InfoPrint AIX server is ready for
interoperability.

Configure Windows servers for interoperability
Some print environments require more than one InfoPrint Manager server to
handle their print management. If you are adding one or more InfoPrint Manager
for Windows servers to your print environment, this section will tell you what you
need to do to make those servers work with the InfoPrint Manager for AIX server.

Notes:

1. In an interoperating environment that includes an AIX server and Windows
servers, the namespace will reside on the AIX server.

2. You can only install one InfoPrint Manager server on a given Windows
workstation or server.

3. If your users will be submitting jobs directly to actual destinations, the actual
destination and the associated queue and logical destination must be on the
same server.

4. Once you have your multiserver system running, if one of your Windows
servers shuts down or is restarted, that InfoPrint Manager server will not
restart automatically when the system restarts. You must open the Management
Console for that server and start it manually.

Installing MS Services for UNIX on the InfoPrint Windows
servers

You must do this task on each Windows server:
1. Create a new user account: ntuser.
2. Using the CD-ROM, install Microsoft Windows Services for UNIX from the

″Add-on Pack for Microsoft Windows.″
3. Reboot each InfoPrint Windows server.

Note: There are other solutions that enable mapping from an NFS file system to a
Windows system, but we recommend the simplest: Microsoft Windows Services for
UNIX (PCNFS).
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Grant appropriate user rights to the domain user on all InfoPrint
Manager Windows servers

To make sure that the Windows InfoPrint Manager servers can run as a Windows
service using the domain userid ntuser, you must make sure that this userid has
the proper level of authority on each Windows InfoPrint Manager server system.
1. Log on to one of the systems as a user who is a member of the Domain

Administrators group.
2. Click the Windows Start button and select Settings → Control Panel.
3. In the Control Panel window, double-click the Administrative Tools icon.
4. In the Administrative Tools window, double-click the Local Security Policy

icon.
5. In the right pane of the Local Security Settings Window, double-click Local

policies.
6. Double-click User Rights Assignment in the right pane.
7. In the list of user rights, select Act as part of the operating system and

double-click it.
8. In the Local Security Policy Setting dialog, click Add.
9. In the Select Users or Groups dialog, click the arrow on the drop-down list

box and select the domain that your InfoPrint Manager servers exist in.
Find and select the domain user you created, and click Add.

10. Click OK in the Select Users or Groups dialog.
11. Click OK in the Local Security Policy Setting dialog.
12. Repeat from step 7 for two other user rights: Create permanent shared

objects and Log on as a service.

Verifying access to the AIX namespace that allows
interoperability on Windows

From each InfoPrint Windows server, you must verify that you have access to the
namespace on the InfoPrint AIX server. You can do this by mapping a network
drive (as ntuser with the ntuser password from step 5 on page 260) from the
Windows server to the shared namespace on the InfoPrint AIX server.
1. From the main Windows view, right-click the My Network Places icon, select

Map Network Drive. In the dialog, use the Folder field to specify:
\\aix_servername\var\pddir\default_cell

Where aix_servername is the name of the InfoPrint AIX server.
2. Check the Reconnect at Login check box.
3. Click on the Connect Using Different User Name link.
4. A dialog box will open asking for a username and password associated with

ntuser. Specify the ntuser password from step 5 on page 260 in the Password
field.

5. Click OK and the NFS Client window opens.
6. Click OK again. A small notification window should appear that says NFS

Login Successful.
Since the NFS Client was set up in the section Configuring the NFS Client to
Access the Namespace, click OK.

7. Click Yes to accept the current login and Finish to map the drive.
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If the drive mapped correctly, a new window should open to the mapped
drive’s contents, and the NFS Client and Map Network Drive windows
should be gone.

Configuring the ’ntuser’ ID for interoperability on the InfoPrint
Windows servers

Make sure that you complete this procedure on all InfoPrint Windows servers.

Note: Once this procedure is completed, make sure that you do all namespace
administration from the Management Console on the InfoPrint Windows server,
not the InfoPrint AIX server.

On all Windows servers, do these steps:
1. Log on as user ipwinadmin .
2. From the Start menu, click Programs → InfoPrint Manager → Management

Console.
3. Stop the server by either clicking the Stop toolbar button or clicking File →

Stop Server.
4. Access the Edit → Service Account/Domain path.
5. Specify the domain name in the Domain field, the account you created in the

User account field, and the password in the Password field.
6. Click OK.

Note: A notification server was installed with each of your InfoPrint Manager
servers. However, now that the namespace is shared, you only need to run
one of them . The notification server must be run on the namespace server.
Disable all but one of the InfoPrint Manager Notification servers.

7. Click Edit → Service Configuration.
8. In the Settings group box, clear both the Run notification server on this

system and Run InfoPrint Manager LPD service check boxes.
9. Clear the Base namespace path field and type the drive letter that you want

to use to link to the namespace followed by a colon (for example, type x:).
Use the same drive letter that you used when mapping the network drive.

10. In the Remote namespace folder field, enter the Universal Naming
Convention (UNC) name of the shared directory on the namespace server in
this format: \\namespaceserver\sharename. The sharename of the namespace on
an AIX server is default_cell. For this example, \\prince\var\pddir\
default_cell .

11. Click OK.
12. Restart all of the InfoPrint Manager servers by selecting File → Start Server

on each Management Console.
13. Verify that all of the servers are now sharing the namespace.

v Log on to any one of the machines that holds an InfoPrint Manager server,
open a command prompt.

v Start the InfoPrint Manager Administration Interface.
v Click Server → Show All Servers.
You should see a list of all of the servers that are using the namespace. If any
of them do not appear, stop the servers and check the settings that you
changed in step 7 for that server.
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Verifying the authority of the ipwinadmin ID

Use this procedure to verify that the ipwinadmin id has permission to both modify
security groups and issue all the InfoPrint pd* commands.
1. Verify that the InfoPrint servers are interoperating by doing step 13 of

“Configuring the ’ntuser’ ID for interoperability on the InfoPrint Windows
servers” on page 263.

2. Ensure that you created a user named ipwinadmin in the domain.
3. Log on to the InfoPrint Windows server as user ipwinadmin.
4. From the Start menu, click the Programs → InfoPrint Manager → Management

Console path.
5. From the left pane, click the Security item.
6. Double-click Groups item.
7. From the Groups view in the right pane, highlight the acl_admin item and

select open from the drop-down menu.
8. Click the Add... button.
9. In the Add Member to Group dialog, type ipwinadmin* in the field provided.

In the Groups view, you should be able to see ipwinadmin listed in the
Members column for the admin group.

10. From the Groups view in the right pane, highlight the admin item and select
open from the drop-down menu.

11. Click the Add... button.
12. In the Add Member to Group dialog, type ipwinadmin* in the field provided.

In the Groups view, you should be able to see ipwinadmin listed in the
Members column for the admin group.

13. Log on to the InfoPrint Windows server as ipwinadmin.
You should be able to create and modify security groups and issue all the
InfoPrint pd* commands.
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Chapter 26. Setting up high speed printers for spacing

In InfoPrint Manager, moving from page to page in a job is called spacing:
v Forward spacing is moving to a point later in the job (such as skipping from page

10 to page 15).
v Backspacing is moving to a point earlier in the job (such as backing up from page

40 to page 20).

For spacing to work effectively on the InfoPrint 2000 for AFP printing, InfoPrint
3000, InfoPrint 4000, and InfoPrint 4100, you must first enable the printer to work
with the Simple Network Management Protocol (SNMP) and allow SNMP to
configure the printer. These settings allow you to use the InfoPrint Manager GUI to
stop a printer very quickly (in ten seconds or less) when you need to, instead of
having to wait for all of the pages of a job that have been buffered to print.

Enabling SNMP on an InfoPrint 2000 for AFP printing
1. On the display/touch screen on the touch screen/printer console, open the

Printer definition pull-down menu.
2. Select Remote Access.
3. On the SNMP tab:
v Select the Enable SNMP Agent and Allow SNMP to configure the printer

check boxes.
v In the Communities list, touch the name of the community you will be using

to access the printer and verify the settings. Make sure that the community
has Write access to the printer.

4. Touch OK to close the window.
5. On the main screen of the console, make sure that the attachment type you will

be using is enabled.
6. If you changed the Enable SNMP Agent or the Allow SNMP to configure the

printer setting, shutdown and restart the printer to make the changes take
effect.

7. Disable the printer and enable it again to refresh the printer configuration
information in the server.
a. Start the InfoPrint Manager Administration GUI.
b. In the GUI, find the InfoPrint Manager printer (actual destination) that

corresponds to this printer and select it.
c. Use the GUI to disable the printer.
d. Use the GUI to enable the printer again.

Enabling SNMP on an InfoPrint 3000 or an InfoPrint 4000 printer that
uses the operator console

The Operator console is the standard console for the InfoPrint 3000 and the
InfoPrint 4000.
1. On the display/touch screen on the Operator console, open the Configure

pull-down menu.
2. Select Remote Access.
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3. Under Select a Remote Access, select SNMP.
4. Under Enabled, select Yes.
5. Under Allow to Configure, select Yes.
6. Touch OK to close the window.
7. You will be prompted to restart the printer so that these settings can take effect.

Restart the printer, and wait for it to power back up before you continue.
8. Disable the printer and enable it again to refresh the printer configuration

information in the server.
a. Start the InfoPrint Manager Administration GUI.
b. In the GUI, find the InfoPrint Manager printer (actual destination) that

corresponds to this printer and select it.
c. Use the GUI to disable the printer.
d. Use the GUI to enable the printer again.

Enabling SNMP on a printer that uses the Enhanced Operator Console

The Enhanced Operator Console is the standard console for the InfoPrint 4100 and
is available as an upgrade for the InfoPrint 4000.
1. On the Enhanced Operator Console, touch Printer definition at the top of the

screen.
2. On the left side of the screen, touch Remote Access.
3. In the Communities list, select the name of the community you will be using to

access the printer and verify the settings. Make sure that the community has
Write access to the printer.

4. Select the SNMP Agent Enabled and Allow SNMP to Configure Printer
checkboxes, so they both say Yes.

5. Touch OK to save the settings.
6. You might be prompted to restart the printer so that these settings can take

effect. Restart the printer, and wait for it to power back up before you continue.
7. Disable the printer and enable it again to refresh the printer configuration

information in the server.
a. Start the InfoPrint Manager Administration GUI.
b. In the GUI, find the InfoPrint Manager printer (actual destination) that

corresponds to this printer and select it.
c. Use the GUI to disable the printer.
d. Use the GUI to enable the printer again.
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Chapter 27. Configuring InfoPrint Manager for AIX to support
the InfoPrint 5000 printer Models CS1 and CD1/2

The InfoPrint 5000 printer Models CS1 and CD1/2 are set up so that PDF and
PostScript Level 3 jobs are submitted by dropping them into printer hot folders.
The printer controller uses Microsoft Shared Folders as hot folders to receive the
print jobs. From a print submission workstation or server, you can map the
top-level hot folder directory to your local system and copy files to the individual
hot folder to get the jobs to the printer. Hot folders can be configured with unique
job attributes.

Note: All hot folders must be created from the InfoPrint 5000 printer operator
panel.

The InfoPrint 5000 printer features a simple 2-up function that can be used for
slit-merge finishing applications. InfoPrint Manager attributes are not passed to the
InfoPrint 5000 printer. For each hot folder that is defined by the printer operator, a
corresponding logical/actual destination pair needs to be defined on InfoPrint
Manager. The InfoPrint 5000 printer requires a 1:1 relationship for logical to actual
destinations.

If you need to configure the InfoPrint Manager for AIX to support the InfoPrint
5000 printer Models CS1 and CD1/2, follow these steps:
1. (Optional) If you do not need to support the AFP or line data input data types,

please ignore this step.
If you want to support the AFP or line data input data types, install the
afp2pdf PRPQ for InfoPrint Manager or afp2pdf PRPQ for InfoPrint Transform
Manager.
See the related documents in PRPQ offerings for detailed instructions.

2. Map a network drive from the local machine to the printer’s hot folder named
SV-110 HotFolder. SV-110 HotFolder is the required name. Ask your Customer
Support Specialist for the InfoPrint 5000 printer’s userid and password. You can
have up to 100 hot folders under SV-110 HotFolder. See “Mapping the Hot
Folder” on page 268 for more information.

3. Run the scripts to create a new BSD DSS printer and the custom transforms to
be assembled into the transforms list of the BSD DSS printer. Depending on
your workflow, you might need to run the scripts many times: once to
reference each PostScript shared folder on the InfoPrint 5000, and again to
reference each PDF shared folder on the InfoPrint 5000.
You need a unique hot folder subdirectory under the SV-110 HotFolder for each
type of PDF and PostScript that you send to the InfoPrint 5000, and you also
need a unique actual destination/logical destination pair for each type of PDF
and PostScript. Let’s say you have two types of PDF and three types of
PostScript, see Table 35 for sample names.

Table 35. Suggested naming convention for InfoPrint 5000 hot folders

Type of PDF or
PostScript

Actual Destination
name (limited to 8
characters)

Logical Destination
name

Hot Folder
subdirectory name

PDF ledger 5K-PDF1 5k-pdf1-ld-ledger PDF ledger
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Table 35. Suggested naming convention for InfoPrint 5000 hot folders (continued)

Type of PDF or
PostScript

Actual Destination
name (limited to 8
characters)

Logical Destination
name

Hot Folder
subdirectory name

PDF letter 5K-PDF2 5k-pdf2-ld-letter PDF letter

PostScript ledger size 5K-PS1 5k-ps1-ld-ledger PS ledger

PostScript letter size 5K-PS2 5k-ps2-ld-letter PS letter

PostScript ABC
Statement size

5K-PS3 5k-ps3-ld-abc PS ABC Statement

See “Running scripts” on page 269 for detailed instructions.

Note: Only the Customer Support Specialist can change the user name and the
password from the InfoPrint 5000 printer control panel. Work with your
Customer Support Specialist if you need to have them change the user name
and password.

4. After a PDF or PostScript print job is copied to the appropriate InfoPrint 5000
hot folder, the print job is no longer available on InfoPrint Manager unless the
job-retain-until or job-retention-period job attributes are specified for the job.

Mapping the Hot Folder

You should map or mount the Hot Folder provided by the InfoPrint 5000 printer
onto your local system. To implement this, you need to install and configure the
Server Message Block Filesystem (SMBFS) on the AIX operating system. The
SMBFS allows access to shares on SMB servers as local filesystems on AIX. In this
filesystem, users can create, delete, read, write, and modify the access times of files
and directories. But the owner or access mode of files and directories cannot be
changed.

To install and configure the SMBFS on the AIX operating system, follow these
steps:
1. Install the bos.cifs_fs package from the AIX installation kit, with administrative

right on the AIX operating system. Then the device nsmb0 will be created. This
device allows the mount command to establish a connection between the client
and the Server Message Block (SMB) server.

2. Create a directory that will be used as the local mount point, such as ip5k.
3. Ping the printer either by the printer name or the printer’s IP address.
4. Map the directory to the local system. Ask your Customer Support Specialist

for the InfoPrint 5000 printer’s userid and password. To implement this, you
can choose either of these two methods:
v Use the smitty utility, smitty fs, which is entered from the command line to

run the mount command after gathering all the necessary information:
smitty fs

Mount a File System
File System name: "/sv-110 hotfolder"
DIRECTORY over which to mount: name of the local mount point, such as /ip5k
TYPE of file system: press F4 and select cifs
REMOTE NODE containing the file sytem to mount: printername/userid/pw

Where:
printername is the printer’s IP address or a printer name like ipc01.
userid is the userid supplied when the printer was installed
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pw is the password that was supplied when the printer was installed
v Use the AIX mount command:

mount -v cifs -n server/user/pass remotePathOfHotFolder localPathOfHotFolder

where:

server Specify the name of the remote server.

user Specify the name of the remote user.

pass Specify the password of the remote server for the user name that the
user parameter specifies.

remotePathOfHotFolder
Specify the complete name of the Hot Folder on the InfoPrint 5000
Controller.

localPathOfHotFolder
Specify the complete name of the Hot Folder as it will appear on the
local system.

Attention:

1. Use quotes to enclose the name (″/sv-110 hotfolder″) because the hot folder
name contains spaces.

2. The mount command does not persist across AIX operating system reboots.
You must rerun the mount command after a system reboot. Follow step 4 to
enter the mount command again.

Running scripts
When you need to enable the InfoPrint 5000 support, some scripts should be run
on the InfoPrint Manager server, to create a new BSD DSS printer (together with a
new logical destination and a new or existing queue), to create the custom
transforms that allows the InfoPrint Manager product to convert the input data to
the corresponding output data format, and to assemble the list of transform objects
previously created into the BSD DSS printer. To run these scripts, you can call an
AIX script run_customization_1.sh, with administrative rights both on the AIX
system and on the InfoPrint Manager server.

The run_customization_1.sh script has this syntax:
run_customization_1.sh nameOfServer nameOfAD nameOfQueue nameOfLD nameOfLocalFolder

where:

nameOfServer
Specify the name of the InfoPrint Manager server where to create the
destination.

nameOfAD
Specify the name of the new actual destination that will be created.

nameOfQueue
Specify the name of an existing queue or a new one that will be created, if
there is no queue named nameOfQueue.

nameOfLD
Specify the name of the new logical destination that will be created.
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nameOfLocalFolder
Specify the name of the local mapped directory for the Hot Folder
provided by the InfoPrint 5000 printer.

For example:
run_customization_1.sh sage ip5k ip5k-q ip5k-ld "/ip5k/Default PS"

Where:
ip5k is the local folder
Default PS is the remote sub-folder

Limitations of InfoPrint 5000 printer support
This support has these limitations:
1. The afp2pdf transform does not support n-up.
2. The afp2pdf transform supports black and white text, color text and GOCA.
3. The afp2pdf transform does not support CMR.
4. The number of copies is limited to 1.
5. Input data streams are limited to line-data, AFP, PDF, and PS data types.
6. There are limitations for output print fidelity of the afp2pdf transform.
7. The accounting information is available only when you use the pdaccount

administrative command.
8. No accurate job completion status is available. Only the page count is

provided as feedback.
9. Any attributes relevant to PS and PDF input files are not supported, because

these files will be simply passed through.
10. InfoPrint Manager submission clients Submit Express and InfoPrint

JobTicketer are not supported.
11. The input AFP files together with the formdef are the only formatting controls

of the input job. Other formatting controls such as output format (booklet,
reverse order) are not supported.
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Chapter 28. Configuring the InfoPrint 5000 Models AS1 and
AD1/2 to print PDF and PostScript

Printing PDF and PostScript files on the InfoPrint 5000 printer Models
AS1 and AD1/2 with hot folders from InfoPrint Manager for AIX

To print PDF and PostScript files on the InfoPrint 5000 printer Models AS1 and
AD1/2 with InfoPrint Manager for AIX, you use can use hot folders.

When you use hot folders, you must complete minor configuration tasks.

Verifying bos.cifs_fs fileset is installed
To print to an InfoPrint 5000 printer hot folder from InfoPrint Manager for AIX
requires the bos.cifs_fs fileset.

To verify that the bos.cifs_fs fileset is installed:
1. Enter this command:

lslpp -l | grep cifs

2. You see results similar to these:
bos.cifs_fs.rte 5.3.0.61 COMMITTED Runtime for SMBFS
bos.cifs_fs.smit 5.3.0.60 COMMITTED SMIT Interface for SMBFS
bos.cifs_fs.rte 5.3.0.61 COMMITTED Runtime for SMBFS
bos.cifs_fs.smit 5.3.0.0 COMMITTED SMIT Interface for SMBFS

3. If the bos.cifs_fs fileset is not installed, contact your System Administrator.

Connecting to the InfoPrint 5000 hot folder
To connect to an InfoPrint 5000 printer hot folder from InfoPrint Manager for AIX,
you need to issue a mount command.

To issue a mount command:
1. Log in as root.
2. Enter this command for Model AS1:

>mount -v cifs -n printerIPAddress/none -o fmode=707 /simplex /mnt

3. Enter this command for Models AD1/2:
>mount -v cifs -n printerIPAddress/none -o fmode=707 /duplex /mnt

4. Press enter when prompted to enter a password.

Note: If either InfoPrint Manager for AIX or the InfoPrint 5000 printer are
shutdown, you need to re-issue the mount command.

Running scripts before printing PDF and PostScript files
All hot folders must be created from the InfoPrint 5000 printer operator panel. The
hot folders can have different job attributes, such as the actual destination to print
the job (actual-destination-requested job/default job attribute) or the combination
of start, end, or separator sheets to use with a job (auxiliary-sheet-selection
job/default job attribute).

To enable the InfoPrint 5000 hot folder support, run scripts on the InfoPrint
Manager server to create a new BSD DSS printer (together with a new logical
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destination and a new or existing queue), to create the custom transforms that
allows InfoPrint Manager to convert the input data to the corresponding output
data format, and to assemble the list of transform objects previously created on the
BSD DSS printer.

To configure the InfoPrint Manager server to enable hot folder support on the
InfoPrint 5000 printer:
1. Log on to your InfoPrint Manager server.
2. Locate the scripts provided by InfoPrint Manager: /usr/lpp/pd/bin
3. Type this commands: run_customization_1.sh nameOfServer nameOfAD

nameOfQueue nameOfLD nameOfLocalFolder/yourhotfolder
nameOfServer

Specify the name of the InfoPrint Manager server where to create the
destination.

nameOfAD
Specify the name of the new actual destination that will be created.

nameOfQueue
Specify the name of the existing queue or a new queue.

nameOfLD
Specify the name of the new logical destination that will be created.

nameOfLocalFolder
Specify the name of the local mount point.

yourhotfolder
Specify the name of the hot folder created at the InfoPrint 5000 printer
console.

4. Verify that a new actual destination and logical destination were created by
checking the InfoPrint Manager Administration GUI.

5. Submit a PDF or PostScript test job to the InfoPrint 5000.

Example script

run_customization_1.sh sage ip5k ip5K-q ip5k-ld "/mnt/hmi_hf"

ipk5 is the local folder.

hmi_hf is the remote sub-folder
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Chapter 29. Using InfoPrint Manager with the InfoPrint Color
130 Plus

This procedure takes you through steps to submit different kinds of jobs to the
InfoPrint Color 130 Plus using different methods. This list describes these
scenarios:
v An Advanced Function Presentation™ (AFP) document created in a page layout

application is submitted through InfoPrint Manager for printing to the InfoPrint
Color 130 Plus using the command line. Color images are transformed offline
using the AIX command line.

v A PostScript document is submitted for printing to the InfoPrint Color 130 Plus
using InfoPrint Submit Express.

v A document is submitted for printing to the InfoPrint Color 130 Plus using MVS
Download.

Setting up
The scenarios in this procedure assume that you have completed these tasks before
submitting the job to the printer, if they are applicable.
v Built a data stream
v Transformed color images

See “Configuring and Using InfoPrint Manager with the InfoPrint Color 130 Plus”
on page 7 for specific information about configuring InfoPrint Manager for AIX
with the InfoPrint Color 130 Plus.

Building a data stream
Build your AFP data stream by using any AFP statement generator or application.
Refer to ″Understanding Form Definitions and Page Definitions″ in Print Services
Facility for z/OS: User’s Guide for more information about AFP architecture.

Build your PostScript data stream with any application that generates PostScript,
such as Microsoft Word with a PostScript driver. InfoPrint Manager sends
PostScript data streams to be transformed and RIPped at the server.

Transforming color images
Color images are transformed automatically at the server when you submit the job
to the printer. However, you can transform your images separately by running
transforms from the AIX command line without printing the generated output
before submitting the job. Jobs run more quickly if the images have already been
transformed.

InfoPrint Manager provides transform programs for most data streams, such as
GIF, PS, and PDF. The transforms convert the incoming data stream into the AFP
format. For example, to transform the file mypicture to AFP using the gif2afp
transform, enter this command:
gif2afp mypicture
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By default, these transform programs produce monochrome FS10 output. To
produce finely-tuned color FS45 output, see the list of flags or options and values
for each transform in ″InfoPrint Object Attributes″ in the InfoPrint Manager:
Reference.

Note: For best results, transform TIFF, JPEG, and GIF images from the AIX
command line.

Using and changing color and resource attributes
You need to decide which color and resource attributes you use or need to change
when you submit your job. The color and resource attribute-value pairs that are
specific to the InfoPrint Color 130 Plus include these:
v color-profile

v color-profiles-supported

v color-bits-per-plane

v color-bits-per-plane-supported

v color-rendering-intent

v color-toner-saver

v color-toner-saver-supported

v resource-context-presentation-object-container

v presentation-object-container-extraction-mode

See ″InfoPrint Object Attributes″ in the InfoPrint Manager: Reference for more
information about these attributes.

Using color attributes
The color attributes can be modified from the command line using the pdset
command or in the InfoPrint Manager Administration GUI. See ″InfoPrint Object
Attributes″ in the InfoPrint Manager: Reference for the correct command syntax
when using the command line.

color-profile
Use this attribute to specify the color profile, if any, to be used by PostScript jobs.
This attribute can be equal to:
v SWOP

v Euroscale

v none

The default value is none, which means that the color rendition will be dependent
on the output device.

The title of this attribute in the InfoPrint Manager Administration GUI is Color
profile.

color-profiles-supported
Use this attribute to identify which color profiles can be used by the actual
destination when printing a document. This attribute can be equal to one or more
of these:
v SWOP

v Euroscale

v none
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The default values for the InfoPrint Color 130 Plus are SWOP, Euroscale, and
none. For all other actual destinations the default is equal to none.

The title of this attribute in the InfoPrint Manager Administration GUI is Color
profiles allowed.

color-bits-per-plane
This attribute specifies whether the transform is to produce monochrome (FS10) or
color images (FS42 or FS45). You can set this attribute equal to:
v 0–bits (monochrome FS10)
v 1–bit (color FS42)
v 8–bits (color FS45)

The default for InfoPrint Color 130 Plus is 8–bits. For all other actual destinations,
the default is 0–bits.

Note: If the attribute is set to 1–bit for a PostScript data stream it will fail.

The title of this attribute in the InfoPrint Manager Administration GUI is Color
bits per plane.

color-bits-per-plane-supported
This attribute specifies the types of images supported on the actual destination
when printing a document. This attribute can be equal to one or more of these:
v 0–bits (monochrome FS10)
v 1–bit (color FS42)
v 8–bits (color FS45)

The default values for InfoPrint Color 130 Plus are:
v 0–bits (monochrome FS10)
v 1–bit (color FS42)
v 8–bits (color FS45)

The title of this attribute in the InfoPrint Manager Administration GUI is Color
bits per plane allowed.

color-rendering-intent
While the InfoPrint Color 130 Plus produces vibrant full-color images, including
images that contain gradients and shading, it is not able to reproduce every shade
of every color. The color-rendering-intent attribute determines what InfoPrint
Manager does when it encounters a shade in a PostScript image that the InfoPrint
Color 130 Plus cannot reproduce exactly.

There are two possible values for color-rendering-intent:

Relative
When InfoPrint Manager encounters a color that InfoPrint Color 130 Plus
cannot reproduce, it substitutes the closest color value that it can
reproduce.

Perceptual
When InfoPrint Manager encounters a color that InfoPrint Color 130 Plus
cannot reproduce, it adjusts all of the colors in the image so that they
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maintain their color relationships to each other. The result is an image that
is pleasing to the eye, but that might not look exactly like the original
image.

The default value is Relative.

You can set the color rendering intent value on a print job, a default document, or on
an actual destination using either the command line or the InfoPrint Manager
Administration GUI. The title of this attribute in the InfoPrint Manager
Administration GUI is Color rendering intent.

color-toner-saver
When cyan, magenta, and yellow are combined in a certain proportion, the result
approximates black. When the color-toner-saver attribute is set to yes, the
proportion of cyan, magenta, and yellow are reduced and substituted with black
toner, which reduces the amount of color toner used. You can enter the values:
v true or yes

v false or no

The default value is false, meaning that you do not want to use this attribute.

The title of this attribute in the InfoPrint Manager Administration GUI is Color
toner saver.

color-toner-saver-supported
This attribute identifies the values that can be specified for color-toner-saver.

The title of this attribute in the InfoPrint Manager Administration GUI is Color
toner saver allowed.

Using resource attributes
The resource attributes can be modified from the command line using the pdset
command or in the InfoPrint Manager Administration GUI. See ″InfoPrint Object
Attributes″ in the InfoPrint Manager: Reference for the correct command syntax
when using the command line.

resource-context-presentation-object-container
This attribute adds paths to the directory that InfoPrint searches for presentation
object containers (also called data object resources), such as EPS or PDF pages, for
the actual destination.

The title of this attribute in the InfoPrint Manager Administration GUI is Location
of presentation object containers.

presentation-object-container-extraction-mode
This attribute specifies the degree of optimization tried by color transforms. The
possible values are:
v ignore (generates the document without resources by ignoring presentation

object containers)
v inline (identifies and extracts the resources in a document for use)

The default value is ignore.

Note: Inline transforms always use an extraction mode of ignore.
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The title of this attribute in the InfoPrint Manager Administration GUI is
Presentation object container extraction mode.

Using the InfoPrint Manager Administration GUI to change
color and resource attributes

The InfoPrint Manager Administration GUI is an interface for managing InfoPrint
Manager jobs, queues, logical destinations, and actual destinations, such as
printers. It runs on multiple platforms, so you can use it either from a Windows
workstation, an AIX workstation, or directly on the AIX InfoPrint Manager server
console.

From the server or from remote work stations, operators can use this interface to
monitor all jobs and printers in the system and to route jobs appropriately to
increase enterprise-wide printing productivity. With the InfoPrint Manager
Administration GUI, you can change the color and resource attributes.

Starting the InfoPrint Manager Administration GUI

To open the InfoPrint Manager Administration GUI from the Windows desktop,
double-click any of the InfoPrint Administration icons.

You can start the InfoPrint Manager Administration GUI from an aixterm window.
For example, to open an advanced view, type ipguiadvadm at the AIX command
line. You can also use the basic (ipguibasicadm) view.

Changing the attributes

Now that you have opened one of the views of the InfoPrint Manager
Administration GUI, you can change the attributes in the actual destination. Follow
this procedure to set the attributes using the GUI.
1. Click your InfoPrint Color 130 Plus actual destination.
2. Select Options → Customize.
3. In the Customize dialog, click the Printer tab.
4. In the Action column, find Change Tuning, Change AFP Resources, and

Change AFP Color, and select the check boxes in the Menu column next to
them.
This step adds these tasks to the Printer menu. If you want to add other tasks
to the Printer menu or to any other menu, you can do it now or you can wait
until later.

5. Click OK to apply the settings and close the dialog.
6. Select Printer → Change AFP Resources to open the Change AFP Resources

dialog. These fields allow you to specify where resources, such as fonts and
presentation object containers, are located. See“Identifying where to store AFP
resources” on page 9.

7. In the Change AFP Resources dialog, find the Location of presentation object
containers field and type the path where your presentation object containers
are stored. If they are stored in more than one location, list all of the paths
separated with colons (:), for example:
/resources/containers:/dept123/priv-pres-obj- containers:/dept123/
public-pres-obj-containers

8. Fill in any other fields that are appropriate. For example, if you use form
definitions, fill in the Location of form definitions field.

9. Click OK to apply the settings and close the dialog.
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10. Select Printer → Change AFP Color to open the Change AFP Color dialog.
These fields allow you to modify the color attributes in your job. See “Using
color attributes” on page 274 for more information.

11. Click OK to apply the settings and close the dialog.
12. Select Printer → Change Tuning to open the Change Tuning dialog. These

fields allow you to modify resource attributes in your job. See “Using resource
attributes” on page 276 for more information.

13. Click OK to apply the settings and close the dialog.

Sending an AFP job to the printer using the AIX command line
In this example, you have created a document using an AFP statement generator.
This job contains color images that you decide to transform offline. You now want
to submit that document through InfoPrint Manager to the InfoPrint Color 130
Plus using the command line.

Setting up assumptions
This scenario assumes that you have completed these tasks:
v Built an AFP data stream
v “Identifying where to store AFP resources” on page 9
v Transformed color images

See “Setting up” on page 273 for more information.

Using AIX commands
On any AIX system, the InfoPrint AIX client allows authorized users to use these
InfoPrint commands:
v pdls

Lists selected attribute values for a job, destination, or other InfoPrint object.
v pdpr

Submits a job to a logical destination.
v pdq

Queries the status of selected jobs, of all jobs submitted to a logical destination,
or of all jobs assigned to an actual destination.

See InfoPrint Manager: Reference or the associated man pages for a complete list of
flags and attributes to use with these commands.

Submitting the job

Complete these steps to submit the job.
1. To determine whether the logical destination IC130P-ld is ready to receive jobs,

type:
pdls -c destination -r "enabled" IC130P-ld

You will see this message if the logical destination is enabled:
enabled=true

2. To submit the file MyJob to the logical destination IC130P-ld and request
two-sided printing and the color-toner-saver attribute, type:
pdpr -d IC130-ld -x "sides=2 color-toner-saver=true" MyJob
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Note: The page size and orientation that is specified in the job and in InfoPrint
Manager must match that specified at the AFCCU. Otherwise, the job will print
on the page size and with the orientation specified at the AFCCU.

3. To query all the jobs that you submitted to logical destination IC130P-ld, type:
pdq -d IC130P-ld

In the previous examples –d refers to the logical destination and –x refers to the
attribute string that contains the attribute-value pairs you want to include.

You can use these attributes from the AIX command line or you can change them
in the InfoPrint Manager Administration GUI:
v color-bits-per-plane

v color-bits-per-plane-supported

v color-rendering-intent

v color-toner-saver

v color-toner-saver-supported

v resource-context-presentation-object-container

See “Using and changing color and resource attributes” on page 274 for details on
when and how to use these attributes.

Sending an AFP job with color images to the printer using InfoPrint
Submit Express

You have created an AFP document using a page layout application and are using
InfoPrint Submit Express to send it to the InfoPrint Color 130 Plus.

Note: This example uses InfoPrint Submit Express for Windows.

Setting up assumptions
This scenario assumes that you have completed these tasks:
v Built a data stream
v Installed InfoPrint Submit Express

See “Setting up” on page 273 for more information.

Submitting the job

When using InfoPrint Submit Express to create the job ticket, you must consider a
number of things to prepare a job for printing. Primarily, however, during this
phase of the process, you will identify and organize the printable files and other
resources that make up the job. As you complete the job ticket, Submit Express
provides a format in which you can specify the details necessary to process a job
effectively. You generate the printable files that you submit to InfoPrint Manager
file by file from the application that you use for authoring.

Note: Use the Help menu from the Job Ticket window or the Help button on the
dialogs to guide you.

Creating a new job ticket

In this example, you will create a new job ticket named MyJob.jtk. You adjust color
attributes and then submit the job.
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Note: When you use InfoPrint Submit Express to send a job to the printer, you do
not need to have previously created a form definition. If you have a form
definition it overrides the attributes you specify in InfoPrint Submit Express.
1. Start InfoPrint Submit Express. The Job Ticket window displays.
2. Fill in all the fields with appropriate information.
3. Insert the files into your job ticket that you want to include in the job. Click

Help → Help... if you have questions.
v To insert new files into the document, click Item → Insert File on the menu

bar. The Select files dialog box displays. Choose the file(s) you want to add
to the document from the Select files dialog box and click Select.

4. From the Print tab, select InfoPrint Color 130 Plus from the Printer type
drop-down list and specify the layout you want in the Layout field.

5. Specify page alignment on the Align tab.

Note: You must specify the same page size and orientation at the AFCCU as
you do in the job, otherwise the page size and orientation specified in the
AFCCU will override that specified in the job.

6. Choose the values for the color attributes on the Look tab. You can use these
attributes in InfoPrint Submit Express:
v Color rendering intent

v Color profile

v Color bits per plane

v Color toner saver

Refer to “Using and changing color and resource attributes” on page 274 for
details on when and how to use these attributes.

7. Click Advanced, find RIP for, and select InfoPrint Color 130 Plus from the
drop-down list.

8. Save the job ticket by clicking Ticket → Save As....
9. Submit the job by clicking Ticket → Submit Job.

Refer to InfoPrint Manager for AIX Print-On-Demand Feature: Submit Express for
Windows User’s Guide for the latest available version on the Web at
http://www.infoprint.com.

Sending a job using Download for z/OS

You have created an AFP document using a page layout application and are using
Download for z/OS to send it to the InfoPrint Color 130 Plus.

Download for z/OS automatically sends data from the job entry subsystem (JES)
spool to remote systems using TCP/IP. This eliminates the need for manual print
file transfer using File Transfer Protocol. A cooperating print server running on a
remote system receives the data sets for printing with InfoPrint Manager for AIX.
For most jobs, you can use the same job control language (JCL) that you would use
for non-AFP printers, changing only the MVS routing information to direct your
job to the InfoPrint Color 130 Plus.

Note: You can use InfoPrint’s Page Printer Formatting Aid (PPFA) to create form
definitions and page definitions when creating the data stream. See
http://www.infoprint.com for information about how to use PPFA.
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If you are using Download for z/OS to submit jobs to the printer, see ″Using JCL
for Advanced Function Presentation″ and ″Printing Tasks and Examples″ in the
Print Services Facility for z/OS: User’s Guide for specific printing tasks and examples.
You can also see Print Services Facility for z/OS: Download for z/OS for more
information.
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Chapter 30. Using the LPD gateway with InfoPrint Manager for
AIX

You can use the AIX line printer daemon (LPD) to submit jobs through the LPD
Gateway to an InfoPrint AIX server. LPD is a subsystem that lets you submit print
jobs from other operating systems using a Line Printer (LPR) client. The AIX LPD
submits the files it receives directly to an InfoPrint destination and supports the -o
options that are available with the AIX LPR clients. (-o options allow you to
specify advanced InfoPrint print options, such as form definitions and page
definitions. For more information about using -o options with AIX print
commands, see InfoPrint Manager: Reference.)

Submitting print jobs through the LPD from an AIX system

To submit jobs from the LPD on an AIX system, you can use the AIX lpr
command, which accepts the -o options.

When you submit print jobs using the LPR client, you need to set up a remote
queue on the local system. To accomplish this task, consult your AIX system
documentation. Once you have defined a remote queue, it identifies the InfoPrint
Manager remote server and the name of the InfoPrint destination (either logical or
actual) on that InfoPrint Manager remote server. The LPD submits the job to the
InfoPrint print spool. we recommend that you specify the LPD subsystem in the
/etc/inittab file to make sure that it starts on a system reboot and is always
available.

When you enter the lpr command, you must specify the option that designates
binary or already-formatted data. For example, on AIX you must use the -l
(lowercase L) option on the lpr.

If you are printing from an InfoPrint Manager AIX server or an AIX server that has
installed the InfoPrint Manager client, you should use the InfoPrint pdpr command
to submit jobs directly to the InfoPrint print spool.

Submitting print jobs through the LPD from a non-AIX UNIX system

You can use any LPR client, but to be able to specify advanced InfoPrint options
on the -o flag, you must make sure that your LPR client supports -o options.
Sample code for an InfoPrint LPR client called lprafp is provided with InfoPrint
Manager for AIX and is available from the /usr/lpp/psf/utils/lpr directory. This
directory contains sample code of the lprafp client for UNIX platforms. This code
must be compiled as described in the README file.

Regardless of what LPD subsystem you decide to use, we recommend that you
specify it in the /etc/inittab file to make sure that the client starts on a system
reboot and is always available.
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Submitting print jobs from a non-AIX UNIX system with the
InfoPrint (lprafp) LPR client

When you submit print jobs from the InfoPrint LPR client on a non-AIX UNIX
system, all you need to specify is the InfoPrint Manager server and the name of an
InfoPrint destination (either logical or actual). The LPD submits the job to the
InfoPrint print spool. If you enter the LPR shell script with the -A flag, it invokes
the lprafp command program (lprafp.c), which is documented in the InfoPrint
Manager: Reference. If you enter the LPR shell script without the -A flag, it invokes
the AIX system’s LP command, which does not support the InfoPrint -o options.

Submitting print jobs through the LPD from a Windows system

You can use any LPR client, but to be able to specify advanced InfoPrint options
on the -o flag, you must make sure that your LPR client supports -o options.
Sample code for an LPR client called lprafp is provided for download on the
InfoPrint Solutions Company Web site. To obtain and install this LPR client, see
“Install and configure lprafp for Windows from the Web.”

Note: If you use another LPR client, make sure that you specify the flag for
specifying binary data. For example, on the Microsoft TCP/IP Printing LPD (the
default LPR on Windows operating systems), this flag is the —Ol or the —o l
(lowercase L) option, depending upon your Windows operating system.
.

Install and configure lprafp for Windows from the Web

For Windows operating system clients, the lprafp sample code package is available
for free download from the InfoPrint Solutions Company Web site at
http://www.infoprint.com/printers. Use this procedure to locate and install the
package.
1. Navigate to http://www.infoprint.com in your web browser.
2. Under Get support, click Download and drivers.
3. Under Print management and driver software, click InfoPrint Manger.
4. On the Downloads page, find lprafp and click to download.
5. Use a zip utility to unzip the package.
6. Open the readme.txt file and follow the instructions for installing the package

on a Windows system.
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Chapter 31. Printing data sets from an MVS system through
MVS Download

This section contains information about setting up and using the MVS Download
daemon supplied with InfoPrint Manager to print MVS jobs on InfoPrint-managed
printers. The MVS jobs must come from an MVS system that has the Download for
z/OS or AFP Download Plus feature of IBM Print Services Facility for z/OS
program product installed.

The InfoPrint MVS Download daemon allows MVS users to print data sets from
the MVS JES spool on InfoPrint-managed printer devices. The MVS data sets
contain MO:DCA data. With Download for z/OS, you can also print MVS data sets
containing PostScript data or data in any of the other formats supported by
InfoPrint.

The PSF for z/OS Download feature uses a routing-control data set residing on the
MVS system to map any combination of the CLASS, FORMS, and DEST JCL
parameters to a specific MVS Download daemon on a specific InfoPrint Manager
server.

See the PSF for z/OS: Download for z/OS Guide for information about the MVS
Download feature and tasks done on the MVS system.

The PSF for z/OS AFP Download Plus feature uses parameters in the PRINTDEV
to identify a single MVS Download daemon on a specific InfoPrint Manager server.
See the PSF for z/OS: AFP Download Plus Guide for information about the AFP
Download Plus feature and tasks done on the MVS system.

Preparing to work with MVS Download
Read through this to become familiar with MVS Download terms and components.

Why use MVS Download?
When you have data on an MVS system that you want to print on an
InfoPrint-managed printer device, you can use the Download for z/OS or AFP
Download Plus feature of PSF for z/OS and the InfoPrint MVS Download daemon.
The PSF for z/OS features and the InfoPrint daemon:
v Provide a high-speed data transfer utility for high-volume jobs.
v Restart from a checkpoint if something interrupts the data transmission.
v Do not require separate spool management and queueing on MVS because of

seamless integration with System Display and Search Facility (SDSF).

For a comparison between the Download for z/OS and AFP Download Plus
features, see the Download for z/OS Guide.

What is the MVS Download daemon?
InfoPrint provides a daemon, mvsprsd, which receives data sets from one or more
MVS systems. If you expect a high volume of data, you can configure several
mvsprsd daemons to receive the data sets from MVS.

To configure an mvsprsd daemon, you must do these tasks:
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1. Make the Advanced Function Presentation (AFP) resources on the MVS system
available to InfoPrint if they are not already available.

2. Use the default version or a customized version of the shell script
mvsprpsm.sh supplied with InfoPrint. See “Modifying the InfoPrint
mvsprpsm.sh shell script” on page 288 for more information.

3. Assign a port number to the InfoPrint daemon and start the daemon using the
mvsprsd command.
See “Using the mvsprsd command to start the daemon” on page 294.

How do you make AFP resources available?
AFP Download Plus can send all needed AFP resources with the print files. When
this is used, the AFP resources do not need to be accessible to the AIX system. If
AFP Download Plus is configured to not send all needed AFP resources or
Download for z/OS is in use, the AFP resources needed for the jobs need to be
accessible to the AIX system.

For jobs that require AFP resources located on the MVS system, you can use the
Network File System (NFS) mount command to make MVS file systems containing
resources accessible to the AIX system on which InfoPrint is running. Or you can
have the resources located on the AIX system. You use the shell script mvsprsd.sh,
supplied with InfoPrint in the /usr/lpp/pd/bin directory, to specify the location of
the resources.

You can associate named media with the bins where they are loaded. By using
Page Printer Formatting Aid (PPFA), you can create form definitions for your MVS
jobs that contain MO:DCA medium maps that specify media names. For more
information about how to create these form definitions, see the PPFA: User’s Guide
and Reference, S544-5284.

How are print options passed to InfoPrint?
MVS users submitting MVS data sets for printing on InfoPrint-managed printer
devices can pass a number of options that further define the requirements of their
jobs. The InfoPrint daemon receives the options with the data set and passes the
options to the shell script.

See “Passing the parameter list from the mvsprsd daemon to the shell script” on
page 290 for information about the options.

What does the mvsprpsm.sh shell script do?
The InfoPrint MVS Download shell script translates the print options specified
with a downloaded MVS file into InfoPrint attributes and values. The shell script
then builds an InfoPrint pdpr command using the -x flag to submit the attributes
and values; it builds the name of the file to print from information received from
the MVS system and the date and time the MVS file was received. The shell script
then creates a log file and submits the pdpr command. A check is made to
determine if InfoPrint accepts the command. If InfoPrint accepts the command, the
InfoPrint MVS Download shell script deletes the log file and the data set received
from the MVS system. Otherwise, the log and file remain in the defined file
system.
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What does the log file generated by the mvsprpsm.sh shell
script contain?

The filename of the log file has this format:
jobname.dataset_name.forms_name.yyddd.log

The log file generated by the InfoPrint MVS Download shell script contains this
information:
v The date InfoPrint received the MVS data set and print options
v The print options sent to the shell script by the mvsprsd daemon
v A copy of the pdpr command issued by the shell script to print the file
v Any error messages issued in response to the pdpr command
v The return code from the pdpr command

Note: If InfoPrint accepts the command, the InfoPrint MVS Download shell script
deletes the log file and the data set received from the MVS system. If you are
having problems, you might want to comment out this behavior while debugging.

If the pdpr command fails, you can use the log file located in the file system you
defined with the -d flag of the mvsprsd utility.
v Ensure the shell script received the correct parameters
v Perform InfoPrint troubleshooting procedures, such as using the pdmsg

command to determine the cause of the problem with the pdpr command.

How do I get page count displayed for AFP Download Plus
jobs?

If you want to be able to see the page count for your AFP Download Plus jobs
listed in the InfoPrint Manager GUI, turn on the page-accounting-support in AFP
Download Plus. See the PSF for z/OS: AFP Download Plus Guide for more
information.

Performance considerations with the Direct Download method

The performance of the download receiver/daemon on the InfoPrint Manager
server decreases when using the Direct download function. The Direct download
support can be enabled or disabled from the host (see AFP Download Plus guide
for further reference).

Note: When enabled, there is an impact upon the throughput of the file from the
beginning of file reception across TCP/IP until first page is printed. Also, the CPU
and disk usage may increase during the operation.

The memory usage is not expected to be affected.

Using Direct download causes additional temporary files in the download
working directory. You must ensure that you have sufficient space in the file
system where the download working directories reside.

If the download working directories are in the same file system as the InfoPrint
Manager spool (/var/pd), no additional file system space is required.
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If the download working directories are in a different file system as the InfoPrint
Manager spool, ensure that you have sufficient space for twice the amount of data
in the working directories.

Modifying the InfoPrint mvsprpsm.sh shell script
You can use the default version of the mvsprpsm.sh shell script, located in the
/usr/lpp/pd/bin directory, or modify the shell script to meet the needs of your
production printing environment. For example, you might include the path to AFP
resources on the AIX system or change how the shell script generates the file name
for the data set received from the MVS system. Or you might want to specify a
default page definition.

When modifying the mvsprpsm.sh script, note that parameters you comment out
do not get dropped but get sent passthrough to the actual destination. For
example, if you comment out the value for copies defined in the script:
# cop ) outputstr="$outputstr results-profile=::${optparm#=}" ;;

the script passes the original JCL copy-count value to the printer. Instead of
commenting out the line in the shell script, change the name of the parameter to
something that will be read as a value, but not passed onto the InfoPrint printer,
such as junk:
cop ) junk="$outputstr results-profile=::${optparm#=}" ;;

Recommendation:

Copy the shell script to another directory such as /var/pd and modify the copy.
This eliminates the possibility of service overwriting your modifications.

The mvsprpsm.sh shell script and associated scripts have been changed to add
support for AFP Download Plus and the multiple data set function of AFP
Download Plus. If you already have custom scripts that will be used instead of the
InfoPrint Manager provided scripts, make sure that they have been updated with
the changes in the new scripts before using AFP Download Plus.

Changes to custom scripts/exits are only required if any of these new functions are
desired:
v AFP Download Plus multiple data set
v Support for the pdpr retry count and retry interval
v Displaying the AFP Download Plus page count on the Admin/Operator GUI
v Printing/discarding AFP Download Plus failed jobs
v Using inline resources with MVS Download multiple data set
v Support for separator pages with AFP Download Plus multiple data set
v Using the new -w or -e option.

If none of these functions are used, the existing custom scripts can be used.

Please see the current sample script/exit provided and the sample script/exit that
your custom script/exit is based on to determine the changes. From this, you will
identify the proper approach for updating and testing your custom script/exit.
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Specifying AFP resource directories
The mvsprpsm.sh shell script contains these lines, which are commented out by
default:
# NOTE: Add resource-context-xxx search paths to the pdpr options
# if necessary. For example:
#outputstr="$outputstr resource-context-font=/font/reslib"
#outputstr="$outputstr resource-contect-page-def=/dept123/pagedef:/acme/pagedef"

Use the format shown in the third and fourth lines to specify the paths to the
directories containing AFP resources. Do not include the pound sign, #, when
specifying the directories. You can specify multiple directories by separating them
with colons. You can also specify MVS file systems accessed through the NFS
mount command.

Changing how the shell script generates the file name
The mvsprpsm.sh shell script contains the following lines, which cause the
InfoPrintMVS Download shell script to include the MVS job identifier in the name
of the file generated by the shell script:
# Rename the downloaded file to include the MVS job id (comment out
# if this behavior is not desired)
if [ "$paopt" != "" ; then

JID=${paopt##*jobid=}
if [ "$JID" != "$paopt" ] ; then

JID=${JID%%, *}
if [ "$JID" != "" ]; then

mv $filename $JID.$filename
filename=$JID.$filename
mv $logfile $JID.$logfile
logfile=$JID.$logfile

fi
fi

fi

If you do not want the MVS job identifier included, comment out the lines.

Using multiple printers with MVS Download
By default, an MVS Download process submits all jobs to the same logical printer.
A parameter that specifies this logical printer starts the mvsprsd daemon. This
printer is fixed for the duration of the process. If you want to send MVS Download
jobs to multiple InfoPrint Manager printers, then multiple daemons must be
started for each printer.

If you want a single mvsprsd daemon process to route MVS Download jobs to
different printers, you can uncomment these lines from the mvsprpsm.sh shell
script:
## ############################################################################
## The following code-segment should be uncommented if dynamic printer
## assignment is desired. Uncomment lines that are singly (#) commented.
## Lines with double comment (##) should remain commented.
##
## The MVS parameter DEST=xxxx is used to assign the logical printer
## (thereby making the MVS Download daemon's startup queue irrelevant).
##
## The assumption below is that the DEST passed is the actual name
## of an IPM logical destination. Note that both JES2 and JES3 will
## pass the DEST in the NJE header in UPPER CASE but the code below
## will convert it to lower-case.
## ############################################################################
#####################################################
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## Begin dynamic printer assignment from DEST
#####################################################
# MVSdest=${paopt##*destination=}
# if [ "$MVSdest" != "$paopt" ] ; then
# MVSdest=${MVSdest%%,*}
# MVSdest=${MVSdest% }
# if [ "$MVSdest" != "" ] ; then
# outputstr="$outputstr mvs-destination=$MVSdest"
# paopt=${paopt##destination=$MVSdest}

##########################################################
## The following typeset converts to lower-case (-l flag)
##########################################################

# typeset -l lpname=$MVSdest
# fi
# fi
#####################################################
## End dynamic printer assignment from DEST
#####################################################

Once this code has been uncommented, the MVS operators merely need to specify
the target InfoPrint Manager logical destination through the DEST= parameter on
each job that is submitted through MVS Download.

If you will be sending jobs that do not specify a value for the DEST= parameter in
the JCL, the MVS configuration substitutes a default value, which is typically
LOCAL. If your InfoPrint configuration does not have a destination with the same
name, those jobs fail and InfoPrint issues this message:
5010-056 Cannot find object 'local' rc=1

To make sure that these jobs do not fail, define either an InfoPrint Manager logical
destination or an actual destination named local (or whatever serves as a
lowercase equivalent for the default value on your MVS configuration) that
addresses the appropriate printer.

Specifying a default page definition
All line-data jobs downloaded from MVS systems require a page definition before
you can print them using InfoPrint. If no page definition is specified, an error
occurs. By default, the shell script contains this line:
pagedef ) outputstr="$outputstr page-definition$optparm" ;;

This causes the shell script to set the value for the page-definition attribute based
on a value passed to the shell script by the mvsprsd daemon. The value passed by
the daemon depends on options downloaded from MVS with the data set. You can
add conditional processing to the shell script to specify a page definition if no page
definition specification is downloaded with the file.

Passing the parameter list from the mvsprsd daemon to the shell
script

The InfoPrint mvsprsd daemon passes a parameter list for each data set it receives
to the InfoPrint MVS Download shell script. The parameter list contains this
information:
1. The name of the downloaded data set in the format:
v For Download for z/OS:

MVS_system_name.job_name.dataset_name.forms_name.yyddd.hhmmsstABCD.PRD

where:
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MVS_system_name
Specifies the name of the MVS system that downloaded the data set.

job_name
Specifies the name of the job containing the data set.

dataset_name
Specifies the name of the data set.

forms_name
Specifies the name of the form identified with the MVS FORMS
parameter.

yyddd Specifies the year followed by the number of the day of the year.

hhmmsstABCD
Specifies the time the data set was received in hours, minutes,
seconds, tenths of a second, hundreds of a second, thousands of a
second, and hundred thousands of a second.

PRD Specifies the type of file that contains print data. PRD is the suffix
used by PSF for AIX, InfoPrint Manager for AIX, or InfoPrint
Manager for Windows servers to identify the data file received and
other information needed to create the final print job.

v For AFP Download Plus:
AFPDP.MVS_system_name.fsa_name.userid.jobid.job_name.step_name.dd_name.forms_name.ccyyddd.hhmmsstABCD.PRD

where:

MVS_system_name
Specifies the name of the MVS system that downloaded the data.

fsa_name
Specifies the name of the FSA that processed the data set.

userid Specifies the userid of the user who submitted the job.

jobid Specifies the job identifier that was assigned by the z/OS system.

job_name
Specifies the name of the job containing the data set.

step_name
Specifies the name of the step in the job.

dd_name
Specifies the DD name in the step.

forms_name
Specifies the name of the form identified with the MVS FORMS
parameter.

ccyyddd
Specifies the century and year followed by the number of the day of
the year.

hhmmsstABCD
Specifies the time the data set was received in hours, minutes,
seconds, tenths of a second, hundreds of a second, thousands of a
second, and hundred thousands of a second.

PRD Specifies the type of file that contains print data. PRD is the suffix
used by PSF for AIX, InfoPrint Manager for AIX, or InfoPrint
Manager for Windows servers to identify the data file received and
other information needed to create the final print job.
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2. The print-options string, which is a series of options and values. See Table 36
for the list of options. When you specify the -k flag with the mvsprsd
command, InfoPrint also stores the options in a file whose name is in this
format:
v For Download for z/OS:

MVS_system_name.job_name.dataset_name.forms_name.yyddd.hhmmsstABCD.JCL

v For AFP Download Plus:
AFPDP.MVS_system_name.fsa_name.userid.jobid.job_name.step_name.dd_name.forms_name.ccyyddd.hhmmsstABCD.JCL

where all the qualifiers in the name are the same as those for the name of the
data set, except for JCL. The -k flag specifies that the file contains print options.

3. The logical printer name, which was specified with the -q flag of the InfoPrint
mvsprsd command when the daemon was started.

4. An empty string.
5. An empty string.
6. The port number that was specified with the -p flag of the InfoPrint mvsprsd

command when the daemon was started.
7. The additional script parameters that were specified with the -X flag of the

InfoPrint mvsprsd command when the daemon was started.
8. A non-zero value, if the -t flag was specified on the mvsprsd command; or a

value of zero, if the -t flag was not specified.

Translating print options to InfoPrint attributes and values
Table 36 shows the print options and values passed to the shell script in the
print-options string, the corresponding InfoPrint attribute, and the attribute value
used for the pdpr command for that job.
v MVS sends print option values in either uppercase or lowercase characters. MVS

sends all print option values shown in italics in Table 36, such as pagedef, formdef,
and font1, in uppercase. It sends other values as shown in the table.

v InfoPrint sets most attribute values to exactly the same values received from the
print-option values; Table 36 lists these values in italics in the InfoPrint
Attribute and Value columns.

Table 36. Print options passed to InfoPrint MVS Download shell script

Print Option Passed to
Shell Script

InfoPrint Attribute and Value for
Download for z/OS

InfoPrint Attribute and Value for AFP
Download Plus

-oac=account ″account-text=account″ ″account-text=account″

-oaddress1=address1 ″address1-text=address1″ ″address1-text=address1″

-oaddress2=address2 ″address2-text=address2″ ″address2-text=address2″

-oaddress3=address3 ″address3-text=address3″ ″address3-text=address3″

-oaddress4=address4 ″address4-text=address4″ ″address4-text=address4″

-obu=building ″building-text=building″ ″building-text=building″

-occtype=a
-occtype=m
-occtype=z

″carriage-control-type=ansi-ebcdic″
″carriage-control-type=machine″
″carriage-control-type=ansi-ascii″
Note: The shell script checks if the job
uses carriage control characters. If they are
used, then InfoPrint sets this attribute and
value based on the input parameter.

None (discarded)
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Table 36. Print options passed to InfoPrint MVS Download shell script (continued)

Print Option Passed to
Shell Script

InfoPrint Attribute and Value for
Download for z/OS

InfoPrint Attribute and Value for AFP
Download Plus

-ochars=font1,font2,font3,font4 ″chars=font1,font2,font3,font4″ None (discarded)

-ocop=nnn ″results-profile=::nnn″ ″results-profile=::nnn″

-odatat=af Not applicable ″document-format=modca-p″

-odatat=line ″document-format=line-data″
Note: If the input value is not line, this
value is not set and InfoPrint tries to
identify the correct format. If InfoPrint
cannot identify the format, InfoPrint uses
a format of ascii.

Not applicable

-odatac=blkchar
-odatac=blkpos
-odatac=block
-odatac=unblock

″data-fidelity-problem-reported=position″
″data-fidelity-problem-reported=character″
″data-fidelity-problem-reported=none″
″data-fidelity-problem-reported=all″

″data-fidelity-problem-reported=position″
″data-fidelity-problem-reported=character″
″data-fidelity-problem-reported=none″
″data-fidelity-problem-reported=all″

-ode=department ″department-text=department″ ″department-text=department″

-odu=no
-odu=normal
-odu=tumble

″sides=1 plex=simplex″
″sides=2 plex=simplex″
″sides=2 plex=tumble″

″sides=1 plex=simplex″
″sides=2 plex=simplex″
″sides=2 plex=tumble″

-of=F1formdef ″form-definition=F1formdef″ ″form-definition=F1formdef″

-ofileformat=record
-ofileformat=stream

″new-line-option=counted-4-octet-aligned″
″new-line-option=lf″

None (discarded)

-ofiletype=dshdr
-ofiletype=jobhdr
-ofiletype=jobtrl
-ofiletype=message
-ofiletype=userdata

None (discarded) ″auxiliary-sheet-selection=none″
″auxiliary-sheet-selection=none″

″auxiliary-sheet-selection=none″

-oformlength=nnn.nnn ″form-length=nnn.nnn″ ″form-length=nnn.nnn″

-oin=nnn ″printer-pass-through=’-obinnnn’″ ″printer-pass-through=’-obinnnn’″

-ojobn=job_name ″job-name=job_name″ ″job-name=job_name″

-ona=name ″name-text=name″ ″name-text=name″

-ono=nodeid ″node-id-text=nodeid″ ″node-id-text=nodeid″

-ooffxb=nnn.nnn ″x-image-shift-back=nnn.nnn″ ″x-image-shift-back=nnn.nnn″

-ooffxf=nnn.nnn ″x-image-shift=nnn.nnn″ ″x-image-shift=nnn.nnn″

-ooffyb=nnn.nnn ″y-image-shift-back=nnn.nnn″ ″y-image-shift-back=nnn.nnn″

-ooffyf=nnn.nnn ″y-image-shift=nnn.nnn″ ″y-image-shift=nnn.nnn″

-oovlyb=overlay ″overlay-back=overlay″ ″overlay-back=overlay″

-oovlyf=overlay ″overlay-front=overlay″ ″overlay-front=overlay″

-opa=
class=output_class
destination=destination
forms=form_name
segmentid=nnn

″printer-pass-through=
’-oclass=output_class’
’-odestination=destination’
’-oforms=form_name’
’-osegmentid=nnn’″

″printer-pass-through=
’-oclass=output_class’
’-odestination=destination’
’-oforms=form_name’
’-osegmentid=nnn’″
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Table 36. Print options passed to InfoPrint MVS Download shell script (continued)

Print Option Passed to
Shell Script

InfoPrint Attribute and Value for
Download for z/OS

InfoPrint Attribute and Value for AFP
Download Plus

-opagecount=nnnnnnnnn “job-page-count=nnnnnnnnn” “job-page-count=nnnnnnnnn”

-opagedef=P1pagedef ″page-definition=P1pagedef″ None (discarded)

-opr=programmer_name ″programmer-text=programmer_name″ ″programmer-text=programmer_name″

-oprmode=SOSI1
-oprmode=SOSI2

″shift-out-shift-in=one″
″shift-out-shift-in=two″

None (discarded)

-ore=P240
-ore=P300

″font-resolution=240″
″font-resolution=300″

″font-resolution=240″
″font-resolution=300″

-oro=room ″room-text=room″ ″room-text=room″

-osheetcount=nnnnnnnnn None (discarded) None (discarded)

-oti=title ″title-text=title″ ″title-text=title″

-otrc=no
-otrc=yes

″table-reference-characters=false″
″table-reference-characters=true″

None (discarded)

-ous=userid ″user-id-text=userid″ ″user-id-text=userid″

Using the mvsprsd command to start the daemon

To start the mvsprsd daemon whenever the InfoPrint system starts, you can
include the mvsprsd command in either the /etc/rc or the /etc/inittab file. Both files
execute when the AIX operating system is initialized. The /etc/inittab file has an
entry for another file called /etc/rc. This shell script (/etc/rc) performs normal
startup initialization for the system; its contents are installation-specific. Because
this file is not usually replaced when a new release of the operating system is
installed (unlike /etc/inittab), you can use it to start the mvsprsd daemon. One can
edit the /etc/rc to call and execute another shell script called /etc/rc.local if it exists.

Use this procedure to start the mvsprsd daemon through the /etc/rc and the
/etc/rc.local files:
1. Using your AIX editor of choice, edit the /etc/rc file and find these lines:

# Manufacturing post install process
# This must be at the end of this file, /etc/rc.
if [ -x /etc/mfg/rc.preload ]
then
/etc/mfg/rc.preload
fi

2. Insert these lines just before the code example provided in the preceding step:
if [ -s /etc/rc.local ]
then
sh /etc/rc.local
fi

3. Save and close the /etc/rc file.
4. Using your AIX editor of choice, edit the /etc/rc.local file. If this file does not

exist on your AIX system, you must create it as root.
5. Add lines similar to these to this file:
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# This is a comment to document that the following command
# starts the mvsprsd daemon automatically at system startup
/usr/lpp/psf/bin/mvsprsd -p 5400 -d /files1 -d /files2 \
-x /usr/lpp/pd/bin/mvsprpsm.sh -q serv2-lp

Note that this example uses the default shell script (mvsprpsm.sh) and specifies
the serv2–lp InfoPrint AIX server.

6. Save and close the /etc/rc.local file.

If the daemon stops for some reason or you want to restart it using different
start-up options, you can use the InfoPrint mvsprsd command to start the InfoPrint
mvsprsd daemon. With the command, you specify an AIX file system in which to
store downloaded data sets, a shell script name, a logical printer name, and
whether print-option information is stored in a file. You start the daemon on the
AIX processor that has InfoPrint installed. Once the mvsprsd daemon is
operational, you can use MVS Download to submit a job to InfoPrint where the
InfoPrint MVS Download shell script translates the JCL keywords and values to
InfoPrint attributes and values and issues a pdpr command.

For the syntax and flags of the mvsprsd command, and for examples of its use, see
InfoPrint Manager: Reference or the mvsprsd man page.

Using MVS Download support for multiple data set jobs

MVS Download sends each JES SYSOUT data set separately to the mvsprsd
daemon on AIX. By default, the mvsprsd daemon spools each data set as a
separate file. On MVS, a job can contain multiple data sets. By using the following
procedure to customize your installation for MVS Download multiple data set job
support, you might be able to cause the data sets in a job sent to InfoPrint
Manager through MVS Download to print in sequence, with no intervening files,
no NPRO processing between files, and only one header and trailer page for the
set.

InfoPrint Manager now enables multiple data sets to be received, individually
transformed by ACIF into MO:DCA-P, and then combined into a single file and
spooled. InfoPrint Manager uses the medium maps (copy groups) from the form
definition that is associated with each data set to build a comprehensive inline
form definition that it inserts at the beginning of the combined file.

The following describes what you must do to install and configure the MVS
Download support for printing multiple data set set jobs received from PSF/MVS
on InfoPrint Manager for AIX.

Description of multiple data set support on both PSF/MVS and
InfoPrint Manager for AIX

To support the printing of multiple data sets in a job as a single unit with
Download for z/OS, you must:
v Install a special Download for z/OS user exit 15 program (apsux15m ) on MVS
v Start the mvsprsd daemon with the -n 1 option on AIX

To support the printing of multiple data sets in a job as a single unit with AFP
Download Plus, you must:
v Install AFP Download Plus with APAR OA15317.
v Set the dataset-grouping parameter in the control statement data set to Yes.
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v Start the mvsprsd daemon with the -n 1 option on AIX

The sample user exit 15 program (apsux15m ) provided with PSF for z/OS for
Download for z/OS, adds a parameter that identifies data sets that belong to
multiple data set jobs and indicates whether the data set is first, next, or last in a
job.

The -n 1 option ensures that the mvsprsd daemon receives the data sets in the
correct sequence by creating no more than one child process. If more than one
child process were created, MVS Download might concurrently send more than
one data set from a multiple data set job. If the second data set was shorter than
the first, it might be received before the first, causing it to print out of sequence or
causing the first data set to be left unprinted.

Note: If you enable multiple data set support using Download for z/OS and you
need to configure multiple MVS Download FSA’s, you must have one mvsprsd
daemon for each Download FSA that is submitting jobs to the InfoPrint Manager
server. If you don’t do this and two Download for z/OS FSA systems send jobs at
the same time, the job data sets can become intermingled and errors or incorrect
output can result. This restriction does not apply to AFP Download Plus. Multiple
AFP Download Plus FSAs can be enabled for multiple data set and use one
mvsprsd daemon.

Procedure for installing multiple data set support with
Download for z/OS

Use this procedure to install the MVS Download multiple data set support:
1. Install the MVS Download user exit 15 program, apsux15m, on MVS. The

program must be assembled and linked into a data set referenced in the
STEPLIB of your MVS Download startup PROC.

2. Run MVS Download on MVS using SEND_REC_LENGTH=YES either by specifying it
explicitly in the MVS Download Routing Control data set on MVS or by
allowing it to default. If you specify SEND_REC_LENGTH=NO, ACIF might be unable
to process some variable length line mode data. In these cases ACIF issues a
message that it cannot read the input file with a return code of 310.

3. Because the mvsprpsm.sh sample shell script has been updated, you must
update any customized versions of this shell script. Specify the name of the
shell script using the ″-x″ option when you start the mvsprsd daemon:
mvsprsd -n 1 -qlp -p6250 -d/mvsdl -x/mvsdl/mvsprpsm.sh

4. Make sure that the PATH environment variable when the mvsprsd daemon is
started includes the /usr/lpp/psf/bin directory. You can set default values for
environment variables like PATH using the /etc/environment file:
PATH=/usr/bin:/etc:/usr/sbin:/usr/lpp/pd/bin:/usr/lpp/psf/bin:.

You must delimit each directory using a colon (:), not a semi-colon (;). Do not
include spaces in the assignment. A period designates the current directory.

5. Make sure that ACIF can locate your resources. It looks in both the
/usr/lpp/psf/reslib directory and the directories specified by the PSFPATH
environment variable. If you specify resource directories using these attributes,
you must specify those same directories in the PSFPATH environment variable:
v resource-context

v resource-context-font

v resource-context-overlay
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v resource-context-page-segment

v resource-context-page-definition

v resource-context-form-definition

You can set default values for environment variables like PSFPATH using the
/etc/environment file:
PSFPATH=/usr/xyz_corp/reslib:/usr/xyz_corp/fontlib

You must delimit each directory using a colon (:), not a semi-colon (;). Do not
include spaces in the assignment.

6. Do not specify these attributes either directly or in Initial Value Job or Initial
Value Document objects:
v transform-message-file-name

v resource-context-page-definition

You can use the resource-context attribute instead of the resource-context-page-
definition attribute.

7. Specify the -n 1 option when you start the mvsprsd daemon:
mvsprsd -n 1 -qlp -p6250 -d/mvsdl -x/mvsdl/mvsprpsm.sh

This option directs the daemon to create exactly one child process to receive
data sets from MVS. Most customers use a shell script to run the mvsprsd
daemon and specify its arguments. Using a shell script ensures that the daemon
is always started correctly, with the same arguments. You should add the -n 1
option to the shell script.

Procedure for installing multiple data set support with AFP
Download Plus

Use this procedure to install the AFP Download Plus multiple data set set support:
1. Install AFP Download Plus with APAR OA15317. To enable the multiple data

set function, set the dataset-grouping parameter in the control statement data
set to Yes. For more information about installing AFP Download Plus, see the
″Installing AFP Download Plus″ chapter in Print Service Facility for z/OS: AFP
Download Plus, S550-0433. Using the Download for z/OS exit 15 program to
enable multiple data set on AFP Download Plus is not supported.

2. Because the mvsprpsm.sh sample shell script has been updated, you must
update any customized versions of this shell script. Specify the name of the
shell script using the ″-x″ option when you start the mvsprsd daemon:
mvsprsd -n 1 -qlp -p6250 -d/mvsdl -x/mvsdl/mvsprpsm.sh

3. When the mvsprsd daemon is started, make sure that the PATH environment
variable includes the /usr/lpp/psf/bin directory. You can set default values for
environment variables like PATH using the /etc/environment file:
PATH=/usr/bin:/etc:/usr/sbin:/usr/lpp/pd/bin:/usr/lpp/psf/bin:.

You must delimit each directory using a colon (:), not a semi-colon (;). Do not
include spaces in the assignment. A period designates the current directory.

4. Do not specify these attributes either directly or in Initial Value Job or Initial
Value Document objects:
v transform-message-file-name

v resource-context-page-definition
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You can use the resource-context attribute instead of the resource-context-page-
definition attribute.

5. Specify the -n 1 option when you start the mvsprsd daemon:
mvsprsd -n 1 -qlp -p6250 -d/mvsdl -x/mvsdl/mvsprpsm.sh

This option directs the daemon to create exactly one child process to receive
data sets from MVS. Most customers use a shell script to run the mvsprsd
daemon and specify its arguments. Using a shell script ensures that the daemon
is always started correctly, with the same arguments. You should add the -n 1
option to the shell script.

Limitations of multiple data set support
This support has these limitations:
1. This solution applies only to line mode, mixed mode, or MO:DCA-P data sets.
2. You must specify the -n 1 option when you start the mvsprsd daemon on AIX.

This support restricts the mvsprsd daemon to receiving one data set at a time.
If you did not previously specify the -n 1 argument and received multiple files
concurrently, you might wish to start more than one instance of the mvsprsd
daemon (using different port numbers) and configure new MVS Download
printers on MVS to communicate with them.

3. You must have enough disk space on the AIX system to receive and transform
all of the data sets in a multiple data set job. If you do not use this solution,
data sets can be received and transformed individually, so less space might be
required.

4. This solution does not create three types of form definition (FORMDEF)
statements in the generation of a comprehensive inline form definition:
v MSU (Map Suppression)
v PFC (Presentation Fidelity Control)
v MFC (Medium Finishing Control)
v PEC (Presentation Environment Control)
v MDR (Map Data Resource)

5. You cannot have inline resources with the same name and different content in
the same job, except for page definitions and form definitions.

6. The job-page-count attribute includes the separator pages when the host
separator page is enabled, but the separator pages are not included in the
job-page-count for any other jobs.

7. When the separator page support is enabled in the host but the data set does
not contain the separator page, the receiver prints the job with InfoPrint
Manager separators. To suppress the InfoPrint Manager separators, you can
perform one of the following options:
v Change the scripts or exits to set the auxiliary-sheet-selection job attribute to

none permanently.
v Set the printer-start-sheet, printer-separator-sheet, and printer-end-sheet job

attributes to none for the actual destination.
v Set the auxiliary-sheet-selection job attribute to none for the logical

destination.

Technical description of multiple data set support
This section describes the sequence of the multiple data set support.
1. The MVS Download daemon receives a data set into a file.

298 InfoPrint Manager for AIX: Procedures

|

|



2. The MVS Download daemon invokes the InfoPrint Manager script to spool the
file. (You specified the script on the -x option when you started mvsprsd.)

3. If MVS user exit 15 or AFP Download Plus marked the file as part of a
multiple data set job, the sample exit does not immediately spool the file.
Instead, the sample exit calls a second program, which invokes ACIF to
transform the file into MO:DCA-P if it is from Download for z/OS.

4. After the last file in a multiple data set job is received and transformed to
MO:DCA-P for Download for z/OS, the sample exit invokes the afpconcat
program to create one file with a comprehensive inline form definition and all
the MO:DCA-P documents. The afpconcat program can combine the multiple
MO:DCA-P files received from MVS Download into a single MO:DCA-P file.
The comprehensive inline form definition contains medium maps (copy groups)
from all of the form definitions associated with the individual data sets. The
formdefs requested for each input file are merged into a single combined
formdef that is placed inline in the output MO:DCA-P document.

5. If medium map names collide, the afpconcat program assigns unique names
and updates references in the MO:DCA-P documents.

6. The afpconcat program merges the inline resource group, discarding page
definitions and the original form definitions. Resources with matching resource
names and types are compared to verify that they are identical.

7. The sample exit spools the combined MO:DCA-P file.

Resubmitting or deleting MVS Download orphaned files

Orphaned files are old files left in the AIX file system because errors prevented
InfoPrint from processing them; their file names follow the MVS Download file
name format, such as:

MVS_system_name.job_name.dataset_name.forms_name.yyddd.hhmmsstABCD.PRD.

You should either correct the problem that prevented the job from processing and
then resubmit the job or delete the files.

Resubmitting an orphaned file

If you started the mvsprsd daemon with the -k flag, InfoPrint saves print options
downloaded with MVS data sets. By default, InfoPrint also stores the downloaded
data set. InfoPrint saves both the data set and the print-options file in the directory
you specify with the -d flag when you start the daemon. See “Passing the
parameter list from the mvsprsd daemon to the shell script” on page 290 for the
format of the file names for the data set and print-options file. If errors occur that
prevent InfoPrint from processing the job, you can correct the errors and then
resubmit the job.
1. Go to the working directory where the failed job’s JCL exists.
2. Run the /usr/lpp/pd/bin/mvsprpsm.sh command with these parameters (or

create a shell script to run the command):

1st parameter : PRD file (line data from host)
2nd parameter: Copy the content of JCL file
3rd paramete: Logical Dest name
4th parameter: none (blank)
5th parameter: none (blank)
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6th parameter: MVSPRSD port number
7th parameter: none (blank)
8th parameter: 0 (zero)

For example:
#!/bin/ksh

JOB00838.SRV1.YAMASAK1.STEP1.PERFAIX.2005105.23235906438.PRD
'"-odatat=line -ofileformat=record -occ=yes -occtype=a

-ochars=GT10 -opagedef=P1V04863 -of=F10101LA -ocop=007
-odatac=unblock -ojobn=MYJOB -ous=MYNAME -oprmode=SOSI2
-otrc=yes -ono=BLDPSRV1
-opa=forms=PERFAIX,class=K,destination=LOCAL,jobid=JOBID,
OUTGRP=ONLY "' local '' '' 6001 '' 0 >>$PPID 2>>$PPID

Note: Multiple data set jobs cannot be resubmitted and must be resent from the
host.
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Chapter 32. Using AFP Upload

AFP Upload consists of a client component (as part of InfoPrint Manager) and an
MVS host server component (available as a priced feature of PSF for z/OS).

Note: The z/OS operating system replaced the MVS operating system, but in
InfoPrint Manager we continue to refer to the MVS operating system because it is
used throughout our program.

The client component is part of the InfoPrint Manager server. The InfoPrint
Manager server accepts AFP files (or files it can convert to AFP) and sends them to
the MVS server, which places them on the JES spool. The host server program
ensures that the attributes passed by the InfoPrint Manager server (such as class,
destination, and forms) are recorded with the data sets on the JES spool. For more
information on how to pass these values to an MVS system, see “Transmitting AFP
file attributes to MVS” on page 304.

Software prerequisites

The following software products are required to use :

Host System

v z/OS V1R7 or later
v PSF 3.4.0 for z/OS AFP Upload Feature

AIX System

v AIX Version 5.3 with ML05 (32 and 64 bit kernels) or later
v InfoPrint Manager for AIX Version 4.2 or later

General information about the host server program
The host server program is a single load module that can be purchased as a feature
of PSF for z/OS. Once started, the host server program runs continuously. It waits
for connection requests from one or more InfoPrint Manager servers and creates a
subtask to process each request. When a request is completely processed, the
subtask ends. The host server program creates a new subtask for each request.

You can run the host server program in a startable address space or as a job
managed by a host initiator.

The InfoPrint Manager server sends AFP data to the host server program that
places the AFP data in a SYSOUT data set. When the host server program allocates
the SYSOUT data set, it accepts the default spool space allocation for the SYSOUT
class definition in JES.

The host server program associates attributes passed by the InfoPrint Manager
server with the SYSOUT data set. These attributes are similar to JCL OUTPUT
statement parameters. They include:
v ADDRESS
v BUILDING
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v BURST
v CLASS
v COPIES
v DATACK
v DEPARTMENT
v DESTINATION
v FORMDEF
v FORMS
v NAME
v ROOM
v TITLE
v WRITER

Notes:

1. The host server program requires a 5A control character to precede each AFP
statement in the AFP data sent by the InfoPrint Manager server.

2. The InfoPrint Manager server always passes a value for the DATACK
parameter with each uploaded file. This DATACK value overrides the DATACK
parameter in the PSF for z/OS PRINTDEV statement.

Specifying the SYSPRINT DD statement
The host server program records its configuration settings and information about
errors in the data set referenced by the SYSPRINT DD statement. You must include
a SYSPRINT DD statement in the JCL statements that run the host server program.

If the SYSPRINT DD statement refers to a data set other than SYSOUT or DUMMY,
the data set must have the following attributes:

directory blocks:
0

record format:
VA

record length:
125

block size:
129

Supported configuration parameters

The AIX client provides most of the information required by the host server
program. The host server program has only a few configuration parameters. The
default values for these parameters are appropriate in most cases.

CASE
Specifies whether the host server program should convert text OUTPUT
parameter values to upper case. The following OUTPUT parameters are
affected:
v ADDRESS
v BUILDING
v DEPARTMENT
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v NAME
v ROOM
v TITLE

The CASE parameter does not affect some other OUTPUT parameter values,
which are always converted to upper case:
v CLASS
v DESTINATION
v FORMDEF
v FORMS
v WRITER

MIXED
Accept the text values as provided by the AIX client.

Note: Some code pages used by fonts printed on header and trailer pages
do not include lower case characters.

UPPER
Convert all alphabetic English characters to upper case.

PORTNUM
Specifies the TCP port number at which the host server program accepts
connection requests from clients. Valid values are 1 to 65535, but values above
5000 are recommended. The default value is 6001.

TASN
Specifies the name of the z/OS TCP/IP address space. The default value is
TCPIP.

TRACE
Specifies whether the host server program should record its internal flow in
the data set referenced in the SYSPRINT DD statement.

Note: Using a TRACE value other than NONE degrades performance. You
should specify a value other than NONE only if directed to do so by an IBM
service representative.

DS
Record transmitted and received data, as well as the internal execution
path.

NONE
Do not record trace information. The host server program only writes
configuration and error information in the SYSPRINT data set.

NORM
Record the internal execution path.

Specifying the configuration parameters
Specify host server program parameters and values as a program parameter on the
JCL EXEC statement.

For example,
//STEP EXEC PGM=AUPTCPS,PARM='/CASE=MIXED'

or
//STEP EXEC PGM=AUPTCPS,PARM='/CASE=MIXED,TRACE=NORM'
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The PARM value has the format:
’run-time options/program parameter’

Run-time options control aspects of the program’s execution environment, such as
the amount of storage available to the program.

The program parameter is passed to the program.

Specifying PL/I run-time options
The host server program is written in the PL/I language. Like most PL/I
programs, aspects of its execution environment can be controlled by run-time
options.

You can specify run-time options in the PARM operand on the JCL EXEC
statement.

For example,
//STEP EXEC PGM=AUPTCPS,PARM='SPAE,SPIE/CASE=MIXED'

The PARM value has the format:
’run-time options/program parameter’

The program parameter is passed to the program. The host server program accepts
its configuration parameters in this way.

For more information about run-time options for PL/I programs, see z/OS
Language Environment Programming Guide.

Transmitting AFP file attributes to MVS
InfoPrint Manager lets you specify values to MVS through two methods:
1. “Using specific InfoPrint Manager attributes”
2. “Using the destination-pass-through attribute” on page 305

The CLASS, FORMS, and DESTINATION values allow you to specify values
through either method. If you want to send these three values through AFP
Upload and Print, as well as the BURST value, you must use the
destination-pass-through attribute. If you specify the CLASS, FORMS, and
DESTINATION attributes as specific attributes (mvs-class, mvs-destination, or
mvs-forms) and then specify a BURST value on the same command or actual
destination, InfoPrint Manager ignores the specific document attributes and only
passes the BURST value onto the MVS host program. To pass BURST with the
other three values, you must use the method described in “Using the
destination-pass-through attribute” on page 305.

Using specific InfoPrint Manager attributes
You can specify a series of document attributes that map to MVS values by
associating them with a job, specifying them on a pdpr print command, or setting
them on an actual destination.

Table 37 on page 305 provides specific attributes that can be used to pass values to
an MVS host system through AFP Upload and Print.
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Table 37. Specific InfoPrint Manager attributes to pass values to an MVS host system

MVS Values InfoPrint Manager Attribute(s)

ADDRESS v address1–text=

v address2–text=

v address3–text=

v address4–text=

BUILDING building–text=

CLASS v mvs-class=

v (destination-pass-through=)

COPIES copy–count=

DATACK data–fidelity-problem-report=

DESTINATION v mvs-destination=

v (destination-pass-through=)

DEPARTMENT department-text=

FORMDEF form-definition=

FORMS v mvs-forms=

v (destination-pass-through=)

NAME name-text=

ROOM room-text=

TITLE title-text=

For example, to pass a BUILDING value of 004 and a ROOM value of A5, you
could use the pdpr print command to pass attributes for a single job with a
test1.tif file:
pdpr -p nome-lp -x"building-text=004 room-text=A5" test1.tif

For specific syntax rules, see the latest draft of the InfoPrint Manager: Reference,
which is available on the InfoPrint Solutions Company Web site
http://www.infoprint.com.

Using the destination-pass-through attribute
For a subset of MVS values that do not match specific InfoPrint Manager
attributes, InfoPrint Manager lets you specify values to MVS as
destination-pass-through (also called printer-pass-through) attribute values. These
values can be associated with a job, specified on a pdpr print command, or set on
an actual destination. The MVS host server program associates attributes passed by
the AIX client with the SYSOUT data set. These attributes are similar to JCL
OUTPUT statement parameters.

They include
v BURST
v CLASS
v DESTINATION
v FORMS

These procedures describe how you can pass these values to an MVS host server
program using AFP Upload and Print, using this syntax:
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-x "destination-pass-through='PASSTHRU=MVS_PARM=value'"

where MVS_PARM can be BURST, CLASS, DESTINATION, and FORMS, either
individually or in any combination. When more than one attribute is being passed,
each value must be separated by a comma, as shown in the examples below.

The MVS value WRITER must be specified through the destination-pass-through
attribute, but it does not conflict with specifying either mvs-class, mvs-destination,
or mvs-forms. As you can see in the table below and the examples that follow, the
syntax for passing the MVS WRITER value differs from that used for the other
options.

This table shows how you can use the destination-pass-through attribute to pass
values to an MVS host system through AFP Upload and Print.

Table 38. Using the destination-pass-through attributes to pass values to an MVS host
system

MVS Values InfoPrint Manager Pass Through Syntax

BURST destination-pass-through=’PASSTHRU=BURST=xxx’

CLASS destination-pass-through=’PASSTHRU=CLASS=xxx’

DESTINATION destination-pass-through=’PASSTHRU=DESTINATION=xxx’

FORMS destination-pass-through=’PASSTHRU=FORMS=xxx’

WRITER destination-pass-through=’WRITER=xxx’

Examples: Using the destination-pass-through attribute
The first two-step example creates an initial value document and associates it with
the default logical destination so that all jobs sent to this destination will pass the
specified attributes.
1. Specify this pdcreate command to create an initial value document named

upload1–dd on the InfoPrint AIX server nome:
pdcreate -c initial-value-document \

-x"destination-pass-through='WRITER=WTR1 PASSTHRU=BURST=YES,CLASS=A'"\

nome:upload1-dd

2. Specify this pdset command to associate the initial value document named
upload1–dd with the nome-lp logical destination:
pdset -c destination\

-x"destination-initial-value-document=upload1-dd"\

nome:nome-lp

The second example uses the pdpr command to pass attributes for a class of A, a
form of B, a job destination of B205, and a BURST value of YES on a single job with
a test2.tif input file:
pdpr -p nome-lp\

-x"destination-pass-through='PASSTHRU=CLASS=A,FORMS=B,DESTINATION=B205,BURST=YES'"\

test2.tif

The third example uses the pdset command to specify a class of A, a form of B, a
BURST value of YES, and a WRITER value of WTR1 on all jobs sent to the actual
destination nome-ad.
pdset \

-x"destination-pass-through='WRITER=WTR1 PASSTHRU=CLASS=A,FORMS=B,BURST=YES'"\
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nome:nome-ad

Using InfoPrint Manager commands with AFP Upload
Because the AIX client program for AFP Upload operates as an InfoPrint Manager
actual destination, you can control and monitor it through the commands used
with other InfoPrint actual destinations:
v To shut down an AFP Upload actual destination, use the pdshutdown command

that is documented in InfoPrint Manager: Reference.
v To find status about AFP Upload actual destinations, use the psfstat command.

There are limitations to the tasks that you can do with an AFP actual destination.
You can neither forward space, back space, nor pause a job to an AFP Upload
actual destination.

When the connection to the MVS host fails
If you experience connection problems with the MVS host after having submitted a
job through AFP Upload and Print, how to make sure that the job prints depends
upon whether InfoPrint Manager detected the loss of connectivity.

If InfoPrint Manager detected the lost connection, the AFP Upload logical
destination becomes red and the job goes into the PENDING state. Once you have
re-established connectivity to the MVS host program, re-enable the AFP Upload
destination. Then InfoPrint Manager will restart the job and continue printing.

If InfoPrint Manager does not detect the lost connection, the job remains in the
PENDING state, while the printer goes into a needs-key-operator state. To resolve
this condition and print your job, you must regain connectivity to the MVS host
program, cancel the job in the PENDING state, and then resubmit the job to the AFP
Upload actual destination.

Troubleshooting problems with AFP Upload on TCP/IP networks
This chapter describes some of the places where information about errors is
recorded. It also lists a few common errors and their most likely causes.

Places where error information is recorded

This section lists a few of the places you should look to get information about
errors configuring and using :

error.log for an InfoPrint Manager actual destination
The AFP Upload program operates as an InfoPrint Manager actual destination.
Like all InfoPrint Manager actual destinations, it records error messages in a
file named error.log in the directory for the InfoPrint Manager actual
destination. The directory is named

/var/psf/printername

where printername is the name of the InfoPrint Manager actual destination.

You can use the psfmsg command to display detailed information about any
InfoPrint Manager PSF message. For more information about the psfmsg
command, refer to the InfoPrint Manager: Reference.
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MVS console log
The MVS console log contains information about host server program errors,
especially if the host server program runs in a startable address space.

MVS held output
If the host server program runs as a job managed by an MVS initiator, check
the job’s held output for information about errors. You must use a MSGCLASS
on the JCL JOB statement that causes job execution data sets to be held.

SYSPRINT data set
The AFP Upload host server program records its configuration values and
information about run-time errors in the data set referenced by the SYSPRINT
DD statement. Refer to “Specifying the SYSPRINT DD statement” on page 302.

Common errors with AFP Upload using TCP/IP networks

The following contains common errors when using . Each problem displays the
Symptom and its Likely Causes and Resolutions:

Symptom:

You run the host server program as a job managed by an MVS initiator. After
running for a period, the host server program ends with system code 522.

Likely Causes and Resolutions:

System code 522 indicates that all of the tasks in a job step were in a wait state for
the time specified in the JWT parameter of the SMFPRMxx parmlib member.
However, lengthy waits are normal during periods when no AFP Upload AIX
clients send files to the host server program.

Specify TIME=NOLIMIT in the JCL EXEC statement for the host server program to
bypass job step wait limits.

Symptom:

You provide values for class, destination, and forms when you enqueue a print
file, but some of the values are not reflected on the SYSOUT data set created in the
MVS JES spool.

Likely Causes and Resolutions:

If you use the AIX enq command and want to specify class, destination, and
forms values, you must use the -o passthru option.

You should use only one -o passthru specification that includes all the values you
want to provide. For example,

enq -P upload1 -o passthru=class=k,forms=std sample

is correct.

If you use the -o passthru specification more than once, only the last specification
will be processed. For example,

enq -P upload1 -o passthru=class=k -o passthru=forms=std sample

is incorrect. The enq command will process the forms value, but will ignore the
class value.
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Symptom:

You enqueue an ASCII file to be uploaded, but InfoPrint Manager for AIX issues
the following error message:

0423-659, File ________ contains data of a type that cannot be processed
by this PSF/6000 instance. For example, the PSF/6000 instance cannot
process ASCII datatype files.

Likely Causes and Resolutions:

You cannot directly enqueue an ASCII file to be uploaded; you must use ACIF to
transform the file into a AFP data stream file.

Symptom:

The host server program fails immediately after you start it. The SYSPRINT data
set contains the following error:

INITAPI ERROR = 10191

Likely Causes and Resolutions:

The host server program referenced a TCP/IP address space name that is not
correct or the address space name is correct but the address space is not running.

If you do not specify a TCP/IP address space name (TASN) when you start the
host server program then TCPIP is assumed. If the TCP/IP address space name is
not TCPIP, the host server program records this INITAPI macro error and ends.

If you specify a TCP/IP address space name (TASN) when you start the host
server program but it is incorrect, the host server program also records this
INITAPI macro error and ends.

Ask your system programmer for the z/OS TCP/IP address space name. Specify it
to the host server program using the TASN configuration parameter. For details
about the TASN configuration parameter and how to specify it, refer to “General
information about the host server program” on page 301.

Symptom:

InfoPrint Manager for AIX issues the following error message:
0423-655 PSF/6000 cannot communicate with the server program

at TCP port number ____ at Internet Protocol (IP) address ____.

Likely Causes and Resolutions:

The host server program is not started at the given IP address and TCP port
number.

Ensure that the IP address is correct. Start the host server program. Ensure that the
PORT number configuration parameter for the actual destination equals the
PORTNUM value that you specified when you started the host server program. If
you do not specify a PORTNUM value when you start the host server program
then 6001 is used. For details about specifying the PORTNUM configuration
parameter, refer to “General information about the host server program” on page
301
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301. For details about creating an AIX printer, see ″Creating and managing actual
destinations″ in the InfoPrint Manager for AIX: Getting Started manual.

Specifying to run the host server program in a startable address space
You can run the host server program either in a startable address space or as a job
managed by an MVS initiator. This section describes how to run the host server
program in a startable address space.

You must place a JCL PROC in a PROCLIB and use the MVS START command to
run the PROC. The JCL must execute the AFP Upload server program, named
AUPTCPS. This program is written in the PL/I language. It requires that the
Language Environment runtime library be included in the STEPLIB definition. The
AFP Upload server program also requires that the SYSPRINT DD name be
allocated. For more information about the SYSPRINT DD name used by the host
server program, refer to “Specifying the SYSPRINT DD statement” on page 302.

You can use the MVS START and CANCEL commands to control execution of the
host server program. The host server program does not support or respond to the
MVS STOP and DISPLAY commands.

Note: The host server program runs continuously. If you run the host server
program in a startable address space, the host server program runs until you
cancel the address space.

Specifying to run the host server program as a job
You can run the host server program either in a startable address space or as a job
managed by an MVS initiator. This section describes how to run the host server
program as a job managed by an MVS initiator.

The JCL must execute the AFP Upload server program, named AUPTCPS. This
program is written in the PL/I language. It requires that the Language
Environment runtime library be included in the STEPLIB definition. The AFP
Upload server program also requires that the SYSPRINT DD name be allocated.
For more information about the SYSPRINT DD name used by the host server
program, refer to “Specifying the SYSPRINT DD statement” on page 302.

Specify TIME=NOLIMIT in the JCL EXEC statement. This specification causes job
step wait limits to be bypassed. If this specification is omitted, the job will end
with system code 522 if all of the tasks are in a wait state for the time specified in
the JWT parameter of the SMFPRMxx parmlib member. Lengthy waits are normal
during periods when no AFP Upload AIX clients send files to the host server
program.

Note: The host server program runs continuously. If you run the host server
program as a job managed by an MVS initiator, the host server program runs until
you cancel the job.

Example to run the host server program in a

For an explanation of these values, see “Specifying to run the host server program
in a startable address space.”
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Example to run the host server program as a job

For an explanation of these values, see “Specifying to run the host server program
as a job” on page 310.

//UPLOAD PROC
//STEP EXEC PGM=AUPTCPS
//STEPLIB DD DSN=AUP.SAUPLOAD,DISP=SHR
// DD DSN=CEE.SCEERUN,DISP=SHR
//SYSPRINT DD SYSOUT=*

Figure 30. Sample to run the host server program in a

//JOBNAME JOB ACCOUNT
//STEP EXEC PGM=AUPTCPS,TIME=NOLIMIT
//STEPLIB DD DSN=AUP.SAUPLOAD,DISP=SHR
// DD DSN=CEE.SCEERUN,DISP=SHR
//SYSPRINT DD SYSOUT=*

Figure 31. Sample to run the host server program as a job
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Chapter 33. Customizing error logs in the InfoPrint Manager
AIX server

InfoPrint Manager provides three configuration files for various InfoPrint
Managers servers and daemons:
1. spl_error.cfg for the InfoPrint Manager server error log.
2. notifyd_error.cfg for the Notification daemon error log.
3. sap_error.cfg for all the SAP daemons.

If you want to customize error logs for one of these servers or daemons to control
their size, whether they wrap, the severity level of messages written to the logs,
and the number of back-up logs that InfoPrint Manager saves, do one of the
following procedures.

Customizing an InfoPrint Manager server error log

By default, the InfoPrint Manager server error log starts when the InfoPrint
Manager server starts. Use the following procedure to customize the InfoPrint
Manager server error log(s). Any InfoPrint Manager server processes that are
running on this AIX server are changed by this customization the next time they
are started.
1. Find the spl_error.cfg file in the /usr/lpp/pd/bin directory and copy it into the

/var/pd or %PDBASE% directory:
cp /usr/lpp/pd/bin/spl_error.cfg /var/pd/spl_error.cfg

Note: If you already customize your server error logs, remember to change the
name or move the current spl_error.cfg file in /var/pd so that your
customization values can be copied over into the newer version of the file.

2. Open the copy of the spl_error.cfg file that you created and specify the settings
for the log attributes that you want (as shown in Figure 32).
For example, you can modify the log-backup-number attribute, which allows
you to specify the number of backup logs that InfoPrint saves, including the
initial error.log.BAK file.

When you start the InfoPrint Manager server after a shutdown, it backs up the
first error log by creating an error.log.BAK file. With each successive restart, it
creates an additional .BAK file, adding a timestamp as a fourth qualifier. By

#
# ErrorLog Configuration File
#
# Log size (units = KBytes)
log-size = 1024
# Wrap On?
log-wrap = true
# Severity?
log-severity = debug
# Number of backup log files
log-backup-number = 10

Figure 32. Sample spl_error.cfg file provided by InfoPrint Manager
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default, the log-backup-number attribute specifies a value of 10, meaning that
you can have nine back up files with timestamps and the initial .BAK file. You
can reduce this number as low as 1 or increase it as high as 999.
For a complete list of the error log attributes that you can customize, see the
″Attributes for logs″ section in ″InfoPrint object attributes″ chapter of InfoPrint
Manager: Reference.

3. Once you have finished defining your options, save and close the
/var/pd/spl_error.cfg file.

4. To shutdown the InfoPrint Manager server so that these customization changes
can take effect, specify from the AIX command line:pdshutdown -w now
servername .

Note: If you do not need the customization change to take effect immediately,
you can skip the final two steps and just wait until the next time the AIX
system where the InfoPrint Manager server is installed on is restarted.

5. To restart the server, enter start_server -F servername where servername is
the name of your InfoPrint Manager server.

Customizing a Notification daemon error log

By default, the Notification daemon error log starts when the Notification server
starts. Use this procedure to customize the InfoPrint Notification daemon error log.
1. Find the notifyd_error.cfg file from the /usr/lpp/pd/bin directory where the file

is installed and copy it into the /var/pd directory:
cp /usr/lpp/pd/bin/notifyd_error.cfg /var/pd/notifyd_error.cfg

Note: If you already customize your Notification daemon error log, remember
to change the name or move the current notifyd_error.cfg file in /var/pd so that
your customization values can be copied over into the newer version of the file.

2. Open the copy of the notifyd_error.cfg file that you created and specify the
settings for the log attributes that you want (as shown in Figure 33).
For example, you can modify the log-backup-number attribute, which lets you
specify the number of backup logs that InfoPrint saves, including the initial
error.log.BAK file.

When you start the Notification daemon after a shutdown, it backs up the first
error log by creating an error.log.BAK file. With each successive restart, it
creates an additional .BAK file, adding a timestamp as a fourth qualifier. By
default, the log-backup-number attribute specifies a value of 10, meaning that
you can have nine back up files with timestamps and the initial .BAK file. You
can reduce this number as low as 1 or increase it as high as 999.
For a complete list of the error log attributes that you can customize, see the
see the ″Attributes for logs″ section in ″InfoPrint object attributes″ chapter of
InfoPrint Manager: Reference.

#
# Error Log Configuration File
#
log-size = 1024
log-wrap = true
log-severity = debug
log-backup-number = 10

Figure 33. Sample notifyd_error.cfg file provided by InfoPrint Manager
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3. Once you have finished defining your options, save and close the
/var/pd/notifyd_error.cfg file.

Note: If you do not need the customization change to take effect immediately,
you can skip the final two steps and just wait until the next time the AIX
system where the InfoPrint Manager server is installed on is restarted.

4. From an AIX command line, specify stopnotd to shut down the Notification
daemon so that these customization changes can take effect.

5. Enter startnotd to restart the Notification daemon.
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Part 3. Operator and user procedures
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Chapter 34. Finishing options

Setting up finishing options for IPDS-only printers
Depending on the printer model, you can set up several finishing options.
InfoPrint Manager can be set up to support many of these possibilities, including
edge stitching (stapling one edge of the print job to create a booklet), saddle stitch
(stapling in the middle of the page to create a folded booklet), and corner stapling.
These sections describe how to set up finishing options for IPDS printers, including
the InfoPrint 45, InfoPrint 60, and InfoPrint 2000.

Telling InfoPrint Manager what options the finisher supports

The first step in enabling the finishing options is to let InfoPrint Manager know
what options the finisher supports. Follow the steps below to set the appropriate
values.

Note: If you are only to submit print jobs that specify a form definition to this
printer, you do not have to complete this procedure. You can proceed to “Setting
up InfoPrint Manager and clients to use finishing options” on page 326.
1. Start the InfoPrint Manager Administration GUI.
2. Find or create the PSF printer (actual destination) that sends jobs to the printer

you are setting up.
3. Right-click the printer and select Properties from the pop-up menu.
4. In the Printer Properties notebook, click the Job tab.
5. Find the Finishing options allowed field.

Note: If you don’t see the Finishing options allowed field, click Show More.
6. Select all of the finishing options that your finisher supports in the Possible

values list and add them to the Values list.
7. Click OK.

Setting up InfoPrint Manager and clients to use finishing
options

How you set up to use finishing options varies depending upon what kind of print
jobs you create and how you submit them. There are several categories; find the
one below that most resembles your situation.

Using the pdpr command
When you submit print jobs from the command line with the pdpr command, you
can use the job-finishing attribute on the –x flag to specify finishing options. For
example:
pdpr -d printername -x"job-finishing=staple-top-left" printfilename

You can also use the form-definition attribute on the –x flag to specify finishing
options. For example:
pdpr -d printername -x"form-definition=F1name" printfilename
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For a list of allowed values, proper syntax, and usage guidelines for the
job-finishing and form-definition attributes, see InfoPrint Manager: Reference.

Using a form definition
If you submit your print jobs using a form definition (either by specifying a certain
one or by using a default form definition), you can identify the finishing options
that you want to apply in the form definition. When you specify printing and
finishing options this way, no InfoPrint finishing attributes are necessary to request
the finishing options. The print job is sent to the printer and the options are read
out of the formdef. If the finisher supports the options chosen, the job should print
correctly without any more configuration on your part.

Note: InfoPrint Manager does not check the finishing options you specify in the
formdef against the options you set in “Telling InfoPrint Manager what options the
finisher supports” on page 326. As a result, if the finisher doesn’t support the
options, the job will fail.

Using InfoPrint Submit Express or InfoPrint Job Ticketer
When you submit a job using InfoPrint Submit Express or InfoPrint Job Ticketer,
you can select a variety of options, including finishing. Build your job ticket as you
usually would, and specify the finishing options that you want to use on the
appropriate tab or page.

Using InfoPrint Select
The InfoPrint Select client lets you specify job-finishing attribute values or a form
definition when submitting a job to the server. For more information about using
the job-finishing attribute, see InfoPrint Manager: Reference. For instructions on
setting attribute values in Select, consult the help system.

Using the InfoPrint AFP driver: If you are interested in using the powerful
features of AFP in a wide range of environments, you might want to install and
use the InfoPrint AFP driver with InfoPrint Select. To install and set up the
InfoPrint AFP driver, see ″Setting up the AFP driver″ in InfoPrint Manager for AIX:
Planning and Installation Guide. To specify the AFP driver for your printer, follow
the directions in the InfoPrint Manager for AIX: Getting Started guide, and specify
one of these drivers depending on your printer model:
1. For the InfoPrint 45 printer, specify the InfoPrint AFP 4345 driver.
2. For the InfoPrint 60 printer, specify the InfoPrint AFP 3160 driver.
3. For the InfoPrint 2000 printer, specify the InfoPrint AFP 2710 driver.

Once installed, you can click either the Printing Preferences button on Windows
2000/XP systems from the Print window, and then use the AFP driver to specify
inline form definitions with finishing options, or make use of other AFP features.

PSF printer:

If you want to use InfoPrint Select to submit print jobs with finishing options to a
PSF printer, you must create a Select printer that uses the specific printer driver for
your printer shown here. The driver is installed on your system when you install
InfoPrint Select. Use the procedure that is described in the InfoPrint Manager for
AIX: Getting Started guide for creating a Select printer, modifying it as described
below.
1. Follow the procedure through creating a port and selecting an InfoPrint

destination.
2. When the Add Printer wizard asks you to select a manufacturer and a printer

model, don’t select anything, just click Have Disk.
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3. In the Install from Disk dialog, click Browse and navigate to the directory that
you installed InfoPrint Select in. The default directory is c:\Infoprint.

Note: Because this dialog assumes the the driver is actually on a floppy disk or
CD-ROM, you might receive an error that the drive is not ready. In the error
box, click Cancel. A Windows Open dialog should then open. Use that dialog
to navigate to the correct directory.

4. Select the Ibmprint.inf file and click Open.
5. Select the appropriate driver based on your printer model and click OK.
v For the InfoPrint 45 printer, specify the IBM AFP 4345 driver.
v For the InfoPrint 60 printer, specify the IBM AFP 3160 driver.
v For the InfoPrint 2000 printer, specify the IBM AFP 2710 driver.

6. In the Install from Disk dialog, click Next.
7. Complete the wizard as usual.

When you submit jobs to this printer, you can select the finishing option you want
to use.

Note: The IBM InfoPrint 60 with Finisher driver only supports four finishing
options: top corner, bottom corner, 2 edge stitch (two staples in one side of the
paper), and 3 edge stitch (three staples on one side of the paper). If you need to
use other finishing options, you have to use a different submission method.

Using MVS Download
MVS Download is an optional feature of PSF for z/OS that uses TCP/IP to
automatically send data sets from the JES spool, without formatting them, directly
to InfoPrint Manager for AIX or InfoPrint Manager for Windows. InfoPrint
Manager receives the data sets into files, formats them, and sends them to the
printer. When you submit a print job with MVS Download, do one of these:
v Specify a mapping from a JCL keyword to a finishing attribute in the AIX shell

script. The selected JCL parameter you specify in z/OS maps to the InfoPrint
Manager pdpr finishing attribute.

v Use the existing form definition JCL keyword to form definition attribute
mapping. The JCL FORMDEF parameter you specify in z/OS maps to the
InfoPrint Manager pdpr form definition attribute.

v Specify a default form definition or finishing attribute so all jobs have the same
finishing option.

Using InfoPrint Manager hot folders
An InfoPrint Manager hot folder is a directory that is associated with a logical
destination. When you copy or move a file to the hot folder, InfoPrint Manager
automatically submits the file to that logical destination. The default job and
document finishing attributes that are set for the logical destination are applied to
jobs submitted through the hot folder. You can also specify other finishing
attributes or use different values for existing attributes.

Using InfoPrint Manager LPD and an LPR client
The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit
print jobs from other operating systems using a Line Printer (LPR) client. To
submit print jobs with finishing to the InfoPrint Manager LPD, you must use an
LPR client, such as lprafp, that lets you use –o options to specify advanced
printing options (for example, form definitions and page definitions) when you
submit jobs to InfoPrint Manager. You can either specify finishing attributes on the
submission command or use a default job.
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Selecting the correct finishing options

In InfoPrint Manager, the finishing options have very descriptive names so that it
is easy to select the one you want for your job. However, the names of those
options are based on print jobs that use the ″portrait″ orientation, and as a result
are misleading for jobs that printed in the ″landscape″ orientation. In addition,
some of the options are valid if the paper is fed through the printer long edge first
(LEF) and not valid if the paper is fed short edge first (SEF), and vice versa. As a
result, choosing the correct finishing option can be confusing. These tables can help
you determine which option to select for the InfoPrint 45, InfoPrint 60, and
InfoPrint 70, based on how you want your job to be finished.

Paper fed LEF
Table 39. Options to set for paper fed LEF on the InfoPrint 45

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

Not supported staple top left

One staple in the bottom left
corner

staple bottom left Not supported

More than one staple on the
left edge of the paper

edge stitch, OR edge stitch
left

Not supported

More than one staple on the
top edge of the paper

Not supported edge stitch OR edge stitch
left

Table 40. Options to set for paper fed LEF on the InfoPrint 60

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom left
corner

staple bottom left staple bottom right

One staple in the bottom
right corner

staple bottom right staple top right

More than one staple on the
left edge of the paper (uses
the default number of staples
that is set for the finisher)

edge stitch OR edge stitch
left

Not supported

Two staples on the left edge
of the paper

edge stitch 2 Not supported

Three staples on the left edge
of the paper

edge stitch 3 Not supported

More than one staple on the
top edge of the paper (uses
the default number of staples
that is set for the finisher)

Not supported edge stitch OR edge stitch
left
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Table 40. Options to set for paper fed LEF on the InfoPrint 60 (continued)

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

Two staples on the top edge
of the paper

Not supported edge stitch 2

Three staples on the top edge
of the paper

Not supported edge stitch 3

More than one staple on the
right edge of the paper

edge stitch right Not supported

More than one staple on the
bottom edge of the paper

Not supported edge stitch right

Table 41. Options to set for paper fed LEF on the InfoPrint 2000

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom left
corner

staple bottom left staple bottom right¹

One staple in the bottom
right corner

staple bottom right¹ staple top right

Two staples on the left edge
of the paper

edge stitch, edge stitch left,
OR edge stitch 2

Not supported

Two staples on the top edge
of the paper

Not supported edge stitch, edge stitch left,
OR edge stitch 2

Two staples on the right
edge of the paper

edge stitch right Not supported

Two staples on the bottom
edge of the paper

Not supported edge stitch right

¹ Some printers support this option via 180-degree image rotation, some do not.
See your printer documentation for more details.

Note: For the InfoPrint 2000, paper must be pulled from the paper tray
long-edge-first (LEF) for finishing options to be applied. Because ledger and A3
paper are both pulled from the paper tray short edge first (SEF), the InfoPrint 2000
does not support finishing options for those paper sizes.

Paper fed SEF
Table 42. Options to set for paper fed SEF on the InfoPrint 45

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left Not supported

One staple in the upper right
corner

staple top right staple top left
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Table 42. Options to set for paper fed SEF on the InfoPrint 45 (continued)

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the bottom
right corner

Not supported staple top right

More than one staple on the
right edge of the paper

Not supported edge stitch OR edge stitch
top

More than one staple on the
top edge of the paper

edge stitch OR edge stitch
top

Not supported

Table 43. Options to set for paper fed SEF on the InfoPrint 60

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom left
corner

staple bottom left staple bottom right

One staple in the bottom
right corner

staple bottom right staple top right

More than one staple on the
top edge of the paper (uses
the default number of staples
that is set for the finisher)

edge stitch OR edge stitch
top

Not supported

Two staples on the top edge
of the paper

edge stitch 2 Not supported

Three staples on the top edge
of the paper

edge stitch 3 Not supported

More than one staple on the
right edge of the paper (uses
the default number of staples
that is set for the finisher)

Not supported edge stitch OR edge stitch
top

Two staples on the right
edge of the paper

Not supported edge stitch 2

Three staples on the right
edge of the paper

Not supported edge stitch 3

More than one staple on the
left edge of the paper

Not supported edge stitch bottom

More than one staple on the
bottom edge of the paper

edge stitch bottom Not supported

Default number of staples in
the center of the sheet

saddle stitch saddle stitch

Staple positions for new InfoPrint printers

For more information about using this support, see the latest version of the
InfoPrint 2060ES/2075ES InfoPrint 2090ES/2105ES Finishing Guide, (S544–5845).
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Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and
InfoPrint 2090ES
Table 44. Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES
mapped to InfoPrint Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported center

Note: The InfoPrint Manager value saddle-stitch means staple down the center. With
the InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES, printers, saddle-stitch
is only supported for sheets in the landscape orientation, and if this is specified
along with bin 3, the sheets are sent to the BookletMaker.

Staple positions for InfoPrint 2105ES
Table 45. Staple positions for InfoPrint 2105ES mapped to InfoPrint Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported
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Setting up finishing options for PS/PCL printers
Depending on the printer model, you can set up several finishing options.
InfoPrint Manager can be set up to support many of these possibilities, including
edge stitching (stapling one edge of the print job to create a booklet), saddle stitch
(stapling in the middle of the page to create a folded booklet), and corner stapling.
These sections describe how to set up finishing options for printers that can be
sent PostScript and PCL, including the InfoPrint 70, InfoPrint 2085, and InfoPrint
2105.

Telling InfoPrint Manager what options the finisher supports
The first step in enabling the finishing options is to let InfoPrint Manager know
what options the finisher supports. Follow the steps below to set the appropriate
values.

Note: For the InfoPrint 70, InfoPrint 2060ES, InfoPrint 2075ES, InfoPrint 2085,
InfoPrint 2090ES, InfoPrint 2105, and InfoPrint 2105ES, the PSF DSS sets default
values for the job-finishings-supported attribute, so you do not need to do this
setup process for the actual destination. These are the default settings:

InfoPrint 70
staple-top-left, staple-bottom-left, staple-top-right, edge-stitch

InfoPrint 2085, InfoPrint 2105
staple-top-left, staple-bottom-left, staple-top-right, edge-stitch,
edge-stitch-left

InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES
staple-top-left, staple-bottom-left, edge-stitch, edge-stitch-left, saddle-stitch

InfoPrint 2105ES
staple-top-left, staple-bottom-left, edge-stitch, edge-stitch-left

1. Start the InfoPrint Manager Administration GUI.
2. Find or create the PSF printer (actual destination) that sends jobs to the printer

you are setting up.
3. Right-click the printer and select Properties from the pop-up menu.
4. In the Printer Properties notebook, click the Job tab.
5. Find the Finishing options allowed field.

Note: If you don’t see the Finishing options allowed field, click Show More.
6. Select all of the finishing options that your finisher supports in the Possible

values list and add them to the Values list.
7. Click OK.

Setting up InfoPrint Manager and clients to use finishing
options

How you set up to use finishing options varies depending upon what kind of print
jobs you create and how you submit them. There are several categories; find the
one below that most resembles your situation.

Using the pdpr command
When you submit print jobs from the command line with the pdpr command, you
can use the job-finishing attribute on the –x flag to specify finishing options. For
example:
pdpr -d printername -x"job-finishing=staple-top-left" printfilename

326 InfoPrint Manager for AIX: Procedures



You can also use the form-definition attribute on the –x flag to specify finishing
options. For example:
pdpr -d printername -x"form-definition=F1name" printfilename

For a list of allowed values, proper syntax, and usage guidelines for the
job-finishing and form-definition attributes, see InfoPrint Manager: Reference.

Using a form definition
If you submit your print jobs using a form definition (either by specifying a certain
one or by using a default form definition), you can identify the finishing options
that you want to apply in the form definition. When you specify printing and
finishing options this way, no InfoPrint finishing attributes are necessary to request
the finishing options. The print job is sent to the printer and the options are read
out of the formdef. If the finisher supports the options chosen, the job should print
correctly without any more configuration on your part.

Note: InfoPrint Manager does not check the finishing options you specify in the
formdef against the options you set in “Telling InfoPrint Manager what options the
finisher supports” on page 326. As a result, if the finisher doesn’t support the
options, the job will fail.

Using InfoPrint Submit or Submit Express
When you submit a job using InfoPrint Submit, you can select a variety of options,
including finishing. Build your job ticket as you usually would, and specify the
finishing options that you want to use in the Finishing field on the appropriate
tab.

Using InfoPrint Select
If you apply InfoPrint Manager for AIX Program Temporary Fix (PTF)
U483882(available in November 2002), your enhanced InfoPrint Select client lets
you specify job-finishing attribute values or a form definition when submitting a
job to the server. For more information about using the job-finishing attribute, see
InfoPrint Manager: Reference. For instructions on setting attribute values in Select,
consult the help system provided with the PTF U483882 level of InfoPrint Select.

The automatic data stream transforms that PSF printers use do not support
finishing (stapling), so in general, if you plan to use InfoPrint Select to submit PCL
or PostScript jobs to a PSF printer (destination), you cannot specify finishing
options when you submit a job, even if the print driver you use supports those
options. However, there are other submission methods that will allow you to
submit jobs with finishing options using Select.

Using the InfoPrint AFP driver: If you are interested in using the powerful
features of AFP in a wide range of environments, you might want to install and
use the InfoPrint AFP driver with InfoPrint Select. To install and set up the
InfoPrint AFP driver, see ″Setting up the AFP driver″ in InfoPrint Manager for AIX:
Planning and Installation Guide. To specify the AFP driver for your printer, follow
the directions in ″Installing and configuring the AFP driver″ from the InfoPrint
Manager for AIX: Installation Instructions, and specify one of these printer drivers
depending on your printer model:
1. For the InfoPrint 70 printer, specify the InfoPrint AFP 2770 driver.
2. For the InfoPrint 2085 printer, specify the InfoPrint AFP 2785 driver.
3. For the InfoPrint 2105 printer, specify the InfoPrint AFP 2705 driver.

Once installed, you can click either the Printing Preferences button on Windows
2000 systems or the Setup button on Windows NT® systems from the Print
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window, and then use the AFP driver to specify inline form definitions with
finishing options, or make use of other AFP features.

Using a PSF other-driver printer: You can use the document-formats-ripped-at-
destination actual destination attribute to prevent the automatic data stream
transform from occurring. See InfoPrint Manager: Reference for details.

Using an AIX printer: An AIX printer does not transform the data stream.This
type of destination uses fewer processing resources but provides fewer functions.

Any other destination type: If you want to use InfoPrint Select to submit print
jobs to a different destination type (such as a BSD or IPP printer), the only way to
request finishing options on PCL and PostScript jobs is to use default jobs. A
default job is a list of attributes that is applied to every job that a particular logical
destination receives. You can use the InfoPrint Manager Administration GUI to
modify the default job for the logical destination that InfoPrint Select sends jobs to
so that it requests the appropriate finishing options.

If you use default jobs, you will need a different logical destination for each
finishing option. Every job that you send to a particular logical destination will be
finished the same way. For example, if you set the Finishing options attribute of
the default job to staple-top-left, every job that is submitted to that printer will
have a staple in the top left corner. In addition, a logical destination can only have
one default job, and a default job can only have one finishing option set.

Using MVS Download
MVS Download is an optional feature of PSF for OS/390® that uses TCP/IP to
automatically send data sets from the JES spool, without formatting them, directly
to InfoPrint Manager for AIX or InfoPrint Manager for Windows. InfoPrint
Manager receives the data sets into files, formats them, and sends them to the
printer. When you submit a print job with MVS Download, do one of these:
v Specify a mapping from a JCL keyword to a finishing attribute in the AIX shell

script. The selected JCL parameter you specify in OS/390 maps to the InfoPrint
Manager pdpr finishing attribute.

v Use the existing form definition JCL keyword to form definition attribute
mapping. The JCL FORMDEF parameter you specify in OS/390 maps to the
InfoPrint Manager pdpr form definition attribute.

v Specify a default form definition or finishing attribute so all jobs have the same
finishing option.

Using InfoPrint Manager hot folders
An InfoPrint Manager hot folder is a directory that is associated with a logical
destination. When you copy or move a file to the hot folder, InfoPrint Manager
automatically submits the file to that logical destination. The default job and
document finishing attributes that are set for the logical destination are applied to
jobs submitted through the hot folder. You can also specify other finishing
attributes or use different values for existing attributes. For instructions on using
hot folders see ″Setting up hot folders to submit jobs″ in InfoPrint Manager for AIX:
Getting Started.

Using InfoPrint Manager LPD and an LPR client
The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit
print jobs from other operating systems using a Line Printer (LPR) client. To
submit print jobs with finishing to the InfoPrint Manager LPD, you must use an
LPR client, such as lprafp, that lets you use –o options to specify advanced
printing options (for example, form definitions and page definitions) when you
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submit jobs to InfoPrint Manager. You can either specify finishing attributes on the
submission command or use a default job.

Selecting the correct finishing options

In InfoPrint Manager, the finishing options have very descriptive names so that it
is easy to select the one you want for your job. However, the names of those
options are based on print jobs that use the ″portrait″ orientation, and as a result
are misleading for jobs that printed in the ″landscape″ orientation. In addition,
some of the options are valid if the paper is fed through the printer long edge first
(LEF) and not valid if the paper is fed short edge first (SEF), and vice versa. As a
result, choosing the correct finishing option can be confusing. The tables below can
help you determine which option to select based on how you want your job to be
finished.

Paper fed LEF
Table 46. Options to set for paper fed LEF for the InfoPrint 70

Desired output Select this value for ″portrait″ jobs Select this value for ″landscape″
jobs

One staple in the upper left corner staple top left staple bottom left

One staple in the upper right corner Not supported staple top left

One staple in the bottom left corner staple bottom left Not supported

More than one staple on the left edge
of the paper

edge stitch, OR edge stitch left Not supported

More than one staple on the top edge
of the paper

Not supported edge stitch OR edge stitch left

Paper fed SEF
Table 47. Options to set for paper fed SEF for the InfoPrint 70

Desired output Select this value for ″portrait″ jobs Select this value for ″landscape″
jobs

One staple in the upper left corner staple top left Not supported

One staple in the upper right corner staple top right staple top left

One staple in the bottom right corner Not supported staple top right

More than one staple on the right
edge of the paper

Not supported edge stitch OR edge stitch top

More than one staple on the top edge
of the paper

edge stitch OR edge stitch top Not supported

Staple positions for InfoPrint 2085 and InfoPrint 2105
Table 48. Staple positions for InfoPrint 2085 and InfoPrint 2105 mapped to InfoPrint
Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported
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Table 48. Staple positions for InfoPrint 2085 and InfoPrint 2105 mapped to InfoPrint
Manager values (continued)

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported not supported

Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and
InfoPrint 2090ES
Table 49. Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES
mapped to InfoPrint Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported center

Note: The InfoPrint Manager value saddle-stitch means staple down the center. With
the InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES, printers, saddle-stitch
is only supported for sheets in the landscape orientation, and if this is specified
along with bin 3, the sheets are sent to the BookletMaker.

Staple positions for InfoPrint 2105ES
Table 50. Staple positions for InfoPrint 2105ES mapped to InfoPrint Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported
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Table 50. Staple positions for InfoPrint 2105ES mapped to InfoPrint Manager
values (continued)

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported not supported
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Chapter 35. Other procedures

Turning duplexing on and off for the InfoPrint 45 and InfoPrint 70
If your printer has the capability to duplex and has an option on the console to
turn it on and off, you should understand the hierarchy of duplex processing
options based on your selections.

The InfoPrint 45 and InfoPrint 70 can produce either simplex (single-sided) or
duplex (double-sided) output. You can turn the duplex option ON or OFF at the
printer console, depending upon what type of output you need. However, you can
also turn duplexing on and off using the sides attribute in InfoPrint Manager. If
you use InfoPrint Manager to turn duplexing on or off, the InfoPrint Manager
setting will override the setting on the printer.

You can set the sides attribute on a document, default document, or an actual
destination. You can also specify duplex or simplex in a form definition (formdef).
If you set the attribute in a document, that setting overrides the value in the
formdef. The formdef overrides the setting on the default document, which
overrides the setting on the actual destination. All of these settings override the
setting on the printer console.

Important: The default value of the sides attribute on all three objects (document,
default document, and actual destination) is Use default. When InfoPrint Manager
encounters that value, it considers the attribute ″not set″ and looks to the next item
in the priority list to see if sides is set there. InfoPrint Manager keeps going down
the list until it finds a value to use.

Some examples of this behavior include:
v You turn duplexing OFF at the console of your InfoPrint 45. Then, you submit a

job to your InfoPrint 45 through InfoPrint Manager. The job uses a formdef that
requests duplex printing. The sides attributes on the document, default
document, and actual destination are set to Use printer default.
InfoPrint Manager looks at the sides attribute on the document, and considers it
″not set,″ so it looks at the formdef. The job prints duplex.

v You turn duplexing OFF at the console of your InfoPrint 70. Then, you use
InfoPrint Submit Express to send a job with Sides set to duplex, and don’t use a
formdef. The sides attributes on the default document is set to Use printer
default and on the actual destination is set to 1.
InfoPrint Manager looks at the sides attribute on the document, and sees that
InfoPrint Submit Express sets it to 2. InfoPrint Manager ignores all of the other
values and the job prints duplex.

For additional information about the sides attribute, see the ″Attributes for
documents and default documents″ section in InfoPrint Manager: Reference
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Submitting a job to a DocuTech Model 135 printer

To send jobs to your networked DocuTech system, you must first create a BSD
destination on your AIX server. Once this is done, you can submit the job through
InfoPrint Manager and release it for printing using your local DocuTech
procedures.

Create a BSD destination for the DocuTech 135 printer

Using the InfoPrint basic administrator’s GUI, do these steps:
1. Drag the BSD template from the Types column in the template area, and drop it

on the Actual Destinations pane. You will be prompted to select the server that
will contain the actual destination.

2. Fill in the required information fields. Physical printer name is a name you
determine, and the command will be as follows: /usr/lpd/rembak -S docu1 -P
docutech135 where -S is the name of the remote print server where the job will
be sent, and where -P is the name of the queue on the remote print server
where the job will be sent.

3. Select the OK button. InfoPrint creates a new actual destination using the
information you supplied. It also creates a new logical destination and new
default job. The new default job is associated with the new logical destination
and requests the actual destination.

4. Enable the actual destination and logical printer.

Submit a job to the Docutech 135 printer

Use a familiar print submision mechanism such as InfoPrint Select or the pdpr
command to submit the job to the logical destination you just created.

For example, pdpr -pyuma-lp /bin/test.ps could be used to route a test job to a
logical printer named yuma-lp.

Note: The job will appear briefly in the jobs window and will be spooled to the
Docutech server.

Release the job from the Docutech 135 server interface and
printer console

1. Access the list of queued jobs, and the file you submitted should display in the
refreshed list. From the server window, release the job for printing. Job status
for each released job will display as the file is released.

2. Now on the DocuTech console, open the printer queue by clicking on its icon,
and open the Job File list. The new job appears in the Job File list.

3. Click on the job and move or copy the file to the printer queue. Your InfoPrint
manager job will then print on the DocuTech printer.
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Supporting status information for InfoPrint Network and HP printers

Network printers

If you have InfoPrint network printers in your InfoPrint Manager environment, be
sure to install the current version of the InfoPrint network printer drivers to take
advantage of InfoPrint Manager’s messaging support.

HP printers

If you have HP printers that you have already configured in InfoPrint Manager,
you will need to change the destination-command attribute to use the pioinfo
backend program rather than the piojetd backend program.

The necessary command is:
pdset -cde -x "destination command='/usr/lpd/pio/etc/pioinfo ipaddr'"

where ipaddr is the ip address or host name of the printer.

Stopping, restarting, or pausing a job that is currently printing
Use this procedure to stop printing a job and start printing it again or to stop
printing a job, move it to a different printer, and start printing again. If you are
printing an AFP print job, you can also use this procedure to stop printing a job
and start it again from any page in the job, not just from the beginning.

This procedure does NOT stop the printer; it only stops the job you select.

Once the job is stopped, the next job in the queue will start to print. If you need to
stop the printer (for example, to replace toner), use the procedure “Stopping a
printer to perform scheduled maintenance” on page 342.

Note: Refer to the online help in the InfoPrint Manager GUI if you need
instructions on completing any of these steps.

When you use the “Stopping the job” procedure, InfoPrint Manager considers the
job cancelled and does not collect any checkpoint information about the job. Unless
the operator changes the page range before releasing the job to print again, the job
restarts printing at page 1. Be sure to remember any n-upping associated with the
job when selecting the page range so that the pages are placed into the correct
partition in relation to each other. You might want to use this procedure when you
realize that a job has started to print on the wrong form.

Stopping the job
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. In the GUI, find the job that you want to stop and select it.
3. Click Job → Hold.

Note: If the Hold item doesn’t appear in the Job menu, use Add/Remove
Menu Items to add it.

4. Click OK.
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The job stops printing, the icon changes to black, and the job is listed in the job
window of the main InfoPrint Manager GUI window.

Restarting the job

Use this procedure to do one of these:
v Print the entire job on the same printer it was printing on before.
v Print the entire job on a different printer.
v Print part of the job (such as page one to page fifty, or page twelve to the end).

Important:

– When you use Job → Hold, the job information resets to the beginning of the
job. Checkpoint information is not stored.

– You can only start printing in the middle of the job if the job is transformed
into AFP before it gets printed. You cannot print part of an ASCII, KGL, or
metacode; you have to print the whole job.

– You can only start printing in the middle of the job if the job has only one
printable document. If it has more than one printable document, you either
have to print the whole job or use spacing to skip a section of the job. See the
“Moving backward or forward in a job that is currently printing” on page 340
for instructions on spacing.
If you submitted this job using DPF from a host system, you can start
printing from any page in the job, but InfoPrint Manager ignores any value
you enter for the end page. You will always print to the end of the job.

Note: Spacing will only work if you send the job to a PSF DSS printer.

To restart the print job:
1. To print the entire job on the same printer it was printing on before, select the

job in the job window and click Job → Release. The job will start printing from
the first page.

2. To print the entire job on a different printer, skip to Before you Continue
between steps 8 and 9 below.

3. If you only want to print part of the job, figure out what page you want to
start printing from.

Important: If you don’t want to start printing from the first page of the job,
be careful when you select which page to start with. Duplex and n-up jobs
can be confusing because you have to start printing with the first page on the
front side of the sheet of paper. If you don’t select the correct start page, the
job will print, but the sequence will probably be wrong.

For example, if you are printing a 2–up duplex job, each sheet of paper
actually has four pages printed on it, like this:
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Table 51. 2–up duplex print job: front and back views

Front of sheet Back of sheet

Sheet one

page 1 page 3 page 4 page 2

Sheet two

page 5 page 7 page 8 page 6

Last sheet

page n-3 page n-1 page n page n-2

Since you have to start printing this job at the first page on the front side, you
can select page one or page five (or any other page that would fall in that
position). If you select a different page, the sequence of pages will be wrong,
and the job won’t print correctly.

4. Figure out what page you want to stop printing on (if you don’t want to print
all the way to the end of the job).
You don’t have to be as precise on the last page to print; the last page can be
in any location on the sheet of paper.

5. Select the job you want to print.
6. With the job selected, click Job → Change Page Range to Process.

If you don’t see the Change Page Range to Process item in the Job menu, use
Add/Remove Menu Items to add it.

7. In the Change Page Range to Process dialog, select Range of Pages and type
the start page and end page you figured out above.

Note: If you submitted this job using Distributed Print Facility (DPF),
InfoPrint Manager ignores the end page that you specify. DPF jobs always
print from the start page you specify to the end of the job.

8. Click OK.
Before you continue:

You should only move a job to an InfoPrint printer that uses the same
destination support system (DSS) as the one the job was originally submitted
to. If you move the job to a printer that uses a different DSS and the new
printer doesn’t support all of the attributes of the job, the job will fail to print.
To check which DSS your InfoPrint printer uses, do this.
a. Select the printer in the tree view of the Main window of the InfoPrint

Manager GUI.
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b. See if the Type column appears in the details view. The Type column
displays the DSS that the InfoPrint printer uses.

c. If you don’t see the Type column, use Add/Remove menu items to add it.

Continue with step 9.
9. Select the job again and click Job → Move job.

10. In the Move Jobs dialog, select the printer that you want to print the job on.
You can select the same printer it was printing on before or a different one.
When you release the job in step 12 below, if the job is accepted it will go
back into the queue and wait to be printed. Depending on how many jobs are
ahead of it in the queue, it might take a while for the job to print. If you want
the job to print right away, you can either move it to the top of the queue (so
it prints next) or you can change its priority (so it prints sooner, but not
necessarily next).

11. To move the job to the top of the queue, select the job in the InfoPrint
Manager GUI and use the Make Job First task. To change the priority of the
job, use the Change Priority task.

12. Select the job in the job window and click Job → Release.

Note: If the task you want to use doesn’t appear in the menu, use
Add/Remove menu items to add it.

Pausing a job that’s printing
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. Find the job that you want to pause and select it.
3. Click either Job → Pause → Now or Job → Pause → After current copy.

Note: If the Pause item doesn’t appear in the Job menu, use Add/Remove
Menu Items to add it.

4. Click OK.
The job will stop printing, the icon will change to black, and the job will be
listed in the job window of the main InfoPrint Manager GUI window.

5. To resume the printing of this job, click Job → Resume.

Pausing and restarting an actual destination
Use these procedures to pause and restart an actual destination. You might want to
pause an actual destination when you are printing a long job, so that you can
perform maintenance on the printer.

Pausing an actual destination
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. In the GUI, find the actual destination you want to pause.
3. Right-click the actual destination, and select Stop or left-click the actual

destination and then left-click the icon on the toolbar.

Note: If the Stop action does not appear on the menu or toolbar, use the
Customize dialog to add the action.

4. Choose from these options:
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v Select Now to pause the actual destination
v Select After current copy to pause the actual destination after the current

copy has finished printing.
v Select After current job to pause the actual destination after the current job

has finished printing.
5. Click OK.

The actual destination stops printing, and the jobs processing on the actual
destination stay in the same state until the actual destination starts again..

Resuming the actual destination

To resume the actual destination:
v In the GUI, right-click the actual destination and select the Resume action.

v Select the actual destination and left-click the icon on the toolbar.

Interrupting and restarting a job that is currently printing on an
InfoPrint 4000/4100

Use this procedure:
v If you want to interrupt the job that is currently printing and start printing it

again
v If you want to interrupt the job that is currently printing, print another job, and

then start the job that you interrupted.
v If you want to interrupt the job that is currently printing, move the job to a

different printer, and start printing the job again.

This procedure does NOT stop the printer; it only stops the job that is currently
printing. Other jobs continue to print on this printer.

Once the job is stopped, the next job in the queue will start to print. If you need to
stop the printer (for example, to replace toner), use the procedure “Stopping a
printer to perform scheduled maintenance” on page 342.

Note: Refer to the online help in the InfoPrint Manager GUI if you need
instructions on completing any of these steps.

When you use the “Interrupting a job that is currently printing” procedure, the job
fills a physical sheet, stops, and prints a message after the last page indicating the
number of the last (AFP) page printed. The job shows on the GUI as Paused.
When the job restarts, it starts on the next page of the job in the next logical
partition. InfoPrint Manager prints a message at the end of the restarted section of
the job indicating the page on which the printing started. You might want to use
this procedure if you are printing a very long job, and you need to print another,
more urgent job immediately.

Interrupting a job that is currently printing
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. In the GUI, find the printer where the currently printing job is, and select it.
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3. Right-click the printer, and select Interrupt Printing Job or left-click the printer

and then left-click the icon on the toolbar.

Note: If the Interrupt Printing Job action does not appear on the Printer menu
or toolbar, use the Customize dialog to add the action.

4. Choose from these options:
v Select Now to interrupt the job as soon as possible
v Select After current copy to interrupt the job after the current copy has

finished printing.
5. Click OK.

The job that is currently printing stops printing, its icon changes to black, and
the job is listed in the job window of the main InfoPrint Manager GUI window.
Other jobs continue to print on this printer.

Restarting the interrupted job

To restart the interrupted print job:
v In the GUI, right-click the interrupted job and select the Resume action.
v Select the job and left-click the

icon on the toolbar.

Moving backward or forward in a job that is currently printing
In InfoPrint Manager, moving from page to page in a job is called spacing the
printer:
v Forward spacing is moving to a point later in the job (such as skipping from page

10 to page 15).
v Backspacing is moving to a point earlier in the job (such as backing up from page

40 to page 20).

Spacing a printer

Things to remember:

v You can only space a printer that uses the PSF Destination Support System
(DSS) and one of these attachment types:

– PSF TCP/IP
– PSF BSD
– PSF Other
To see what DSS your printer uses, do this:
1. Select the printer in the tree view of the Main window of the InfoPrint

Manager GUI.
2. See if the Type column appears in the details view. The Type column

displays the DSS that the InfoPrint printer uses.
3. If you don’t see the Type column, use Add/Remove menu items to add it.

v You can only space a printer after a job has already started to print.
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To only print a section of a job (such as page 11 to page 20), or to start printing
from a page other than the first page of the job, use the Change Page Range to
Process task in the InfoPrint Manager GUI.

v Spacing works better on high-speed printers than on low speed printers.

While spacing is supported on all printers that you print to using the PSF DSS,
it is very difficult to space printers that print 40 pages per minute (ppm) or less.
Spacing works adequately on printers that print between 60 and 100 ppm, and
works very well with high-speed InfoPrint printers that are configured correctly.

v The InfoPrint 2000, InfoPrint 3000, InfoPrint 4000, and InfoPrint 4100 printers
require additional configuration for spacing to work efficiently.

See the Setting up high speed printers for spacing topic for instructions on
configuring your printer.

v Page numbers refer to pages of the print job, not necessarily to any page
numbers in your document.

For example, in a book, the first page of chapter one is usually ″page 1.″
However, it might be page 15 of the print job, because of the title page, credits,
and table of contents.

v You cannot space to the back side of a sheet of paper.

If you are printing a duplex job, you will always print both the front and back
sides of the sheet of paper that you space to.

To space a printer, do this:
1. Start the InfoPrint Manager GUI.
2. In the GUI, find the InfoPrint printer that you need to space.
3. Select the InfoPrint printer by clicking on it, then click Printer → Stop.

Note: If you don’t see Stop in the menu, useAdd/Remove menu items to add
it.

4. In the Stop printer_name dialog, select Pause and Now, and click OK.
Even though you selected Now, the printer will keep printing for a while
because it has to get to a point in the job where it can stop. For InfoPrint 2000,
InfoPrint 3000, and InfoPrint 4000 printers that are configured correctly, you
shouldn’t have to wait more than 10 seconds. For other printers, you might
have to wait longer.

5. Once the printer has stopped printing, look at the last sheet that printed.
Write down the number of that sheet of the job.

6. Figure out what sheet of paper in the job you want to space to. Write down
the number of that sheet of the job.

7. Figure out the number of sheets of paper you need to space.
v To forward space the printer:

Subtract the number of the sheet that printed last (from step 5) from the
number of the sheet that you want to skip to (from step 6), and then
subtract one. Like this:
(number from step 6) – (number from step 5) – 1 = number of sheets to skip

v To backspace the printer:
Subtract the number of the sheet that you want to go back to (from step 6)
from the page that printed last (from step 5), and add one (for the current
page). Like this:
(number from step 5) – (number from step 6) + 1 = number of sheets to
back up
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8. Determine the number of ″sides″ to space the printer.
v If you are printing a simplex job, the number of sides is the same as the

number of sheet from step 7 on page 341.
v If you are printing a duplex job, multiply the number from step 7 on page

341 by two to get the number of sides. (number from step 7 on page 341 x 2
= number of sides)

9. In the InfoPrint Manager GUI, find the printer you want to space and select it.
10. With the printer selected, click Printer → Space.
11. In the Space printer_name dialog, select Backspace or Forward space and type

the number of sides you found in step 8.
12. Click OK.
13. Make sure the printer is still selected and click Printer → Resume to start the

printer again.

Stopping a printer to perform scheduled maintenance

Use this procedure to stop a printer so you can perform routine maintenance, such
as updating the microcode, changing paper, or cleaning the printer. While you
have the printer stopped, InfoPrint Manager will not be able to send or schedule
jobs to it. This procedure will work for printers that use any DSS.
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. In the GUI, find the printer that you want to stop and select it.
3. Use Printer—>Disable to disable the printer.

The InfoPrint printer will stop accepting jobs, but the printer will not stop
printing immediately. All of the jobs that were in the processing state before
you disabled the printer will print before it stops.

4. After the printer stops printing, you can perform whatever maintenance you
need to.

5. When you are finished and the printer is ready to receive jobs again, go back to
the InfoPrint Manager GUI.

6. Find the printer in the GUI and select it.
7. Use the GUI to enable the printer again.

The printer will be available to accept and print jobs again.

Fixing a printer problem and starting to print again
Use this procedure when the printer stops printing because of a paper jam, ″out of
paper″ error, or for some other reason.

Note: Refer to the online help in the InfoPrint Manager GUI if you need
instructions on completing any of these steps.
1. If you want to print the entire job on the same printer it was printing on

before, select the job in the job window and click Job → Release. The job will
start printing from the first page.

2. If you want to print the entire job on a different printer, skip to Before you
Continue between steps 8 and 9 below.

3. If you only want to print part of the job, figure out what page you want to
start printing from.
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Important: If you don’t want to start printing from the first page of the job,
be careful when you select which page to start with. Duplex and n-up jobs
can be confusing because you have to start printing with the first page on the
front side of the sheet of paper. If you don’t choose the correct start page, the
job will print, but the sequence will probably be wrong.

For example, if you are printing a 2–up duplex job, each sheet of paper
actually has four pages printed on it, like this:

Table 52. 2–up duplex print job: front and back views

Front of sheet Back of sheet

Sheet one

page 1 page 3 page 4 page 2

Sheet two

page 5 page 7 page 8 page 6

Last sheet

page n-3 page n-1 page n page n-2

Since you have to start printing this job at the first page on the front side, you
can select page one or page five (or any other page that would fall in that
position). If you select a different page, the sequence of pages will be wrong,
and the job won’t print correctly.

4. Figure out what page you want to stop printing on (if you don’t want to print
all the way to the end of the job).
You don’t have to be as precise on the last page to print; the last page can be
in any location on the sheet of paper.

5. Select the job you want to print.
6. With the job selected, click Job → Change Page Range to Process.

If you don’t see the Change Page Range to Process item in the Job menu, use
Add/Remove Menu Items to add it.

7. In the Change Page Range to Process dialog, select Range of Pages and type
the start page and end page you figured out above.

Note: If you submitted this job using Distributed Print Facility (DPF),
InfoPrint Managerignores the end page that you specify. DPF jobs always
print from the start page you specify to the end of the job.

8. Click OK.
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Before you continue:

You should only move a job to an InfoPrint printer that uses the same
destination support system (DSS) as the one the job was originally submitted
to. If you move the job to a printer that uses a different DSS and the new
printer doesn’t support all of the attributes of the job, the job will fail to print.
To check which DSS your InfoPrint printer uses, do this.
a. Select the printer in the tree view of the Main window of the InfoPrint

Manager GUI.
b. See if the Type column appears in the details view. The Type column

displays the DSS that the InfoPrint printer uses.
c. If you don’t see the Type column, use Add/Remove menu items to add it.

Continue with step 9.
9. Select the job again and click Job → Move job.

10. In the Move Jobs dialog, select the printer that you want to print the job on.
You can select the same printer it was printing on before or a different one.
When you release the job in step 12 below, if the job is accepted it will go
back into the queue and wait to be printed. Depending on how many jobs are
ahead of it in the queue, it might take a while for the job to print. If you want
the job to print right away, you can either move it to the top of the queue (so
it prints next) or you can change its priority (so it prints sooner, but not
necessarily next).

11. To move the job to the top of the queue, select the job in the InfoPrint
Manager GUI and use the Make Job First task. To change the priority of the
job, use the Change Priority task.

12. Select the job in the job window and click Job → Release.

Note: If the task you want to use doesn’t appear in the menu, use
Add/Remove menu items to add it.

Try this first

″Out of paper″ errors and some paper jams are easy to recover from. Most of the
time, you don’t have to do anything to InfoPrint Manager to fix them; InfoPrint
Manager just waits until the printer is ready to print again. While it is waiting,
InfoPrint Manager continues to accept jobs and schedule them to the printer.

If the printer stops printing because of a problem, first try this.
1. Check the printer.
v If a lot of pages of the job are ruined and need to be reprinted, stop here.

Don’t finish this procedure. Use the “Fixing more complicated problems” on
page 345 procedure below instead.

v Otherwise, load paper if the bins are empty or clear paper jams as the printer
console indicates. Once everything is clear, the printer should reset itself and
continue sending jobs. InfoPrint Manager should pick up where it left off.

2. Find the printer in the InfoPrint Manager GUI. Make sure that its status is
ready. If it is not, select the printer and use the GUI to enable it.

3. If just a few pages of the print job need to be printed again, the easiest thing to
do is to resubmit the job and print just those pages. You can only print part of
the job if you are using the PSF DSS and if the job will be transformed to AFP
before it is printed.

344 InfoPrint Manager for AIX: Procedures



Fixing more complicated problems

Use this procedure when the problem is more difficult to fix or if you have to
reprint numerous pages of a job.
1. Open the InfoPrint Manager GUI.
2. Find the InfoPrint Manager printer (also called an actual destination) that

sends jobs to that printer and select it.
3. Use the GUI to disable the printer.

The printer won’t be able to accept any print jobs until you enable it again.
4. If the printer stopped printing in the middle of a job, find that job in the GUI

and select it.
5. With the job selected, click Job → Hold.

Note: If the Hold item doesn’t appear in the Job menu, use Add/Remove
Menu Items to add it.

6. Click OK.
The job will stop printing, the icon will change to black, and the job will be
listed in the job window of the main InfoPrint Manager GUI window.

7. Decide what you want to do with any other jobs that are in the queue waiting
for this printer. Some of the options are:
v Leave them in the queue, so they print when you enable the printer again.

If you can fix the problem quickly, this option is the easiest one. In addition,
if your printers are pooled, the other printers will take care of all of the jobs
until this one is ready.

v Move them to a different printer so they can be scheduled to print while
you are working on this one.

v Delete them. You should only consider this option if it is easier to resubmit
the jobs than to use other methods to recover them.

8. Fix the problem at the printer.
Once the problem is fixed, the printer might start to print again, just to clear
the pages that were in the buffer before you disabled it and deleted the job. If
any other jobs were in processing state when you disabled the printer, they
will print as well.

9. Go back to the InfoPrint Manager GUI, find the InfoPrint printer again, and
select it.

10. Use the GUI to enable the printer.
The printer will be available to accept jobs again. If you left jobs in the queue,
the printer should start accepting and printing them.

Restarting the job that was printing when the problem
occurred

You can either:
v Start the job from the beginning.
v Start the job from a point before the problem occurred (so the ruined pages get

printed).
Important:

– You can only start printing in the middle of the job if the job is transformed
into AFP before it gets printed. You cannot print part of an ASCII, KGL, or
metacode; you have to print the whole job.
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– You can only start printing in the middle of the job if the job has only one
printable document. If it has more than one printable document, you either
have to print the whole job or use spacing to skip a section of the job. See the
“Moving backward or forward in a job that is currently printing” on page 340
topic for instructions on spacing.

Note: Spacing will only work if you send the job to a PSF DSS printer.
1. If you want to print the entire job on the same printer it was printing on

before, select the job in the job window and click Job → Release. The job will
start printing from the first page.

2. If you want to print the entire job on a different printer, skip to Before you
Continue between steps 8 and 9 below.

3. If you only want to print part of the job, figure out what page you want to
start printing from.

Important: If you don’t want to start printing from the first page of the job,
be careful when you select which page to start with. Duplex and n-up jobs
can be confusing because you have to start printing with the first page on the
front side of the sheet of paper. If you don’t select the correct start page, the
job will print, but the sequence will probably be wrong.

For example, if you are printing a 2–up duplex job, each sheet of paper
actually has four pages printed on it, like this:

Table 53. 2–up duplex print job: front and back views

Front of sheet Back of sheet

Sheet one

page 1 page 3 page 4 page 2

Sheet two

page 5 page 7 page 8 page 6

Last sheet

page n-3 page n-1 page n page n-2

Since you have to start printing this job at the first page on the front side, you
can select page one or page five (or any other page that would fall in that
position). If you select a different page, the sequence of pages will be wrong,
and the job won’t print correctly.
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4. Figure out what page you want to stop printing on (if you don’t want to print
all the way to the end of the job).
You don’t have to be as precise on the last page to print; the last page can be
in any location on the sheet of paper.

5. Select the job you want to print.
6. With the job selected, click Job → Change Page Range to Process.

If you don’t see the Change Page Range to Process item in the Job menu, use
Add/Remove Menu Items to add it.

7. In the Change Page Range to Process dialog, select Range of Pages and type
the start page and end page you figured out above.

Note: If you submitted this job using Distributed Print Facility (DPF),
InfoPrint Managerignores the end page that you specify. DPF jobs always
print from the start page you specify to the end of the job.

8. Click OK.
Before you continue:

You should only move a job to an InfoPrint printer that uses the same
destination support system (DSS) as the one the job was originally submitted
to. If you move the job to a printer that uses a different DSS and the new
printer doesn’t support all of the attributes of the job, the job will fail to print.
To check which DSS your InfoPrint printer uses, do this.
a. Select the printer in the tree view of the Main window of the InfoPrint

Manager GUI.
b. See if the Type column appears in the details view. The Type column

displays the DSS that the InfoPrint printer uses.
c. If you don’t see the Type column, use Add/Remove menu items to add it.

Continue with step 9.
9. Select the job again and click Job → Move job.

10. In the Move Jobs dialog, select the printer that you want to print the job on.
You can select the same printer it was printing on before or a different one.
When you release the job in step 12 below, if the job is accepted it will go
back into the queue and wait to be printed. Depending on how many jobs are
ahead of it in the queue, it might take a while for the job to print. If you want
the job to print right away, you can either move it to the top of the queue (so
it prints next) or you can change its priority (so it prints sooner, but not
necessarily next).

11. To move the job to the top of the queue, select the job in the InfoPrint
Manager GUI and use the Make Job First task. To change the priority of the
job, use the Change Priority task.

12. Select the job in the job window and click Job → Release.

Note: If the task you want to use doesn’t appear in the menu, use
Add/Remove menu items to add it.
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Appendix A. IPDS print operator commands

InfoPrint Manager offers a comprehensive set of operator commands that can be
used to manage printing on IPDS printers. These commands can be used to help
manage printing priorities and also help by providing the operator with functions
that are useful when dealing with problems that can occur in the printing system.
This table describes several of the most commonly used operator tasks, and their
corresponding commands. For more information, see the InfoPrint Manager:
Reference.

Task Description InfoPrint Manager Command
Syntax

1 Disable
Stop a printer from receiving
new jobs.

pddisable -cd dest where dest
specifies either a logical or an
actual destination (printer) object.

2 Enable
Allow a printer to receive
new jobs.

pdenable -cd dest where dest
specifies either a logical or an
actual destination (printer) object.

3 Query active job

Query which job is actively
printing on a printer
Notes: The query response is
based on the last set of
station counters obtained
from the printer, which is
printing pages continuously.
To get an absolutely accurate
query you must:

v Pause the printer (7)

v Issue the query

v Resume the printer (11).

pdls -f ″destination-name-
requested==ldest &&
current-job-state==printing″
server: where server specifies the
InfoPrint AIX server to which the
job was submitted, and
destspecifies the actual destination
(physical printer).

4
Query page
number

Query the page number of
the currently printing page.
See Note after (3).

pdls -cj -r current-page-printing
jobid where jobid specifies the
job-identifier attribute. we
recommend using the global ID,
which follows the convention
server:0123456789 where server
specifies the name of the InfoPrint
AIX server to which this job was
submitted and 0123456789
indicates a 10-digit numeric value
assigned by the InfoPrint spooler.
You can determine the
job-identifier attribute value by
specifying: pdls -cj server:

5
Query job
details

Query the number of copies,
sheets and pages stacked for
a job. See Note after (3).

pdls -cj -r ″job-copies-completed
media-sheets-completed
pages-completed″ jobid where
jobid specifies the job-identifier
attribute.

6 Clean
Remove all jobs from a
printer.

pdclean ldest where ldest specifies
the logical destination (logical
printer).
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Task Description InfoPrint Manager Command
Syntax

7 Pause printer Pause a printer immediately.
pdpause -cd dest where dest
specifies the actual destination
(physical printer).

8 Pause printer
Pause a printer after the
current copy completes.

pdpause -cd -w after-current-copy
dest where dest specifies the
actual destination (physical
printer).

9 Pause printer
Pause a printer after the
current job completes.

pdpause -cd -w after-current-job
dest where dest specifies the
actual destination (physical
printer).

10 Resume printer
Resume a printer that had
been paused.

pdresume -cd dest where dest
specifies the actual destination
(physical printer).

11 Cancel job Cancel a specific job.
pdrm jobid where jobid specifies
the job-identifier attribute.

12 Pause job
Pause a specific job after the
current copy completes.

pdpause -cj -w after-current-copy
jobid where jobid specifies the
job-identifier attribute.

13 Pause job
Pause a specific job
immediately.

pdpause -cj jobid where jobid
specifies the job-identifier
attribute.

14 Pause job
Pause the job that is
currently printing
immediately.

pdpause -cd -j dest where dest
specifies the actual destination
(physical printer).

15 Pause job
Pause the job that is
currently printing after the
current copy.

pdpause -cd -j -w
after-current-copy dest where dest
specifies the actual destination
(physical printer).

16 Resume job
Resume a job that was
paused.

pdresume -cj jobid where jobid
specifies the job-identifier
attribute.

17 Back space
Back space (reprint a specific
number of sides) the job that
is printing.

pdspace -cd -b sidecount dest
where dest specifies the actual
destination (physical printer).

18 Reprint
Reprint the job that is
printing from the beginning.

pdspace -cd -b -1 dest where dest
specifies the actual destination
(physical printer).

19 Forward space
Forward space (skip a
specific number of sides) the
job that is printing.

pdspace -cd -f sidecount dest
where dest specifies the actual
destination (physical printer).

If one of these commands is received and it affects a job that has been sent or is in
the process of being sent to the printer, InfoPrint Manager immediately stops
sending data to the printer and sends the printer a command to stop printing (this
applies to commands 7, 9, 10, 12-15).

For printers that support the SNMP Remote Operator interface, like the InfoPrint
4000, the printer will stop in a few seconds. For printers without this support,
some pages will likely print before the printer stops.
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The number of pages that print before the printer stops will vary depending on the
number, size, and complexity of jobs that are in process as well as the speed and
type of printer involved. Once the printer has stopped, InfoPrint Manager does the
steps necessary to execute the requested operator command.
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Appendix B. IPDS error recovery

When driving an IPDS printer, InfoPrint Manager sends page and resource data to
the printer. The printer reports status and errors back to InfoPrint Manager. The
printer status information is in the form of station counters representing progress
of pages sent to the device through the printer microcode and the physical printing
mechanism. Station counters report the number of pages and the number of copies
of pages proceeding through each point in the printer.

InfoPrint Manager requests printer status information (an acknowledgement
request) after sending each job. The acknowledgement response contains the latest
values of all the printer station counters. Once all pending jobs have been
processed, InfoPrint Manager polls the printer periodically until all the pages of
each job have been stacked.

The actual destination object ack-interval attribute is configurable and defines how
often InfoPrint Manager requests updated station counters from the printer while
processing a particular job. The value for this attribute is specified in terms of
pages and can be from 1 to 9999; the default value is 100 pages. For a 360 page job,
an ack-interval setting of 100 pages means that InfoPrint Manager will send an
acknowledgement request to the printer after sending pages 100, 200, 300, and 360.

The printer responds to an acknowledgement request and returns station counters
when all of the pages up to that point have been processed. This does not
necessarily mean that all of those pages have printed or are stacked. The
acknowledgement response from the printer after the 100th page will show that
100 pages have been processed (received). The printer might report, however, that
only 10 pages have stacked.

The ack-interval value affects printing performance and the currency of job status
information. A small ack-interval value causes increased communication and
processing and can cause a reduction in printer throughput. A small ack-interval
value will, however, increase the frequency that job attributes such as
current-page-printing, job-copies-completed, media-sheets-completed, and
pages-completed are updated. A small ack-interval value will also enable the
InfoPrint Manager software to have more recent station counters than it would
with a large ack-interval value.

Errors reported from the printer can be grouped into these categories:
v “IPDS error recovery: Data stream errors”
v “IPDS error recovery: Insufficient memory in the printer” on page 357
v “IPDS error recovery: Intervention required conditions” on page 358
v “IPDS error recovery: Unrecoverable problems” on page 359

IPDS error recovery: Data stream errors

For data stream errors, the job might continue printing or the job might be
terminated, depending on the severity of the error. There are hundreds of specific
data stream errors. If one data stream error is defined for the error, InfoPrint
Manager directs the printer to continue processing the page and take an alternate
exception action.
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When a data stream error occurs, messages are produced describing the problem
and the recovery actions performed. The messages report details about the error
and include the page number where the error occurred. After InfoPrint Manager
receives a data stream error from the printer and produces a message, it uses
station counters returned from the printer to continue printing without skipping or
reprinting any pages.

Reporting of some data stream errors (for example, using undefined code points in
a font or printing outside of the valid printable area) can be controlled with job
attributes. This allows the job submitter to decide whether error messages or
printer error marks should be generated when these types of errors are
encountered:
v “Data stream error example 1 (job continues printing):”
v “Data stream error example 2 (job is terminated, no pages print):”
v “Data stream error example 3 (job is terminated; some pages print):” on page

357

Interrupt Message Pages

If Interrupt Message Pages are activated, InfoPrint Manager will insert an IMP to
mark the location of the error. See “Using Interrupt Message Pages” on page 93 for
more information.

Data stream error example 1 (job continues printing):

If page 3 of a 10–page document tries to print outside the valid printable area (an
error) and the submitter specified (data-fidelity-problem-reported=all), this occurs:
1. Pages 1-2 and 4-10 in the document print normally.
2. For page 3, the printer prints only the data that is inside the valid printable

area. In addition, a printer error marker (PEM) is printed on the page where
the print data extends outside the valid printable area.

3. After all 10 pages have printed, a set of messages is printed:

0420-094: The following messages were generated for file /info/afp/baddata with
Job ID 123. This file printed on the InfoPrint destination ip60, which is a
3160 destination.

0420-484: The destination reported that an attempt was made to print outside of the
valid printable area.

0420-249: InfoPrint received IPDS exception X’08C1..00’, action code X’01’ from the
destination.

0420-098: The error occurred while printing page 3 of copy 1 of this print job.

0420-254: The destination reported an error that caused InfoPrint to stop processing
the page.

Data stream error example 2 (job is terminated, no pages
print):

If a document is submitted and it requests a specific form definition which does
not exist, this occurs:
1. The document does not print. However, auxiliary sheets such as the start sheet

(header) and end sheet (trailer) page, if requested, do print.
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2. A message page will print with these messages:

0420-094: The following messages were generated for file /info/afp/testfdef with
Job ID 456. This file printed on the InfoPrint destination ip60, which is a
3160 destination.

0420-128: ERROR: InfoPrint cannot find or cannot access the FORMDEF resource
named F1BAD.

0420-060: The error occurred with the object type page with token name PAGE0001.

0420-060: The error occurred with the object type document with token name ASCII.

0420-098: The error occurred while printing page 1 of copy 1 of this print job.

Data stream error example 3 (job is terminated; some pages
print):

If page 5 of a 10–page document requests a font (C0D0GT15) which cannot be
located, this occurs:
1. Pages one through four print; page five does not print. Printing of the

document ends; pages 6 through 10 also do not print.
2. A message page will print with these messages:

0420-094: The following messages were generated for file /info/afp/long.list3820
with Job ID 167. This file printed on the InfoPrint destination psf4317,
which is a 4317 destination.

0423-284: InfoPrint mapped the FGID, GCSGID, width, vertical size combination:
230, 0, 96, 160 to the FCS name C0D0GT15. The FGID.GRD mapping file
specified that this mapping be performed.

0423-291: Map Coded Font (MCF) structured field could not be processed because
InfoPrint could not locate the font character set C0D0GT15. Attempted
resolution/type(s): 300-pel Font Fidelity for this job was CONTINUE.
Destination supported resolution/type(s): 300-pel.

0420-060: The error occurred with the object type Active Environment Group with
token name 1.

0420-060: The error occurred with the object type page with token name 1.

0420-060: The error occurred with the object type document with token name
LONG.

0420-098: The error occurred while printing page 1 of copy 1 of this print job.

0423-302: The font reference in the MCF1 structured field, repeating group number
1, with sequence number 1, at file offset 118, could not be processed
successfully. Additional error and diagnostic messages follow.

0420-729: The error occurred in file /info/afp/long.list3820. The structured field in
error was structured field EAG with code X’D3A9C9’ and sequence
number 1 located at file offset 250.

IPDS error recovery: Insufficient memory in the printer

In some cases, a printer might not have sufficient storage to process the data or
resources required for a page. When this occurs, InfoPrint Manager responds by
deleting resources in the printer which are not required for the page and then tries
to print the page again. Frequently, this recovery will allow the page to print
successfully. If the printer still reports that there is insufficient storage to process
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the page, the job is terminated and a message is produced indicating that the page
and its associated resources are too complex.

Insufficient memory in the printer exmple:

A 30 page document is submitted. Each page of the document references several
complex page segments.
1. InfoPrint Manager sends pages for the document to the printer.
v Before each page is sent, InfoPrint Manager downloads page segments that

are required by the page.
2. The printer reports an insufficient memory error to InfoPrint Manager (for page

23).
v InfoPrint Manager deletes all the page segments (and any other resources)

previously downloaded to the printer. All of the printer memory available
for resources should now be free. InfoPrint Manager then tries to load only
the page segments required for page 23. Because unnecessary page segments
have been removed from printer memory, all of the page segments for page
23 can be successfully downloaded into the printer. No messages are
reported to the server and no message pages are printed.

3. All 30 pages of the job print successfully.

IPDS error recovery: Intervention required conditions

A printer might experience intervention required conditions that are not related to
the data stream or complexity of the data. These conditions cause printing to stop.
Some intervention required conditions are handled directly by some printers and
are not reported back to InfoPrint Manager. In these cases, InfoPrint Manager
continues to send data to the printer.

Example:
1. As soon as the paper jam occurs, printing stops and the destination (printer)

object changes to red.
v A message is sent to the operator:

– 0420-466: The destination reported a paper jam; clear the jam.

2. The actual destination (printer) object’s destination-state changes to ″needs key
operator.″
v InfoPrint Manager waits until the paper jam has been cleared.

3. The operator then clears the paper jam, according to the printer jam recovery
procedure. Some damaged pages are usually discarded as part of this
procedure.

4. Once the printer jam is cleared, the destination (printer) object is no longer red.
Using station counters from the printer, InfoPrint Manager repositions to the
correct page and continues printing the document. If Interrupt Message Pages
are activated, InfoPrint Manager will insert an IMP at this point to mark the
location of the error. See “Using Interrupt Message Pages” on page 93 for more
information.

5. At the end of the document, a message page is printed which contains this:
v 0420-094: The following messages were generated for file /info/paperjam

with Job ID 787. This file printed on the InfoPrint destination ip32, which is a
4332 destination.
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v 0420-467: A paper jam occurred in the destination while printing this job.
Inspect the output to determine if it is complete and that all printed pages
are acceptable.

IPDS error recovery: Unrecoverable problems

Unrecoverable problems cause the InfoPrint Manager software or printer software
to stop functioning or prevent them from communicating with each other.
Examples of unrecoverable errors include: server system crash, software core
dump, printer abort, power failure, or severe network problems.

These errors prevent the InfoPrint Manager software from obtaining current station
counter status information from the printer. In these cases, InfoPrint Manager
cannot determine how many pages and which jobs printed since the last set of
valid station counters were received. InfoPrint Manager considers a job complete
only when all pages are reported by the printer as stacked. In most cases, some
pages for one or more jobs will print between the time InfoPrint Manager last
received a printer acknowledgment and the time the unrecoverable error occurs.

Those jobs, because they are considered incomplete, will normally start printing
from the beginning when the problem is resolved and both the InfoPrint Manager
software and the printer are operating and communicating again.

However, if the submitter or operator does not want the job to start printing from
the beginning, there is a way to modify where printing starts for the documents in
these jobs. The document object page-select attribute can be modified before the
job is processed again. This attribute allows the submitter to specify a page range
(first to last) for each document in a job. This way, the submitter or operator can
control which pages are printed after the problem is resolved.

Depending on the type of error and the network configuration, some errors might
not be reported to InfoPrint Manager immediately. In these cases, an operator can
issue a pdshutdown command to the actual destination object. This command
works without any attempts to communicate with the printer. InfoPrint Manager
will checkpoint the job that was partially stacked at the printer and use the station
counters from the last valid acknowledgment to determine which page of which
job to checkpoint. A small ack-interval value will make it possible to checkpoint
using a more recent set of station counters than would be available with a large
ack-interval value. The job can be resumed later from that checkpoint.

Some unrecoverable errors are reported immediately to the InfoPrint Manager
software and the actual destination object (printer) is disabled. When this occurs,
the pdshutdown command cannot be issued and therefore no checkpoint can be
taken. InfoPrint Manager does not do automatic checkpointing.

Unrecoverable problem example:
1. The destination (printer) object becomes disabled and the icon changes to

black.
2. The job object changes to the pending state.
3. Later, the printer power is restored.
4. The operator must enable the destination (printer) object.
5. Jobs start printing on the printer in the order they have been scheduled.

All 300 pages of the job that were printing during the power failure print again.
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Appendix C. Accessibility

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, use software products successfully. The major
accessibility features in the InfoPrint Manager for Windows let users:
v Use assistive technologies such as screen-readers and screen magnifier software.
v Operate specific or equivalent features using only the keyboard.
v Customize display attributes such as color, contrast, and font size.

Using assistive technologies

Assistive technology products, such as screen-readers, function with the user
interfaces found in the InfoPrint Manager for Windows. Consult the assistive
technology documentation for specific information when using it to access the
InfoPrint Manager for Windows.

Keyboard navigation of the user interface

The InfoPrint Manager for Windows user interface complies with the accessibility
guidelines for HTML. Users can use keyboard shortcuts or function keys (PF keys)
to access the InfoPrint Manager for Windows user interface. For example,
Alt+Shift+F2 lets you skip to the main content. see your browser documentation
for keyboard shortcuts and default settings for the PF keys and for explanations
about how to modify their functions.
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Notices

This information was developed for products and services offered in the U.S.A.

InfoPrint Solutions Company may not offer the products, services, or features
discussed in this document in other countries. Consult your local InfoPrint
Solutions Company representative for information on the products and services
currently available in your area. Any reference to an InfoPrint Solutions Company
product, program, or service is not intended to state or imply that only that
InfoPrint Solutions Company product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any
InfoPrint Solutions Company intellectual property rights may be used instead.
However, it is the user’s responsibility to evaluate and verify the operation of any
non-InfoPrint Solutions Company product, program, or service.

References in this document to InfoPrint Solutions Company products, product
features, programs or services do not imply that InfoPrint Solutions Company
intends to make such products, product features, programs or services available in
all countries in which InfoPrint Solutions Company operates or does business.

InfoPrint Solutions Company may have patents or pending patent applications
covering subject matter described in this document. The furnishing of this
document does not give you any license to these patents. You can send license
inquiries, in writing, to:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
InfoPrint Solutions Company Intellectual Property Department in your country or
send inquiries, in writing, to:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INFOPRINT
SOLUTIONS COMPANY PROVIDES THIS PUBLICATION ″AS IS″ WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states
do not allow disclaimer of express or implied warranties in certain transactions,
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. InfoPrint Solutions Company may
make improvements and/or changes in the product(s) described in this publication
at any time without notice.
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Any references in this information to non-InfoPrint Solutions Company Web sites
are provided for convenience only and do not in any manner serve as an
endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this InfoPrint Solutions Company product and use of those Web
sites is at your own risk.

InfoPrint Solutions Company may use or distribute any of the information you
supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by InfoPrint Solutions Company under terms of the
InfoPrint Solutions Company Customer Agreement, InfoPrint Solutions Company
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-InfoPrint Solutions Company products was obtained
from the suppliers of those products, their published announcements or other
publicly available sources. InfoPrint Solutions Company has not tested those
products and cannot confirm the accuracy of performance, compatibility or any
other claims related to non-InfoPrint Solutions Company products. Questions on
the capabilities of non-InfoPrint Solutions Company products should be addressed
to the suppliers of those products.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
These terms are trademarks or registered trademarks of Ricoh Co., Ltd., in the
United States, other countries, or both:
v Advanced Function Presentation
v Advanced Function Printing
v AFCCU
v AFP
v Bar Code Object Content Architecture
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v BCOCA
v Color Management Object Content Architecture
v InfoPrint
v Infoprint
v Intelligent Printer Data Stream
v IPDS
v Mixed Object Document Content Architecture
v MO:DCA
v Ricoh

These terms are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both:
v AIX
v DFS
v HACMP
v IBM
v IP PrintWay
v MVS
v OS/2
v OS/390
v POWER
v Print Services Facility
v z/OS

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States
and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the U.S. and other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.

Notices 365



366 InfoPrint Manager for AIX: Procedures



Glossary

This glossary defines technical terms and abbreviations used in InfoPrint Manager.

Special Characters

.Guidefaults file
A file created by InfoPrint in the home
directory of a person using the InfoPrint
GUI. InfoPrint uses this file to save and
reference information about the servers
you are monitoring and the windows you
are working in.

A

Access Control List (ACL)
In computer security, a collection of all
access rights for one object.

ACL Access Control List.

acl editor
A command line interface that lets you
view, add, update, and delete access
authorization records in an ACL.

action In the InfoPrint GUI, an icon that
represents an operation that you can
perform on an InfoPrint object. You drag
and drop the action onto an object to
initiate the operation for that object. For
example, using the Enable action to
enable a disabled actual destination.

actual destination
In InfoPrint, an object that represents the
output device that performs the printing
or transmission function. See email
destination, fax destination; see also physical
printer, printer device; contrast with logical
destination.

additive color system
A system that reproduces an image by
mixing (adding) appropriate quantities of
red, green, and blue light (the additive
primary colors) to create all other colors
of light, either direct or transmitted.
When the additive primaries are
superimposed on one another, they create
white light. Contrast with subtractive color
system.

administrator
In InfoPrint, the person who creates and
manages one or more components of a

printing system, such as servers and
actual destinations. By default, InfoPrint
gives administrators authorization to
perform some InfoPrint operations and to
access certain information that is not
available to the operators or job
submitters.

Adobe Acrobat
An Adobe software program that
provides instant access to documents in
their original format, independent of
computer platform. With the Adobe
Reader, you can view, navigate, print, and
present any Portable Document Format
(.pdf) file.

Adobe PageMaker
A desktop publishing program that
produces PostScript documents.

Adobe PostScript Raster to Image Transform
(RIP) See raster image processor (RIP).

ADSM/6000
Advanced Distributed Storage Manager.

Advanced Distributed Storage Manager
(ADSM/6000)

A program that provides storage
management for archived files.

Advanced Function Common Control Unit
(AFCCU)

An IBM RISC-based control unit with
code common to all printers that use the
AFCCU.

Advanced Function Presentation (AFP)
A set of licensed programs, together with
user applications, that use the
all-points-addressable concept to print
data on a wide variety of printers or to
display data on a wide variety of display
devices. AFP includes creating,
formatting, archiving, retrieving, viewing,
distributing, and printing information.

Advanced Function Presentation data stream
(AFP data stream)

The printer data stream used for printing
AFP data. The AFP data stream includes
composed text, page segments, electronic
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overlays, form definitions, and fonts
downloaded from the operating system to
the printer.

A presentation data stream that is
processed in AFP environments. The AFP
data stream includes MO:DCA-P-based
data streams.

Advanced Interactive Executive (AIX)
An operating system used with RS/6000
computers. The AIX operating system is
IBM’s implementation of the UNIX
operating system.

AFCCU
Advanced Function Common Control
Unit.

AFP Advanced Function Presentation.

AFP data stream
Advanced Function Presentation data
stream.

ainbe The printer input/output backend
program used by the PSF DSS to send
jobs to printer devices. Depending on the
incoming data stream of the job, the PSF
DSS might have transformed the data
stream of the job before the backend
program sending it to the printer device.

AIX Advanced Interactive Executive.

AIX-attached printer
A printer device, attached to an RS/6000
computer through the network or through
a serial or parallel port that receives jobs
from an AIX print queue.

In InfoPrint, a PSF physical printer that
represents an AIX-attached printer device.
See also direct-attached printer,
TCP/IP-attached printer,
upload-TCP/IP-attached printer.

AIX destination support system
In InfoPrint, the destination support
system that communicates with the
standard AIX print backend (piobe), or
with certain variations of the rembak
print backend, to print jobs.

AIX physical printer
In InfoPrint, the object representing a
printer device that uses the AIX
destination support system.

aliasing
In a digitized image, the creation of
diagonal lines by combining short

horizontal and vertical line segments that
approximate the path of the desired line.

all-points-addressability (APA)
The capability to address, reference, and
position text, overlays, and images at any
defined point of the printable area of the
paper or display medium.

alphameric
Synonym for alphanumeric.

alphanumeric
Pertaining to a character set containing
letters, digits, and other symbols such as
punctuation marks. Synonymous with
alphameric.

AMPV
Average monthly print volume.

analog
Pertaining to a continuous variable
sampling of information between two
points that achieves an even, smooth
transition of photographic material.

analog color proof
An off-press color proof made from
separation films.

anti-aliasing
The rendering of hard-edged objects so
that they blend smoothly into the
background. PhotoShop offers
anti-aliasing when rasterizing an EPS file.

Removing the jagged “stairstep” quality
in diagonal lines produced on a computer
screen by aliasing. This removal is
effected by creating less densely shaded
fields parallel to the diagonal line.

APA All-points-addressability.

API Application Program Interface.

Application Program Interface (API)
The call interface between a client
program and the procedures that
implement the printing system, as defined
by the specification. Clients use the API to
access servers. (P)

architecture
The set of rules and conventions that
govern the creation and control of data
types such as text, image, graphics, font,
fax, color, audio, bar code, and
multimedia.
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archiving
The transfer of digital information from
an online system onto floppy disk,
compact disc, or other media for offline
storage. The original copy is deleted from
the online system. See also retrieval.

array inkjet
An ordered collection of multiple print
heads used in an inkjet printer.

ASCII American National Standard Code for
Information Exchange. The standard code,
using a coded character set consisting of
7–bit coded characters (8 bits including a
parity check). The ASCII code is used for
information exchange among data
processing systems, data communications
systems, and associated equipment. The
ASCII character set includes control
charactes and graphic characters.

asynchronous
Pertaining to two or more processes that
do not depend upon the occurrence of
specific events, such as common timing
signals. (T)

In InfoPrint, occurring without a regular
or predictable time relationship to a
specified action. Contrast with
synchronous.

attachment type
Defines the method by which a printer
device is attached to the AIX system from
which it receives data. See AIX-attached
printer, direct-attached printer,
TCP/IP-attached printer, and
upload-TCP/IP-attached printer.

attribute
A defined characteristic of an object, such
as the number of copies required of a job,
or the document formats accepted by an
actual destination.

attribute name
A string that identifies an attribute.
Typically, in InfoPrint attribute names
consist of two or more words separated
by hyphens.

attribute value
The element of an attribute that specifies
the characteristics relating to the attribute.

authorization
In computer security, verification of the
eligibility of a user to access an object.

authorized user
A person with the appropriate
permissions to access an object or to issue
a command.

automatic recovery
A function of printer logic that permits
the printer to reprint a job if the job is
misprinted or damaged or if a component
has failed.

auxiliary sheet
In InfoPrint, an object that represents a
particular sheet of paper, blank or
otherwise, that can precede a job, separate
documents in a job, or follow a job.

auxiliary-sheet selections
A particular combination of start,
separator, and end sheets that print with
jobs on a particular printer device.

B

backend
In AIX, the program that is invoked by
the qdaemon process to run a print or
batch job. Synonymous with backend
program.

backend program
Synonym for backend.

backlog
In InfoPrint, the amount of time
calculated by InfoPrint that is required to
print all of the jobs currently in a queue.

backspace
In InfoPrint, the action used to back up
and reprint pages in a job.

bar code
A code representing characters by sets of
parallel bars of varying thickness and
separation that are read optically by
transverse scanning.

An array of parallel rectangular bars and
spaces that together represent data
elements or characters in a particular
symbology. The bars and spaces are
arranged in a predetermined pattern
following unambiguous rules defined by
the symbology.

BCOCA
Bar Code Object Content Architecture™.

Bezier curves
A method of defining curves using anchor
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points, control handles, and tangent lines.
The PostScript path passes through
anchor points. Its approach direction is
along the tangent lines that are controlled
by the control handles. Many personal
computer programs use this drawing
method. Type 1 PostScript fonts are
defined using Bezier curves.

binding
The cover and materials that hold a book
together. See edition binding, perfect
binding, spiral binding, wire-o binding.

The process of applying the binding to a
book.

In InfoPrint, assigning a job to an actual
destination. See early binding, late binding.

bitmapped
Pertaining to an image formed by a
rectangular grid of pixels. Each pixel is
assigned a value to denote its color.
One-bit images are black and white; 8–bit
images have 256 colors (or grays); 24–bit
images have full color. CMYK images
have 32–bits per pixel to encode 256
levels in each of four channels. Bitmapped
images are also called raster images.

bleed An extra amount of printed image that
extends beyond the trim edge of the
sheet. Bleed ensures that no white gap
appears at the edge of the sheet.

boot To prepare a computer for operating by
loading an operating system.

BSD Berkeley Software Distribution.

BSD destination support system
In InfoPrint, the destination support
system that generates a print command
string that the shell runs to print jobs.

BSD physical printer
In InfoPrint, the object representing a
printer device that uses the BSD
destination support system.

burn In platemaking, an exposure. Burn is
named because of the extremely bright
ultraviolet lamps used to transfer images
from film to plate.

In photography, to lengthen the final
exposure time to increase the final density
of print.

C

cathode ray tube (CRT)
A vacuum tube in which a beam of
electrons can be moved to draw lines or
form characters or symbols on its
luminescent (phosphor-coated) screen.
CRTs are the heart of all modern
computer display screens. Black and
white displays have only one phosphor
scanned by one electron beam, while
color displays have RGB phosphors
scanned by three beams.

CDE Common Desktop Environment.

child See parent/child relationship.

choke In color printing, an area whose
dimensions have been reduced to avoid
overlapping another color. Contrast with
spread.

class Synonym for object class.

clean In InfoPrint, an action used to remove all
the jobs from specified servers, actual
destinations, or queues, or to remove all
the jobs submitted to specified logical
destinations.

CLI Command Line Interface.

client In InfoPrint, the component of the print
system that assembles a print request and
submits the request to a server. The client
generates the local ID numbers for each
job, submits the jobs to the servers, and
keeps track of where each user’s jobs
have been submitted.

CMR Color Management Resource.

CMY Cyan, magenta, yellow.

CMYK
Cyan, magenta, yellow, black.

collator
In some printers a special-purpose hard
drive disk array used to store RIPped files
and later transfer them to the LED print
heads for imaging.

color balance
The relative levels of cyan, magenta, and
yellow channels in an image to produce
accurate color rendition of an original
image.

color correction
The adjustment of the color balance in an
image to produce accurate color rendition
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of an original image. Color correction is
used for two- or three-spot-color jobs.

color key
A color proof similar to Cromalin, but
typically not laminated and not
necessarily accurate in color. Color keys
are used to verify that breaks or color
assignments and traps have been made
accurately.

Color management resource
Color management resource (CMR) is an
architected resource that is used to carry
all of the color management information
required to render a print file, document,
group of pages or sheets, page, or data
object with color fidelity.

Command Line Interface (CLI)
A type of user interface where commands
are specified on the command line.
Contrast with Graphical User Interface.

Common Desktop Environment (CDE)
A graphical user interface running on a
UNIX operating system.

complex attribute
In InfoPrint, an attribute that can have
multiple values with each value
containing multiple components.

constant data
Data that does not change between copies
of a document and that is merged with
variable data to produce personalized
documents. For example, a form letter
(constant data) can be merged with a
customer’s name and address (variable
data).

contextual help
A type of online help that provides
specific information about each selectable
object, menu choice, notebook tab, field,
control, and pushbutton in a window.

control strip
A strip of information that can be
attached to a print job and used to
measure registration and density.

Cromalin
The Dupont color proofing system. Four
layers (CMYK) of light-sensitive material
are exposed through final halftone
negative films, then laminated together on
an opaque backing to produce a color-
and trap-accurate final proof showing

actual halftone dot structure. Cromalin is
sometimes called an analog proof.

crop To remove unwanted areas of an image,
usually indicated by crop marks on the
original.

CRT Cathode ray tube.

CTS Cutter-trimmer-stacker.

cutter-trimmer-stacker (CTS)
A post-processing device attached to a
printer device and used for paper
handling.

cyan, magenta, yellow (CMY)
The subtractive primary colors.

cyan, magenta, yellow, black (CMYK)
The four basic colors used in offset
printing, as opposed to the three basic
colors of light: red, green, and blue.
Magenta, yellow, and cyan are the
subtractive primaries. Black is added to
provide better density and to produce a
true black.

D

daemon
A program that runs unattended to
perform a standard service. Some
daemons are triggered automatically to
perform their tasks; others operate
periodically. Daemon processes generally
provide a service that must be available at
all times to more than one task or user,
such as sending data to a printer.

DAT Digital audio tape.

data stream
All information (data and control
commands) sent over a data link.

A continuous stream of data that has a
defined format.

In InfoPrint, pertaining to the incoming
format of the job and the output format
required by the printer device. InfoPrint
transforms the incoming format into the
output format, as required. See also
document format.

DB2*/6000
DataBase 2/6000.

deadline
In InfoPrint, a queuing technique where
the next job assigned to the first position
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in the queue is the one whose deadline is
closest. Contrast with FIFO
(first-in-first-out), job-priority,
longest-job-first, and shortest-job-first.

default document
In InfoPrint, an object that represents
default attribute values for a document in
a job. Synonymous with initial value
document.

default job
In InfoPrint, an object that represents
default attribute values for a job.
Synonymous with initial value job.

default object
In InfoPrint, a general term that refers
either to a default document or a default job.
Synonymous with initial value object.

default value
A value stored in the system that is used
when no other value is specified.

delete In InfoPrint, an action used to delete
default objects, jobs, logical destinations,
actual destinations, or queues from the
server.

desktop publishing
Performing print-related activities on a
personal computer, including but not
limited to layout, design, photo
manipulation, creating fonts, editing text,
color separation, scanning, and animation.

destination
See actual destination, logical destination.

destination support system (DSS)
In InfoPrint, the programs that an actual
destination uses to communicate with the
output device. Synonymous with device
support system. See AIX destination support
system, BSD destination support system,
email destination support system, Generalized
Fax destination support system, and PSF
destination support system.

device An individual piece of equipment
(hardware) that attaches to a computer,
such as a printer device.

device address
The identification of an input or output
device by its channel and unit number.

device driver
A file that communicates with a specific
device such as a printer, disk drive, or

display. An application that sends output
to a device controls the actions of the
device through the device driver. See
printer driver.

device support system (DSS)
Synonym for destination support system.

DFS™ Distributed File Service.

digital Pertaining to data represented by digits,
sometimes with special characters and the
space character.

digital audio tape (DAT)
A high-capacity, low-cost bulk storage
system used for archiving, copying (for
backup purposes), and transferring large
files. Typical DAT units store 1.3 GB on
inexpensive cassette tapes.

digital color proof
An off-press color proof made from a
color printer attached to a computer.

digital printing
A filmless and plateless printing process
in which digital data for each page is
transferred directly to a light-sensitive
drum and then to paper for a final image.

direct-attached printer
A printer device, attached to an RS/6000
computer through the network or through
a serial or parallel port.

In InfoPrint, a PSF physical printer that
represents a direct-attached printer device.
See also AIX-attached printer,
TCP/IP-attached printer, and
upload-TCP/IP-attached printer.

disable
In InfoPrint, an action used to stop the
acceptance of jobs on destinations,
queues, or servers, or to stop writing
information to logs.

distributed print system
A computer system with the ability to
interchange print data and controls
among different computing environments
with the intent of printing the data on a
different system from the one where the
print request was generated. For example,
in host-to-LAN distributed printing, data
that is located on the host is printed on
printers attached to a local area network.

dithering
A technique of filling the gap between
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two pixels with another pixel having an
average value of the two to minimize the
difference or to add detail to smooth the
result.

document
In InfoPrint, an object representing a
grouping of data in a job. A job can
contain one or more documents. The
documents in a job can differ from each
other in some ways. For example, they
can contain different data and can have
different document formats. A document
in a job can contain printable data or a
resource that is not printable by itself. See
file-reference document, printable document,
and resource document.

document element
A portion of a document at least a single
page in size.

document format
In InfoPrint, a document format describes
the type of the data and control characters
in the document, such as line data or
PostScript. The format of the data
determines which printer devices are
capable of printing the document and
whether InfoPrint must transform the
format.

document identifier
A string that identifies a document in a
job. It consists of a job ID followed by a
period (.) and a document sequence
number. For example, 12.2. Document
sequence numbers are integers starting at
1.

Document Printing Application (DPA)
An ISO/IEC 10175 standard that
addresses those aspects of document
processing that enable users in a
distributed open systems environment to
send electronic documents to shared,
possibly geographically-dispersed
printers. InfoPrint supports the DPA
standard.

document transfer method
In InfoPrint, the transfer method describes
how documents are transferred to, or
acquired by, servers. See pipe-pull and
with-request.

document type
In InfoPrint, the document type describes
the kind of data in the document. A

printable document can only contain
printable data. A resource document can
only contain data such as fonts or form
definitions that are not printable. A file
reference document can only contain names
of files entered on separate lines.

dot The individual elements of a halftone.

dot gain
An increase in the size of a halftone dot
during printing, caused by ink spreading.
Generally, this value is known precisely,
and the scanning and filming production
process is calibrated to compensate for it.
The Cromalin proofing system simulates
this effect.

dots per inch (dpi)
A measure of data density per unit
distance. Typical values for desktop
publishing range from 200 to 300 dpi.

DPA Document Printing Application.

DPF Distributed Print Facility.

dpi Dots per inch.

drag and drop
In graphical user interfaces, a procedure
by which you perform actions and tasks.
Using the mouse, you drag (move) an
action or object icon to a new position
where you want the action or task to
occur.

DSS Destination support system.

dummy
A rough paste-up or hand-drawn
representation of the anticipated finished
product. A dummy is used for basic
design and pagination.

duplex printing
Printing on both sides of the paper.
Contrast with simplex printing (1).

Printing on both sides of the paper,
placing output images on the media in a
head-to-head format, so that the top of
one image is at the same edge as the top
of the next image. Contrast with tumble
duplex printing; see also simplex printing
(2).

E

early binding
In InfoPrint, assigning a job to an actual
destination as soon as it is accepted. Early
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binding permits InfoPrint to estimate the
time when the job will be completed.
Contrast with late binding.

edition binding
A type of book binding in which printed
sheets are folded into 16- or 32-page
signatures. Four-page endleaves are
pasted on the outside of the first and last
signature. The signatures are then collated
by machine and sewn together using
special sewing machines. Contrast with
perfect binding, spiral binding, and wire-o
binding.

electronic document
A document stored in a computer instead
of printed on paper.

electronic mail
Correspondence in the form of messages
sent between workstations over a
network. Synonymous with email.

electrophotographic
Pertaining to a type of printer technology
that creates an image on paper by
uniformly charging the photoconductor,
creating an electrostatic image on the
photoconductor, attracting negatively
charged toner to the discharged areas of
the photoconductor, and transferring and
fusing the toner to paper.

em In composition, a unit of measurement
exactly as wide and as high as the point
size of the font being set. The name is
derived from the fact that the letter M in
early typefaces was usually cast on a
square body.

email Electronic mail.

email destination
In InfoPrint, an actual destination
representing an electronic mailing system.

email destination support system
In InfoPrint, the destination support
system that supports email destinations.

embellishments
Variable data added to all copies of
assembled pages to make the unit appear
like a whole; for example, headers,
footers, a table of contents, and chapter
separations.

en In composition, exactly one-half an em.

enable
In InfoPrint, the action that makes a
destination, queue, or server able to
accept jobs, or a log able to accept
information.

end sheet
The sheet of paper, blank or otherwise,
that can follow a job. See also auxiliary
sheet.

Enhanced X-Windows
A tool designed to permit multiple
application processes to operate in
multiple windows displayed on a virtual
terminal. See X-Windows.

environment variable
Any one of a number of variables that
describe the way an operating system
runs and the devices it recognizes.

error log
A data set or file in a product or system
where error information is stored for later
access.

estimate
The professional cost analysis made by a
print shop in response to a customer’s
request for a price quotation on a print
job.

event In InfoPrint, an occurrence in the printing
system during an operation; for example,
the completion of a command.

event log
In InfoPrint, a collection of messages
about events that have occurred.

event notification
The notification that is sent by InfoPrint
for an event.

F

fax destination
In InfoPrint, an actual destination
representing a fax device.

FIFO (first-in-first-out)
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the job that has been in
the queue for the longest time. InfoPrint
processes jobs in the order in which they
are received. Contrast with deadline,
job-priority, longest-job-first, and
shortest-job-first.
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file-reference document
In InfoPrint, a file containing the names
of other files, each entered on a separate
line. Job submitters can specify this file
for printing when they specify a
document type of file-reference; InfoPrint
prints each file listed in the reference
document.

File Transfer Protocol (FTP)
In TCP/IP, the application protocol that
makes it possible to transfer data to and
from host computers and to use foreign
hosts indirectly.

finisher
A hardware device attached to a printer
that performs such operations as folding
or stapling the printed pages.

finishing
In a print shop, the final operations on a
printed product, such as stapling,
trimming, drilling, folding, embossing,
varnishing, gluing, shrink wrapping,
perforating, laminating, collating, and so
on.

flag A modifier of a command that specifies
the action of the command. A dash
usually precedes a flag. Synonymous with
option. See also keyword.

FOCA Font object content architecture.

folder In the InfoPrint GUI, an object that
represents a container for a collection of
similar objects. For example, the Retained
Jobs folder contains retained jobs.

font A family of characters of a given size and
style; for example, 9-point Helvetica.

One size and one typeface in a particular
type family, including letters, numerals,
punctuation marks, special characters,
and ligatures.

A paired character set and code page that
can be used together for printing a string
of text characters. A double-byte font can
consist of multiple pairs of character sets
and code pages.

form definition
A resource object used by InfoPrint that
defines the characteristics of the form or
printed media, which include: overlays to
be used, the paper source (for cut-sheet
printers), duplex printing, text

suppression, and the position of
composed-text data on the form.

forward space
In InfoPrint, the action used to move
ahead and skip the printing of a specified
number of pages in a job.

FPO Low-quality (sometimes photographic)
images placed in a dummy to represent
final images. Desktop publishing software
produces images as display-screen
resolution FPOs.

front panel
In the CDE, a workspace area containing
controls that represent various tasks you
can perform and workspace switches.

FTP File Transfer Protocol.

G

GCR Gray component replacement.

Generalized Fax destination support system
In InfoPrint, the destination support
system that supports generalized fax
destinations.

GIF Graphics Interchange Format.

global change
In the InfoPrint GUI, an action used to
make changes to one or more attributes of
several objects at once. You can also
perform the same action on several
objects of the same object class at the
same time; for example, disabling two or
more actual destinations at the same time.

global character
A character or set of characters used to
specify an unknown number or set of
characters in a search string. In InfoPrint,
a global character is represented by an
asterisk (*).

global ID
Global job identifier.

global job identifier
An unambiguous job identifier. In
InfoPrint, it is represented as the name of
the server managing the job followed by a
colon (:) and a generated integer. This ID
uniquely identifies the job in the InfoPrint
server.

glyph An image, usually of a character, in a
font.
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GOCA
Graphics object content architecture.

graphic character
A visual representation of a character,
other than a control character, that is
normally produced by writing, printing,
or displaying.

Graphical User Interface (GUI)
A type of user interface that takes
advantage of a high-resolution monitor
and includes a combination of graphics to
implement an object-action paradigm, the
use of pointing devices, menu bars,
overlapping windows, and icons. Contrast
with Command Line Interface.

Graphics Interchange Format (GIF)
A compressed graphics format widely
used on the Internet.

gray component replacement (GCR)
Synonym for under color removal (UCR).

gray scale
A strip of standard gray tones, ranging
from white to black, placed at the side of
the original copy during photography to
measure the tonal range and contrast
obtained.

GUI Graphical User Interface.

gutter The blank area or inner margin from the
printing area to the binding.

H

halftone
A printing method that simulates
continuous-tone shading using dots of
varying sizes laid out on a rectangular
grid. Larger dots simulate darker tones
and smaller dots simulate lighter tones.
Typical grid spacings are 85 lines per inch
(lpi) (newspaper), 133 lpi (low end), 150
lpi (midrange), and 175+ lpi (high
quality).

help In the InfoPrint GUI, an action used to
display the online help for a specific
template, object, action, button, control, or
area in an application window.

The name of a button used to access the
online help.

hold An indication determined by the job-hold

attribute that is used to keep a job in the
queue and prevent InfoPrint from
scheduling it.

hostname
The name given to an AIX system.

hot folder
A workstation directory where users copy
jobs to submit them to print.

hypertext
A way of presenting information online
with connections between one piece of
information and another. These
connections are called hypertext links. See
also hypertext link.

hypertext link
A connection between one piece of
information and another. Selecting a link
displays the target piece of information.

I

icon A graphic symbol displayed on a screen
that a user can click to invoke a function
or software application.

image Toned and untoned pels arranged in a
pattern.

image data
Rectangular arrays of raster information
that define an image.

imagesetter
A high resolution (1270–3600+ dpi)
printer that uses an Argon (green) laser to
write to film using digital imput.
Imagesetting is the step before Cromalin
proofing and platemaking.

imposition
The process of arranging pages on a press
sheet to ensure the correct order during
final cutting, folding, and binding.
Electronic imposition builds press sheets
automatically during the RIP and outputs
film formatted for immediate use in
platemaking.

InfoPrint
A solution of software and hardware
products that can supplement or replace
the offset presses and copiers in print
shops with high-quality, non-impact,
black and white or process color printers.
InfoPrint takes documents from creation
to the published, kitted, and shipped
product.
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In InfoPrint software publications,
InfoPrint Manager for AIX or any of its
components.

InfoPrint Manager for AIX
The software component of InfoPrint.
InfoPrint Manager for AIX handles the
scheduling, archiving, retrieving, and
assembly of a print job and its related
resource files. It also tracks the finishing
and packaging of the printed product.

InfoPrint Manager for AIX is based on
Palladium technology developed at
MIT/Project Athena. It conforms to the
ISO DPA and POSIX standards.

InfoPrint Network
The local area network running TCP/IP
protocol that InfoPrint uses to
communicate among servers, clients, and
output devices.

InfoPrint Select
The component of InfoPrint Manager for
AIX that lets you submit jobs from an
OS/2® or Windows workstation.

InfoPrint Submit Express
The component of InfoPrint Manager that
lets you submit jobs with a job ticket from
a Windows or Macintosh workstation.

InfoPrint 20
A black and white, large-format, cut-sheet,
workgroup laser printer with optional
duplexing and 600-dpi resolution.

InfoPrint 60
A duplex, black and white, cut-sheet
printer with 600-dpi resolution.

InfoPrint 62
A non-impact, continuous-forms printer
that runs at a maximum of 62
impressions-per-minute (depending on
forms size), and is factory set to run at
either 240 or 300 dpi on a maximum
paper size of 370.8 mm (14.6 in.).

InfoPrint 4000
A duplex, black and white,
continuous-forms printer with 600-dpi
resolution.

initial value document
Synonym for default document.

initial value job
Synonym for default job.

initial value object
Synonym for default object.

initially settable attribute
An attribute whose value can be
established when an object is created but
cannot be subsequently set or modified.
See also resettable attribute; contrast with
non-settable attribute.

input focus
The area of a window where user
interaction is possible from either the
keyboard or the mouse.

input tray
For a printer device, the container that
holds the medium upon which the printer
prints its output.

Intelligent Printer Data Stream (IPDS)
An all-points-addressable data stream that
enables users to position text, images, and
graphics at any defined point on a
printed page.

Information that the host sends to IPDS
printers. This information generally
contains basic formatting, error recovery,
and character data and enables the
printers to make decisions.

An architected host-to-printer data stream
that contains both data (text, image,
graphics, and bar codes) and controls
defining how the data is to be presented.
IPDS provides a device-independent
interface for controlling and managing
all-points-addressable (APA) printers.

International Organization for Standardization
(ISO) An organization of national standards

bodies from various countries established
to promote development standards to
facilitate international exchange of goods
and services, and develop cooperation in
intellectual, scientific, technological, and
economic activity.

Internet
A wide area network connecting
thousands of disparate networks in
industry, education, government, and
research. The Internet network uses
TCP/IP as the protocol for sending
information.

Internet Protocol
The set of rules that determines how to
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route data from its source to its
destination in an internet environment.

intervening jobs
In InfoPrint, the number of jobs in a
queue that are scheduled to print before
the job in question.

IOCA Image object content architecture.

IP address
The Internet Protocol address of the
server in a dotted decimal format where
each node is an integer. (For example,
9.99.9.143).

IPDS Intelligent Printer Data Stream.

ISO International Organization for
Standardization.

J

job In InfoPrint, an object that represents a
request to print or send one or more
documents together in a single session. A
job includes the data to be printed or sent
and resources such as fonts, images, and
overlays. Depending on how it was
submitted, it can also include a job ticket.
Synonymous with job bundle and print job.

job bundle
Synonym for job.

job data
The page descriptions, merge data, and
embellishments that compose a document
in a job, either directly or by reference.

job ID
A local or a global identifier that
identifies a job to a job submitter,
administrator, operator, or InfoPrint. See
local job identifier, global job identifier.

job-priority
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the one with the highest
priority. Contrast with deadline, FIFO
(first-in-first-out), longest-job-first, and
shortest-job-first.

job submitter
In InfoPrint, the person who submits jobs
for printing. Often, this person is an
application programmer who maintains
applications that generate data to be
printed.

job ticket
The customer’s hardcopy or electronic
instructions listing all the variables
describing a print job, either directly or
by reference. The print shop can add
specifications to the job ticket and can
print the job ticket.

Joint Photographic Experts Group (JPEG)
A compressed graphics format widely
used on the Internet.

JPEG Joint Photographic Experts Group.

K

kerning
In typesetting, adjusting the relative
spacing of two characters to improve their
appearance and readability. Kerning pairs
are specific sets of characters with built-in
relative spacing. Some typefaces have as
many as 100 kerning pairs.

keyword
A name or symbol that identifies a
parameter.

Part of a command operand that consists
of a specific character string, such as
DSNAME=.

kitting
In a print shop, packaging the completed
published work with attendant binders,
tabs, diskettes, and other equipment or
information, before shipping the finished
product.

L

LAN Local Area Network.

laser (light amplification by stimulated emission
of radiation)

In InfoPrint printers, a device that emits a
beam of coherent light that forms the
image on the photoconductor that is
subsequently transferred to the paper.

late binding
In InfoPrint, waiting to assign a job to an
actual destination until it is about to be
processed. Late binding permits InfoPrint
to route a job to the first suitable actual
destination that becomes available.
Contrast with early binding.

LED Light-emitting diode.
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light-emitting diode (LED)
The imaging device element for
electrophotographic print units.

lines per inch (lpi)
A measure of the density of the grid used
to space halftone dots. Typical grid
spacings are 85 lpi (newspaper), 133 lpi
(low end), 150 lpi (midrange), and 175+
lpi (high quality).

Local Area Network (LAN)
A computer network at one location that
consisting of devices connected to one
another and communicating. This
network can also be connected to a larger
network.

local ID
Local job identifier.

local job identifier
In InfoPrint, a job identifier automatically
generated by the server, identifying the
job to the person who submitted it.
InfoPrint maps a local job ID to a global
job ID.

locale The human language and character set of
information presented to a user.

In InfoPrint, the language InfoPrint uses
when sending notification and error
messages or displaying the InfoPrint
graphical user interfaces.

log A collection of messages or message
segments added to a file for accounting or
data collection purposes.

To record messages in a file.

logical destination
In InfoPrint, an object to which users
submit their jobs. The logical destination
routes jobs to one or more actual
destinations representing output devices
such as printers, electronic mail systems,
or fax machines. See also logical printer;
contrast with actual destination.

logical printer
In InfoPrint, a type of logical destination.
The logical printer routes jobs to one or
more physical printers representing
printing devices.

logical unit (LU)
A type of network accessible unit that

enables end users to gain access to
network resources and communicate with
each other.

logical unit (LU) 6.2
A type of logical unit that supports
general communication between
programs in a distributed processing
environment. LU 6.2 is characterized by
(a) a peer relationship between session
partners, (b) efficient utilization of a
session for multiple transactions, (c)
comprehensive end-to-end error
processing, and (d) a generic application
program interface (API) consisting of
structured verbs that are mapped into a
product implementation.

longest-job-first
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the longest job in the
queue. Contrast with deadline, FIFO
(first-in-first-out), job-priority, and
shortest-job-first.

lpi Lines per inch.

LU Logical unit.

M

magnetic ink character recognition (MICR)
Identification of characters printed with
ink that contains particles of magnetic
material.

mainframe processor
A functional unit that interprets and
executes instructions in a large computer
to which other computers are connected
so that they can share the facilities the
mainframe provides.

makeready
All the setup work involved in preparing
a press for a print run.

manage
In the InfoPrint GUI, the action used to
put an object into a mode where its icon
reflects changes of status.

mechanical
A camera-ready layout. The mechanical
can consist of multiple sheets or overlays
for each spot or process color used. Final
images, if not stripped in later, should be
at final size, cropped and screened to the
correct line frequency.
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medium
In InfoPrint, an object representing the
physical material upon which a job is
printed.

merge data
Data that is unique to each copy of a
document and that customizes the
document; for example, serial numbers or
mailing information. Merge data is
typically a small percentage of the total
data in the document.

message catalog
A file of all the possible messages than
can display during the processing of an
application.

MICR Magnetic ink character recognition.

Mixed Object Document Content Architecture
(MO:DCA)

An architected, device-independent data
stream for interchanging documents.

MO:DCA-P
Mixed Object Document Content
Architecture Presentation.

modify
In InfoPrint, an action used to modify the
values of attributes in the object attributes
notebook.

moire Undesirable interference patterns caused
by two overprinting halftone screens with
incorrect halftone dot angles.

monospaced
In typesetting, pertaining to a typeface in
which all the characters have equal
widths. Monospaced typefaces are useful
for tabulating figures.

Multiple Virtual Storage (MVS)
An operating system developed by IBM.
The design of MVS incorporates an
addressing architecture that provides a
unique address space to each job in the
system.

MVS Multiple Virtual Storage.

N

N_UP Pertaining to the number of forms placed
together in a layout. Typical layouts are
2_UP, 4_UP, 8_UP, 16_UP, and so on.
N_UP printing is done to use the
maximum area of the print sheet.

namespace
A global name repository available to all
utilities and API procedures. The
namespace contains mappings of object
names to other related objects. For
example, the namespace provides the
mapping of a logical destination to the
server in which it is located.

Network File System (NFS)
A protocol developed by Sun
Microsystems that uses Internet Protocol
to allow a set of cooperating computers to
access each other’s file systems as if they
were local.

newline options
The different ways in which the printer
determines how lines are delimited in a
document data stream.

NFS Network File System.

non-process-runout (NPRO)
A printer function that moves the last
printed sheet to the stacker of the printer
device.

non-settable attribute
An attribute that is neither initially
settable nor resettable. The values for
these attributes are controlled by
InfoPrint. Contrast with initially settable
attribute and resettable attribute.

notification
The act of reporting the occurrence of
events.

In InfoPrint, notification of events appears
as messages in event logs or messages
sent to administrators, operators, and job
submitters. In the InfoPrint GUI,
notification of events also appears as
changes to the appearance of icons.

notification-profile
In InfoPrint, an attribute associated with
an object that contains information
designating the people to whom InfoPrint
sends notification about events for that
object, which event information it sends,
and how it sends the information.

NPRO Non-process-runout.

O

object A collection of attributes that represent a
physical or logical entity in the print
system. For example, a specific printer
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device is represented by an actual
destination (physical printer) object. An
object is identified by its object name.
Objects are grouped into classes. See also
object class.

object class
A group of objects that share a common
definition and therefore share common
properties, operations, and behavior as
defined by their attributes. For example,
all InfoPrint queue objects are in the same
object class and each queue has the same
set of queue attributes. However, the
values for those attributes can differ for
each queue in the queue object class.

Object Identifier (OID)
In architecture, a notation that assigns a
globally unambiguous identifier to an
object or a document component. The
notation is defined in international
standard ISO.IEC 8824(E).

object name
The alphanumeric term that identifies an
object.

object state
The state of an object indicates its
availability and readiness for performing
its functions. An object can be in one of a
number of states such as ready, busy, or
unknown.

OCR Optical character recognition.

octet A byte that consists of eight binary digits
(bits).

offset stacking
In certain printer devices, a function that
allows the printer to offset the printed
output pages for easy separation of the
jobs.

OID Object Identifier.

open destinations window
In the InfoPrint GUI, the action used to
open a new application window
displaying the logical and actual
destinations associated with a queue.

Open Prepress Interface (OPI)
An industry standard for replacing
low-resolution images in review
documents with high-resolution images
needed for high-quality final output.

Open Software Foundation (OSF)
A nonprofit research and development
organization created by a consortium of
companies that work together to develop
software in the open systems market.

OpenType font (OTF)
An extension of the TrueType font format
that adds:
v Support for PostScript outlines
v Better support for international

character sets
v Broader support for advanced

typographic control

open window
In the InfoPrint GUI, the action used to
open a new application window
representing one or more objects
displayed in the currently open
application window.

operation
An action performed on one or more data
items.

operator
In InfoPrint, the person responsible for
printer devices. Also, this person
performs a subset of tasks for InfoPrint
queues and actual destinations and
performs some job-related tasks.

OPI Open Prepress Interface.

optical character recognition (OCR)
Conversion of scanned text to editable
ASCII characters.

option A modifier of a command that specifies
the action of the command. A dash
usually precedes an option. Synonymous
with flag. See also keyword.

orphan logical destination
In the InfoPrint GUI, an object that
represents a logical destination that is not
associated with an existing queue.

orphan logical printer
In the InfoPrint GUI, an object that
represents a logical printer that is not
associated with an existing queue.

OSF Open Software Foundation.

overlay
A collection of constant data, such as
lines, shading, text, boxes, or logos, that is
electronically composed in the host
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processor and stored in a library, and that
can be merged with variable data during
printing.

OTF OpenType font.

P

PAC Privilege Attribute Certificate.

page definition
A resource that contains the formatting
controls for line data.

In InfoPrint, a resource that defines the
rules of transforming line data into
composed pages and text controls.

page segment
A resource that contains composed text
and images, which are prepared before
formatting and included during printing.

Palladium
A distributed print system developed at
MIT/Project Athena with participation
from Digital Equipment Corporation
(DEC), International Business Machines
(IBM), and Hewlett-Packard (HP). It is a
reference implementation for the OSI
Document Printing Architecture (DPA)
standard, ISO/IEC 10175.

pane In the Work Area of the InfoPrint
Manager Administration GUI, an area
containing a group of objects of a specific
type, such as an actual destinations pane.

parent/child relationship
In InfoPrint, servers, queues, and
destinations are related to one another in
a parent/child relationship. For example,
a server is the parent of all the queues
that reside in that server, and these
queues are its children.

pass through
In InfoPrint, referring to options
submitted with a job that are used by the
device driver, but not InfoPrint. InfoPrint
does not process or validate this
information; it passes it along to the
device driver. See printer driver.

path The route used to locate files; the storage
location of a file. A fully qualified path
lists the drive identifier (if any), directory
name, subdirectory name (if any), and file
name with the associated extension.

pause In InfoPrint, the action used to

temporarily halt the printing or
transmission of jobs on actual destinations
or the distribution of jobs from servers or
queues.

pdcreate
In InfoPrint, the command used to create
a new object and set its attributes to
specified values.

PDF Portable Document Format.

Printer description file.

pdmsg
In InfoPrint, a utility used to display
information about a message.

pdpr In InfoPrint, the command used to create
and submit a job, consisting of one or
more documents, to a server for printing
or transmission.

perfect binding
A type of book binding in which the
pages are held together with flexible
adhesive. Contrast with edition binding,
spiral binding, and wire-o binding.

permissions
In AIX, codes that determine who can
access a file and what operations they can
perform on the file.

physical printer
In InfoPrint, a type of actual destination
that represents a printer device. See also
printer device.

piobe The standard printer input/output
backend program used by AIX for
printing. See also ainbe.

pipe-pull
In InfoPrint, a document transfer method
where InfoPrint saves the documents in a
file and transfers the address of the file to
the server. InfoPrint transfers the file to
the server upon the request from the
server. This is an efficient transfer method
for large jobs and is the default transfer
method at job submission. Contrast with
with-request.

plex A document or actual destination
attribute used to define the placement of
output images on the page. See the plex
values simplex and tumble.

Portable Document Format (PDF)
An Adobe PostScript data format that can
be viewed or printed.
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Portable Operating System Interface for
Computer Environments (POSIX)

An Institute of Electrical and Electronics
Engineers (IEEE) standard for computer
operating systems.

POSIX
Portable Operating System Interface for
Computer Environments.

PostScript
Adobe’s page description language.
PostScript has become a standard for
graphic design and layout software.
PostScript files can contain both vector
and raster data. Fonts are described using
PostScript coding. Many desktop
publishing systems produce PostScript
data as their output data stream.

PostScript printer description (PPD)
A file that contains options for printing
PostScript data on various printer devices.

PPD PostScript printer description.

preflight
To assess all resources for a job before the
actual print run.

prepress
Work done in the print shop before
printing a job, such as preparing data and
art, page imposition, color retouching,
electronic editing, and page layout.

print database
The set of files on disk that provide a
permanent repository for the attributes of
all print objects, such as logical
destinations, queues, and actual
destinations.

print job
Synonym for job.

Print Quality Enhancement (PQE)
A printer facility that provides edge
smoothing along diagonal lines, fine
fidelity protection, and independent
boldness control.

Print Services Facility (PSF)
Any of several programs, including PSF
for AIX, PSF/MVS, PSF/VM, and
PSF/VSE, that produce printer commands
from the data sent to them.

print system
A group of one or more print servers and
one or more printing devices, which

might or might not be located in the same
geographical area. The components of a
print system are assumed to be
interconnected in some manner, providing
at least one network interface to print
clients, and acting synergistically to
supply the defined document print
service. (D)

printable document
In InfoPrint, an object that represents text
or data to be printed by a job. Contrast
with resource document.

printer description file (PDF)
A file that contains options for printing
PostScript data on a specific printer
device.

printer device
The physical output device that performs
the printing function. See also physical
printer.

printer driver
A file that describes the physical
characteristics of a printer or other
peripheral device. This file is used to
convert graphics and text into
device-specific data at the time of printing
or plotting. Synonymous with device
driver.

priority
In InfoPrint, a number assigned to a job
that determines its precedence in being
printed. Jobs with higher priority
numbers are handled before jobs with
lower priority numbers.

process color
Color made up of CMYK links simulating
a specified color. This is the traditional
method of reproducing continuous tone
color images (color separations). Because
of the nature of color inks, certain inks do
not reproduce well.

processor
In a computer, a functional unit that
interprets and executes instructions. A
processor consists of at least an
instruction control unit and an arithmetic
and logic unit. (T)

promote
In InfoPrint, the action used to move a job
to the beginning of the queue so that it
will print on the next available printer
that can handle that job.
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protocol
A set of semantic and syntactic rules that
determines the behavior of functional
units in achieving communication.

PSF Print Services Facility.

PSF destination support system
In InfoPrint, the destination support
system that communicates with PSF for
AIX to print jobs.

PSF physical printer
In InfoPrint, the object representing a
printer device that uses the PSF
destination support system.

Q

QuarkXpress
A desktop publishing system produced by
Quark, Incorporated.

queue In InfoPrint, an object that manages a
collection of jobs that are waiting to print.
A queue receives jobs from one or more
logical destinations and sends jobs to one
or more actual destinations.

A line or list formed by items waiting for
processing.

R

raster A pattern of dots defined at varying data
depths. Black and white images are
one-bit (on/off); grayscale images are
8-bit (256 levels); RGB images are 24-bit;
CMYK images are 32-bit.

raster image processor (RIP)
A processor in which a PostScript data
stream is converted into dot patterns that
are transferred to the final print medium.
InfoPrint uses an Adobe RIP to convert
PostScript to IPDS for such printers as the
InfoPrint 4000 and InfoPrint 60.

rc.pd In InfoPrint, a utility used to start the
InfoPrint servers listed in the
/etc/pd.servers file.

read-only
In InfoPrint, describes an attribute value
that cannot be set by the user but can
change based on other activity.

ready A state in which an object is ready and
able to perform tasks.

An available resource, such as a value of
the media-ready attribute. Contrast with
supported.

red, green, blue (RGB)
The colors of CRT display phosphors.
RGB images are for screen display only.
They must be converted to CMYK images
before printing.

registration
The accuracy of printing on paper relative
to the edges of the paper.

The accuracy of printing a single color
(cyan, magenta, or yellow) relative to
black.

The accuracy of printing on one side of a
page relative to printing on the reverse
side of the page.

reprographics
The process of copying or duplicating
documents or information.

requested
In InfoPrint, pertaining to the specific
values of attributes requested by a job
when it is submitted. The requested
attribute values of a job are validated
against supported attribute values for an
actual destination to determine if the
printer can handle that job. Contrast with
supported.

resettable attribute
An attribute whose value can be set or
modified after an object has been created,
assuming the object is in an appropriate
state to be modified. See also initially
settable attribute; contrast with non-settable
attribute.

resource
In AFP, a file containing a collection of
printing instructions used when printing
a job. Resources include fonts, overlays,
form definitions, page definitions, and
page segments.

resource context
In InfoPrint, an object that contains
directory path information that helps the
print system locate resources needed for
printing a job. The resources include
fonts, overlays, form definitions, page
definitions, and page segments.

resource document
In InfoPrint, an object that represents a
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resource, such as graphics or fonts, used
by a job to print a printable document.
Contrast with printable document.

resubmit
In InfoPrint, an action used to reroute
pending or retained jobs to a different
logical destination than the one through
which the job was originally submitted.

resume
In InfoPrint, the action used to resume the
printing of paused jobs or resume the
distribution of jobs from paused servers
or queues.

retained job
In InfoPrint, an object that represents a
job that is being stored in the print
system for a specified amount of time,
normally after the completion of printing
the job. A retained job does not reside in a
queue.

retention
The process of storing data after
completion of a process for a certain
length of time.

retrieval
The process of bringing digital archived
data out of storage and into online
memory for reuse. See also archiving.

RGB Red, green, blue.

RIP Raster image processor.

To convert data to dot patterns using a
raster image processor.

root user
In the AIX environment, the system user
with the most authority who can log in
and execute restricted commands, shut
down the system, and edit or delete
protected files. Synonymous with
superuser.

RPC Remote Procedure Call.

RS/6000
A family of workstations and servers
based on IBM’s POWER® architecture.
They are primarily designed for running
multi-user numerical computing
applications that use the AIX operating
system.

S

scanner
A device that converts hardcopy source
data into digital format (halftone dots) to
avoid retyping the data.

scheduler
In InfoPrint, the scheduling method that
the queue uses when assigning a job to an
actual destination.

separator sheet
The sheet of paper, blank or otherwise,
that separates documents in a job. See
also auxiliary sheet.

server In InfoPrint, the object that accepts
configuration, management, and printing
requests, performs the requested
operations, and sends responses back as a
result of the operation.

settable attribute
See initially settable attribute, resettable
attribute.

severity
An indication of how serious an error
condition is.

shell In the AIX operating system, a command
interpreter that acts as an interface
between the user and the operating
system. In InfoPrint documentation, all
shell examples use the Korn shell.

shift-out, shift-in code
Control characters used to indicate the
beginning and end of a string of
double-byte, ideographic characters.

shortest-job-first
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the shortest job in the
queue. Contrast with deadline, FIFO
(first-in-first-out), job-priority, and
longest-job-first.

shut down
In InfoPrint, the action used to halt all
server or actual destination processes
without deleting the server or actual
destination.

signature
A group of pages that are printed, folded,
cut, and bound together. Manual
placement of pages in the signature is
determined using a folding dummy.
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simplex
In InfoPrint, the value of the document or
actual destination plex attribute indicating
that output images are placed on the
media in a head-to-head format, so that
the top of one image is at the same edge
as the top of the next image. Depending
on the value of the document or actual
destination sides attribute, the document
can be printed on one or both sides of the
paper. Contrast with tumble; see also
simplex printing and duplex printing.

simplex printing
Printing on only one side of the paper.
Contrast with duplex printing (1).

Printing on one or both sides of the
paper, placing output images on the
media in a head-to-head format, so that
the top of one image is at the same edge
as the top of the next image. Contrast
with tumble duplex printing; see also duplex
printing (2).

SMIT System Management Interface Tool.

SNA Systems Network Architecture.

spiral binding
A type of book binding in which wire or
plastic coils are threaded through a series
of holes or slots in the binding edge.
Contrast with edition binding, perfect
binding, and wire-o binding.

spot color
Individual colored inks formulated to
exactly match a specified color. Spot color
is used when CMYK process color cannot
produce a reasonable facsimile of the
color or when vivid color is needed. Spot
color is also used when fluorescent or
metallic colors are needed.

spread
In color printing, an area whose
dimensions have been enlarged to
eliminate white space between it and
another color. Contrast with choke.

start sheet
The sheet of paper, blank or otherwise,
that can precede a job. See also auxiliary
sheet.

state Synonym for object state.

stripping
The process of mechanically assembling

film into plate layouts. Page imposition
takes place during stripping.

subnet mask
A bit template indicating which part of an
IP address represents the network. A 1 in
the subnet mask means that the
corresponding bit in the IP address is part
of the network address; a 0 means that it
is not. For example, if the IP address is
9.99.12.137 and the subnet mask is
255.255.255.0, the network address is
9.99.12.0.

subnetwork
Any group of nodes that have a set of
common characteristics, such as the same
network ID.

In the AIX operating system, one of a
group of multiple logical divisions of
another network, such as can be created
by TCP/IP.

subtractive color system
A system that reproduces an image by
mixing (adding) appropriate quantities of
cyan, magenta, and yellow paints on
white paper. These paints reflect certain
colors and absorb—or subtract—others.
Contrast with additive color system.

superuser
Synonym for root user.

supported
In InfoPrint, pertaining to the specific job
attribute values that the actual destination
can accept during job validation. InfoPrint
validates the requested attribute values of
the job against the supported attribute
values of the actual destination to
determine whether the actual destination
can handle that job. Contrast with
requested.

synchronous
Occurring with a regular or predictable
time relationship to a specified action.
Contrast with asynchronous.

system administrator
Synonym for administrator.

System Management Interface Tool (SMIT)
In the AIX operating system, an interface
tool for installation, maintenance,
configuration, and diagnostic tasks. SMIT
lets you perform tasks without entering
any commands.
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Systems Network Architecture (SNA)
The description of IBM’s logical structure,
formats, protocols, and operational
sequences for sending units through, and
controlling the configuration and
operation of, networks.

T

table reference character (TRC)
An optional control character in a print
data set. The TRC identifies the font used
to print the record and can be used to
select a font during printing.

Tagged Image File Format (TIFF)
A digital format for storing scanned
images. TIFF files are also referred to as
raster format files (as opposed to vector
format files). When used in desktop
publishing, TIFF files produce only a
low-resolution FPO image; the
high-resolution data remains on the hard
disk.

task help
A type of online help that provides a list
of tasks that can be completed with a
selected object. When you select a task,
the help provides step-by-step
information about how to complete the
task.

TCP/IP
Transmission Control Protocol/Internet
Protocol.

TCP/IP-attached printer
A printer device attached to an RS/6000
computer through telecommunication
lines using the TCP/IP protocol.

In InfoPrint, a PSF physical printer that
represents a TCP/IP-attached printer
device. See also AIX-attached printer,
direct-attached printer, and
upload-TCP/IP-attached printer.

template
In the InfoPrint Manager Administration
GUI, an object that represents a set of
default attribute values that has been
defined for creating a particular type of
object, such as an actual destination.

ticket See job ticket.

TIFF Tagged Image File Format.

Transmission Control Protocol/Internet Protocol
(TCP/IP)

A set of communication rules used in the
Internet and in any network that follows
the U.S. Department of Defense standards
for inter-network protocol. TCP provides
a reliable host-to-host protocol between
hosts in packet-switched communications
networks and in interconnected systems
of such networks. It assumes that the
Internet Protocol (IP) is the underlying
protocol. See also Internet Protocol.

trapping
In desktop publishing, the amount of
overlap in overprinting colors. Trapping
prevents white paper showing through
gaps caused by normal errors in
registration. On sheet-fed presses,
trapping is usually 0.25 point. See also
choke and spread.

TRC Table Reference Character.

TrueType font (TTF)
A font format based on scalable outline
technology with flexible hinting. Glyph
shapes are based on quadratic curves. The
font is described with a set of tables
contained in a TrueType Font File.

TTF TrueType font.

tumble
In InfoPrint, the value of the document or
actual destination plex attribute indicating
that output images are placed on the
media in a head-to-toe format, so that the
top of one image is at the same edge as
the bottom of the next image. The
document must be printed on both sides
of the paper. Contrast with simplex.

tumble duplex printing
Printing on both sides of the paper,
placing output images on the media in a
head-to-toe format, so that the top of one
image is at the same edge as the bottom
of the next image. Contrast with simplex
printing (2), duplex printing (2).

U

UCR Under color removal.

under color removal (UCR)
Conversion of neutral color areas to black
ink that reduces use of CMY inks,
improves trapping, and reduces setup
time. Generally, UCR is performed during
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image scanning, but some RIPs perform it
during processing. Synonymous with gray
component replacement (GCR).

unmanage
In the InfoPrint Manager Administration
GUI, the action used to put an object into
a mode where its icon does not reflect the
changes of status for the object.

upload printer
See upload-TCP/IP-attached printer.

upload-TCP/IP-attached printer
In InfoPrint, a PSF physical printer that
represents a printer device attached
through an MVS system and managed by
PSF/MVS. InfoPrint communicates with
the MVS system through the TCP/IP
network. See also AIX-attached printer,
direct-attached printer, and TCP/IP-attached
printer.

V

validate
In InfoPrint, to compare the attribute
values requested by a job with the
supported attribute values of the actual
destinations in the system and to
determine whether there is an actual
destination capable of printing or sending
the job.

value A specific characteristic of an attribute.

variable
A name used to represent a data item
whose value can change while the
program is running.

variable data
Data that can be changed between copies
of a document. For example, a form letter
(constant data) can be merged with
variable data, such as a customer’s name
and address to produce personalized
documents.

varnish
A protective layer applied to a finished
sheet, usually for photos, but sometimes
used as a design element because of its
reflective qualities. Varnishes can be
tinted.

vector An absolute coordinate point and line in
space. PostScript files can contain vector
artwork. Vector files are converted to
rasters during the RIP process.

velox A black and white photographic print
made from a halftone negative, to be used
as a proof copy.

vignette
An image with soft, fade-away edges.

Virtual Machine (VM)
An IBM licensed product that manages
the resources of a single computer so that
multiple computing systems appear to
exist.

A virtual data processing system that
appears to be at the exclusive disposal of
a particular user, but whose functions are
accomplished by sharing the resources of
a real data processing system. (T)

Virtual Storage Extended (VSE)
An IBM licensed program whose full
name is the Virtual Storage
Extended/Advanced Function. It is a
software operating system controlling the
execution of programs.

Visual Systems Management (VSM)
In AIX, a type of graphical user interface
that allows system management through
the direct manipulation of objects.

VM Virtual Machine.

VSE Virtual Storage Extended.

VSM Visual Systems Management.

W

web A roll of paper used in web or rotary
printing.

well In the InfoPrint Manager Administration
GUI, an area in a pane that contains a
group of objects related to the objects in
the pane; for example, a queues well in a
servers pane.

what you see is what you get (WYSIWYG)
Refers to the fact that the composite
image displayed on the screen at a
computer workstation has the appearance
of the final printed image.

window
A rectangular area of the screen that you
can move about, place on top of, or pull
under other windows, or reduce to an
icon.

wire-o binding
A continuous double series of wire loops

388 InfoPrint Manager for AIX: Procedures



run through punched slots along the
binding side of a booklet. Contrast with
edition binding, perfect binding, and spiral
binding.

with-request
In InfoPrint, a document transfer method
where the client transfers the documents
directly to the server. Contrast with
pipe-pull.

workstation
A terminal or microcomputer, usually one
that is connected to a mainframe or to a
network, at which a user can use
applications.

write access
A level of authorization that grants the
ability to modify data.

WYSIWYG
What you see is what you get.

X

X-Windows
A network-transparent windowing system
developed by MIT. It is the basis for
Enhanced X-Windows, which runs on the
AIX Operating System.

xerography
A dry printing process using
corona-charged photoconductive surfaces
to hold latent images that are developed
with a dry toner and then transferred to
paper and fused with heat.

Xstation
A terminal that is connected through a
network to an RS/6000 computer, from
which a user can perform command-line
functions and run X-Windows based
applications.
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Index

Special characters
/etc/environment file 135, 137
/etc/hosts file 24
/usr/lib/font/devafp/devafp.fontmap

file 227
/usr/lib/font/devhplj directory 226
/usr/lpp/psf/config directory 251
/usr/lpp/psf/fontlib directory 226
/usr/lpp/psf/gif2afp/gif2afp.3160cfg

file 161
/usr/lpp/psf/gif2afp/gif2afp.cfg

file 161
/usr/lpp/psf/gif2afp/gif2afp3900.cfg

file 161
/usr/lpp/psf/grd directory 239
/usr/lpp/psf/jpeg2afp/jpeg2afp.3160cfg

file 161
/usr/lpp/psf/jpeg2afp/jpeg2afp.cfg

file 161
/usr/lpp/psf/jpeg2afp/jpeg2afp3900.cfg

file 161
/usr/lpp/psf/pcl2afp/pcl2afp.cfg

file 153
/usr/lpp/psf/pcl2afp/pcl2afpd.cfg

file 153
/usr/lpp/psf/ppml22afp/ppml2afp.cfg

file 177
/usr/lpp/psf/ppml2afp/ppml2afp.cfg

transform command configuration file,
default 178

/usr/lpp/psf/ps2afp/826*.cfg file 172
/usr/lpp/psf/ps2afp/ps2afp.cfg

file 153
/usr/lpp/psf/ps2afp/ps2afpd.cfg

file 153
/usr/lpp/psf/tiff2afp/tiff2afp.3160cfg

file 161
/usr/lpp/psf/tiff2afp/tiff2afp.cfg

file 161
/usr/lpp/psf/tiff2afp/tiff2afp3900.cfg

file 161
/var/pd file system 142
/var/psf file system 142
/var/psf/fonts directory 221
/var/psf/segments directory 49
/var/psf/segments file system 142
.profile file

editing 137
use of 135

—Z option
using to submit attributes through a

file 51

common errors 308
finding error information 307
troubleshooting 307

A
abend code 522 308

Access control list (ACL)
interoperating environment 255

accessibility 361
accounting data

gathering 97
viewing 97

accounting user-exit
contents 102
formatting data 104
managing the file 105

accounting.log file 100, 102, 106
actual destination 43

associating input data user-exit
program with 93

associating output data user-exit
program with 93

attributes 37
create 8
pause 338
restarting 339
resuming 339

ADDRESS 301
Advanced Function Presentation 179
AFP 179

capabilities for transforming to 181
configuration file for 183
resources for graphic data 182
scenarios for using data 179

AFP data stream, build 273
AFP Download Plus support 297
AFP resources, identify 9
AFP resources, search order 108
AFP Upload

configuring the host server
program 301

supported configuration
parameters 302

ainupod1 104
ainupod2 105
ainupod3 105
ainurpt1 105
ainurpt3 105
ainurpt4 105
ainurpt5 105
ainurpt6 105
ainurpt7 105
ainurpt8 105
ainurpt9 105
AIX

adding non-IBM fonts 221
monitoring memory 139
monitoring space 139

AIX client attributes
ADDRESS 301
BUILDING 301
BURST 302
CLASS 302
COPIES 302
DATACK 302
DEPARTMENT 302
DESTINATION 302

AIX client attributes (continued)
FORMDEF 302
FORMS 302
NAME 302
ROOM 302
TITLE 302
WRITER 302

AIX command line, printing from 34
AIX command values 253
AIX commands

AIX commands
df 142
make 59

df 142
make 59
using 278

AIX printer backend
pioibmdpm 17, 20

AIX printer halftone files 164
allowing the auxiliary-sheet-selection job

attribute with the BSD DSS 94
appearance

dark 32
highlight midtone 32
standard 32

apsux15m user exit program 296
associating

a transform with an actual
destination 195

assumptions
command line 278
InfoPrint Submit Express 279

attribute
ack-interval 355, 359
actual destination 37
current-page-printing 355
destination-tcpip-internet-address 41
input-trays-medium 37
job-copies-completed 355
media-sheets-completed 355
media-supported 37
notification-profile 124
output-bin-numbers 37
page-select 359
pages-completed 355
plexes-supported 37
printer-model 37
psf-tray-characteristics 37
snmp-community-name 41
snmp-discovery-during-startup 43
snmp-retry-count 42
snmp-timeout 42
snmp-write-community-name 41
use-snmp 41

attributes
auxiliary sheets, used to create 91
capture-inline-otf-resources 223
delivery-address 125, 126
delivery-method 125, 126
event-identifiers 125
events-supported 125
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attributes (continued)
job-end-message 129
job-start-message 129
job-start-wait 129
log-backup-number 313
notification-profile 124
notify-operator 129
of a line-data input file 80

audit user-exit
contents 102
formatting data 104
managing the file 105

audit.log file 100, 102, 106
auditing data

gathering 97
viewing 97

automatic tasks during migration 146
auxiliary-sheet attribute

activating for post-print accounting
information 92

auxiliary-sheet object
activating for accounting or audit

information 92
associating with PSF printers 91

auxiliary-sheet objects
creating 91
default objects 84
edge marks 84
examples of 86
managing 83
sequence of 89
terms relating to 83

B
back up 146
backspacing 265, 340, 341
backup directory

for system changes 222
Backups 256
bar code support 181
booklet maker finishing options 20, 23,

29
Booklet Maker function 19, 23, 29
BSD DSS

allowing the auxiliary-sheet-selection
job attribute 94

BUILDING 301
BURST 302

C
calibrating

densitometer 30
halftone 33
printer 32

calibrating a printer using the halftone
management system 32

cannot be upload file 309
cannot communicate with TCP/IP 309
capabilities, XML Extender 181
capture-inline-cmr-resources 111
capture-inline-otf-resources attribute 223
CASE 302

host server configuration
parameters 302

changing
notification 124

changing attributes 277
InfoPrint Manager Administration

GUI 277
InfoPrint Submit Express 280

changing color and resource
attributes 274

changing Select notifications 120
CLASS 302
cleaning up file systems 142
CMRs

search order 110
cmt.cfg file 249
cmt.cfg file, sample 251
cmtsampl file 249
color attributes 274

color-bits-per-plane 275
color-bits-per-plane-supported 275
color-profile 274
color-profiles-supported 274
color-toner-saver 276
color-toner-saver-supported 276
using 274

color email 54
color mapping table

parts of 249
specific object types to map 250

color mapping table,
submitting source and output files for

printing 253
color mapping table, creating 251
color space value

GOCA pattern fill 250
Highlight color 250
Standard Object Content Architecture

(OCA) 250
color-bits-per-plane 275
color-bits-per-plane-supported 275
color-profile 274
color-profiles-supported 274
color-toner-saver 276
color-toner-saver-supported 276
command

IPDS operator 351
pdclean 351
pddisable 351
pdenable 351
pdls 351
pdpause 352
pdpr 319, 326
pdresume 352
pdrm 352
pdshutdown 359
pdspace 352

commands
df 139
fstshow 3
pdcreate 195
pddelete 195
pdls 195, 278
pdpr 279
pdq 279
pdset 124, 195, 274

common customization tasks 183
common error

abend code 522 308

common error (continued)
cannot be upload file 309
cannot communicate with

TCP/IP 309
host server program failure 309
wrong values in MVS JES spool 308

common errors 308
community

SNMP 41
conditionally- terminating

transform 189
conditionally- terminating transform

object
example 198

Configurable Transform Subsystem 189
configuration

PPML transform 177
configuration files 179

/usr/lpp/psf/gif2afp/
gif2afp.3160cfg 161

/usr/lpp/psf/gif2afp/
gif2afp.cfg 161

/usr/lpp/psf/gif2afp/
gif2afp3900.cfg 161

/usr/lpp/psf/jpeg2afp/
jpeg2afp.3160cfg 161

/usr/lpp/psf/jpeg2afp/
jpeg2afp.cfg 161

/usr/lpp/psf/jpeg2afp/
jpeg2afp3900.cfg 161

/usr/lpp/psf/pcl2afp/
pcl2afp.cfg 153

/usr/lpp/psf/pcl2afp/
pcl2afpd.cfg 153

/usr/lpp/psf/ppml22afp/
ppml2afp.cfg 177

/usr/lpp/psf/ps2afp/826*.cfg 172
/usr/lpp/psf/ps2afp/ps2afp.cfg 153
/usr/lpp/psf/ps2afp/

ps2afpd.cfg 153
/usr/lpp/psf/tiff2afp/

tiff2afp.3160cfg 161
/usr/lpp/psf/tiff2afp/

tiff2afp.cfg 161
/usr/lpp/psf/tiff2afp/

tiff2afp3900.cfg 161
GIF transform 161
JPEG transform 161
Parallel PDF transform client 172
PCL transform 153
PDF transform 153
PostScript transform 11, 153
TIFF transform 161
xml2afp.cfg 183
xml2pdf.cfg 186

configuration parameters
supporting AFP Upload 302

configuration tasks
media 45

configuring
cutter-trimmer-stacker 23
email 49
for receiving notifications with Select

on Windows 120
Halftone Management System 29
halftone support 29
hardware 7
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configuring (continued)
host server program 301
InfoPrint 2000 12
InfoPrint 2085 and InfoPrint 2105 with

InfoPrint Manager 17
InfoPrint 2090ES and InfoPrint 2105ES

with InfoPrint Manager 17
InfoPrint 4000 23
InfoPrint 4100 23
transforms 191

configuring for cut sheet emulation 247
Configuring your server notification

profile 141
COPIES 302
Courier 219
creating

a transform object that updates the
job’s page count 200

auxiliary sheet objects
default 91
your own 91

conditionally- terminating transform
object 198

resource-context objects, new 114
terminating transform object 196
transform to convert data and print

only smaller files 198
transform to copy a file without

printing 196
transforms 191

creating a color mapping table 251
creating an InfoPrint email

destination 50
creating job ticket 279
custom patch sets, defining 32
customization tasks 183

common 183
Customize Dialog for adding the Email

option 50
customizing

error logs in the server 313
GIF transform 161
img2afp transform 163
JPEG transform 161
PCL transform 153
PDF parallel transform 172
PDF transform 153
PostScript transform 153
PPML transform 177
TIFF transform 161

cut sheet emulation
configuring for 247
using 247

cut sheet emulation support, defaults and
limitations 248

cutter-trimmer-stacker (CTS)
configuring 23

D
daemon

configuration files 173
daemons

/usr/lpp/psf/ps2afp/
ps2afpd.cfg 153

826*.cfg 173
pcl2afpd 154

daemons (continued)
ps2afpd 154, 155
rexecd 24

data objects
search order 110

data sets, printing through MVS
Download 285

data stream
AFP 273
error 355

job continues printing 356
job is terminated, no pages

print 356
job is terminated, some pages

print 357
PostScript 273
transforms 189

DATACK 302
DATACK parameter

AIX value 302
overriding PSF for z/OS value 302

dbblank exit program 169
default job 123
default notification profile 122
defining

custom patch sets 32
InfoPrint servers to the halftone

management system client 32
transform sequence 190

defining RIPs 176
defining the SMTP email server to

InfoPrint 49
delete

and retain 345
delivery-address 125, 126
delivery-method 125, 126
densitometer, calibrating 30
densitometer, measuring optical density

with 34
DEPARTMENT 302
DESTINATION 302
destination support system (DSS) 337,

340, 343, 347
destination-MID-support-enabled

destination-MID-release-timer 203
destination-tcpip-internet-address 41
device_controls finishing option 157
device-specific actual destination

attributes
non-settable 39
settable 39

df command 142
Direct download 287
Direct download method

performance 287
directories

/tmp 53
/usr/lib/font/devhplj 226
/usr/lpp/psf/bin 249
/usr/lpp/psf/cmt/ 254
/usr/lpp/psf/config 249, 251
/usr/lpp/psf/fontlib 226
/usr/lpp/psf/grd 239
/var/psf/fonts 221
/var/psf/PrinterName 241
/var/psf/segments 49, 142
cleaning up 142

directories (continued)
definition 139
global resource identifiers

(GRIDS) 241
Directories

/tmp 54
disability 361
Disk Usage tool 142
disk-space-low event 141
displaying

InfoPrint Manager Operations GUI
from the Enhanced Operator
Console 24

ditroff transform
ditroff characters mapped to IBM font

characters 227
files, InfoPrint supplied 234
fonts, adding 234
fonts, required for 226

ditroff, character mapping tables 227
double-byte character set ASCII and EUC

transform
font resources, setting up 235
fonts, required 235

DSS (see also Destination support
system) 340

E
E-mail 124
ecp 224
edge marks

auxiliary sheets 84
editing

/etc/environment file 137
.profile file 137

email destination, creating 50
Enable MID Support 203
enabling font capture

for OpenType fonts 223
environment variables

MANPATH 138
overview 135
PATH 138
PD_SOCKET 5
PDBASE 138
PSFPATH 109
setting 138
setting of 135
verifying setting 138

error
IPDS

data stream errors 355
insufficient memory 357
intervention required

conditions 358
unrecoverable problems 359

messages 356, 357, 358
out of paper 342
paper jam 342

error information 307
error logs

customizing 313
using the log-backup-number

attribute 313
event-identifiers 125
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events
detecting 117
disk-space-low 141
messages about 117
out-of-disk-space 141

events-supported 125
example configuration

JCL for host server as a job 311
JCL for host server as address

space 310
examples

auxiliary sheets 86
img2afp transform 165
of creating transform objects 196

executable reporting utilities
ainupod1 104
ainupod2 105
ainupod3 105
ainurpt1 105
ainurpt2 105
ainurpt3 105
ainurpt4 105
ainurpt5 105
ainurpt6 105
ainurpt7 105
ainurpt8 105
ainurpt9 105

extended code pages 224

F
file size for /var/psf/segments 49
file system

/etc/environment 135
/usr/lib/font/devafp/

devafp.fontmap 227
/var/pd 142
/var/psf 142
/var/psf/segments 142
.profile 135
charset.grd.sample 239
cleaning up 142
codepage.grd.sample 240
cpgid.grd.file 240
fgid.grd.sample 240
fixed-length, line-data 167
variable-length, line-data 167

file systems
definition 139
monitored by InfoPrint Manager

for AIX 141
files

/etc/hosts 24
/etc/pdserver.conf 5
/usr/lpp/psf/gif2afp/

gif2afp.3160cfg 161
/usr/lpp/psf/gif2afp/

gif2afp.cfg 161
/usr/lpp/psf/gif2afp/

gif2afp3900.cfg 161
/usr/lpp/psf/jpeg2afp/

jpeg2afp.3160cfg 161
/usr/lpp/psf/jpeg2afp/

jpeg2afp.cfg 161
/usr/lpp/psf/jpeg2afp/

jpeg2afp3900.cfg 161

files (continued)
/usr/lpp/psf/pcl2afp/

pcl2afp.cfg 153
/usr/lpp/psf/pcl2afp/

pcl2afpd.cfg 153
/usr/lpp/psf/ppml22afp/

ppml2afp.cfg 177
/usr/lpp/psf/ppml2afp/

ppml2afp.cfg 178
/usr/lpp/psf/ps2afp/826*.cfg 172
/usr/lpp/psf/ps2afp/ps2afp.cfg 153
/usr/lpp/psf/ps2afp/

ps2afpd.cfg 153
/usr/lpp/psf/tiff2afp/

tiff2afp.3160cfg 161
/usr/lpp/psf/tiff2afp/

tiff2afp.cfg 161
/usr/lpp/psf/tiff2afp/

tiff2afp3900.cfg 161
accounting.log 100, 102, 106
audit.log 100, 102, 106
body.txt 52
cmt.cfg 249
cmt.cfg sample 251
cmtsampl 249
email_script/samp.script 52
pie1.cfg 253
pie1.out 253, 254
pie1.src 253
podaccount.log 102, 106
prt1.accounting.log 100
Resource Access Table 223
sample file for RGB mapping 253
sampleJPEG.ppml 177
samplePDF.ppml 177
samplePS.ppml 177
sampleTIFF.ppml 177
sig.txt 52
user.map 221
UserInit 220
UserInit.turnFontSubstitutionOn.sample 221

finishing
InfoPrint 45 319
InfoPrint 70 326
staple and punch options with

ps2afp 158
fixed-length files 167
font capture

for fonts in a library 223
overview 223

font index files 179
customizing 184

font support 181
fonts

adding non-IBM fonts to AIX 221
adding Type 1 fonts to a personal font

library 221
Courier 219
global resource identifiers

(GRIDS) 239
IBM mapped to ditroff

characters 227
printer-resident 239
required for double-byte

transform 235
required for PostScript transform 219
resource-context object 107

fonts (continued)
substitution

through initialization files 220
UserInit file 220

using OpenType fonts 222
form definition

finishing 320, 327
formatting accounting data 104
formatting audit data 104
formatting objects 179

definition 179
FORMDEF 302
FORMS 302
forward spacing 265, 340, 341
fstshow command 3

G
generating color mapping table source

and output files 249
global resource identifiers

description 239
global id example 244
location 241
modifying 243
resident font id example 243
specifying 245
specifying fonts 239

global resource identifiers (GRIDS) 239
GOCA pattern fill color space 250
graphic interchange format transform

configuration files 161
customizing 161

graphic support 182
guidelines

specifying JCL 310

H
halftone

calibrating 33
specifying for printing on InfoPrint

server 34
halftone management system

invoking 29
overview 29

Halftone Management System
actual screen frequencies and

angles 25
using 29
Versions 2 or Standard Toner 25
Versions 2, 3, or Standard Toner 26
Versions 3 Toner 25

halftone management system client
starting 30

halftone management system server
starting 30

halftones
configuring printer devices for 29

hardware
cutter-trimmer-stacker 23
InfoPrint 2000 12
InfoPrint 4000 23
InfoPrint 4100 23
installing and configuring 7

help for notification messages 128
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hierarchy of PPML transform
options 178

Highlight color color space 250
host server configuration parameters

CASE 302
MIXED 303
PORTNUM 303
specifying values on JCL 303
TASN 303
TRACE 303

host server program 310
running as a job 310
running as an address space 310

host server program failure 309
hot folder

mapping 268
mounting 268

http://www.infoprint.com 281

I
icons

Disk Usage 142
img2afp transform 163, 164

AIX printer halftone files 164
configuration files 163
customizing 163
examples 165
limitations 165
thresh printer files 163

improving performance in the PDF
RIP 154

IMPs 93
InfoPrint 2000 265

configuring 12
limitations 16
shutting down 13
spacing 341

InfoPrint 2000 model MS1,
configuring 12

InfoPrint 2060ES and InfoPrint 2075ES
configuring 17

InfoPrint 2085 and InfoPrint 2105
configuring 17

InfoPrint 2090ES and InfoPrint 2105ES
configuring 17

InfoPrint 3000 265
spacing 341

InfoPrint 4000 265
configuring 23
displaying InfoPrint Manager

Operations GUI from the Enhanced
Operator Console 24

feature 4560 24
spacing 341

InfoPrint 4000 printer
actual screen angles 25
actual screen frequencies 25

InfoPrint 4100 265
configuring 23

InfoPrint 4100 printer
actual screen angles 25
actual screen frequencies 25

InfoPrint 45
duplexing 333
finishing options 319
using 333

InfoPrint 5000
setting up

Model CS1 267
Models CD1/2 267

InfoPrint 70
duplexing 333
finishing options 326
using 333

InfoPrint Color 130 Plus 177
InfoPrint commands

InfoPrint commands
mkfntmap 219
mvsprsd 294

mkfntmap 219
mvsprsd 294
pdaccount 97

InfoPrint Control
configuring

media 45
InfoPrint email destination, creating 50
InfoPrint Manager 145, 146, 287

service update 314
InfoPrint Manager Administration GUI

starting from command line 277
starting from Windows desktop 277

InfoPrint Manager Administration GUI,
changing attributes 277

InfoPrint Manager Notifications 117
InfoPrint Select

finishing 320, 327
InfoPrint servers, defining to the halftone

management system 32
InfoPrint Submit

finishing 327
InfoPrint Submit Express 247

finishing 320
InfoPrint Submit Express, printing

from 34
InfoPrint System Migration utility 146
INITAPI macro 309
input data

user-exit programs
associating with actual

destination 93
input data format

PCL 189
PostScript 189

input file, line-data transform 80
input record user-exit, line-data

transform 74
input-trays-medium 37
installing

InfoPrint 2000 12
InfoPrint 4000 23
InfoPrint 4100 23
PDF parallel transform 170

installing hardware 7
insufficient memory 357

example 358
Internet Printing Protocol (IPP)

client software 203
IPP Gateway 203

interoperating environment 255
example configurations 256
namespace 257
printer driver 257
reasons for setting up 255

interoperating environment (continued)
security 257

interrupt job 339
Interrupt message page mark form 94
Interrupt Message Pages

Activating IMPs 94
Using Interrupt Message Pages 93

intervention required conditions 358
example 358

IOCA object support 182
IPDS

error recovery
data stream errors 355
insufficient memory 357
intervention required

conditions 358
unrecoverable problems 359

print operator commands 351
ismu utility 145
ismu Utility

prerequisites 146

J
JCL

SYSPRINT DD statement 302
JCL for a job

example for host server 310
JCL for address space

example for host server 310
JCL for host server as a job

example 311
JCL for host server in address space

example 310
job

hold 335, 340
interrupt 339
pause 338
restarting 336, 340
stopping 335

job tickets
viewing accounting data 97

job-end-message 129
job-start-message 129
job-start-wait 129
jobs

required for troff transform 226
joint photographic experts group

transform
configuration files 161
customizing 161

K
keyboard 361

L
limitations

img2afp transform 165
InfoPrint 2000 16
printing line data with OpenType

fonts 225
limitations of actual screen frequencies

and angles on InfoPrint 4000 and 4100
printers 25
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limitations, XML Extender 181
line printer (LPR) gateway 283
line-data transform

carriage controls 166
files, variable-length and

fixed-length 167
fonts, specifying 236
imageout keyword, affecting

processing 168
introduction 166
restrictions 166
user-exit programs 168

log-backup-number attribute 313
logging Send and Save accounting

information 17, 19, 21, 22, 26, 28
logical destination, create and

configure 8

M
maintenance 342
Managed IPDS Dialog (MID) 203
managing

accounting and audit data 105
auxiliary sheets 83

MANPATH environment variable 138
manuals

Graphics Objects Content Architecture
for Advanced Function Presentation
Reference 251

InfoPrint 400 HC Introduction and
Planning Guide 251

InfoPrint Hi-Lite Color Application
Design Reference 251

Mark form, interrupt message page 94
maximum-presentation-object-containers-

to-keep attribute 111
measuring optical density 34
media-supported 37
medium

configuring 45
memory

insufficient 357
messages

notification, getting help for 128
Microsoft Unicode Open Type Fonts 222
MID Release Timer 203
migrate 146
MIXED 303

host server configuration
parameters 303

mixed language environment
configuring servers 4

mixed locale
configuring servers 4

Mixed Object Document Content
Architecture 190

mkfntmap command 219
mkfntmap utility

adding Type 1 fonts to the
server 221, 222

MO:DCA-P output support 182
monitoring file system use

polling schedule 140
monitoring memory 139
monitoring space 139

moving
accounting and audit data 105

multiple printers
with MVS Download 289

multiserver configuration 256
MVS Download

daemon 285
deleting orphaned files 299
description 285
print options translation table 292
resubmitting orphaned files 299
shell script 286
with multiple printers 289

MVS Download support
apsux15m user exit 296

mvsprpsm.sh shell script 286
mvsprsd command 294
mvsprsd daemon 285

N
NAME 302
Namespace

interoperating environment 257
sharing 255

non-IBM fonts, adding to AIX 221
non-zero return codes, line-data

transform 80
notification

changing 124
message 117

actual destination 122
default job 122
job 122
logical destination 122
queue 122
server 122

messages, getting help for 128
notification profile 117

default 122, 141
modifying 141
Select 120

notification-profile 124
notify-operator 129

O
object types to map 250
OpenType fonts 107

capturing fonts in a library 223
limitations 225
non-Latin typefaces 222
Resource Access Table file 223
Unicode support 222
updating the global search path 225
using 222
using font capture 223

operator
tasks 351

optical density, measuring with a
densitometer 34

out of paper 342
out-of-disk-space event 141

output data
user-exit programs

associating with actual
destination 93

output data format 189
output document size support 181
output fields

DOCRU 70
ExtStart Date 69
ExtStop Date 69
Start Date 69
Start Time 69
Stop Date 70
Stop Time 70

output record user-exit, line-data
transform 77

output-bin-numbers 37
overlay support 182
overlays

resource-context object 108

P
page definitions

resource-context object 108
Page Printer Formatting Aid (PPFA) 273
page segment support 182
paper fed LEF 322, 323, 329
paper fed SEF 323, 324, 329
paper jam 342
parts of a color mapping table

source groups 249
target groups 249

PATH environment variable 138
pause actual destination 338
pause printer 338
pausing a job that’s printing 338
PCL printer

submitting PSF printer input 213
pcl2afpd daemon

configuration file 154
PD_SOCKET environment variable 5
pdaccount command 97
PDBASE environment variable 138
pdclean 351
pdcreate 195
pddelete 195
pddeviceop command

with SNMP devices 40
pddisable 351
pdenable 351
PDF 179

capabilities for transforming to 182
configuration file for 186
output support 182
scenarios for using data 179

PDF parallel RIP transform
customizing 172
installing 170

PDF RIP
improving performance in a

multi-processor AIX server 154
pdfprs client

customizing 172
installing 170
troubleshooting 176

pdinitports utility 3
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pdls 195, 351
pdls command 278

with SNMP devices 40
pdpause 352
pdpr

finishing 319, 326
pdpr command 279
pdpr command, using 248
pdq command 279
pdresume 352
pdrm 352
pdserver.conf file 5
pdset 124, 195
pdset command 274

with SNMP devices 40
pdshutdown 359
pdspace 352
performance 42

improving performance in a
multi-processor AIX server 154

Personalized Print Markup Language
(PPML) 177

pioibmdpm printer backend 17
pioipdm printer backend 20
PL/I language

specifying run-time options 304
plexes-supported 37
podaccount.log file 102, 106
polling schedule

file system use 140
Portable Document Format 179
portable document format transform

configuration files 153
customizing 153
fonts required 219

PORTNUM 303
host server configuration

parameters 303
PostScript 190, 191, 320, 327
PostScript data stream, build 273
PostScript transform

configuration files 153
customizing 153
fonts required 219
staple and punch options 156

PPDS printer
submitting PSF printer input 213

PPML 177
PPML transform

configuration files 177
customizing 177
hierarchy of options 178
overview 177
sample configuration file 177

ppml2afp configuration file, sample 177
presentation object containers 9
presentation-object-container-extraction-

mode 276
PRINTDEV statement 302
printer

pause 338
restarting 339
resuming 339

printer calibration icon 29
printer control language transform

configuration files 153
customizing 153

printer devices
configuring to support halftones 29
InfoPrint 20 29
InfoPrint 2000 12
InfoPrint 4000 23, 29
InfoPrint 4100 23

printer driver 257
printer media 23
Printer Properties notebook 61
printer-model 37
printing from AIX command line 34
printing from InfoPrint Submit

Express 34
properties notebooks 124
prt1.accounting.log.v1 file 100
ps2afp transform

staple and punch options 158
ps2afpd daemon

configuration file 154
ps2afpd.cfg file

device_controls option 157
modifying for finishing 157
plex keywords 157
staple and punch options 156

PSF Destination Support System
(DSS) 340, 344

PSF DSS user-exits
sample programs

accounting 58
accounting log 58
audit 58
header page 58
input data 58
output data 58
separator page 58
trailer page 58

PSF Physical Printer Properties Notebook,
using 248

PSF printer
finishing 320

PSF printer input 213
PSFPATH 109

R
receiving notifications with Select on

Windows
configuring 120

related publications xiii
requirements to compile user-exit

programs 59
resident fonts 239
Resource Access Table file 223
resource allocation table

registering OpenType fonts 107
resource attributes 276

presentation-object-container-
extraction-mode 276

resource-context-presentation-object-
container 276

resource attributes, using 274
resource user-exit, line-data

transform 78
resource-context object

resource-context object 107
resource-context objects

changing directory paths 114

resource-context objects (continued)
creating and managing 107
data object font resources 107
data objects 107
fonts 107
for MVS Download 286
form definition 107
overlays 108
page definition 108
page segments 108
resource-context object 108
resource-context objects 107
restriction 107

resource-context-presentation-object-
container 276

resources for graphic data 182
restarting actual destination 339
restarting job 336, 340
restarting printer 339
restrictions

line-data transform 166
resuming actual destination 339
resuming printer 339
retained jobs 337, 343, 347
retaining resources for multiple print

jobs 111
reusing resources for multiple print

jobs 111
rexecd daemon

for InfoPrint 4000 feature 4560 24
ROOM 302
running XML transforms 181

S
sample cmt.cfg file 251
scenarios for using AFP and PDF

data 179
screen captures

Customize Dialog for adding the
Email option 50

Server Properties Dialog for Setting
the Mail Server 49

search order
CMRs 110
data objects 110

security
interoperating environment 257

Segment Size Parameter 143
Select notifications

changing 120
notification profile 120

selecting
finishing options 322, 329

Send and Save functions 17, 21, 26
send job

command line 278
Download for z/OS 280
InfoPrint Submit Express 279

Server Properties Dialog for Setting the
Mail Server 49

servers
creating and managing 3
mixed language environment 4
shutting down 5
starting 4

setting an environment variable 138
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setting Color Mapping Table with
InfoPrint Manager Administration
GUI 254

setting the SMTP server 49
setting up 273

build data stream 273
create actual destination 8
creating and configuring a logical

destination 8
identify AFP resources 9

setting up InfoPrint 5000
Model CD1/2 267
Model CS1 267

shortcut keys 361
shutting down

InfoPrint 2000 13
servers 5

sides 342
Simple Network Management Protocol

(SNMP) MIB 265
SMIT

creating servers 4, 5
panels

Start a Server 4
Stop a Server 5

shutting down
servers 5

starting
servers 4

SMTP email server , defining to
InfoPrint 49

SMTP server, setting 49
SNMP

attributes
snmp-community-name 41
snmp-discovery-during-

startup 43
snmp-retry-count 42
snmp-timeout 42
snmp-write-community-name 41
use-snmp 41

communication
setting up 37
tuning 37

detecting, reporting printer
problems 37

polling 43
requests 37
smart-defaulting attributes 37

SNMP connection lost 41
SNMP printers

working with 37
software prerequisites for AFP

Upload 301
description 301

source groups, using 249
spacing 336, 346

backspacing 340
forward spacing 265, 340

specifying halftone for printing 34
Standard Object Content Architecture

(OCA) color space 250
staple and punch options 156
starting

servers 4
stopping

servers 5

stopping job 335
structures of user-exit programs 62
stylesheet language 179
submitting attributes through a file with

the —Z option 51
submitting color mapping table source

and output files 253
submitting email jobs 50
submitting files with a Korn shell script

Korn shell script, submitting email
files 52

submitting job, command line 278
submitting job, InfoPrint Submit

Express 279
submitting jobs through the AIX

command line 253
submitting text files with a Korn shell

script
Korn shell script, submitting email

text files 53
supported operating environments 145
SYSPRINT DD statement

including for 302

T
tag image file format transform

configuration files 161
customizing 161

target groups, using 250
TASN 303

host server configuration
parameters 303

TCP/IP address 41
terminating

transform 189
terminating transform object

example 196
TITLE 302
toner versions

effect on actual screen angles for
InfoPrint 4000 ID5/ID6 25

effect on actual screen angles for
InfoPrint 4000 IR1/IR2 26

effect on actual screen angles for
InfoPrint 4000 IR3/IR4 25

effect on actual screen frequencies for
InfoPrint 4000 ID5/ID6 25

effect on actual screen frequencies for
InfoPrint 4000 IR1/IR2 26

effect on actual screen frequencies for
InfoPrint 4000 IR3/IR4 25

effect on actual screen frequencies for
InfoPrint 4100 HD1/HD2 25

effect on actual screen frequencies for
InfoPrint 4100 HD3/HD4 25

effect on actual screen frequencies for
InfoPrint 4100PD1/PD2 25

TRACE 303
host server configuration

parameters 303
transform

associating with an actual
destination 195

conditionally- terminating 189
Configurable Transform

Subsystem 189

transform (continued)
input data format 189
options 189
output data format 189
terminating 189

transform command configuration file,
default

/usr/lpp/psf/ppml2afp/
ppml2afp.cfg 178

transform objects
examples of creating 196

transform sequence
defining 190

transform_update utility
example 200

transform_update utility, using 201
transformation process 180
transforms

configuring 191
creating 191
GIF 161
img2afp 163
JPEG 161
line data 166
PCL 153
PDF 153
PostScript 153
TIFF 161

troubleshooting
307

defining RIPs 176
specifying an uneven number of

RIPs 176
using the –p and–g flags 176

Type 1 fonts 221

U
Unicode extended code pages 224
unrecoverable problems 359

example 359
user-exit programs

accounting 67
activating 61
compiling your own 59
description of 83, 84
header (start) page 66
InfoPrint supplied 90
input data 70
line-data transform 168
line2afp input record 74, 77
line2afp resource 78
managing 83
output data 73
sample programs supplied 57
separator page 66
sequence of use 89
structures 62
trailer (end) page 66

user.map file 221
UserInit file 220
UserInit.turnFontSubstitutionOn.sample

file 221
using

cut sheet emulation 247
InfoPrint Job Ticketer 247
InfoPrint Submit Express 247
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